Safety guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring to property damage only have no safety alert symbol. The notices shown below are graded according to the degree of danger.

⚠️ Danger
indicates that death or severe personal injury will result if proper precautions are not taken.

⚠️ Warning
indicates that death or severe personal injury may result if proper precautions are not taken.

⚠️ Caution
with a safety alert symbol indicates that minor personal injury can result if proper precautions are not taken.

⚠️ Caution
without a safety alert symbol indicates that property damage can result if proper precautions are not taken.

⚠️ Attention
indicates that an unintended result or situation can occur if the corresponding notice is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and operation of a device/system may only be performed by qualified personnel. Within the context of the safety notices in this documentation qualified persons are defined as persons who are authorized to commission, ground and label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Note the following:

⚠️ Warning
This device and its components may only be used for the applications described in the catalog or the technical description, and only in connection with devices or components from other manufacturers which have been approved or recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and assembly as well as careful operation and maintenance.

Trademarks

All names identified by © are registered trademarks of the Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.
Preface

Purpose of this Manual
This Manual explains the principle use and functions of the D7-SYS automation software with the main focus on the appropriate technological and drive control components SIMATIC TDC, FM 458-1 DP, T400, SIMADYN D.

TDC: Technology and Drives Control

Basic knowledge required
This Manual addresses programmers and commissioning engineers. General knowhow regarding automation technology is required in order to understand the contents of the Manual.

Validity of the Manual
This Manual is valid for SIMATIC D7-SYS Version 7.1 SP1.
Information overview

This manual is part of the overall documentation for the technological and drive control components T400, FM 458, SIMADYN D, SIMATIC TDC and SIMATIC D7-SYS.

<table>
<thead>
<tr>
<th>Titel</th>
<th>Inhalt</th>
</tr>
</thead>
</table>
| System and communications configuring D7-SYS | The first project in a few steps  
This Section provides an extremely simple entry into the methodology when assembling and programming the SIMATIC TDC/SIMADYN D control system. It is especially conceived for first-time users of a control system.  
System software  
This Section provides basic know-how about the structure of the operating system and an application program of a CPU. It should be used to obtain an overview of the programming methodology, and basis for configuring user programs.  
Communications configuring  
This section provides you with basic know-how about the communication possibilities and how you configure links to the communication partners.  
Changeover from STRUC V4.x to D7-SYS  
Essential features are included in this section, which have changed over STRUC V4.x with the introduction of SIMATIC D7-SYS. |
| D7-SYS - STEP 7, CFC and SFC configuring | Basis software  
This section explains the essential use and the functions of the STEP 7 automation software. For first users, it provides an overview on configuring, programming and commissioning a station.  
When working with the basis software, you can access the online help which provides you with support when it comes to detailed questions on using the software.  
CFC  
The CFC language (Continuous Function Chart) allows you to graphically interconnect blocks.  
When working with the particular software, you can also use the online help which can answer detailed questions regarding the use of the editors/compiler.  
SFC  
Configuring sequence controls using SFC (Sequential Function Chart) of SIMATIC S7.  
In the SFC editor, you generate a sequence chart using graphic resources. The SFC elements of the chart are then positioned according to specific rules. |
| Hardware | The complete hardware spectrum is described as reference in this Manuals. |
Preface

<table>
<thead>
<tr>
<th>Titel</th>
<th>Inhalt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting Function blocks</td>
<td>The Reference Manual provides you with an overview of all of the function blocks for the corresponding technology and drive control components - SIMATIC TDC, FM 458-1 DP, SIMADYN D and T400.</td>
</tr>
<tr>
<td>Chapter 1</td>
<td>The function blocks that can be configured in all target systems of SIMATIC D7-SYS are described in this Chapter.</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>The function blocks that can only be configured for SIMATIC TDC are described in this Chapter.</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>The function blocks that can only be configured for FM 458-1 DP application module are described in this Chapter.</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>The function blocks that can only be configured for SIMADYN D and T400 are described in this Chapter.</td>
</tr>
</tbody>
</table>

Guide

As first time user, we recommend that this Manual is used as follows:

- Please read the first section on using the software in order to get to know some of the terminology and basic procedure.
- Then use the particular sections of the Manual if you wish to carry-out certain processing steps (e.g. loading programs).

If you have already executed a small project, and have gained some experience, then you can read individual sections of the Manual in order to get up to speed about a specific subject.

Special Notes

This user part of the Manual does not include any detailed information/instructions with individual descriptions, but is only intended to provide a basic procedure. More detailed information on the dialog boxes in the software and how they are handled is provided in the appropriate online help.

Training Center

We offer courses to help you get started with the S7 automation system. Contact your regional training center or the central training center in D 90327 Nuremberg, Federal Republic of Germany.

Internet: [http://www.sitrain.com](http://www.sitrain.com)
Service & Support im Internet

In addition to our paper documentation, our complete knowledge base is available to you on the Internet at:

http://www.siemens.com/automation/service&support

There, you will find the following information:

- Newsletters providing the latest information on your products
- A search engine in Service & Support for locating the documents you need
- A forum where users and experts from all over the world exchange ideas
- Your local contact partner for Automation & Drives in our Contact Partners database
- Information about on-site service, repairs, spare parts, and much more under "Services"
Contents

Preface ............................................................................................................................................ iii

1 In just a few steps to the first project .................................................................................. 1-1
  1.1 Prerequisites .................................................................................................................. 1-2
  1.1.1 Software and hardware.......................................................................................... 1-2
  1.1.2 What you can expect ............................................................................................. 1-4
  1.2 Creating a new project............................................................................................... 1-5
  1.3 Defining the hardware............................................................................................... 1-5
  1.4 Generating a CFC chart............................................................................................. 1-6
  1.4.1 Generating a new chart ....................................................................................... 1-6
  1.4.2 Inserting, parameterizing and inter-connecting function blocks ....................... 1-6
  1.5 Testing, compiling and downloading the project .................................................... 1-10
  1.5.1 Checking the project consistency and compiling .............................................. 1-10
  1.5.2 Downloading the user project into the SIMATIC TDC-CPU module ............... 1-10
  1.6 Testing the user project ........................................................................................... 1-12
  1.6.1 Disconnecting the connection online ................................................................ 1-13
  1.6.2 Generating a connection online .......................................................................... 1-13
  1.6.3 Changing the parameterization online .............................................................. 1-13
  1.6.4 Inserting a block online ...................................................................................... 1-13
  1.6.5 Deleting blocks online ...................................................................................... 1-13
  1.7 Results ......................................................................................................................... 1-14
  1.8 Archiving the project ............................................................................................... 1-14

2 Systemsoftware...................................................................................................................... 2-1
  2.1 Configuring .................................................................................................................. 2-2
  2.1.1 General description .............................................................................................. 2-2
  2.1.1.1 Configuring tools .......................................................................................... 2-2
  2.1.1.2 Configuring steps ......................................................................................... 2-3
  2.1.1.3 Terminology and libraries .......................................................................... 2-3
  2.1.2 Configuring the hardware .................................................................................... 2-4
  2.1.2.1 The first step: Selecting the hardware modules ........................................... 2-4
  2.1.2.2 The second step: Parameterizing the hardware modules ............................ 2-5
  2.1.2.3 The third step: Checking the configuring ..................................................... 2-7
  2.1.3 Creating CFC charts ............................................................................................ 2-7
2.1.3.1 The first step: Selecting the function blocks ................................................. 2-7
2.1.3.2 The second step: Parameterizing and interconnecting function blocks......... 2-8
2.1.3.3 The third step: Compiling and loading the user program into the CPU .......... 2-13
2.1.4 Operating statuses of a CPU module .............................................................. 2-14
2.1.5 Description and use of the signal transfer mechanisms ................................... 2-15
2.1.5.1 Data consistency ....................................................................................... 2-15
2.1.5.2 Data transfer within the same task of a CPU ........................................... 2-16
2.1.5.3 Data transfer between various CPU tasks ............................................... 2-16
2.1.5.4 Data transfer between cyclic tasks of several CPUs ................................. 2-17
2.1.5.5 Data transfer between interrupt tasks of several CPUs ............................ 2-18
2.1.5.6 Minimizing the deadtimes ....................................................................... 2-19
2.1.5.7 Processing sequence within a basic CPU clock cycle ............................... 2-19
2.1.5.8 Interconnection changes and limited number of interconnections ............ 2-20
2.1.6 Significance and uses of the process image .................................................... 2-21
2.1.6.1 Implementing the process image .............................................................. 2-22
2.1.6.2 Process image for cyclic tasks ................................................................. 2-23
2.1.6.3 Process image for interrupt tasks ............................................................. 2-24
2.1.7 Significance and application of the CPU synchronization ............................... 2-25
2.1.7.1 Time synchronization .............................................................................. 2-25
2.1.7.2 Synchronizing its own basic clock cycle to the basic clock cycle of a master CPU ........................................................................................................ 2-25
2.1.7.3 Synchronizing its own basic clock cycle to an interrupt task of a master CPU ... 2-26
2.1.7.4 Synchronizing its own interrupt tasks to interrupt tasks of a master CPU ... 2-26
2.1.7.5 Synchronizing several SIMATIC TDC/SIMADYN D stations ....................... 2-26
2.1.7.6 Response when the synchronization fails .................................................. 2-26
2.1.7.7 Configuring the CPU basic clock cycle synchronization ............................ 2-26
2.1.7.8 Configuring the interrupt task synchronization .......................................... 2-28
2.1.7.9 Example of a synchronization configuration .............................................. 2-29
2.1.8 Significance of the processor utilization ......................................................... 2-30
2.1.8.1 Determining the approximate processor utilization ................................. 2-30
2.1.8.2 Calculating the precise processor utilization ............................................ 2-30
2.1.8.3 Mode of operation of the task administrator .......................................... 2-31
2.1.8.4 Eliminating cycle errors .......................................................................... 2-32
2.1.9 Technical data of the operating system ....................................................... 2-33
2.1.9.1 Features ................................................................................................... 2-33
2.1.9.2 The basic operating system functions ...................................................... 2-34
2.1.9.3 The service utility .................................................................................... 2-37
2.2 Function description and user instructions ....................................................... 2-40
2.2.1 Fatal system error "H" ................................................................................ 2-40
2.2.2 Background processing .............................................................................. 2-43
2.2.2.1 Online test mode .................................................................................... 2-43
2.3 System chart @SIMD ....................................................................................... 2-44

3 Communications configuring .............................................................................. 3-1
3.1 Introduction ..................................................................................................... 3-2
3.1.1 Basic information on communications ....................................................... 3-2
3.1.1.1 Overview of the various data couplings .................................................. 3-2
3.1.2 Overview of the communication utilities ................................................... 3-6
3.1.3 Communication block I/Os ......................................................................... 3-7
3.1.3.1 Initialization input CTS ......................................................................... 3-7
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1.3.2</td>
<td>Address connections AT, AR and US</td>
<td>3-7</td>
</tr>
<tr>
<td>3.1.3.3</td>
<td>Data transfer mode, MOD input</td>
<td>3-8</td>
</tr>
<tr>
<td>3.1.3.4</td>
<td>Firmware status, ECL, ECO connection</td>
<td>3-12</td>
</tr>
<tr>
<td>3.1.3.5</td>
<td>Status display, output YTS</td>
<td>3-13</td>
</tr>
<tr>
<td>3.1.4</td>
<td>Mode of operation of the couplings</td>
<td>3-13</td>
</tr>
<tr>
<td>3.1.4.1</td>
<td>Central coupling blocks</td>
<td>3-14</td>
</tr>
<tr>
<td>3.1.4.2</td>
<td>Transmitters and receivers</td>
<td>3-15</td>
</tr>
<tr>
<td>3.1.4.3</td>
<td>Compatible net data structures</td>
<td>3-16</td>
</tr>
<tr>
<td>3.1.4.4</td>
<td>Number of coupling modules in a subrack</td>
<td>3-17</td>
</tr>
<tr>
<td>3.1.4.5</td>
<td>Reorganizing a data interface</td>
<td>3-18</td>
</tr>
<tr>
<td>3.2</td>
<td>Couplings on the subrack</td>
<td>3-19</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Local CPU coupling</td>
<td>3-19</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Direct CPU-CPU coupling</td>
<td>3-20</td>
</tr>
<tr>
<td>3.2.3</td>
<td>Communications buffer coupling</td>
<td>3-21</td>
</tr>
<tr>
<td>3.3</td>
<td>Subrack coupling CP52M0</td>
<td>3-22</td>
</tr>
<tr>
<td>3.3.1</td>
<td>Applications</td>
<td>3-22</td>
</tr>
<tr>
<td>3.3.2</td>
<td>Behavior when powering-up and powering-down</td>
<td>3-23</td>
</tr>
<tr>
<td>3.3.3</td>
<td>Synchronizing and triggering methods</td>
<td>3-24</td>
</tr>
<tr>
<td>3.3.4</td>
<td>Configuring</td>
<td>3-24</td>
</tr>
<tr>
<td>3.3.4.1</td>
<td>Configuring in HWConfig</td>
<td>3-24</td>
</tr>
<tr>
<td>3.3.4.2</td>
<td>Configuring in CFC</td>
<td>3-26</td>
</tr>
<tr>
<td>3.3.5</td>
<td>Performance data</td>
<td>3-27</td>
</tr>
<tr>
<td>3.3.5.1</td>
<td>Data transfer rates</td>
<td>3-27</td>
</tr>
<tr>
<td>3.3.5.2</td>
<td>Cable lengths</td>
<td>3-27</td>
</tr>
<tr>
<td>3.3.5.3</td>
<td>Interface assignment</td>
<td>3-27</td>
</tr>
<tr>
<td>3.4</td>
<td>Subrack coupling CP53M0</td>
<td>3-28</td>
</tr>
<tr>
<td>3.4.1</td>
<td>Hardware structure</td>
<td>3-31</td>
</tr>
<tr>
<td>3.4.2</td>
<td>Scope of supply</td>
<td>3-31</td>
</tr>
<tr>
<td>3.4.3</td>
<td>Response when &quot;shutting down&quot; a coupling partner</td>
<td>3-32</td>
</tr>
<tr>
<td>3.4.4</td>
<td>Response when &quot;powering-up&quot; the master subrack</td>
<td>3-32</td>
</tr>
<tr>
<td>3.4.4.1</td>
<td>Acknowledging</td>
<td>3-32</td>
</tr>
<tr>
<td>3.4.5</td>
<td>Restart capability</td>
<td>3-33</td>
</tr>
<tr>
<td>3.4.6</td>
<td>Configuring</td>
<td>3-34</td>
</tr>
<tr>
<td>3.4.7</td>
<td>Restrictions</td>
<td>3-35</td>
</tr>
<tr>
<td>3.5</td>
<td>TCP/IP coupling (CP51M1)</td>
<td>3-36</td>
</tr>
<tr>
<td>3.5.1</td>
<td>Comparison between TCP/IP and UDP</td>
<td>3-37</td>
</tr>
<tr>
<td>3.5.2</td>
<td>Typical configuration</td>
<td>3-38</td>
</tr>
<tr>
<td>3.5.3</td>
<td>Configuring steps</td>
<td>3-38</td>
</tr>
<tr>
<td>3.5.3.1</td>
<td>Configuring in HWConfig</td>
<td>3-38</td>
</tr>
<tr>
<td>3.5.3.2</td>
<td>Configuring with CFC</td>
<td>3-39</td>
</tr>
<tr>
<td>3.5.3.2.1</td>
<td>Central block @TCP/IP</td>
<td>3-39</td>
</tr>
<tr>
<td>3.5.3.2.2</td>
<td>Receive block CRV</td>
<td>3-39</td>
</tr>
<tr>
<td>3.5.3.2.3</td>
<td>Send block CTV</td>
<td>3-40</td>
</tr>
<tr>
<td>3.5.4</td>
<td>Application information</td>
<td>3-42</td>
</tr>
<tr>
<td>3.5.4.1</td>
<td>Channel number</td>
<td>3-42</td>
</tr>
<tr>
<td>3.5.4.2</td>
<td>Telegram length</td>
<td>3-42</td>
</tr>
<tr>
<td>3.5.4.3</td>
<td>&quot;Ping&quot; on CP51M1</td>
<td>3-42</td>
</tr>
<tr>
<td>3.5.4.4</td>
<td>Performance</td>
<td>3-42</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>3.7.5.1</td>
<td>Diagnostics function block</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.5.2</td>
<td>Error class (ECL) and error code (ECO)</td>
<td>3-64</td>
</tr>
<tr>
<td>3.7.5</td>
<td>Commissioning/ diagnostics</td>
<td>3-61</td>
</tr>
<tr>
<td>3.6</td>
<td>Application information</td>
<td>3-51</td>
</tr>
<tr>
<td>3.6.2</td>
<td>Typical configuration</td>
<td>3-47</td>
</tr>
<tr>
<td>3.6.3</td>
<td>Configuring steps</td>
<td>3-48</td>
</tr>
<tr>
<td>3.6.3.1</td>
<td>Configuring in HWConfig</td>
<td>3-48</td>
</tr>
<tr>
<td>3.6.3.2</td>
<td>Configuring with CFC</td>
<td>3-49</td>
</tr>
<tr>
<td>3.6.3.2.1</td>
<td>Central block @TCP/IP</td>
<td>3-49</td>
</tr>
<tr>
<td>3.6.3.2.2</td>
<td>Receive block CRV</td>
<td>3-49</td>
</tr>
<tr>
<td>3.6.3.2.3</td>
<td>Send block CTV</td>
<td>3-50</td>
</tr>
<tr>
<td>3.7.2</td>
<td>Configuring</td>
<td>3-54</td>
</tr>
<tr>
<td>3.7.2.1</td>
<td>Configuring the DP system on CP50M1</td>
<td>3-54</td>
</tr>
<tr>
<td>3.7.2.2</td>
<td>Configuring communications in CFC</td>
<td>3-54</td>
</tr>
<tr>
<td>3.7.2.3</td>
<td>Configuring as Slave</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.2.4</td>
<td>Shared Input</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.3</td>
<td>Equidistance</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.4</td>
<td>SYNC/FREEZE commands</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.4.1</td>
<td>Configuring versions of SYNC/FREEZE</td>
<td>3-56</td>
</tr>
<tr>
<td>3.5.5</td>
<td>Communications with WinCC</td>
<td>3-53</td>
</tr>
<tr>
<td>3.5.5.1</td>
<td>Standard coupling</td>
<td>3-43</td>
</tr>
<tr>
<td>3.5.5.2</td>
<td>Coupling via TDC PMC channel-DLL</td>
<td>3-43</td>
</tr>
<tr>
<td>3.5.6</td>
<td>Central service</td>
<td>3-43</td>
</tr>
<tr>
<td>3.5.7</td>
<td>Clock time synchronization</td>
<td>3-43</td>
</tr>
<tr>
<td>3.5.8</td>
<td>Changing-over from CP5100 to CP51M1</td>
<td>3-43</td>
</tr>
<tr>
<td>3.6.1</td>
<td>Comparison between TCP/IP and UDP</td>
<td>3-46</td>
</tr>
<tr>
<td>3.6.2</td>
<td>Typical configuration</td>
<td>3-47</td>
</tr>
<tr>
<td>3.6.3</td>
<td>Configuring steps</td>
<td>3-48</td>
</tr>
<tr>
<td>3.6.3.1</td>
<td>Configuring in HWConfig</td>
<td>3-48</td>
</tr>
<tr>
<td>3.6.3.2</td>
<td>Configuring with CFC</td>
<td>3-49</td>
</tr>
<tr>
<td>3.6.3.2.1</td>
<td>Central block @TCP/IP</td>
<td>3-49</td>
</tr>
<tr>
<td>3.6.3.2.2</td>
<td>Receive block CRV</td>
<td>3-49</td>
</tr>
<tr>
<td>3.6.3.2.3</td>
<td>Send block CTV</td>
<td>3-50</td>
</tr>
<tr>
<td>3.6.4</td>
<td>Application information</td>
<td>3-51</td>
</tr>
<tr>
<td>3.6.4.1</td>
<td>Channel number</td>
<td>3-51</td>
</tr>
<tr>
<td>3.6.4.2</td>
<td>Telegram length</td>
<td>3-52</td>
</tr>
<tr>
<td>3.6.4.3</td>
<td>&quot;Ping&quot; on CP5100</td>
<td>3-52</td>
</tr>
<tr>
<td>3.6.4.4</td>
<td>Performance</td>
<td>3-52</td>
</tr>
<tr>
<td>3.7</td>
<td>PROFIBUS DP coupling (CP50M1)</td>
<td>3-53</td>
</tr>
<tr>
<td>3.7.1</td>
<td>General basics</td>
<td>3-53</td>
</tr>
<tr>
<td>3.7.1.1</td>
<td>Configuring</td>
<td>3-54</td>
</tr>
<tr>
<td>3.7.1.2</td>
<td>Configuring the DP system on CP50M1</td>
<td>3-54</td>
</tr>
<tr>
<td>3.7.1.3</td>
<td>Configuring communications in CFC</td>
<td>3-54</td>
</tr>
<tr>
<td>3.7.1.4</td>
<td>Configuring as Slave</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.1.5</td>
<td>Shared Input</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.2</td>
<td>Configuring</td>
<td>3-54</td>
</tr>
<tr>
<td>3.7.2.1</td>
<td>Configuring the DP system on CP50M1</td>
<td>3-54</td>
</tr>
<tr>
<td>3.7.2.2</td>
<td>Configuring communications in CFC</td>
<td>3-54</td>
</tr>
<tr>
<td>3.7.2.3</td>
<td>Configuring as Slave</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.2.4</td>
<td>Shared Input</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.3</td>
<td>Equidistance</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.4</td>
<td>SYNC/FREEZE commands</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.4.1</td>
<td>Configuring versions of SYNC/FREEZE</td>
<td>3-56</td>
</tr>
<tr>
<td>3.7.5</td>
<td>Commissioning/ diagnostics</td>
<td>3-61</td>
</tr>
<tr>
<td>3.7.5.1</td>
<td>Diagnostics function block</td>
<td>3-61</td>
</tr>
<tr>
<td>3.7.5.2</td>
<td>Error class (ECL) and error code (ECO)</td>
<td>3-64</td>
</tr>
<tr>
<td>3.8</td>
<td>PROFIBUS DP coupling (CP50M0)</td>
<td>3-65</td>
</tr>
<tr>
<td>3.8.1</td>
<td>Configuring with D7-SYS</td>
<td>3-66</td>
</tr>
<tr>
<td>3.8.1.1</td>
<td>Central coupling block</td>
<td>3-66</td>
</tr>
<tr>
<td>3.8.1.2</td>
<td>Address connections AT, AR</td>
<td>3-67</td>
</tr>
<tr>
<td>3.8.1.3</td>
<td>SYNC/FREEZE commands</td>
<td>3-68</td>
</tr>
<tr>
<td>3.8.1.4</td>
<td>Configuring versions of SYNC/FREEZE</td>
<td>3-69</td>
</tr>
<tr>
<td>3.8.1.5</td>
<td>Diagnostics function block</td>
<td>3-73</td>
</tr>
<tr>
<td>3.8.2</td>
<td>Configuring with COM PROFIBUS</td>
<td>3-77</td>
</tr>
<tr>
<td>3.8.2.1</td>
<td>Harmonizing with data configured in CFC</td>
<td>3-77</td>
</tr>
<tr>
<td>3.8.2.2</td>
<td>CP50M0 as PROFIBUS slave</td>
<td>3-78</td>
</tr>
<tr>
<td>3.8.2.3</td>
<td>Loading the database</td>
<td>3-79</td>
</tr>
<tr>
<td>3.8.3</td>
<td>Start-up/diagnostics</td>
<td>3-80</td>
</tr>
<tr>
<td>3.8.3.1</td>
<td>LEDs</td>
<td>3-80</td>
</tr>
<tr>
<td>3.8.3.2</td>
<td>Error class (ECL) and error code (ECO)</td>
<td>3-81</td>
</tr>
<tr>
<td>3.8.3.3</td>
<td>Application example, PROFIBUS DP coupling</td>
<td>3-82</td>
</tr>
<tr>
<td>3.8.3.4</td>
<td>Typical configuration and system requirements</td>
<td>3-83</td>
</tr>
</tbody>
</table>
Contents

3.8.3.5 Check list of the required hardware and software components for SIMATIC TDC................................................................. 3-84
3.8.3.6 Configuring under STEP 7 CFC ........................................................................................................................................... 3-85
3.8.3.7 Using transmit- and receive blocks ................................................................................................................................ 3-87
3.8.3.8 Configuring the typical configuration in CFC ...................................................................................................................... 3-88
3.8.3.9 Configuring the SS52 communications module with COM PROFIBUS .................................................................................. 3-91
3.8.3.10 Generating the COM database with COM PROFIBUS ...................................................................................................... 3-91
3.8.3.11 Downloading the COM database into the CP50M0 .......................................................................................................... 3-99
3.8.3.12 Working with the "SS52load" download tool .................................................................................................................... 3-99
3.8.3.13 Behavior of the CP50M0 during and after the download .................................................................................................. 3-99

3.9 MPI coupling .................................................................................................................................................................................. 3-101
3.9.1 Characteristics and hardware ................................................................................................................................................... 3-101
3.9.2 Configuring .................................................................................................................................................................................... 3-101

3.10 Table function .................................................................................................................................................................................. 3-102
3.10.1 Introduction .................................................................................................................................................................................. 3-102
3.10.1.1 Overview, "Manual mode" ............................................................................................................................................... 3-103
3.10.1.2 Overview, "Automatic mode: Communications" ........................................................................................................... 3-103
3.10.1.3 Function block WR_TAB .................................................................................................................................................. 3-105
3.10.2 Manual mode ................................................................................................................................................................................ 3-107
3.10.2.1 Application ........................................................................................................................................................................ 3-107
3.10.2.2 Configuring .......................................................................................................................................................................... 3-108
3.10.3 Automatic mode: Communications .......................................................................................................................................... 3-109
3.10.3.1 Application with an S7 control and SIMATIC FM 458 application module ........................................................................ 3-109
3.10.3.2 Configuring for S7 control and SIMATIC FM 458 application module ................................................................................ 3-111
3.10.3.3 Inserting tabular values in the data block .......................................................................................................................... 3-112
3.10.3.3.1 Manually entering tabular values .................................................................................................................................. 3-112
3.10.3.3.2 Importing tabular values .............................................................................................................................................. 3-116
3.10.3.3.3 Subsequently downloading tabular values into a DB ........................................................................................................ 3-126
3.10.3.4 Structure of the data telegram for TCP/IP or DUST1 connection ...................................................................................... 3-127
3.10.4 Automatic mode: Memory card .................................................................................................................................................. 3-128
3.10.4.1 Generating a table file in the csv format .............................................................................................................................. 3-129
3.10.4.2 Working with the D7-SYS additional Component Builder .................................................................................................. 3-131
3.10.4.3 Downloading ........................................................................................................................................................................ 3-134
3.10.4.4 Configuring the function blocks .......................................................................................................................................... 3-136

3.11 Communications utility, message system ........................................................................................................................................ 3-138
3.11.1 Entry logic of the message entry blocks .................................................................................................................................. 3-138
3.11.1.1 Message entry blocks for an activated message .................................................................................................................. 3-138
3.11.1.2 Message entry blocks for an activated and a de-activated message .................................................................................... 3-139
3.11.2 Configuring example for a message system .................................................................................................................................. 3-139
3.11.3 Output formats of the message evaluation block MSI .............................................................................................................. 3-143
3.11.3.1 Structure of an error- or alarm message ............................................................................................................................. 3-143
3.11.3.2 Overview of the message formats ...................................................................................................................................... 3-143
3.11.3.3 Structure of an overflow message ...................................................................................................................................... 3-145
3.11.3.4 Structure of a communications error message .................................................................................................................... 3-145
3.11.3.5 System error message structure ........................................................................................................................................ 3-145
3.11.3.6 Detailed description of the message formats of function block MSI ..................................................................................... 3-146
3.11.3.7 Output format of the message evaluation block MSIPRI ....................................................................................................... 3-151

3.12 Communications utility process data ................................................................................................................................................ 3-153
3.12.1 Receive- and transmit blocks .................................................................................................................................................... 3-153
3.12.1.1 Virtual connections ............................................................................................................................................................. 3-153
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.12.1.2</td>
<td>I/O of the CRV, CTV blocks</td>
<td>3-157</td>
</tr>
<tr>
<td>3.12.2</td>
<td>Channel marshalling blocks CCC4 and CDC4</td>
<td>3-157</td>
</tr>
<tr>
<td>3.12.2.1</td>
<td>Group block CCC4</td>
<td>3-157</td>
</tr>
<tr>
<td>3.12.2.2</td>
<td>Distribution block CDC4</td>
<td>3-158</td>
</tr>
<tr>
<td>3.12.2.3</td>
<td>Compatible net data structure</td>
<td>3-159</td>
</tr>
<tr>
<td>3.12.3</td>
<td>Diagnostic outputs</td>
<td>3-159</td>
</tr>
<tr>
<td>3.12.3.1</td>
<td>Fault/error cause</td>
<td>3-159</td>
</tr>
<tr>
<td>3.12.3.2</td>
<td>Channel assignment</td>
<td>3-160</td>
</tr>
<tr>
<td>3.12.3.3</td>
<td>Channel statuses</td>
<td>3-161</td>
</tr>
<tr>
<td>3.12.4</td>
<td>Introduction – “Pointer-based communication blocks”</td>
<td>3-161</td>
</tr>
<tr>
<td>3.12.4.1</td>
<td>Principle mode of operation</td>
<td>3-162</td>
</tr>
<tr>
<td>3.12.4.2</td>
<td>Applications</td>
<td>3-162</td>
</tr>
<tr>
<td>3.12.4.3</td>
<td>Features of pointer-based communications</td>
<td>3-162</td>
</tr>
<tr>
<td>3.12.4.4</td>
<td>Associated function blocks</td>
<td>3-163</td>
</tr>
<tr>
<td>3.12.4.5</td>
<td>Pointer interface</td>
<td>3-164</td>
</tr>
<tr>
<td>3.12.4.6</td>
<td>Configuring information and instructions</td>
<td>3-164</td>
</tr>
<tr>
<td>3.12.4.7</td>
<td>Examples of CFC screenshots</td>
<td>3-166</td>
</tr>
<tr>
<td>3.13</td>
<td>Communications utility service</td>
<td>3-171</td>
</tr>
<tr>
<td>3.13.1</td>
<td>Function block SER</td>
<td>3-172</td>
</tr>
<tr>
<td>3.13.2</td>
<td>System load, response times</td>
<td>3-173</td>
</tr>
<tr>
<td>3.14</td>
<td>Communications utility time of day synchronization</td>
<td>3-174</td>
</tr>
<tr>
<td>3.15</td>
<td>Communications with SIMATIC Operator Panels</td>
<td>3-176</td>
</tr>
<tr>
<td>3.15.1</td>
<td>Configuring example</td>
<td>3-176</td>
</tr>
<tr>
<td>3.15.2</td>
<td>Configuring SIMATIC TDC</td>
<td>3-177</td>
</tr>
<tr>
<td>3.15.2.1</td>
<td>Selecting the components in HWConfig</td>
<td>3-177</td>
</tr>
<tr>
<td>3.15.2.2</td>
<td>Configuring with CFC</td>
<td>3-177</td>
</tr>
<tr>
<td>3.15.2.2.1</td>
<td>Initializing the OP7</td>
<td>3-178</td>
</tr>
<tr>
<td>3.15.2.2.2</td>
<td>Reading function block connections (I/O)</td>
<td>3-178</td>
</tr>
<tr>
<td>3.15.2.2.3</td>
<td>Writing function block connections</td>
<td>3-179</td>
</tr>
<tr>
<td>3.15.2.2.4</td>
<td>Configuring events</td>
<td>3-179</td>
</tr>
<tr>
<td>3.15.2.2.5</td>
<td>Configuring alarm messages</td>
<td>3-180</td>
</tr>
<tr>
<td>3.15.2.2.6</td>
<td>Configuring the function keyboard</td>
<td>3-180</td>
</tr>
<tr>
<td>3.15.2.2.7</td>
<td>Configuring the interface area</td>
<td>3-181</td>
</tr>
<tr>
<td>3.15.2.3</td>
<td>Importing the symbol table</td>
<td>3-181</td>
</tr>
<tr>
<td>3.15.3</td>
<td>Configuring the OP7 with ProTool/Lite</td>
<td>3-182</td>
</tr>
<tr>
<td>3.15.4</td>
<td>Application information</td>
<td>3-183</td>
</tr>
<tr>
<td>3.15.4.1</td>
<td>Computation times</td>
<td>3-183</td>
</tr>
<tr>
<td>3.16</td>
<td>WinCC connection to SIMATIC TDC via the standard channel (SIMATIC S7 Protocol Suite.CHN)</td>
<td>3-184</td>
</tr>
<tr>
<td>3.16.1</td>
<td>Coupling via TCP/IP with &quot;OCM&quot; functions</td>
<td>3-185</td>
</tr>
<tr>
<td>3.16.1.1</td>
<td>Configuring the coupling-relevant TDC hardware</td>
<td>3-185</td>
</tr>
<tr>
<td>3.16.1.2</td>
<td>Configuring the CFC</td>
<td>3-186</td>
</tr>
<tr>
<td>3.16.1.2.1</td>
<td>Configuring the coupling-relevant CFC function blocks</td>
<td>3-186</td>
</tr>
<tr>
<td>3.16.1.2.2</td>
<td>Marking the function block connections in the CFC charts and creating the address book</td>
<td>3-188</td>
</tr>
<tr>
<td>3.16.1.3</td>
<td>Configuring WinCC</td>
<td>3-194</td>
</tr>
<tr>
<td>3.16.2</td>
<td>&quot;S7DB&quot; configuration version</td>
<td>3-199</td>
</tr>
<tr>
<td>3.16.3</td>
<td>MPI and PROFIBUS DP coupling versions</td>
<td>3-201</td>
</tr>
<tr>
<td>3.16.3.1</td>
<td>Hardware configuration</td>
<td>3-201</td>
</tr>
<tr>
<td>3.16.3.2</td>
<td>Configuring the CFC</td>
<td>3-206</td>
</tr>
</tbody>
</table>
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.16.3.3</td>
<td>Configuring WinCC</td>
<td>3-206</td>
</tr>
<tr>
<td>3.16.4</td>
<td>Configuring using the &quot;D7-SYS-OS engineering tool&quot;</td>
<td>3-208</td>
</tr>
<tr>
<td>3.17</td>
<td>Communications with WinCC (TCP/IP)</td>
<td>3-216</td>
</tr>
<tr>
<td>3.17.1</td>
<td>Prerequisites</td>
<td>3-216</td>
</tr>
<tr>
<td>3.17.2</td>
<td>Process variables</td>
<td>3-217</td>
</tr>
<tr>
<td>3.17.2.1</td>
<td>SIMATIC TDC software</td>
<td>3-217</td>
</tr>
<tr>
<td>3.17.2.2</td>
<td>Configuring WinCC</td>
<td>3-219</td>
</tr>
<tr>
<td>3.17.3</td>
<td>Binary events</td>
<td>3-220</td>
</tr>
<tr>
<td>3.17.4</td>
<td>SIMATIC TDC messages</td>
<td>3-220</td>
</tr>
<tr>
<td>3.17.4.1</td>
<td>SIMATIC TDC configuring software</td>
<td>3-220</td>
</tr>
<tr>
<td>3.17.4.2</td>
<td>WinCC configuring software</td>
<td>3-221</td>
</tr>
<tr>
<td>3.17.5</td>
<td>Generating the address book using the CFC editor</td>
<td>3-222</td>
</tr>
<tr>
<td>3.17.6</td>
<td>Address list import tool ADRIMP</td>
<td>3-222</td>
</tr>
<tr>
<td>3.17.6.1</td>
<td>Prerequisites</td>
<td>3-222</td>
</tr>
<tr>
<td>3.17.6.1.1</td>
<td>Generating the variable definition file</td>
<td>3-222</td>
</tr>
<tr>
<td>3.17.6.1.2</td>
<td>Generating and importing a new signal list</td>
<td>3-223</td>
</tr>
<tr>
<td>3.17.6.1.3</td>
<td>Importing an existing signal list</td>
<td>3-223</td>
</tr>
<tr>
<td>3.17.6.2</td>
<td>Checking the generated tag management in WinCC</td>
<td>3-224</td>
</tr>
<tr>
<td>3.17.7</td>
<td>Communications set-up, SIMATIC TDC-WinCC</td>
<td>3-224</td>
</tr>
<tr>
<td>3.17.7.1</td>
<td>Activating WinCC</td>
<td>3-224</td>
</tr>
<tr>
<td>3.17.7.2</td>
<td>Activating SIMATIC TDC</td>
<td>3-225</td>
</tr>
<tr>
<td>3.18</td>
<td>Communications service Trace</td>
<td>3-226</td>
</tr>
<tr>
<td>3.18.1</td>
<td>Simple Trace</td>
<td>3-226</td>
</tr>
<tr>
<td>3.18.1.1</td>
<td>Method of Operation of the @TCP</td>
<td>3-226</td>
</tr>
<tr>
<td>3.18.1.2</td>
<td>Method of Operation of the Acquisition Blocks</td>
<td>3-228</td>
</tr>
<tr>
<td>3.18.1.3</td>
<td>Method of Operation of the Header Block TRHI</td>
<td>3-229</td>
</tr>
<tr>
<td>3.18.1.4</td>
<td>Simple Trace Configuring</td>
<td>3-230</td>
</tr>
<tr>
<td>3.18.1.5</td>
<td>Reply Telegrams</td>
<td>3-232</td>
</tr>
</tbody>
</table>

# Index
1 In just a few steps to the first project

Section overview

1.1 Prerequisites 1-2
1.2 Creating a new project 1-5
1.3 Defining the hardware 1-5
1.4 Generating a CFC chart 1-6
1.5 Testing, compiling and downloading the project 1-10
1.6 Testing the user project 1-12
1.7 Results 1-14
1.8 Archiving the project 1-14
1.1 Prerequisites

Introduction

These brief instructions are intended for introductory level personnel and it outlines the basic procedure when generating a project.

More detailed information about the dialog boxes of the development software and their processing is provided in the corresponding online help.

1.1.1 Software and hardware

Software

Three software packages

- STEP 7
- CFC
- D7-SYS

must be installed precisely in this sequence on your PG/PC with Windows 95/98/ME/NT 4.0/2000. Authorization is required for STEP7 and CFC.

NOTE

The installation and user instructions are provided in the particular "readme" files. Please observe the interdependencies between versions!

When installing STEP7, you will be prompted for the online interface, however, for SIMATIC TDC nothing has to be selected and installed. ("Close" window and exit the following window with "OK").

Hardware

You will require the following hardware components for the "My First Project" project example:

<table>
<thead>
<tr>
<th>Components</th>
<th>Function</th>
<th>Diagram/Order No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>UR5213 subrack with power supply 21 slots, 32-bit bus, fan, 115/230 V AC</td>
<td>if the subrack is for a SIMATIC TDC station. it is used to mechanically accommodate the modules and supply them with power.</td>
<td>6DD1682-0CH0</td>
</tr>
<tr>
<td>CPU module CPU551 (at slot 1) 64-bit, 266 MHz, 32 Mbyte SD-RAM, VME-bus, PCI-bus, 8 digital inputs, of which 4 are interrupt-capable</td>
<td>executes the user program. exchanges data with other modules via the backplane PC board of the subrack. communicates with a PG/PC via the serial interface.</td>
<td>6DD1600-0BA1</td>
</tr>
</tbody>
</table>
In just a few steps to the first project

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC521 program memory module</td>
<td>2 Mbyte user program memory, 8 kbyte change memory</td>
<td>... saves the operating system, the user program and the online changes.</td>
</tr>
<tr>
<td>PC cable SC 67</td>
<td></td>
<td>... connects the CPU module to the PG/PC.</td>
</tr>
<tr>
<td>SM500 signal module (at slot 2)</td>
<td>Signal modules, 16 DO, 16 DI, 8AI, 4A1 integrating, 8AO, 4 pulse encoder inputs, 4 absolute value encoder inputs</td>
<td>... expands the CPU module by technology-specific functions. It is especially fast, as it is directly screwed to the CPU module and the backplane bus is not used.</td>
</tr>
<tr>
<td>Interface cable SC 54</td>
<td>Length: 2 m</td>
<td>... connects the inputs/outputs of the SM500 signal module with up to 5 SBxx or SU12 interface modules.</td>
</tr>
<tr>
<td>Interface module SB10</td>
<td>2 x 8 screw terminals, LED displays</td>
<td>... allows you to test the user program during commissioning and in operation, as the statuses of the digital outputs are displayed using LEDs.</td>
</tr>
</tbody>
</table>

Fig. 1-1 Module list for the project example "My First Project"

NOTE Technical data is provided in the SIMATIC TDC Hardware Manual, additional ordering information in Catalog DA99.
1.1.2 What you can expect

The example "My First Project" guides you step-by-step to a project which can actually run.

1. **Analyze the particular task**
   This allows you to identify the function blocks, inputs and outputs which you require and which hardware:

2. **Define the hardware**
   You will use this hardware information in STEP7 in order to enter the modules and define your particular properties.

3. **Configure and compile**
   You generate the configured software in CFC using the function blocks and compile this. You can configure the hardware after all of the checks have been made.

4. **Test the configuring software**
   You can now run the program, tested online and change it on the SIMATIC TDC modules.

5. **Archive the project**
   You can subsequently apply this procedure for your own applications.

The task

The task comprises two sections:

1. A **sawtooth generator** with a fixed frequency, outputs its value via a D/A converter.

2. **Running Lights** with 8 channels.

To start off with, define the individual functions for the appropriate sub-tasks and define the necessary hardware:

1. **Sawtooth generator**
   A sawtooth waveform is generated by an integrator, which resets itself after an upper limit has been exceeded. The integrator value is output via an analog output.

2. **Running light**
   Eight comparators compare the sawtooth value with constant values. The results are output through digital outputs and control the LEDs on the interface module.

   The running light has the following phases:
   - All of the LEDs are dark.
   - The LEDs are switched bright and then dark again so that only one is bright at any one time.
1.2 Creating a new project

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Double-click on the symbol <img src="image.png" alt="image" /> (if the STEP 7 Assistant starts, cancel this.)</td>
<td>The SIMATIC Manager is opened.</td>
</tr>
<tr>
<td>2</td>
<td>Select File &gt; New. Enter &quot;My First Project&quot; into the dialog box, Project. In the dialog box, select the path &quot;LW:\Siemens\Step7\S7proj&quot;. Click on OK.</td>
<td>Your new project is displayed.</td>
</tr>
<tr>
<td>3</td>
<td>Select Insert &gt; Station &gt; SIMATIC TDC station.</td>
<td>The &quot;SIMATIC TDC station&quot; hardware object is inserted.</td>
</tr>
</tbody>
</table>

1.3 Defining the hardware

The SIMATIC TDC subrack structure is entered in STEP 7 (HW Config).

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Select the hardware object &quot;SIMATIC TDC station&quot; and select Edit &gt; Open object.</td>
<td>HW Config is called-up.</td>
</tr>
<tr>
<td>5</td>
<td>Open it, if required, the hardware catalog with View &gt; Catalog.</td>
<td>The hardware catalog with all of the available family of modules is opened.</td>
</tr>
<tr>
<td>6</td>
<td>Select the UR5213 from the SIMATIC TDC family of modules and Catalog Subracks and drag it to the (upper) window</td>
<td>The subrack is displayed with 21 slots.</td>
</tr>
<tr>
<td>7</td>
<td>Locate them one after the other &gt;CPU Modules &gt; CPU551 at slot 1 &gt;Signal modules&gt; SM500 at slot 2 &gt;Slot covers &gt; UR5213 at slots 3 to 21</td>
<td>The subrack is equipped.</td>
</tr>
<tr>
<td>8</td>
<td>Open the properties dialog box of the CPU551 CPU module with Edit &gt; Object properties.</td>
<td>The CPU551 dialog box with general module information and the setting registers for addresses, basic clock cycle, cyclic tasks and interrupt tasks are displayed.</td>
</tr>
<tr>
<td>9</td>
<td>Select the basic sampling time T0 (in this case: 1 ms) under the basic clock cycle tab. Click on the cyclic tasks tab and set the sampling time T1 to 2 ms and T2 to 4 ms. Click on OK.</td>
<td>The required sampling times are entered. The properties dialog box is closed.</td>
</tr>
<tr>
<td>10</td>
<td>Open the properties dialog box of SM500 signal module using Edit &gt; Object properties.</td>
<td>The SM500 dialog box with general module information and the setting tab for addresses is displayed.</td>
</tr>
</tbody>
</table>
11 Under the **Addresses** tab, click on the **Pre-assign** button. Click on **OK**. All of the addresses are assigned symbolic names for subsequent use in CFC charts.

12 Check your hardware with **Station > Check consistency**. If fault/error-free, continue with Step 13, otherwise check the hardware configuration.

13 Compile your hardware configuration with **Station > Save and compile**. The hardware has been fully configured.

### 1.4 Generating a CFC chart

#### 1.4.1 Generating a new chart

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>Change into the SIMATIC Manager and open the project tree up to the Charts object. Select the charts by clicking on them.</td>
<td><img src="image1.png" alt="Image" /> The CFC Editor is opened with the working area (&gt;1 sheet) and the block catalog. (Catalog missing? Select <strong>View &gt; Catalog</strong>) (&gt;1 Sheet? Select <strong>View &gt; Sheet view</strong>)</td>
</tr>
<tr>
<td>15</td>
<td>Generate a new CFC chart twice with <strong>Insert &gt; S7 software &gt; CFC</strong>.</td>
<td>The CFC 1 and CFC 2 charts are displayed as new objects at the righthand side of the project window.</td>
</tr>
<tr>
<td>16</td>
<td>Select chart CFC2 in the project window and open the properties dialog box with <strong>Edit &gt; Object properties</strong>. Enter the &quot;sawtooth generator&quot; name. Click on <strong>OK</strong>.</td>
<td>You obtain the properties dialog box of the CNC chart. The Properties dialog box is closed.</td>
</tr>
<tr>
<td>17</td>
<td>Repeat step 16 with the CFC2 chart and re-name it &quot;Running lights&quot;.</td>
<td>The charts appear in the project window under their new name.</td>
</tr>
</tbody>
</table>

#### 1.4.2 Inserting, parameterizing and inter-connecting function blocks

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>Select the &quot;sawtooth generator&quot; chart and open the &quot;CFC Editor with <strong>Edit &gt; Open object</strong>. The CFC Editor is opened with the working area (&gt;1 sheet) and the block catalog. (Catalog missing? Select <strong>View &gt; Catalog</strong>) (&gt;1 Sheet? Select <strong>View &gt; Sheet view</strong>)</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Open the family of blocks <strong>Closed-loop control</strong> and drag the function block <strong>INT</strong> (integrator) to the working area. The block is now located on the sheet and has the ID for running in cyclic task T1.</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Open the properties dialog box of function block <strong>INT</strong> with <strong>Edit &gt; Object properties</strong>. The INT dialog box with general block information and the setting tab I/O appears.</td>
<td></td>
</tr>
</tbody>
</table>
In just a few steps to the first project

<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>Under the <strong>General</strong> tab, change the name to „sawtooth“.</td>
</tr>
</tbody>
</table>
| 22   | Under the **I/O** tab, enter the values for the block inputs, e.g.  
  - \( X = 1 \)  
  - \( LU = 11250 \)  
  - \( TI = 5 \text{ ms} \)  
  Click on **OK**.  
  The Properties dialog box is closed and the function block inputs now have values assigned.  
| 23   | First **click on** output QU and then on input S.  
  The output QU (upper limit) is now coupled back to input S (set).  
| 24   | Select **DAC** (analog output) from the block family **ON/OFF** and locate it next to function block INT.  
  Open the dialog box using **Edit > Object properties** and change the name to “analog output”.  
  Enter, for example under the **I/O** tab:  
  - \( DM = 0 \)  
  - \( OFF= 0 \)  
  - \( SF = 1\text{E}6 \)  
  Click on **OK**.  
  The block inputs are parameterized.  
| 25   | In the "sawtooth" block, **click on** output Y and after this on input X in the "analog output" block.  
  The sawtooth generator is connected to the analog output.  

All changes made in the CFC chart are immediately saved.

Proceed the same for the second sub-task (running lights) (from step 18).  
Change into the SIMATIC Manager, open the CFC chart "running lights" insert the function blocks into the CFC chart, parameterize and connect them.  
All of the necessary information (number of blocks, types and block parameters) can be taken from the following diagrams. Arrange the first function block and all others, via **Edit > Run sequence** in cyclic task T2. The connection between the "sawtooth" block and the comparators is realized by changing the CFC window (**Window > ...**).
In just a few steps to the first project

Fig. 1-2 "Sawtooth generator" chart
Fig. 1-3  "Running lights" chart
1.5 Testing, compiling and downloading the project

1.5.1 Checking the project consistency and compiling

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>26</td>
<td>Start the consistency check of your project with Chart &gt; Check consistency &gt; Charts as program, then OK. Acknowledge the dialog window or evaluate the error messages via Details.</td>
<td>The result is displayed in the dialog window.</td>
</tr>
<tr>
<td>27</td>
<td>Start to compile the project after a successful consistency check with Chart &gt; Compile &gt; Charts as program, then OK. Acknowledge the dialog window or evaluate the error messages using Details.</td>
<td>The result is displayed in a dialog window. You have created your first user project.</td>
</tr>
</tbody>
</table>

1.5.2 Downloading the user project into the SIMATIC TDC-CPU module

**Introduction**
SIMATIC TDC allows you to
- download online or
- offline.

**Downloading offline**
Maybe you do not have a connection from your PC/PG to the SIMATIC TDC station, which is why you can use the possibility of downloading into a memory module.

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>28</td>
<td>Select Target system &gt; Download.</td>
<td>You will obtain a dialog window with options.</td>
</tr>
<tr>
<td>29</td>
<td>Select &quot;User program&quot; and &quot;Offline&quot; Insert the memory module into the PCMCIA slot of the PG/PC. Start to download with OK.</td>
<td>A progress display shows how the system and your user program are being downloaded into the memory module.</td>
</tr>
<tr>
<td>30</td>
<td>Insert the memory module into the SIMATIC TDC station and re-start it.</td>
<td>Your user program is then started.</td>
</tr>
</tbody>
</table>
You have established a connection from your PC/PG to SIMATIC TDC station, and you can download the program memory module into the CPU module.

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>28</td>
<td>Check whether your SIMATIC TDC station (hardware) is correctly configured, assembled and connected.</td>
<td>Observe the configuration instructions and connection possibilities for the individual hardware components in the appropriate hardware documentation!</td>
</tr>
<tr>
<td>29</td>
<td>Insert the memory module into the CPU module and start the SIMATIC TDC station.</td>
<td>A flashing zero appears on the CPU module display</td>
</tr>
<tr>
<td>30</td>
<td>Install the interface between the SIMATIC TDC station and the PC in the SIMATIC Manager using the menu command: Options &gt; Set PG/PC interface....</td>
<td>You obtain a dialog window &quot;Install/uninstall interfaces&quot; in which the various interfaces are listed.</td>
</tr>
<tr>
<td>31</td>
<td>In the dialog window, select &quot;DUST1 protocol&quot; and install this protocol with Install→ Acknowledge with &quot;yes&quot; and then close the dialog window. Select the interface used and acknowledge with &quot;OK&quot;.</td>
<td>You obtain a dialog window in which you can decide, by entering either &quot;Yes&quot; or &quot;No&quot; whether you wish to immediately go online. The &quot;Set PG interface dialog window&quot; is displayed where you can select the access route &quot;DUST1 (COM1)&quot; or &quot;DUST1 (COM2)&quot;.</td>
</tr>
<tr>
<td>32</td>
<td>Select the Target system &gt; Download.</td>
<td>You obtain the dialog window with options.</td>
</tr>
<tr>
<td>33</td>
<td>Select the &quot;System and user program&quot;, &quot;Online (COM1)&quot; and initialization when first downloading the user program. <strong>Note:</strong> If a user program is downloaded again, you can also specify &quot;User program&quot; without &quot;initialization&quot;. Start with &quot;download&quot;</td>
<td>A progress display shows how the system and your user program are being downloaded into the memory module. If download has been completed, the dialog window &quot;Operating status&quot; is displayed with the &quot;STOP&quot; status.</td>
</tr>
<tr>
<td>34</td>
<td>Start the SIMATIC TDC station with &quot;Restart&quot; and then select &quot;Close&quot;.</td>
<td>Your user program is started and the &quot;Operating status&quot; dialog window is displayed with the &quot;RUN&quot; status.</td>
</tr>
</tbody>
</table>
1.6 Testing the user project

**Introduction**

In the test mode, you can

- Monitor the values of block I/O and change the values of block inputs,
- Generate and delete connections, and
- Insert and delete blocks.

The values which are registered for test, have a yellow background. You can easily monitor the behavior by changing parameters at the block inputs.

Before you start the test, please check whether the following prerequisites are fulfilled:

- You have established a connection between the PG/PC and your SIMATIC TDC station.
- You have downloaded the actual project into the memory module, which is located in the CPU module.
- The associated CFC chart (e.g. "running lights") has been opened.

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>35</td>
<td>Select the menu command: <strong>Target system &gt; Compare</strong>, to display the &quot;Compare&quot; dialog field.</td>
<td>The CPU name with data and time of the last compilation between the actual configured software and the current CPU program are displayed. If they match, the result is: &quot;The configuring and the CPU program match&quot;. You have checked that the PG/PC and the SIMATIC TDC station can communicate.</td>
</tr>
<tr>
<td>36</td>
<td>Select the menu command: <strong>Test &gt; Test settings</strong> Enter the refresh period for the screen display in tenths of seconds. Acknowledge the change with &quot;OK&quot;.</td>
<td>In the test mode, the values of the I/O are updated cyclically on the screen with the selected refresh period. If the computation time is not sufficient to fulfill the refresh periods, then you will be warned. The closed-loop control always has the higher priority</td>
</tr>
<tr>
<td>37</td>
<td>Before you go into the test mode, change over the test mode from &quot;Process operation&quot; to &quot;laboratory operation&quot; with <strong>Test &gt; Laboratory operation</strong>. <strong>Note</strong>: In &quot;Process operation&quot;, the default setting is that no I/O are registered for monitoring. In this test mode, you must select the appropriate blocks and explicitly log them-on for monitoring.</td>
<td>This means that all of the block I/O are automatically switched-in for &quot;monitoring&quot; (the values have a yellow background).</td>
</tr>
<tr>
<td>38</td>
<td>Select the menu command: <strong>Test &gt; Test mode</strong></td>
<td>The &quot;Test: RUN (laboratory)&quot; text appears with a green background in the status bar. In the test mode, you can monitor and change the dynamic behavior (online).</td>
</tr>
</tbody>
</table>
### 1.6.1 Disconnecting the connection online

**Procedure**
In the CFC chart, using the mouse pointing device, select the block I/O which you wish to disconnect. Then remove this with **Edit > Delete**.

**Result**
The connecting line between the I/O disappears and at the I/O, the last value, which was transferred on the connection, is displayed as parameter value.

**NOTE**
Connections to global operands can neither be generated online nor deleted.

### 1.6.2 Generating a connection online

**Procedure**
In the CFC chart, using the mouse pointing device, select the block I/O where you wish to establish a connection.
With the changeover key pressed, now select the block I/O to which this connection should be made.

**Result**
The connecting line between the selected I/O is generated, and the actual parameter value, which is presently being transferred, is displayed at the output.

### 1.6.3 Changing the parameterization online

**Procedure**
Select the block input whose parameter value is to be changed, by double-clicking. The dialog box "Properties I/O" is displayed in which you can change the value.

**Result**
You can immediately identify the effect of the change in the CFC Chart.

### 1.6.4 Inserting a block online

**Procedure**
Using the command **View > Catalog**, call-up the block catalog. Open the block family and drag the selected function block to the working area.

**NOTE**
Not all of the function blocks can be inserted online. Refer under "configuring data" in the online help for the block.

### 1.6.5 Deleting blocks online

**Procedure**
Select the function block and remove it using the command **Edit > Delete**.
1.7 Results

You have now got to know some of the simple handling operations in the CFC configuring. You now know how a project is created using the SIMATIC Manager, how a CFC Chart is generated and function blocks inserted from a library. You have interconnected and parameterized the function blocks. You have generated a program which can run and which has been downloaded into the CPU. You can observe and modify the dynamic behavior in the test mode.

You can now review the results for the project example "My First Project" in process operation if you have assembled and connected-up the necessary hardware of the SIMATIC TDC station (refer to Table 1-1, Section 1.1.2).

Sawtooth generator

In order to view the sawtooth, you must first connect an oscilloscope to the SIMATIC TDC station. The following table shows the assignment of the pins at output connector X1 of SM500 signal module. The output voltage range extends from -10 V to +10 V.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Analog output 1+</td>
<td>Sawtooth</td>
</tr>
<tr>
<td>2</td>
<td>Analog output 1-</td>
<td></td>
</tr>
</tbody>
</table>

Table 1-1 Excerpt from the pin assignment of SM500, connector X1

Running light

You can observe the running light function at the LED display of interface module SB10.

1.8 Archiving the project

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>44</td>
<td>In the SIMATIC Manager, select File &gt; Archive.</td>
<td>The &quot;archiving&quot; dialog field is displayed.</td>
</tr>
<tr>
<td>45</td>
<td>In the dialog field &quot;Archiving&quot;, select the user project with &quot;My First Project&quot;. Click on OK.</td>
<td>The &quot;archiving - select archive dialog field&quot; is displayed. The default file &quot;My_first.zip&quot; has already been entered with archiving path.</td>
</tr>
<tr>
<td>46</td>
<td>In the dialog field &quot;archiving - select archive&quot;, when required, change the file name and/or the path and then click on &quot;save&quot;.</td>
<td>The project is now saved in the selected path and filenames as zip file.</td>
</tr>
</tbody>
</table>

NOTE

When you select menu bar File > De-archive, the archived project can always be re-established with this particular release.
# 2 Systemsoftware

<table>
<thead>
<tr>
<th>Overview</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>Configuring</td>
<td>2-2</td>
</tr>
<tr>
<td>2.2</td>
<td>Function description and user instructions</td>
<td>2-40</td>
</tr>
<tr>
<td>2.3</td>
<td>System chart @SIMD</td>
<td>2-44</td>
</tr>
</tbody>
</table>
2.1 Configuring

2.1.1 General description

This Chapter provides instructions and support when configuring SIMADYN D. It explains the general requirements when configuring SIMADYN D hardware and software.

It is assumed that the reader is knowledgeable about Windows 95/98/NT, handling the SIMATIC Manager, HWConfig and the CFC Editor; they will not be explained in this document. The configuring instructions are illustrated using diagrams and graphics. These illustrations are intended to highlight specific features, and do not necessarily precisely illustrate the CFC window. This Manual does not discuss the hardware (e.g. CPUs, memory modules, cables etc.), even if hardware designations are used in the configuring examples; if hardware information is required, then please consult the "Hardware" User Manual.

This Manual is sub-divided into the following Chapters:

- General description
- Configuring the hardware
- Creating CFC charts
- Operating statuses of a CPU module
- Configuring example for a CPU module
- Using signal transfer mechanisms
- Significance and uses of the process image
- Significance and uses of the CPU synchronization
- Significance of processor utilization

To implement most of the applications, the information in Chapter "General description" up to the Chapter "Creating CFC charts" is sufficient. More detailed information regarding special system characteristics of SIMATIC TDC/SIMADYN D is described in the following Chapters.

2.1.1.1 Configuring tools

In practice, a configuring engineer can select the required hardware modules from a module spectrum and achieve the desired technological functions by generating function diagrams and block diagrams. SIMATIC TDC/SIMADYN D supports these activities using HWConfig (configuring tool to define the hardware configuration of SIMATIC TDC/SIMADYN D stations) and CFC (block technology using numerous standard function blocks).
2.1.1.2 Configuring steps

SIMATIC TDC/SIMADYN D is configured in the following sequence:

1. The hardware configuration is generated, and
2. The CFC charts are created.

2.1.1.3 Terminology and libraries

Assigning a name

When configuring SIMATIC TDC/SIMADYN D, the names to be assigned must be as follows:

- Station names
  - max. 24 characters
- Modules
  - maximum length, 6 characters.

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Characters permitted</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>First character</td>
<td>Alpha- and special characters</td>
<td>A-Z, @</td>
</tr>
<tr>
<td>Second character</td>
<td>Alphanumeric characters and special characters</td>
<td>A-Z, 0-9 , _, or @ if the first character is @</td>
</tr>
<tr>
<td>Additional characters</td>
<td>Alphanumeric characters and special characters</td>
<td>A-Z, 0-9 , _</td>
</tr>
</tbody>
</table>

Table 2-1 Nomenclature when assigning names to modules

- Chart- and function block names
  - when both names are connected, the total number of characters may not exceed 24.

<table>
<thead>
<tr>
<th>Name</th>
<th>Max. length</th>
<th>Permitted characters</th>
<th>Characters which are not permitted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>22</td>
<td></td>
<td>* , ., ?, &lt;, &gt;,</td>
</tr>
<tr>
<td>Function block</td>
<td>16</td>
<td></td>
<td>*</td>
</tr>
</tbody>
</table>

Table 2-2 Nomenclature when assigning names to charts and function blocks

- Comments
  - for modules, maximum of 255 characters
  - for charts, maximum 255 characters
  - for function blocks and parameters, max. 80 characters
Connections (I/O) with special functions have the following suffixes:

- the dollar symbol "$" (connecting signals between CPUs),
- the star symbol "*" (symbolic hardware addresses),
- or the exclamation mark "!" (virtual addressing).

HWConfig or CFC automatically enter these suffixes. A function block name may only appear once on a CPU. The name syntax and rules are checked when entered.

HWConfig or CFC automatically enter these suffixes. A function block name may only appear once on a CPU. The name syntax and rules are checked when entered.

### Libraries

Hardware modules and function block types are saved in libraries. The required function blocks can be called-up from the libraries using HWConfig or the CFC editor.

Several function block libraries can be used for each CPU. The "FB\&;LIB" standard function block library is pre-assigned. It has over 200 function blocks, whose functionality is sufficient for most applications. When required, additional supplementary libraries can be imported for the particular CPU. The libraries can be found in the directory "step7\s7cfc\sdblocks\std (SIMADYN D) or ...t\d (SIMATIC TDC)".

### 2.1.2 Configuring the hardware

HWConfig is used to configure the hardware of SIMATIC TDC/SIMADYN D stations. A SIMATIC TDC/SIMADYN D station consists of a rack with up to 20/8 CPUs and other hardware modules. When required, several stations can be coupled with one another. The modules to be configured can be selected from the modules in the HWConfig hardware catalog. Racks, CPUs, I/O modules, coupling modules etc. can be selected.

HWConfig defines the system hardware configuration as result of

- the rack used together with the defined bus structure (bus termination, Daisy Chain),
- the configured hardware modules inserted in the rack as well as
- defining hardware-relevant information such as tasks, synchronization etc.

#### 2.1.2.1 The first step: Selecting the hardware modules

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subracks</td>
<td>Various types depending on the slot number, bus configuration, cooling etc.</td>
</tr>
<tr>
<td>I/O modules</td>
<td>Peripheral modules to input/output process signals (analog-binary I/O, speed sensing signals etc.)</td>
</tr>
<tr>
<td>Expansion modules</td>
<td>Peripheral modules to input/output process signals. They are used to achieve higher data rates by bypassing the backplane bus, and are directly connected to a CPU module.</td>
</tr>
<tr>
<td>Hardware</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Communication modules</td>
<td>Modules to provide communication utilities</td>
</tr>
<tr>
<td>Communication buffer modules</td>
<td>Modules to transfer data between several CPUs</td>
</tr>
<tr>
<td>CPU modules</td>
<td>Modules on which the configured open-loop or closed-loop control program is executed. A maximum of two expansion modules can be inserted next to a CPU.</td>
</tr>
<tr>
<td>Special modules</td>
<td>Modules with special functions.</td>
</tr>
<tr>
<td>Slot covers</td>
<td>Slot covers cover empty slots against dirt accumulation and as EMC measure</td>
</tr>
<tr>
<td>Sub-modules</td>
<td>A sub-module is inserted in or on a module, e.g. a memory module for a CPU or an interface module for a communications module</td>
</tr>
<tr>
<td>Technology components</td>
<td>Subracks as well as modules for drive converters</td>
</tr>
</tbody>
</table>

Table 2-3  Hardware components

Further information
Refer to the "SIMATIC TDC/SIMADYN D hardware" Manual for the individual modules which can be selected.

Using HWConfig, a module is configured, possibly with a sub-module for every subrack slot. This provides a precise image of the rack as it is in reality while the hardware is being configured. When selected, each module is given a name (recommended) which can be changed in accordance with the syntax for names. Slot covers must be provided for those slots which remain empty.

2.1.2.2 The second step: Parameterizing the hardware modules

After they have been selected, the modules must be parameterized using HWConfig. The following must be set

- the sampling times of the cyclic tasks,
- synchronizing cyclic or interrupt-control tasks of several CPUs of a station,
- the process interrupts and comments

Various parameterizing dialog windows are provided in HWConfig for this purpose.

Parameterizing dialogs in HWConfig

The pre-settings of the modules can still be changed in the module dialog windows. For instance, the parameterizing dialog for CPU modules includes the "Cyclic tasks" information. This allows the sampling times of 5 cyclic tasks to be changed.
At least one rack and all of the modules and sub-modules which it accommodates must be configured in HWConfig. When a module is generated, a recommended module name is assigned. This recommended name can be overwritten as long as it conforms to the maximum name length (max. 6 characters) and the character exists (refer to the Chapter "General description"), with (A-Z,0-9,_,@). It is recommended that the names are selected according to the schematic in the following table for the plant/system components:

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Logical name</th>
<th>Designator</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subrack</td>
<td>An00</td>
<td>n</td>
<td>Subrack number, starting at 1</td>
</tr>
<tr>
<td>CPU</td>
<td>Dxy_Pn</td>
<td>xy</td>
<td>Slot number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>n</td>
<td>CPU number</td>
</tr>
<tr>
<td>Sub-module</td>
<td>Dxyj</td>
<td>xy</td>
<td>Slot number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>j</td>
<td>Sub-module number</td>
</tr>
<tr>
<td>Communication buffer module</td>
<td>Dxy_A</td>
<td>xy</td>
<td>xy = slot number</td>
</tr>
<tr>
<td>Rack coupling</td>
<td>Dxy_B</td>
<td>xy</td>
<td>xy = slot number</td>
</tr>
<tr>
<td>Serial couplings</td>
<td>Dxy_C</td>
<td>xy</td>
<td>xy = slot number</td>
</tr>
<tr>
<td>Other modules</td>
<td>Dxy</td>
<td>xy</td>
<td>xy = slot number</td>
</tr>
</tbody>
</table>

Table 2-4  Designation schematic for the hardware configuration in HWConfig

The slot number of a module specifies the number of the slot in the subrack where the actual module is configured. For a SR24 with 24 slots, these are slots 1 to 24.

All sub-modules of a module are consecutively numbered starting from 1. The sub-module which is located at the top of the table is number 1.

The recommended CPU rack name is 6 characters long. The logical processor number (in the rack, from left to right) is displayed in operation, independently of the assigned name on the 7-segment display of the CPU module.

NOTE

The configured module names within a station must be unique.

The configured function blocks are processed via

- 5 cyclic tasks and/or
- 8 interrupt tasks.

The start of an interrupt task with respect to the instant that the process interrupt was initiated can be offset by a freely-configurable delay time.
The system chart, in which the behavior/characteristics of the 7-segment display, acknowledge button etc. is configured, is administered in a newly created SIMATIC TDC/SIMADYN D program, and may not be deleted. The sampling time of the system chart is pre-assigned in the factory at approx. 128 ms.

2.1.2.3 The third step: Checking the configuring

When the hardware configuration has been completed, the configured data must be verified using a consistency check over the complete station. The complete hardware configuration is checked using HWConfig. If the software has bugs or is incomplete, these are displayed and can be „debugged" (refer to the Chapter "Configuring example of a CPU module").

2.1.3 Creating CFC charts

A CFC chart (Continuous Function Chart) is generated using the CFC editor. This is a configuring tool to describe continuous processes by graphically interconnecting complex functions in the form of individual function blocks. Thus, the CFC is used to graphically implement a technological application by interconnecting and parameterizing function blocks. For a configuring engineer this means that he can program using a system which is closely related to block diagrams.

A CFC comprises of several CFC charts, each with 6 sheets. Each sheet can have a different number of various function blocks. The actual number is only limited by the graphic layout. In the overview of the CFC editor, all 6 sheets of a chart are displayed, and in the sheet view, an individual sheet can be displayed in detail. The function blocks which can be called-up in the CFC editor are sub-divided into function block classes, which include the interconnected (associated) functional scope. For instance, this can include logic blocks, arithmetic blocks etc.. Each function block class in turn includes a number of various function block types.

The CFC editor defines the technological configuring by:

- selecting, interconnecting and parameterizing the configured function blocks,
- defining of the sequence characteristics of the function blocks,
- generating programs to program the CPU memory modules.

2.1.3.1 The first step: Selecting the function blocks

The various function block classes are available in the FBSTLIB standard library. The individual function blocks can be called-up using the CFC editor, and located on the chart sheets. Individual blocks or block groups can be subsequently deleted, shifted and copied at any time.

Additional information
For further information on the function blocks refer to the Reference Manual "SIMADYN D function block library".
2.1.3.2 The second step: Parameterizing and interconnecting function blocks

After the function blocks have been selected, these are interconnected and parameterized using the CFC editor. The task, in which the individual function blocks are computed, must also be defined.

Parameterizing dialogs in the CFC editor

By double clicking on the function block header or under the menu selection Edit > Object characteristics, the following data can be configured deviating from the pre-settings:

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>The name and a comment text which is displayed in the function block header can be configured. Under &quot;special object properties&quot; you can execute the steps which are necessary to prepare a block for operator control and monitoring using WinCC.</td>
</tr>
<tr>
<td>Run-time properties</td>
<td>Here, the execution sequence of a function block, defined under function block insert, can be changed within a task. The selected function block can be &quot;searched for&quot;, &quot;cut-out&quot; in the execution sequence, and &quot;inserted&quot; in another position.</td>
</tr>
<tr>
<td>I/O</td>
<td>The following I/O data can be entered here for all parameters:</td>
</tr>
<tr>
<td></td>
<td>• value and comment for input and output parameters</td>
</tr>
<tr>
<td></td>
<td>• visibility in the CFC chart for parameters which are not interconnected</td>
</tr>
<tr>
<td></td>
<td>• set or inhibit parameter ID for test</td>
</tr>
<tr>
<td></td>
<td>• scaling value for parameters, REAL data type</td>
</tr>
<tr>
<td></td>
<td>• texts for the various units</td>
</tr>
</tbody>
</table>

Table 2-5 Configuring function blocks

Additional information
Refer to the Manual "D7-SYS - STEP 7, CFC and SFC configuring".

Defining the runtime properties
Function blocks which are consecutively executed within a task can be combined to form a run-time group. In addition to structuring the task, this allows task execution to be individually enabled/disabled.

NOTE
If a run-time group, is disabled via a function block input which is connected to it, then all of the function blocks contained in it are no longer computed.
By assigning the function blocks to a cyclic or interrupt-controlled task or run-time group and defining the position within the task or run-time group the configuring engineer can define the run-time properties of the function blocks. These properties are decisive for the characteristics of the target system as far as

- deadtimes,
- response times,
- the stability of time-dependent structures.

### Assigning the function blocks to cyclic tasks
The function blocks are assigned to one of the 5 possible cyclic tasks by calling-up the block using the CFC editor or in the program section, execution sequence of the CFC editor. Each function block can therefore be assigned to a cyclic task and a processing sequence within the sampling time of the task.

### Assignment of the function blocks to interrupt task
In order to process function blocks and run-time groups, interrupt-controlled, when they are called-up, or in the execution sequence of the CFC editor, they are entered in the required sequence under one of the 8 possible process interrupts. Thus, individual function blocks or a run-time group can be executed, initiated by a specific process interrupt.

### NOTE
Contrary to cyclic tasks, interrupt tasks are not started in equidistant time intervals, but when a process interrupt occurs.

### Configuring the equivalent sampling time
Several function blocks, e. g. some control blocks, have to be processed at regular interval as result of the program design. If these are to be configured in an interrupt task, then an equivalent sampling time must be configured in the HWConfig program section for this particular interrupt task. This should approximately correspond to the average time between two process interrupts.

By clicking twice on the module, you can configure the equivalent sampling time under the menu item **Basic clock > Synchronization.**
The actual open-loop and closed-loop control task can be implemented using SIMATIC TDC/SIMADYN D, almost the same as in a block diagram, by interconnecting and parameterizing the function blocks. A function block type can be used as often as required. The function blocks are parameterized and interconnected at the block inputs and outputs.
For general parameterization of the function blocks and interconnections between the function blocks, there are

- inputs (function block inputs) and
- outputs (function block outputs).

**Inputs**

The configuring engineer can parameterize the inputs with constants or connect them to other function block outputs. When the function blocks are called-up, the inputs and outputs are pre-assigned, but these can be changed.

**Outputs**

The outputs can be connected to other inputs or assigned an initialization value which is different than the pre-assigned value. This value is available at this output if the function block is executed for the first time in the INIT operating status. This is practical, if the output of a flipflop block is to be pre-assigned.

**Margins**

The margins at the left and right of a CFC chart include, on one hand, the references to the objects to be interconnected, e.g. other blocks or run-time groups, which are not located on that sheet. On the other hand, they also include the number of the connector (termination location), if the autorouter cannot draw the connecting line to the margin as the sheet is overfilled.

**Overflow sheets**

Overflow sheets are automatically created, if more margin entries are generated on a sheet than there is space to display them. An overflow sheet consists exclusively of the margins and does not contain any objects.
Parameterization

Instead of an interconnection, a constant, deviating from the pre-assigned constant, can be parameterized at each input or output.

A block connection can be designated as parameter using a pseudocomment.

**Additional information**
on parameterizing, refer to the Manual "System and Communications Configuring D7-SYS , Section "Parameterizing SIMATIC TDC/SIMADYN D"

Interconnecting

Interconnecting involves the following:

- connecting a function block output to another function block input on the same CPU.

- connecting a function block output to a run-time group

- connecting a function block output to a global operand or a global operand with a function block input. A global operand can be:
  - a name with a "$" dollar symbol as suffix, i.e. connecting a signal from or to a function block on another CPU.
  - a virtual connection name or a virtual connection, i.e. transferring process data between function blocks or via any links using the process data utility.
  - a symbolic hardware address. A hardware address is in this case a symbolic designation of one or several associated terminals of a module. For example, binary inputs of a binary input module. The symbolic hardware address is defined in the HWConfig program section.
  - a name reference, i.e. the name of a message system

All types of interconnections which leave a chart sheet, generate an appropriate cross reference at the margin of the CFC chart.

Comments:

Each function block I/O on the CFC chart can be provided with a comment text.

Pseudo comments

There are three pseudo comments, which are identified by the @ character as suffix and can be separated by blanks in front of the standard comment text:

1. @DATX
   - The input is connected, bypassing the consistency mechanisms (refer to the Chapter "Description and use of the signal transfer mechanisms").

2. @TP_bnnn
   - A connection identified like this can also be addressed as parameter. (The parameter can be read and changed at the block inputs using operating control devices and can only be read at the block outputs:
• The I/O, defined as parameters, can be read and changed via these interfaces; and also via drive converter operator control panels or SIMOVIS. The following variables are used:

• b: range identification "H", "L", "c" or "d"
  - identifies the parameter number range
  - "H" or "L": connections can be read and changed
  - "c" or "d": connections can only be read

• nnn: three-digit parameter number
  - 000 to 999

3. @TC_nnnn:

• A technology connector @TC_nnnn at a block output can be interconnected with a parameter at a block input using BICO technology. A technology connector is identified using its number:

• nnnn: four-digit technology connector number
  - 0000 to 9999

**Additional information**
on parameters and technology connectors, refer to Manual "SIMADYN D Control System, Communications Configuring D7-SYS", Section Parameterizing SIMADYN D.

### 2.1.3.3 The third step: Compiling and loading the user program into the CPU

After all of the required hardware modules have been configured with HWConfig and the required function blocks on the individual charts using the CFC editor, the software can be compiled into the CPU machine code using the compiler. There are 2 ways to do this:

**Offline loading**
A memory module is programmed with the PCMCIA interface of the configuring PC. After all of the correctly programmed memory modules of all of the subrack CPUs have been inserted, the modules are ready.

**Online loading**
The user program and operating system are directly loaded from the configuring PC into the CPU via a serial communications link.
## 2.1.4 Operating statuses of a CPU module

In the SIMATIC TDC/SIMADYN D system, the system statuses, shown in the following table are possible:

<table>
<thead>
<tr>
<th>Operating status</th>
<th>Power off</th>
<th>INIT</th>
<th>RUN</th>
<th>STOP</th>
<th>User stop</th>
<th>Initialization error</th>
<th>System error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal system status</td>
<td>No-voltage condition</td>
<td>System run-up (initialization)</td>
<td>Cyclic operation (standard operation)</td>
<td>Stop initiated by the user</td>
<td>Status after initialization error</td>
<td>Status after fatal system error</td>
<td></td>
</tr>
<tr>
<td>Status description</td>
<td>System not operational</td>
<td>System run-up --&gt; external control not possible</td>
<td>Functionality in accordance with that configured</td>
<td>No cyclic processing - &gt; fast download</td>
<td>Initialization erroneous -- &gt; no transition into cyclic operation</td>
<td>Fatal system error -&gt; processing aborted</td>
<td></td>
</tr>
<tr>
<td>Characteristic/properties</td>
<td>7-segment display</td>
<td>Dark</td>
<td>'0'</td>
<td>PN number ('1' ... '8') and 'C', 'E', 'b', 'A'</td>
<td>'d' (flashing when downloading)</td>
<td>'0' (the cause flashes)</td>
<td>'H' (the cause flashes)</td>
</tr>
<tr>
<td></td>
<td>Red LED on T400</td>
<td>Dark</td>
<td>Off</td>
<td>Flashes at a low frequency</td>
<td>Flashes at a medium frequency</td>
<td>Flashes at a high frequency</td>
<td>Lit (bright)</td>
</tr>
<tr>
<td></td>
<td>Available diagnostic interfaces</td>
<td>--</td>
<td>None</td>
<td>All of those configured (one must be at the first CS7-SS) and local interface</td>
<td>Local interface and first CS7 interface</td>
<td>Local interface</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Possible operator control functions</td>
<td>--</td>
<td>None</td>
<td>Complete functionality of CFC online</td>
<td>Only diagnostics or download</td>
<td>Only diagnostics or download</td>
<td>Only diagnostics or download</td>
</tr>
<tr>
<td></td>
<td>Administered through the user interface (CFC)</td>
<td>--</td>
<td>--</td>
<td>The user can interrogate the statuses per interactive dialog</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 2-6 System statuses of a CPU module

### Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First CS7-SS</td>
<td>SIMATIC TDC: Interface which is inserted at the top in the first CP50M0/CP51M1 in the subrack (when counting from the left).</td>
</tr>
<tr>
<td></td>
<td>SIMADYN D: Interface module (SS4 or SS52) which is inserted at the top in the first CS7 in the subrack (when counting from the left).</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Only possible to read-out error fields</td>
</tr>
</tbody>
</table>

Table 2-7 Terminology
INIT, RUN and STOP are the operating statuses, whereby STOP is subdivided into three different system statuses.

**System status user stop**

The "User stop" system status has been newly implemented and is used to quickly load a program via SS52/MPI, SS4/DUST1 (SIMADYN D), CP50M0/CP51M1 (SIMATIC TDC) or a local interface. Fast program loading means that cyclic processing is stopped in this status and the full performance of the CPU is available for download. A 'd' is displayed in the 7-segment display which starts to flash when a program is being loaded. This status is initiated by the user, whereby the parameterization as far as the configured diagnostics interface is concerned still remains valid (SS4, SS5x interface module in the CS7 module, CP50M0/CP51M1).

**Download in the RUN status**

It is also possible to download a program in the RUN status using each utility however this does not involve significantly longer download times (data is loaded in parallel with the cyclic processing).

It is only possible to changeover into the "User stop" status out of the RUN status by the user explicitly requesting this via a service interface (local or configured). In this status, all configured service interfaces and the local service interface are still available, i.e. diagnostics and downloading are still possible via all of the service interfaces (this is necessary if several PCs are connected at the rack).

### 2.1.5 Description and use of the signal transfer mechanisms

Signal transfer is data exchange between various blocks.

![Signal transfer between two tasks](image)

**2.1.5.1 Data consistency**

For interconnections between different cyclic tasks, SIMATIC TDC/SIMADYN D ensures the consistency of all data which is transferred. This means, that all data transferred from a task come from the same computation cycle of this task. All values calculated during a sampling cycle are "exported" at the end of the task. When starting a task, the required values are "imported", whereby it is ensured that there is no overlap (from a time perspective) between reading and writing the values (buffer system). As deadtimes are unavoidable with this concept, a signal should not be routed via several tasks and CPUs - if this can be avoided.
A differentiation is made between the following signal transfer types:

- Data transfer within the same task of a CPU
- Data transfer between various tasks of a CPU
- Data transfer between cyclic tasks of several CPUs
- Data transfer between alarm tasks of several CPUs

### 2.1.5.2 Data transfer within the same task of a CPU

Each function block output in the system is assigned a memory location. The function block saves its computed value in this memory location after being processed. All inputs, which are connected with the outputs in the same task, retrieve their values from the memory locations assigned to the connected output. In order to prevent deadtimes, the blocks of a task should if possible be computed corresponding to the "signal flow", i.e., that block whose outputs are used as inputs for the following block is first computed etc.

### 2.1.5.3 Data transfer between various CPU tasks

Data transfer between various tasks of a CPU is realized via a buffer system so that the data consistency can be guaranteed (refer to the Chapter "Data consistency"). However, for data transfer from a faster to a slower task, it should be observed that value changes are not sensed in the slow task or are only sensed with a delay. If this cannot be tolerated, then the software must be appropriately adapted, e.g., using pulse-extending function blocks.

![Diagram of signal transfer between tasks](image-url)

*Fig. 2-4 Signal not sensed in task 3*
2.1.5.4 Data transfer between cyclic tasks of several CPUs

Signals are transferred between the CPUs using the MM3, MM4 and MM11 (SIMADYN D) or CP50M0/CP51M1 (SIMATIC TDC) communication buffer modules. $ signals are used to handle the connections between function blocks, which run on different CPUs within the same SIMADYN D station (menu item "Insert-connection to the operand " in the CFC editor). The following data are required to configure a $ signal:

- the signal name,
- type
- bus assignment.

The dollar signal type defines whether data transfer is to be

- consistent ("standard") or
- inconsistent ("fast $ signal")

For a fast $ signal, the user (destination) can always access a current value. The deadtime, generated during signal transfer is then minimal if the generator (source) and user (destination) are configured in the same task, and if the tasks are possibly synchronized (refer to Chapter "Significance and application of the CPU synchronization").

The bus assignment defines whether data is to be transferred via the L bus or the C bus.
NOTE
If time-critical functions are processed on the CPUs of a subrack, then please observe the following rules:

- Limit the number of signals to a minimum.
- Select the L bus for the signals, which are configured in interrupt tasks (alarm tasks).
- Select the C bus for the signals, which are not configured in interrupt tasks (alarm tasks).
- If possible, configure all of the communication links of the rack coupling to one or a maximum of two CPUs of the subrack.
- Configure the CPUs with the configured communication links of the rack coupling so that, if possible, there are no additional CPUs between these CPUs and the rack coupling module.

2.1.5.5 Data transfer between interrupt tasks of several CPUs

Fast signal
A fast signal must always be configured if the signal is generated or used in an interrupt task. This is because an interrupt event can occur at any instant in time and therefore the consistency mechanisms must be bypassed in order to prevent data loss. In this case, a conflict could occur between the demand for data consistency and low deadtimes. A decision must now be made depending on the particular application.

NOTE
It should always be checked as to whether problems could occur if there is no data consistency (data consistency mechanism bypassed).

The data consistency can be achieved by looping the signals through a cyclic task on the CPU module which is used to calculate the interrupt task. The deadline computation is illustrated in the following table.

<table>
<thead>
<tr>
<th>Time interval</th>
<th>Computation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum value</td>
<td>1 * Tx</td>
</tr>
<tr>
<td>Maximum value</td>
<td>2 * Tx + 1 * Ty + 1 * T_interrupt</td>
</tr>
</tbody>
</table>

Table 2-8 Deadline computation

- Tx = sampling time of the cyclic tasks through which the signals are looped,
- Ty = sampling time of the source/destination (target) CPU and
- T_alarm = maximum interrupt repeat time of the interrupt task.
2.1.5.6 Minimizing the deadtimes

To minimize the deadtimes, a signal can be directly transferred, bypassing the data consistency mechanism. It can be directly "connected" to the output of the generating block. They are two ways to configure this:

- Pseudo comment @DATX for interconnecting tasks of a CPU
- Fast $ signals for interconnecting several CPUs

2.1.5.7 Processing sequence within a basic CPU clock cycle

The task administrator (refer to the Chapter "Mode of operation of the task administrator") of the operating system is started with the basic CPU clock cycle T0. This then decides which tasks are to be started (T1 and maximum of one other Tn, with Tn from {T2...T5}).

Essentially, the following components are to be executed within the task processing:

- Buffer changeover for the tasks to be started (T1 and, if required an additional task Tn)
- System mode of the blocks in T1 corresponding to the module sequence (refer to the Chapter "Significance and uses of the process image")
- System mode of blocks in Tn corresponding to the block sequence (refer to the Chapter "Significance and uses of the process image");
- Importing signal interconnections in the T1 and standard mode T1
- Exporting signal interconnections from T1
- Importing signal interconnections in Tn and standard mode Tn
- Exporting signal interconnections from Tn

The components relevant for signal transfer are highlighted.
### Interconnection changes and limited number of interconnections

#### Interconnection changes during the configuring test phase

Interconnections extending beyond the task limits can only be changed with some restrictions using the test mode of the CFC editor. The CFC editor test mode is used to test and optimize the user program, which is already running online on the CPU.

When service makes changes such as these, there are only a limited number of reserves for additional interconnections. The number of additional interconnections is

- minimum of 10 additional interconnections, and
- maximum of 20% of the already configured number of interconnections.

#### Example:

There are already 5 interconnections from cyclic task T2 to cyclic task T3. For interconnection changes from T2 to T3 there is then a reserve of 10 interconnection changes, as 20% of 5 = 1, however a minimum of 10.

For 100 existing interconnections, there are an additional 20 reserve interconnections, as 20% of 100 = 20.

#### Limited number of interconnections

A differentiation is made between interconnections within a task, between tasks of a CPU and between several CPUs of a station. For operation with several CPUs, an additional differentiation is made between standard- and fast $ signals.

For interconnections between tasks of a CPU, the alternating buffer system on the processor is used. The maximum number of interconnections is limited by the main memory expansion stage.

Connections between several CPUs of a station are handled via the communication buffer modules. The number of possible interconnections is dependent on the communication buffer module used and the signal types.

**Further information**

on the communication buffer modules refer to the "SIMATIC TDC/SIMADYN D hardware" Manual

For an MM11 module with 64 Kbyte memory each for the L- and C bus, the following are obtained when using:

<table>
<thead>
<tr>
<th>Signal type</th>
<th>Bytes/interconnection</th>
<th>Number of interconnections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast $ signals</td>
<td>4</td>
<td>Approx. 16000 per bus type</td>
</tr>
<tr>
<td>Standard signal</td>
<td>Max. 36 (No. CPUs + 1)*4</td>
<td>Min. 1800 per bus type</td>
</tr>
</tbody>
</table>

Table 2-9  Calculating the maximum number of interconnections

#### NOTE

If standard and fast interconnections are combined, an appropriately lower number are obtained.
2.1.6 Significance and uses of the process image

A process image is an instantaneous image of all interface signals from the process at the start of a cyclic task.

**Necessity for data consistency**

For a digital control system, the interface signals must be processed consistently to the individual processes. In this case, interface signals are the digital and analog input- or output signals of a hardware module.

The input signals of the various tasks must be kept constant during a computation cycle. If this was not the case, interface signal changes while processing a task and run times of the individual function blocks would unpredictably influence the result of a computation cycle.

The data from the hardware interfaces is processed in the so-called process image, implemented by the system mode of the function blocks when a task is started to be processed.

The task administrator (refer to the Chapter "Mode of operation of the task administrator") of the operating system is started with the basic CPU clock cycle T0. This decides which tasks are to be started (T1 and a maximum of additional Tn, with Tn ∈ {T2...T5}).

**Task processing**

Within the task processing, the following components are to be executed:

- **Buffer changeover for the tasks to be started (task 1 T1 and if required an additional task Tn)**
- **System mode of function blocks in T1 corresponding to the block sequence**
- **System mode of function blocks in Tn corresponding to the block sequence**
- **Importing signal interconnections in T1 and standard mode T1**
- **Exporting signal interconnections from T1**
- **Importing signal interconnections in Tn and the standard mode Tn**
- **Exporting signal interconnections from Tn**

The components relevant for the process image are highlighted; for the other components refer to the Chapter "Description and use of the signal transfer mechanisms".
2.1.6.1 Implementing the process image

System mode

The system mode is used to implement the process image before a task is computed. In the following Fig. 2-6, the sequence in which the function blocks are executed in the system- and standard mode is illustrated in cyclic operation (CPU in the RUN status). In this example, function blocks 10 and 30 in the system mode are computed within the process image so that the results can be subsequently consistently used in the standard mode.

The system mode starts immediately after the initiating event (process interrupt or basic clock cycle) in order to create a real time process image. The execution between the jump into the operating system up to the end of the system mode can only be interrupted by a higher priority system mode. Among other things, function blocks with access to the periphery are computed.
2.1.6.2 Process image for cyclic tasks

**Input blocks with system component**

For input blocks, which have a system component or whose system component is activated, the input signals are read-in from the hardware and buffered. The signals are evaluated with the blocks in the standard mode of the same cycle.

**Output blocks with system component**

For output blocks, which have a system component and whose system component is activated, in the standard mode of the previous cycle, the signals to be output are calculated corresponding to the block function and the actual connection (I/O) values. These signals are buffered. Signals are output to the hardware in the system mode at the start of the next sampling cycle.
As the system component is essentially restricted to the input and output of hardware signals, the system mode is processed within just a few micro seconds.

For several input/output blocks, the „DM“ block input can be used to control whether an input/output is made in the system mode or in the standard mode. For computation in the standard mode, the interface signals at the blocks are computed, bypassing the process image within the standard mode. For input blocks, the signals are read-in immediately before being computed, and for output blocks, immediately after their computation.

2.1.6.3 Process image for interrupt tasks

An interrupt task has essentially the same behavior as a cyclic task.

An interrupt task can interrupt a cyclic task running in the standard mode. However it cannot be interrupted by cyclic tasks. Thus, e. g. for longer computation times of an interrupt task, the start of cyclic tasks and therefore output to the hardware can be delayed. This is because, for output blocks with system mode, the signal is only output to the hardware after the next task has been started.

Further it should be precisely checked when using input/output blocks with the system mode within an interrupt task for non quasi-cyclic interrupts. In this case, the output is only realized after the next interrupt event whose timing is unknown. For specific input/output blocks, this problem can be remedied by using a block input so that input/output is realized in the standard mode.
2.1.7 Significance and application of the CPU synchronization

Configuring the CPU synchronization

The CPU synchronization is configured in the HWConfig program section. The directory of the appropriate SIMATIC TDC/SIMADYN D station is opened in the SIMATIC manager and HWConfig is activated by double clicking on the hardware symbol in the righthand section of the window. Now select the required CPU module. There are separate dialog windows to synchronize the basic sampling time of the CPUs and the interrupt tasks under **Edit > Object characteristics**.

SIMADYN D synchronizing mechanisms

SIMATIC TDC/SIMADYN D provides the following synchronizing mechanisms:

- Time synchronizing
- Synchronizing its own basic clock cycle to the clock cycle of a master CPU
- Synchronizing its own basic clock cycle to an interrupt task of a master CPU
- Synchronizing its own interrupt task to interrupt tasks of a master CPU
- Synchronizing several stations
- Response when synchronization fails
- Configuring the CPU basic clock cycle synchronization
- Configuring the interrupt task-synchronization

2.1.7.1 Time synchronization

The real-time clocks of all CPUs in a SIMATIC TDC/SIMADYN D station are synchronized to the clock of CPU inserted at slot 1. This prevents the various CPU clocks from drifting apart. This synchronization is automatically realized every 10 s.

2.1.7.2 Synchronizing its own basic clock cycle to the basic clock cycle of a master CPU

The basic clock cycle can be switched from a CPU to the L- and/or C bus of the subrack and can be received from other CPUs of the station, or by several SIMATIC TDC/SIMADYN D stations, which are coupled using the rack coupling or GDM coupling. For the receiver CPU, an offset can be configured between the basic sampling time and the transmitter basic sampling time. This time offset can also then be changed online with the CPU in the RUN status using the DTS function block type.
2.1.7.3 Synchronizing its own basic clock cycle to an interrupt task of a master CPU

At the start or at the end of an interrupt task of a transmitting CPU, it is possible to initiate an L- or C-bus interrupt. This can be received from one or several other receiver CPUs where it is then used to generate the basic clock cycle.

2.1.7.4 Synchronizing its own interrupt tasks to interrupt tasks of a master CPU

To synchronize an interrupt task it is possible to use an L- or C-bus interrupt, initiated at the start or the end of an interrupt task from a transmitter CPU. This interrupt can be received at one or several other receiver CPUs in order to initiate an interrupt-controlled task there.

2.1.7.5 Synchronizing several SIMATIC TDC/SIMADYN D stations

CS12, CS13 and CS14 modules (master rack coupling) and CS22 (slave rack coupling) (SIMADYN D) or CP52M0, CP52IO, CP52A0 (SIMATIC TDC) and CP53M0 (SIMATIC TDC with SIMADYN D) are available to synchronize the basic sampling time over several stations. In this case, the bus systems of the two stations are connected via coupling modules.

Further information on synchronization please refer to the "System and communication configuring D7-SYS" Manual.

2.1.7.6 Response when the synchronization fails

The basic clock cycle is monitored on the synchronized receiver CPUs using a hardware timer. If the transmitted clock is no longer available for 4 cycles, the basic clock timer on the CPU module, generates the basic clock cycle. The basic sampling time configured in HWConfig is used as basis, which in this case serves as the equivalent sampling time. The changeover to the basic clock cycle of the CPU is signaled by a flashing "E" on the 7-segment display of the CPU module, and is flagged in the error field. When the external clock source kicks in again, this can be again used on the basic sampling time clock receiver using the "DTS" function block type.

2.1.7.7 Configuring the CPU basic clock cycle synchronization

The configuring is set in the dialog window "Basic clock cycle" of HWConfig (refer to the Chapter "Significance and use of CPU synchronization"). The synchronization is disabled as default.
If the CPU should generate a basic clock cycle itself, the following settings must be made in the dialog field „Basic clock cycle“ (refer to Fig. Dialog field, basic clock cycle in HWConfig):

- Activate the „Generate“ button with a mouse click.
- Enter the required basic sampling time from 0.1 to 16 ms.

In the lower section of the window it can be defined as to whether the selected CPU should be used as the source for the basic clock cycle. The appropriate bus must be set for this purpose. „No“ is pre-assigned (default).

If the basic clock cycle is to be synchronized to another source, HWConfig requires the following settings:

- Activate the „Synchronizing“ button with a mouse click.
- Select the required source from a list, e. g.
  
  - L- or C-bus basic clock cycle
  
  - L- or C-bus interrupt (SIMADYN D)
  
  - bus interrupt (SIMATIC TDC)

- Enter an equivalent sampling time of 0.1 to 16 ms.
  
  Pre-assignment = 1.0 ms (default)

- If required, enter a synchronization delay time of 0.1 ms up to the equivalent sampling time.

  No sampling time is pre-assigned (default value)
2.1.7.8 Configuring the interrupt task synchronization

The setting is made in the dialog window "Interrupt tasks" of the HWConfig (refer to the Chapter "Significance and use of CPU synchronization"). The synchronization is disabled as default, i.e. no process interrupts are defined and a bus interrupt is not transmitted.

Setting the interrupt task synchronization

- The mouse is used to select one of the 8 possible interrupt tasks I1 - I8.
- Select the required source of the defined process interrupt from a list, e.g. C bus interrupt or CPU counter C1 or C2
- Enter an equivalent sampling time from 0.1 to 16 ms.

CPU as interrupt source for the subrack

In the lower window section, select whether the selected CPU is to function as the process interrupt source for the subrack. In this case, one of the defined interrupt tasks I1 - I8 must be selected, and transmitted on the L- and/or C bus. It can be decided as to whether the interrupt task is sent at the start or at the end of the interrupt task processing.
Transmitting at the start of interrupt task processing

It is practical to transmit the interrupt task at the start, if several alarm interrupts must start in synchronism on several CPU modules without any delay. However, the interrupt task on the receiver CPU module may end before the interrupt task on the transmitting CPU module as the transmitting task was inhibited by a higher-priority interrupt.

Transmitting at the end of interrupt task processing

If transmitted at the end, it is ensured that the task on the receive side is not started before the transmit task has been completed. This second possibility can be used when data is being transferred from a transmit- to a receive task.

2.1.7.9 Example of a synchronization configuration

In Fig. 2-10 Synchronization configuration, CPU 1 transmits its basic clock cycle onto the L bus. Further, the C bus interrupt is used as interrupt event by an interrupt-controlled task of the CPU 1.

CPU 2 retrieves its basic clock cycle from the basic clock line of the L bus and switches the interrupt from counter C1 (configuration with function block PAC) to the L bus interrupt line.

CPU 3 retrieves its basic clock cycle from the L bus interrupt line and switches the interrupt, received via the binary input (configuration with function block PAI) to the C bus interrupt line.

Description

In Fig. 2-10 Synchronization configuration, CPU 1 transmits its basic clock cycle onto the L bus. Further, the C bus interrupt is used as interrupt event by an interrupt-controlled task of the CPU 1.

CPU 2 retrieves its basic clock cycle from the basic clock line of the L bus and switches the interrupt from counter C1 (configuration with function block PAC) to the L bus interrupt line.

CPU 3 retrieves its basic clock cycle from the L bus interrupt line and switches the interrupt, received via the binary input (configuration with function block PAI) to the C bus interrupt line.
2.1.8 Significance of the processor utilization

2.1.8.1 Determining the approximate processor utilization

When compiling, the CFC determines a value for the CPU computation time utilization. A list is accessed, in which the computation time of a block is entered for each function block type. When developing the blocks, these computation times are determined for the "worst case", and are specified in the User documentation, function block library (Edition in Autumn 1997).

For several function blocks, especially for blocks, which access hardware, the worst case situation will generally result in higher time and therefore a typical computation type is used (e. g. for medium bus load levels). Based on these nominal values, for several function block types, the actual computation time can fluctuate significantly.

The computation time, entered in the block catalog, specifies the typical block computation time on a PM5 in $\mu$s. However, this value especially for communication blocks, can deviate from the actually required time, depending on the quantity of data to be transferred.

After the charts of a CPU have been compiled using the CFC editor via the menu item Chart > Compile the path of a MAP list is specified in an info window or in an error window. The processor utilization, entered in the MAP list, is an approximate value for the reasons mentioned above, which is generally accurate to approximately +/- 10 %.

2.1.8.2 Calculating the precise processor utilization

Function block PSL The precise CPU utilization can only be determined when the PSL "Permanent System Load" block is configured. The PSL block is configured in any cyclic task in the CPU to be investigated.

It has 5 outputs (Y1..5) which display the actual utilization of the individual tasks in the form of a load factor. The displayed factor should not exceed 1.0 (100%). Values exceeding 1.0 indicate that a CPU is overloaded.

Further, the PSL block has 5 inputs (T1..5) which, for each task, can be used to simulate an additional load in milliseconds (ms). It is then possible to read how such a load effects the utilization of the individual tasks at the outputs. The utilization is determined by measuring the task run times and then dividing this by the actual sampling time. Higher priority tasks occur within the run time of a task which extend the run time and noticeably increase the utilization. Thus, by just adding these values, it isn't possible to obtain an overall utilization level.
2.1.8.3 Mode of operation of the task administrator

The mode of operation of the task administrator is illustrated in this Chapter in Fig. 2-12.

If a task can be completed within a basic sampling time due to a low computation time, then this is illustrated in the 1st cycle.

If a task can no longer be completed within a basic sampling time due to a higher computation time, then it is completed in the following basic cycles. The tasks with short sampling times are completed before tasks with long sampling times, i.e. T1 before T2, before T3 before T4 before .... This distribution is permissible, i.e. without cycle error, as long as the required sampling times are maintained (refer to the 2nd and 3rd cycle).

Cycle errors

If the computation time loading becomes higher, for the task with the longest sampling time, at same stage a cycle error will occur. This means that the sum of the function blocks cannot be computed completely within the configured sampling time.

NOTE

If a specific number of cycle errors is exceeded, an "E" error ID is set, and is displayed in the 7-segment display on the front panel of the CPU, if this is the highest priority error status of the CPU at this time.

In addition to the configurable interrupt tasks, the cyclic tasks are interrupted, especially by communication interrupts. These interrupts ensure that, for example, the data to be transmitted and received via the serial interfaces is processed before new data is received. Transmit- and receive interrupts such as these can occur independently of the configured cycle time of the appropriate communication blocks at almost any instant in time. As result of this, and the unpredictable occurrence of interrupt tasks, if the process utilization is extremely high, each cyclic task can generate one or several cycle errors due to task back-up.
This can be especially noticed, if

- the utilization by the task with the lowest sampling time is extremely high, and
- the functions computed in this task are extremely sensitive to sporadic sampling cycle failures, (e. g. closed-loop position controls).

<table>
<thead>
<tr>
<th>T1</th>
<th>T1+T2</th>
<th>T1+T3</th>
<th>T1+T2</th>
<th>T1+interrupt task+T4</th>
<th>T1</th>
</tr>
</thead>
<tbody>
<tr>
<td>T2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interrupt task</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Fig. 2-12 Sequence of a configured task*

### 2.1.8.4 Eliminating cycle errors

The modular SIMATIC TDC/SIMADYN D provides the following possibilities of eliminating cycle errors:

- Increasing the configured basic sampling time
- Shifting configured blocks from fast to slow tasks.
- Using several or higher-performance CPUs or several SIMATIC TDC/SIMADYN D stations
- Reducing the number of blocks or changing the block types
- Checking the necessity to have communication interfaces on this CPU
- Checking the necessity for interrupt function packages on this CPU

**NOTE**

On a case for case basis it should be checked the most cost-effective way to achieve the desired result.
2.1.9 Technical data of the operating system

2.1.9.1 Features

The most important properties and technical data of the operating system are specified in the following.

Number of CPU modules

A maximum of 8 (SIMADYN D) or 20 (SIMATIC TDC) CPU modules can be inserted in a subrack. A CPU module requires 1 slot. Slots which are not occupied by CPU modules can have peripheral modules.

Number of function diagrams

The maximum number of function diagrams is dependent on the particular software, but is approximately 65536.

Cyclic tasks

<table>
<thead>
<tr>
<th>System diagram</th>
<th>Available automatically</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic sampling time T0 can be configured</td>
<td>From 0.1 [ms] to 16 [ms] in steps of 0.1 [ms]</td>
</tr>
<tr>
<td>Number of configurable cyclic tasks</td>
<td>5</td>
</tr>
<tr>
<td>From the basic sampling time</td>
<td>T0</td>
</tr>
<tr>
<td>To</td>
<td>T0 * (2 ** 15)</td>
</tr>
<tr>
<td>Configurable from</td>
<td>T0 to 32768 * T0 e. g. of 1 [ms] to 32768 [s]</td>
</tr>
</tbody>
</table>

Table 2-10 Technical data of the cyclic task

Interrupt tasks

| Number of configurable interrupt tasks | 8 |
| Number of available interrupt sources, total | 54 (SIMADYN D) or 19 (SIMATIC TDC) |
| Of which | |
| Software interrupts | 8 |
| CPU timer interrupts | 2 |
| Interrupts for binary inputs | 4 |
| Bus interrupts (L/C) | 2 (SIMADYN D) or 3 (SIMATIC TDC) |
| LE bus interrupt | 4 (only SIMADYN D) |
| LE bus interrupt, extended | 32 (only SIMADYN D) |
| Only T400 ISL, ISR | 2 |

Table 2-11 Technical data of the interrupt task

Computation times of the operating system

The run times of the operating system are specified in the following, based on the PM5 CPU module. For PM6 CPU modules, the computation time is shortened to approximately one third of the specified times.

The signals, which are transferred along the L- and/or C bus represent an almost consistent system load, as the bus is always clocked at 8 MHz.
The minimum time is shown in the following table which is required to process each cycle of a task (refer above for the basis for the calculations!):

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Time to start</td>
<td>40 µs</td>
</tr>
<tr>
<td>Time to end</td>
<td>40 µs</td>
</tr>
<tr>
<td>Additional component for a local buffer system</td>
<td>20 µs</td>
</tr>
<tr>
<td>C-bus buffer system</td>
<td>20 µs</td>
</tr>
<tr>
<td>L-bus buffer system</td>
<td>20 µs</td>
</tr>
</tbody>
</table>

*Table 2-12 Computation times of the operating system*

**Memory requirement of the operating system**

The code and data of the operating system are copied from the memory module into the CPU RAM on the CPU module and the data is "unzipped". Memory requirements are as follows:

- CPU-RAM area: 400 Kbyte
- Memory module area: 200 Kbyte ("zipped")

On the communication buffer modules, the operating system after the start uses 1 Kbyte of the C-bus- and the L-bus buffer memory as data area to administer operating system lists. This is supplemented by the appropriate memory requirement, depending on the configured software, for the buffer system and additional components, e.g. communications.

**Operating system version**

The operating system is identified by a version ID in the form "yyymmddVxzy". The significance of the individual letters is

- yy: Year, mm: Month, dd: Day
- "V": Version
- xzy: Version number

e.g. for version 5.0 as "961201V500".

**2.1.9.2 The basic operating system functions**

The operating system is comprised of the following components:

- Task administrator for cyclic- and interrupt controlled processing
- Hardware and software initialization
- Memory administration (buffer administration)
- Operating system data and lists
- Interface to the central AMC lists
- Coupling to the other components (system interfaces)
The operating system is capable of multi-processing and multi-tasking.

The basic operating system functions are embedded in the overall system, whereby these represent the most important interfaces to the environment.

<table>
<thead>
<tr>
<th>Operating system functions</th>
<th>Initiated by</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialization</td>
<td>RESET</td>
</tr>
<tr>
<td>Cyclic processing</td>
<td>Sampling time timer</td>
</tr>
<tr>
<td>Interrupt-controlled processing</td>
<td>Process interrupts</td>
</tr>
<tr>
<td>Process image</td>
<td></td>
</tr>
<tr>
<td>Exception handling and diagnostics</td>
<td>System interrupts</td>
</tr>
<tr>
<td>Communications, I/O</td>
<td>Input/output interrupts</td>
</tr>
<tr>
<td>Service</td>
<td></td>
</tr>
<tr>
<td>User program</td>
<td></td>
</tr>
<tr>
<td>Utility programs</td>
<td></td>
</tr>
</tbody>
</table>

Table 2-13  Basic operating system functions

Initialization

Initialization is initiated by powering-up the power supply or depressing the RESET button to output a reset pulse. The initialization conditions/prepares the hardware and software so that the system can go into the standard operating mode (RUN status).

Cyclic processing (RUN operating status)

The task administrator ensures that the functions, assigned to the various tasks are cyclically processed. The cyclic tasks are in a ratio to the power of 2 to each other

\[ T(i) = T(0) \times (2^j) \]

\( j \) defines the sampling time value with \( 0 \leq j \leq 15 \)

\( i \) numbers the sampling times with \( 1 \leq i \leq 5 \).

Example:

For a basic sampling time of 1 ms, the sampling times can be 1 ms, 2 ms, 8 ms, 32 ms and 128 ms. The basic sampling time is defined for each CPU module during configuring, using the HWConfig program section of the SIMATIC Manager. The sampling times of the tasks running on the particular CPU module are also configured at this time.

In order to prevent bottlenecks, the tasks are started, phase-shifted with the basic clock cycle, so that with the basic clock cycle, the start of a second, lower-priority task is flagged. As result of the discrete distribution of the sampling times, based on a ratio to the power of 2, also low-priority tasks are completely taken into account. This means that it no longer occurs as a low-priority sampling time on the basic clock cycle. (refer to the Chapter "Processor utilization"). The priorities of the various tasks decreases with increasing sampling time.

The task administrator is started with the clock cycle of the basic sampling time of the sampling time timer. This determines the second task, task Tn to be started in addition to T1 (Tn from {T2...T5}). If the task to be started has a lower priority than an interrupted task, its start is buffered, and the interrupted task is continued. Otherwise, the determined task is started. The status of the interrupted task is written...
into a task-specific data area, which allows the task to be further processed as soon as a higher-priority task is no longer present (refer to Fig. Calculating the run time).

The time component required by the operating system itself is not taken into account in this description. If the diagram was to be precise, then the actual starting instant of the task would be shifted by these amounts.

**Interrupt-controlled processing**

In addition to cyclic processing, the operating system also administers tasks, which are started by non-cyclic interrupts, especially process interrupts. Interrupt sources could be:

- software interrupts
- CPU-timer interrupts
- L/C-bus interrupts
- LE-bus interrupts

The priority of the interrupt tasks is defined by the data configured in HWConfig (I1 > I2...> I8). The programming engineer programming the user program configures, using HWConfig, the interrupt sources which he or she requires for his or her application, and their processing in the interrupt-controlled tasks.

**Process image (system mode)**

Before a task is processed, it is first investigated whether an associated process image must be updated. If yes, this is realized before the task is started, by calling-up the system mode of the function blocks (refer to the Chapter "Significance and use of the process image"). The update is referred to:

- binary inputs/outputs, for example, the status images for controller enable signals and the position of limit switches.
- analog inputs/outputs, for example, values for temperature, speed, etc.

**NOTE**

The system mode is started for both tasks to be started before standard mode processing (refer to the Chapter "Significance and use of the process image").

**Error differentiation**

SIMATIC TDC/SIMADYN D differentiates between errors, which occur during initialization and those which occur during standard operation.

Errors from the initialization (INIT operating status) result that the system is not released for start (transition into the RUN operating status).

For errors in standard operation (RUN status), a differentiation should be made whether processing is to be continued or terminated.

The system informs the user about its status, especially about the error statuses, using the 7-segment display on the CPU module.
When an error situation occurs, detailed information is deposited in the error data fields of the operating system. These error data fields permit a precise error analysis to be made.

This data can be read-out and changed using the service utility.

The significance of the error signals and information can be taken from the online help "D7-SYS, Help on events".

Communications
Communications handles all of the input/output data transfer between the hardware as well as the associated software components and the user interfaces. The interfaces and their parameterization are configured in the user program using CFC.

Service utility
The service utility is the central interface of the CPU modules. It is an instrument for start-up, diagnostics and troubleshooting.

As the processing time of the service utility is undefined, the task associated with it as well as the tasks with lower priority can be blocked. This has been implemented, so that service is allocated a maximum processing time within its cycle (maximum of one basic clock cycle T0).

The service units form the user interface via which the communications software is controlled.

User program
The user program is used to implement the technological tasks on the target hardware. It is generated at the programmer in the CFC programming language, using the available utility programs such as HWConfig, CFC editor, CFC compiler, linker/locator and the memory module driver.

The CFC source code of the user program is converted into data structures using the CFC compiler, and loaded on the target hardware where it is processed by the operating system.

Utility programs
Utility programs are basic system functions for the operating system. These include watchdog functions, functions to handle the CPU display, special test- and interrupt routines to handle system errors.

2.1.9.3 The service utility

The service utility provides a pool of information functions so that the user has access to system information on the processor. The service utility is designed as support resource for start-up and testing.

Start-up area
Configured data (setpoints/actual values) are displayed and/or changed here and the software optimized (e.g. interconnection changes, controller times changed etc.).

Testing
Causes of plant/system faults (crashes, run-up problems) and faults, which are caused in the CPU module itself, are identified here.

All activities of the service utility are controlled via tasks, which are received via "its" data interface (corresponding to the parameterization of the service function block I/O).
All devices which can process the task- and response language of the utility can be used as handling devices for the service utility. In the SIMATIC TDC/SIMADYN D world, these are the programs (tools) CFC in the test mode and service IBS (service start-up).

**NOTE**
The user can also use his own tools. They must be compatible with the interface definitions of the service utility. The interface specification can be sourced from ASI 1 R.

The service utility is made available with the "SER" function block. This function block ensures that none of the messages/data get lost.

**Task processing**
The service utility differentiates between cyclic and non-cyclic tasks. A non-cyclic task is completed when its response telegram has been sent. A cyclic task remains active until it is explicitly terminated, either by being aborted via a reset or as result of a new task. A task comprises of at least one response telegram.

**NOTE**
The service utility can always only process one task. The next task is only processed if the previous task was responded to.

**System loading, response times**
The actual service utility processing is realized in a 32 ms sampling time (the next sampling time below 35 ms is selected; the sampling times specified at the SER blocks are not significant for processing). In the cyclic task used, the service blocks are provided a certain computation time, which may use as maximum the basic clock cycle T0. The ratio of the basic clock cycle T0 to the used task defines the CPU performance available and therefore the system loading.

Example 1:

Basic clock cycle T0 = 1 ms; selected sampling time = 32 ms. Every 32 ms, 1 ms is reserved for the service utility. Thus, the system load is calculated of

\[
\frac{1ms}{32 ms} = 0.03125 = 3.125\%
\]

Example 2:

Basic clock cycle T0 = 2 ms; selected sampling time = 16 ms. Every 16 ms, 2 ms are reserved for the service utility. Thus, a system load is obtained from

\[
\frac{2ms}{16 ms} = 0.125 = 12.5\%
\]

This available computation time is used by all service blocks to the same extent, i.e. as long as the time is sufficient, if possible, all of the SER blocks are processed once. An SER block processes a maximum of one task per clock cycle. For cyclic tasks, for each clock a maximum of one response telegram is received. The advantage of this mode of operation is that for cyclic tasks, equidistant-timed responses are obtained.

If the reserved computation time is not fully utilized, because, for example, there is no task to be processed, then this time is made available to the system.
For multiple configuring with simultaneous access to system resources which are only available once (e.g. change memory of the memory module), resources are assigned to the first component which makes the request. All others are rejected and output at the latest after 1 second, an error message ("resource occupied") via the data interface.

**Behavior under fault conditions**

In a fault condition (exception), i.e. for initialization errors or online faults, the system goes into the stop mode. Thus, there are special conditions for the service utility. It is then no longer computed in a cyclic task, but runs continuously, started from an exception administrator. Under fault conditions, the service utility cannot be connected to the configured user. In order to still permit system diagnostics, the CPU's own diagnostics interface is connected. The DUST1 protocol runs here (refer to the Chapter "Operating statuses of a CPU module").
2.2 Function description and user instructions

2.2.1 Fatal system error "H"

If a fatal system error occurs, processing (initialization or normal operation) is interrupted, and the system goes into the stop mode. The error cause is available for diagnostic purposes.

**NOTE**
Before investigating a fatal system error, the INIT_ERR and SYS_ERR system error fields should first be investigated. If errors are entered there (especially hardware (monitoring) errors), then this could be the cause of a fatal system error.

A SAVE area is set-up in the upper area, in the local RAM of each CPU module. This area is not erased at re-initialization, if the status of the RAM copy is appropriate. An error buffer is set-up in this SAVE area, which includes the error protocol (error report) consisting of several messages.

The error buffer consists of an administration part and a ring buffer, in which the error messages are saved. The ring buffer is implemented as buffer which can be overwritten, i.e., if the buffer is full with error messages, then the new messages overwrite the oldest messages.

There are 2 different types of error messages. A long message is output in the case of a non-maskable interrupt NMI. A short message for a power-OFF.

The service communications utility is available, (even if it has not been configured) to troubleshoot fatal system errors. It can be accessed via the local diagnostics interface, after pressing the acknowledge button. Using the service utility, the error causes can be output in plain text.

What is especially important is the error cause, specified under an ID code and supplementary ID. If a function block is being calculated at the instant that the system error occurs, then this is output. In addition, the results of the last bus accesses are displayed; these are important, if a bus access is the error cause. Further, all of the process registers are displayed for the system specialists to allow them to make a precise error analyses.

**NMI handling**
When a non-maskable interrupt occurs, this is considered as fatal error and causes initialization or normal operation to be interrupted. All of the modules, inserted in the subracks, are no longer processed.

A large flashing \( H \) is displayed on the CPU module display of the faulted module, which caused this fatal error. A large \( H \) is displayed as steady display on the other CPU modules which received an NMI as result of the faulted module. The debug monitor can be activated by pressing the acknowledge button or setting the status value.
The symbols output on the 7-segment display have the following significance:

**Steady** : CPU module was shutdown by another module.

**Flashing** : Fatal error on this CPU module (error cause).

### Example for an error protocol (error report) for fatal system errors

#### Information on the last crash:

- **Time:** 01.01.93 04:16:24.9294 h
- **Crash instant:**
- **ID:** #5 CPU
- **Supplementary ID:** 28 (unaligned instruction fetch)
- **EPC:** 0x04C4F19A
- **Return jump address:** 0x801201f8

#### Running task:

- **T2**

#### Started levels:

- **T2 (NRM), T5 (NRM), BACKGROUND**

#### Last processed FB:

- FP-KRUMMS.AY0815 (Typ: ADD8F)
- (ALE: 0x80107DB8 CODE: 0x801201E0)

#### Last L-bus access:

- **Access type:** q_read_2byte
- **Bus address:** 0x80025874
- **Retries:** 0

#### Last C-bus access:

- **Access type:** q_read_2byte
- **Bus address:** 0xB4F4508B
- **Retries:** 0

#### The processor status at the crash instant:

- **EPC:** 0x04C4F19A
- **BadVAddr:** 0x04C4F19A
- **Status:** 0x00000000
- **fpc_csr:** 0x00000000
- **CAUTION:** The value of a0, a1 (and possibly a2) is not valid!

#### The running and started tasks at the crash instant as well as the processed function on the data- and code areas:

- **T2 (NRM), T5 (NRM), BACKGROUND**
- **Running task:** T2

#### Data on the system bus accesses:

- **Access type:** q_read_2byte
- **Last L-bus access:**
  - **Bus address:** 0xB0F25874
  - **Retries:** 0
- **Last C-bus access:**
  - **Bus address:** 0xB4F4508B
  - **Retries:** 0

#### Register dump of all process registers:

- **EPC (crash address, as above) and BadVAddr (bad virtual address, address which was erroneously accessed(mainly for ID TLB and CPU))**

#### End of the diagnostics

---

**Systemsoftware**

System- and communication configuring D7-SYS - SIMATIC TDC

### Causes of fatal error

A fatal system error can have the following causes (ID codes). A supplementary ID describes the error cause in more detail.

#### Supplementary ID code (precise description)

- **NMI** a non-maskable interrupt  
  - second bus clear for task-controlled access  
  - bus clear for direct access  
  - timeout during L/C-bus arbitration/assignment  
  - (module missing/defective, daisy chain missing)  
  - ready internal from L/C bus (error on another CPU module)  
  - ready internal from the local expansion bus (LE bus)  
  - system bus controller overrun  
  - timeout when accessing the local periphery  
  - spurious interrupt (an interrupt source cannot be identified)  
  - direct access to the L/C bus (bypassing the driver functions)

- **CPU** exceptional status of the CPU  
  - internal error  
  - reserved Instruction  
  - unknown Syscall  
  - unaligned instruction fetch (jump to address which cannot be divided by four)  
  - user access to kernel space  
  - unaligned load/store to coprozessor 0/2/3  
  - unaligned load/store to L-/C-bus address space  
  - break 6/7 not in div/mul context  
  - unknown break value  
  - reserved exception  
  - task running in endless loop

- **FPU** FPU exception status  
  - fpu fault at non-fpu instruction  
  - illegal fpu sub opcode  
  - operation on NaNs  
  - add/sub/division of infinities  
  - mul of infinity and 0

- **TLB** exception status of the TLB  
  - TLB modified exception  
  - TLB read/write miss (access to illegal address)  
  - UTLB miss (access to illegal address)

- **TIME** basic cycle time failure

- **OFF** power down  
  - power down/reset in the normal mode  
  - power down/reset in the stop mode (after another exception)
2.2.2 Background processing

If the CPU has no tasks to process during normal operation, it processes the background task.

As background task, the following functions are simultaneously available:

- the online test mode
- a service utility

The online test mode is normally processed in the background after initialization was successfully completed. However, if the acknowledge button is pressed at the end of initialization, then only the service communications utility is activated.

Errors in the background processing are saved in the UEB element of the error field SYS_ERR.

2.2.2.1 Online test mode

In the online test mode, for example, a battery test, a memory module checksum test etc. are executed. The memory module checksum routine determines the memory module checksum and compares it with the checksum calculated by the programmer and that saved in the memory module. If a memory module checksum error is identified in the online test mode, the user can remove the error by repeatedly generating the memory module. For battery test errors, he can replace the battery.
2.3 System chart @SIMD

Overview
The system chart @SIMD (Part A and B) is a CFC chart made available as standard to the user. They permit standard diagnostics of the hardware and system software.

Program structure
The system chart is configured, structured in the following parts:
- Acknowledge: Acknowledge the error display
- Evaluate components: Determine the components which signaled an error
- Display: Output the identified error

<table>
<thead>
<tr>
<th>System chart @SIMD</th>
<th>Function block names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge</td>
<td></td>
</tr>
<tr>
<td>Pushbutton</td>
<td>ACK Acknowledge</td>
</tr>
<tr>
<td>Service intervention</td>
<td>ACK</td>
</tr>
<tr>
<td>Evaluate components</td>
<td></td>
</tr>
<tr>
<td>First error field</td>
<td>FER First error</td>
</tr>
<tr>
<td>Communications error field</td>
<td>CER Communication error</td>
</tr>
<tr>
<td>Task administrator error field</td>
<td>TER Task management error</td>
</tr>
<tr>
<td>Hardware failure error</td>
<td>Monitoring error</td>
</tr>
<tr>
<td>User error field</td>
<td>UER User error</td>
</tr>
<tr>
<td>Evaluate errors</td>
<td>DER Display error</td>
</tr>
<tr>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>Output, 7-segment display</td>
<td>DST Display status</td>
</tr>
<tr>
<td>Output, diagnostics LED</td>
<td>DST</td>
</tr>
<tr>
<td>Output, status word SIMS, status bit SIMD</td>
<td>SIMS, SIMD</td>
</tr>
</tbody>
</table>

Table 2-14 Detailed information on system chart @SIMD

Description
The operating system monitors the hardware and system software. If the monitoring function identifies an error, it flags this by setting the appropriate bits (flags) in the system error field.

The system chart @SIMD allow the user access to these flags. An output is displayed on the 7-segment display of the CPU module if a flag of a component was set.

If several messages are generated for the 7-segment display, the highest-priority message is output.
The flags of the displayed error and the next priority error code is displayed when the acknowledge button on the CPU module is depressed, or an acknowledge signal is issued via a service unit. If there are no errors present, the CPU number is displayed on the 7-segment display as the lowest priority message. In order to identify that the displayed error message was the first to occur, it is displayed flashing.

The sequence diagram illustrates the global program sequence of the system charts. It consists of the three functional components:

- identify acknowledge signal
- evaluate components, and
- display.

The acknowledge signal is a pulse which is derived from the pushbutton status read-in from the ASI function block or as result of a service intervention at connection ACK000.I (set from 1 to 0). Priority-controlled error fields and therefore their display are acknowledged using this pulse. Output of error codes „C“ and „E“ can be suppressed by changing the ACK050.I connection from 0 to 1.

The components are evaluated using the function blocks SYF1 and SYF4. The appropriate numbers of the errors fields are documented in the function block description (refer to the reference manual, SIMADYN D function block library). An error field can only be acknowledged if an error was identified for the particular component and this was displayed.

The first error field evaluation determines which error entry was the first to be identified by the system. The error in the first error field is displayed flashing on the 7-segment display.

All of the components are evaluated according to their priority one after the other. The communications error field cannot be acknowledged, as a software change is required in order to remove this error. When the system runs-up, the CPU could be subject to a higher loading. Task administration errors are automatically acknowledged during the system run-up using a counting logic function.

### Table 2-15  Error priorities for the message display

<table>
<thead>
<tr>
<th>Error name</th>
<th>Error display</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications error</td>
<td>C</td>
<td>High</td>
</tr>
<tr>
<td>Task administrator error</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>Hardware failure, monitoring error</td>
<td>b</td>
<td></td>
</tr>
<tr>
<td>User-generated error ID</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>No error present</td>
<td>CPU number</td>
<td>Low</td>
</tr>
</tbody>
</table>

**Resetting the flags**

**Mode of operation**

**Identify acknowledge**

**Evaluating components**

**Evaluating the first error field**
Control using priority logic

A priority logic circuit ensures that only the highest priority component is displayed. The lowest-priority component supplies a bit signal, which changes-over the display from a CPU number display to an error display (UER070.Q). If the highest priority error component is additionally entered in the first error field, the error display is output flashing.

An acknowledge pulse only resets one error status of a component and its display.

NOTE

If a displayed error is acknowledged, the error source is still present. Before an error can be removed, the error cause must be determined and removed.

Display

When there are no errors, the processor number is displayed on the 7-segment display. If a component signals an error, then the appropriate error code is output.

The status display on a T400 is realized via a diagnostics LED. The flashing clock cycle is increased if the error is a first error.

The status display on a FM 458 is realized via fontside LEDs (refer to User Manual "Application Module FM 458").

Sequence diagram

![Sequence diagram](image-url)
Interfaces

The acknowledge button of the CPU module or the possibility of acknowledging via the service interface is provided as external input of the system chart. The 7-segment display of the CPU module or the diagnostics LED (T400) are available as external outputs for the user display.

The two connections SIMS.QS and SIMD.Q can be evaluated to handle an error in the user program. The error outputs of the individual components are combined to form an error status word via the SIMS function block. The SIMD.Q output connection represents a general error status.

The error status word at the SIMS.QS block connection has the following bit assignment:

<table>
<thead>
<tr>
<th>Bit</th>
<th>Bit assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit1</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit2</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit3</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit4</td>
<td>Task administrator error</td>
</tr>
<tr>
<td>Bit5</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit6</td>
<td>Hardware failure</td>
</tr>
<tr>
<td>Bit7</td>
<td>Communications error</td>
</tr>
<tr>
<td>Bit8</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit9</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit10</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit11</td>
<td>User-generated error ID</td>
</tr>
<tr>
<td>Bit12</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit13</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit14</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit15</td>
<td>Unused</td>
</tr>
<tr>
<td>Bit16</td>
<td>Unused</td>
</tr>
</tbody>
</table>

Table 2-16 Bit assignment of the function block connection SIMS.QS
# 3 Communications configuring

## Overview

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>Introduction</td>
<td>3-2</td>
</tr>
<tr>
<td>3.2</td>
<td>Couplings on the subrack</td>
<td>3-19</td>
</tr>
<tr>
<td>3.3</td>
<td>Subrack coupling CP52M0</td>
<td>3-22</td>
</tr>
<tr>
<td>3.4</td>
<td>Subrack coupling CP53M0</td>
<td>3-28</td>
</tr>
<tr>
<td>3.5</td>
<td>TCP/IP coupling (CP51M1)</td>
<td>3-36</td>
</tr>
<tr>
<td>3.6</td>
<td>TCP/IP coupling (CP5100)</td>
<td>3-45</td>
</tr>
<tr>
<td>3.7</td>
<td>PROFIBUS DP coupling (CP50M1)</td>
<td>3-53</td>
</tr>
<tr>
<td>3.8</td>
<td>PROFIBUS DP coupling (CP50M0)</td>
<td>3-65</td>
</tr>
<tr>
<td>3.9</td>
<td>MPI coupling</td>
<td>3-101</td>
</tr>
<tr>
<td>3.10</td>
<td>Table function</td>
<td>3-102</td>
</tr>
<tr>
<td>3.11</td>
<td>Communications utility, message system</td>
<td>3-138</td>
</tr>
<tr>
<td>3.12</td>
<td>Communications utility process data</td>
<td>3-153</td>
</tr>
<tr>
<td>3.13</td>
<td>Communications utility service</td>
<td>3-171</td>
</tr>
<tr>
<td>3.14</td>
<td>Communications utility time of day synchronization</td>
<td>3-174</td>
</tr>
<tr>
<td>3.15</td>
<td>Communications with SIMATIC Operator Panels</td>
<td>3-176</td>
</tr>
<tr>
<td>3.16</td>
<td>WinCC connection to SIMATIC TDC via the standard channel (SIMATIC S7 Protocol Suite.CHN)</td>
<td>3-184</td>
</tr>
<tr>
<td>3.17</td>
<td>Communications with WinCC (TCP/IP)</td>
<td>3-216</td>
</tr>
<tr>
<td>3.18</td>
<td>Communications service Trace</td>
<td>3-226</td>
</tr>
</tbody>
</table>
3.1 Introduction

3.1.1 Basic information on communications

Communications permit information and data to be transferred to other systems and devices.

To establish communications, the following are required:

- a communications utility must be configured together with a link
- a communications interface must be available

The communications utility defines the information contents (e.g. process data) during communications.

The coupling defines the hardware (e.g. CP50M0) and the data transfer protocol (e.g. PROFIBUS DP) for communications.

The particular application and communication capabilities of the partner define the communications interface and the data coupling.

3.1.1.1 Overview of the various data couplings

General

Couplings are configured in the CFC application using the central coupling blocks.

**CPU-local coupling**

<table>
<thead>
<tr>
<th>Used for the communications partner</th>
<th>• CPU-internal to test transmitters/receivers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware required</td>
<td>• CPU</td>
</tr>
<tr>
<td>Communications utility</td>
<td>• Process data</td>
</tr>
<tr>
<td>Central coupling block</td>
<td>• @LOCAL</td>
</tr>
<tr>
<td>Features</td>
<td>• SIMATIC TDC-internal memory coupling</td>
</tr>
</tbody>
</table>

Table 3-1 CPU-local coupling

**Direct CPU-CPU coupling**

<table>
<thead>
<tr>
<th>Used for communication partner</th>
<th>• CPU-CPU communication for higher data quantities as an alternative to $ signals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware required</td>
<td>• CPU</td>
</tr>
<tr>
<td>Communication service</td>
<td>• Process data</td>
</tr>
<tr>
<td>Central coupling block</td>
<td>• @LOCAL</td>
</tr>
<tr>
<td>Features</td>
<td>• SIMATIC TDC internal memory coupling</td>
</tr>
</tbody>
</table>

Table 3-2 CPU-CPU coupling
Communications configuring

### Communications buffer coupling

<table>
<thead>
<tr>
<th>Used for the communications partner</th>
<th>• CPU-CPU communications for higher data quantities as an alternative to $ signals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware required</td>
<td>• Communications buffer module (CP50M0 / CP50M1 / CP51M1 or CP53M0)</td>
</tr>
<tr>
<td>Communications utility</td>
<td>• Process data</td>
</tr>
<tr>
<td>Central coupling block</td>
<td>• @GLOB</td>
</tr>
<tr>
<td>Features</td>
<td>• SIMATIC TDC-internal memory coupling</td>
</tr>
</tbody>
</table>

**Table 3-3  Communications buffer coupling**

### Subrack coupling SIMATIC TDC

<table>
<thead>
<tr>
<th>Used for the communications partner</th>
<th>• SIMATIC TDC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware required</td>
<td>Communication modules for the master interface:</td>
</tr>
<tr>
<td></td>
<td>• CP52M0 (GDM-Memory)</td>
</tr>
<tr>
<td></td>
<td>• CP5210 (GDM-Interface)</td>
</tr>
<tr>
<td>Hardware required</td>
<td>Communications module for the slave interface:</td>
</tr>
<tr>
<td></td>
<td>• CP52A0</td>
</tr>
<tr>
<td>Communication utility</td>
<td>• Process data, message system, trace</td>
</tr>
<tr>
<td>Central coupling block</td>
<td>• @SRACK</td>
</tr>
<tr>
<td>Features</td>
<td>• Fiber-optic cable</td>
</tr>
<tr>
<td></td>
<td>• Parallel coupling of up to 44 SIMATIC TDC subracks</td>
</tr>
<tr>
<td></td>
<td>• All subracks can be synchronized</td>
</tr>
<tr>
<td></td>
<td>• Uniform system clock possible (unified)</td>
</tr>
<tr>
<td></td>
<td>• Fast</td>
</tr>
<tr>
<td></td>
<td>• The maximum distance between 2 subracks is 200 m</td>
</tr>
<tr>
<td></td>
<td>• The subrack can be disabled (disconnected) at any time</td>
</tr>
</tbody>
</table>

**Table 3-4  Subrack coupling SIMATIC TDC**
### Subrack coupling SIMATIC TDC with SIMADYN D

<table>
<thead>
<tr>
<th>Used for the communications partner</th>
<th>SIMATIC TDC with SIMADYN D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware required</td>
<td>Communication module SIMATIC TDC: CP53M0</td>
</tr>
<tr>
<td>Hardware required</td>
<td>Communication module für SIMADYN D: CS12/CS13/CS14/CS22</td>
</tr>
<tr>
<td>Communication utility</td>
<td>Process data</td>
</tr>
<tr>
<td>Central coupling block</td>
<td>@CS1 (master mode) @CS2 (slave mode)</td>
</tr>
<tr>
<td>Features</td>
<td>Fiber-optic cable Parallel coupling of SIMATIC TDC with SIMADYN D Parallel coupling of up to 3 SIMATIC TDC subracks All subracks can be synchronized Uniform system clock possible Fast The maximum distance between 2 subracks is 200 m The subrack can be disabled (disconnected) at any time</td>
</tr>
</tbody>
</table>

**Table 3-5 Subrack coupling SIMATIC TDC with SIMADYN D**

### TCP/IP coupling

<table>
<thead>
<tr>
<th>Used for the communications partner</th>
<th>• SIMATIC TDC • SIMATIC S5/S7 • Third-party systems • WinCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware required</td>
<td>CP5100/ CP51M1 communications module</td>
</tr>
<tr>
<td>Communication utility</td>
<td>• Process data and message system • Service • S7 kommunikation</td>
</tr>
<tr>
<td>Central coupling block</td>
<td>@TCP/IP</td>
</tr>
<tr>
<td>Features</td>
<td>• Standardized bus according to Ethernet (IEEE 802.3) • Baud rate: 10 or 100 Mbaud (autosensing)</td>
</tr>
</tbody>
</table>

**Table 3-6 TCP/IP coupling**
PROFIBUS DP

| Used for the communications partner | • SIMATIC S5/S7  
• SIMOVERT/SIMOREG drive converters  
• ET200  
• SIMATIC TDC  
• Certified third-party equipment/devices |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware required</td>
<td>• CS7 communications module with CP50M1/ CP50M0 communications module</td>
</tr>
</tbody>
</table>
| Communications utility               | • Process data  
• Parameter processing |
| Central coupling block               | • @PRODP |
| Features                              | • Standardized multi-master bus for communications between SIMATIC TDC and a maximum of 123 communication partners  
• Master slave principle (CP50M1/ CP50M0 is master and/or slave)  
• PROFIBUS standard according to EN 50170  
• Fast  
• Max. 12 Mbaud  
• Maximum net data length, 244 bytes  
• Bus is parameterized using the COM PROFIBUS software(only CP50M0) |

Table 3-7 PROFIBUS DP coupling

MPI

| Used for the communications partner | • CFC  
• WinCC  
• SIMATIC-OPs |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware required</td>
<td>• CP50M1/CP50M0 communications module</td>
</tr>
</tbody>
</table>
| Communications utility              | • Service  
• S7 communications |
| Central coupling block              | • @MPI |
| Features                             | • Multi-master bus with a maximum of 126 nodes  
• 187,5 kbaud / 1,5 Mbaud  
• Standard for SIMATIC S7 |

Table 3-8 MPI coupling
3.1.2 Overview of the communication utilities

Various data can be transferred via the communication interfaces, for example, process data and messages.

The communication utilities define which information/data is to be transferred. The communication utilities are defined by configuring the communication modules.

<table>
<thead>
<tr>
<th>Communication utility</th>
<th>Description</th>
<th>Communication blocks to be configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message system</td>
<td>Establishing alarm- and fault systems</td>
<td>Special message blocks: @MSC, MER..., MSI...</td>
</tr>
<tr>
<td>Process data</td>
<td>Transferring process data (setpoints and actual values)</td>
<td>Send- and receive blocks: CTV, CRV, CCC4, CDC4</td>
</tr>
<tr>
<td>Service</td>
<td>Diagnostics and analysis of CPU programs / CFC</td>
<td>Service- function block: SER</td>
</tr>
<tr>
<td>Time synchronization</td>
<td>Time synchronization of all of the CPUs used (e. g. in order to compare messages with a time stamp).</td>
<td>Special function blocks: RTC...</td>
</tr>
<tr>
<td>Data trace</td>
<td>Trace process quantities</td>
<td>@TCP, TR...</td>
</tr>
<tr>
<td>S7 communications</td>
<td>Operator handling and visualization of CPU program / CFC</td>
<td>Communication function block: S7OS</td>
</tr>
</tbody>
</table>

Table 3-9 Overview of the communication utilities
3.1.3 Communication block I/Os

3.1.3.1 Initialization input CTS

Communication blocks which access a data interface have a CTS input.

The following are specified at the CTS input:

1. The configured name for the communications module

   Syntax for module names:
   - the name is 1 - 6 characters long
   - 1st character: A - Z
   - 2nd - 6th characters: A - Z, 0 - 9, _

2. Connector of the data interface if the data interface is on a CP50M0, CP50M1 or CP51M1 communications module

   Syntax for the connector designation:
   - enter "." after the module name
   - the name after "." is 3 characters long
   - "X01", "X02" or "X03"

Example of data entry at CTS

Configuring example of a subrack:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
<th>Configured module name in HWConfig</th>
<th>Possible data entry at the CTS input</th>
</tr>
</thead>
<tbody>
<tr>
<td>S01</td>
<td>CPU550</td>
<td>&quot;D01P01&quot;</td>
<td>&quot;D01P01&quot;</td>
</tr>
<tr>
<td>S03</td>
<td>CP50M1</td>
<td>&quot;KOPPEL&quot;</td>
<td>&quot;KOPPEL&quot;</td>
</tr>
<tr>
<td>S04</td>
<td>CP50M1</td>
<td>&quot;KOMM1&quot;</td>
<td>&quot;KOMM1.X01&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>&quot;KOMM1.X02&quot;</td>
</tr>
<tr>
<td>S06</td>
<td>CP51M1</td>
<td>&quot;TCPIP&quot;</td>
<td>&quot;TCPIP.X01&quot;</td>
</tr>
</tbody>
</table>

Table 3-10 Configuring example of a subrack

3.1.3.2 Address connections AT, AR and US

General

Communication blocks, which can access a data interface, have an address connection.

Address connection types

Depending on the particular block type, a differentiation is made between three address connection types:

- AT connection: Available when transmitting
- AR connection: Available when receiving
- US connection: Available for function blocks, which are processing a send- and a receive channel
Possible address connection data

The data entries at the address connection are independent of types AT, AR or US. The possible data are:

- "Channel name"
- "Channel name. Address stage 1"
- "Channel name. Address stage 1. Address stage 2"

Channel name

- The channel name addresses a channel at a data interface.
- Transmitter and receiver, which access a data interface with the same channel name, communicate with one another.
- The channel name consists of a maximum of 8 ASCII characters, excluding "Point" and "@".

NOTE

It is not checked as to whether a channel name is configured a multiple number of times. The configuring engineer must uniquely assign the channel names at a data interface for each transmitter/receiver at the AT, AR or US connections. If this condition is not fulfilled, then

- transmitter/receiver may be used a multiple number of times, but uncoordinated.
- the transmitter/receiver could log-off with a communications error.

Exceptions:

- Several transmitters are permitted for the "Select" data transfer mode.
- Several receivers are permitted for the "Multiple" data transfer mode.

Address stages

- There is address stage 1 and address stage 2.
- Several couplings, for example, PROFIBUS and Industrial Ethernet require the address stage to be specified for data transfer. For subrack couplings, for example, address stages are not specified.
- Address stage 1 is a maximum of 14 characters long, address stage 2, maximum 20 characters.
- Significance and contents of the address stages are described for the particular coupling.

3.1.3.3 Data transfer mode, MOD input

Overview

There are five various data transfer modi for the various communication requirements:

- handshake
- refresh
- select
Communications configuring

- multiple
- image

Selecting the data transfer mode

The data transfer mode is specified at the MOD connection of the appropriate transmitter or receiver.

"Handshake" data transfer mode

The "Handshake" data transfer mode is used,

- if information loss may not occur due to data being overwritten, and
- if there is precisely one receiver for each transmitter.

"Handshake" defines a sequential channel processing. The transmitter first deposits a new data set in the channel after the receiver has acknowledged that it has received the first data set. A net data buffer is provided for data transfer.

The transmitter inputs the net data into the channel in an operating cycle and the receiver reads them out in an operating cycle.

![Diagram of data transfer in the "Handshake" mode](image)

Fig. 3-1 Data transfer in the "Handshake" mode

"Refresh" data transfer mode

The "Refresh" data transfer mode is used,

- if the latest data is always to be made available to a receiver and
- if there is precisely one receiver for each transmitter.

"Refresh" overwrites when it transfers data. The transmitter always deposits the latest data set in the channel without the receiver having acknowledged that it has received the last data set. There are two net data buffers for data transfer, which are used as alternating buffer system. The transmitter flags in which buffer the latest data are located.
"Select" data transfer mode

The "Select" data transfer mode is used,

- if information loss may not occur due to data being overwritten, and
- if there can be as many transmitters as required for one receiver

"Select" defines a sequential channel processing. If the receiver acknowledges that it has received the last data set, then the transmitter deposits a new data set in the channel. A net data buffer is provided for data transfer. A channel administrator controls the data transfer.

All of the configured transmitters use the same net data buffer. There is no defined sending sequence for the transmitter. The first one sends first. In order to achieve controlled data transfer, a "1" may only be specified at one transmitter at the EN connection.

The transmitter must be configured in a shorter sampling time than the receiver.
"Multiple" data transfer mode

The "Multiple" data transfer mode is used,

- if receivers are to always be provided with the latest data, and
- if as many receivers as required are available for each transmitter.

"Multiple" overwrites data when transferring data. The transmitter always deposits the latest data set in the channel without the receiver first acknowledging that it has received the last data set.

If a transmitter overwrites a buffer, from which a receiver is presently reading, then the receiver rejects the data which were last received. Receive is repeated in the next operating cycle.

There are two net data buffers for data transfer, which are used as alternating buffer system. The transmitter flags in which buffer the latest data are located.

The receivers must be configured in the same or shorter sampling time than the transmitter (the receivers must therefore operate faster).

Fig. 3-4   Data transfer in the "Multiple" mode

KVL = channel  
NDP = net data buffer
"Image" data transfer mode

The "Image" data transfer mode is used for the FM 458-1 DP to communicate via the PROFIBUS DP interface,

- if all of the receivers, which are configured in a task, should be provided with data that come from the same DP cycle,
- if all transmitters, which are configured in the same task, wish to send their data to the DP slaves in the same DP cycle.

To do this, transmitter and receiver FBs synchronize themselves within a task in order to supply consistent data. They form a so-called "consistency group". All receiver FBs, associated with such a consistency group, fetch their net (useful) data from a common alternating buffer and all of the transmitter FBs deposit their data in such a buffer.

"Image" is an overwriting data exchange (refer to refresh). There are two net (useful) data buffers which are used for data exchange. They are used as alternating buffer system.

This data transfer mode is only permitted for the PROFIBUS DP interface of the FM458-1 DP application module.

![Diagram](image)

**Fig. 3-5 Data transfer in the "Image" mode**

3.1.3.4 Firmware status, ECL, ECO connection

**General**

Central coupling blocks, which communicate with a firmware (e. g. @PRODP) have outputs ECL and ECO.

**Function**

The outputs ECL and ECO indicate the status of the appropriate firmware:

- ECL=0 and ECO=0:
  The firmware is in an error-free condition.
- ECL=0 and ECO>0: The firmware has an error condition, which can be rectified by the configuring engineer or user. The error cause is described in the Chapters associated with the individual couplings.

- ECL>0 and ECO>0: An irreparable firmware error is present.

### 3.1.3.5 Status display, output YTS

#### General
The block outputs an error code or the instantaneous data transfer status at its output YTS.

#### Displayed error
- Real (severe) run-time errors
- Configuring errors, which are identified when the system is initialized, and which are displayed at the 7-segment display of the CPU using a flashing "C".
- Temporary status displays and alarms

#### Fault diagnostics
The value at output YTS can be read as decimal number using CFC.

**Additional information**
regarding the significance of the decimal number, refer to the online help "Help on events".

### 3.1.4 Mode of operation of the couplings

#### General
A coupling functions as follows:

- CPUs transfer data with a coupling module via the backplane bus.
- For serial couplings (e.g. for TCP/IP) the firmware on the coupling module "re-structures" and "packages" the data, so that they correspond to the required telegram structure and protocol.
- If the communications partner is also a SIMATIC TDC (subrack coupling, buffer memory coupling), then the data are not conditioned.
Communications configuring

As the data interfaces are located on external coupling modules and not locally on a CPU, they can be used by all CPUs in a subrack. However to use a data interface, the CPU and the coupling module must have the same bus connection.

**NOTE**
For the local CPU coupling, the data interface is located on the CPU RAM. This data interface cannot be accessed by any of the other subrack CPUs. It can only be used by that CPU on which it was configured.

**Basic initialization**
A coupling module is always initialized (basic initialization) at system run-up.

The first CPU into the subrack executes the following tasks:
- checks as to whether the coupling module can be "addressed"
- formats the data interface

**Configuring the coupling module**
The required coupling module is configured in HWConfig. When initializing a coupling (basic initialization), no explicit configuring steps must be executed.

### 3.1.4.1 Central coupling blocks

The central coupling blocks have the following functions for a coupling:

- **Initialization:**
  - copying the configured initialization information (this is configured at the initialization inputs) at the data interface
  - defines as to whether the data interface is in an error-free condition.

- **Enabling:**
after initializing by the central coupling blocks and the coupling module firmware, the central coupling block enables the coupling for all transmitters and receivers in the same subrack. Data transfer can now start.

for timing reasons, a coupling is always enabled in the RUN condition after several sampling times.

- Monitoring:
  - the central coupling blocks provide information at their outputs about the status of the coupling and, if relevant, the status of the firmware.

**Configuring the central coupling blocks**

When configuring, the following points must be observed:

- Exactly one central coupling block must be configured for each coupling.
- The central coupling blocks can all be configured on a CPU of a subrack or they can be distributed over various CPUs of a subrack.
  - configuring all central coupling blocks on a CPU simplifies, for example, diagnostics.
- Central coupling blocks have no transmit- or receive functionality.
- All central coupling blocks must be configured in a sampling time $32 \text{ ms} \leq TA \leq 256 \text{ ms}$

**Errors**

The central coupling block makes an entry into the communications error field and no longer processes the coupling module, if

- a central coupling block identifies an error when being initialized
- a firmware does not respond or manifests erroneous behavior,
- the central coupling block is running on the incorrect communications module.

### 3.1.4.2 Transmitters and receivers

**General**

Transmitters and receivers are:

- function blocks, which access the data interface of a coupling, either writing and/or reading.
- part of the communications utility which uses the coupling.

Examples of transmitters:

- message output, function block MSI:
  Copies messages from the message buffer into a data interface
- process data transmit block CTV

Examples of the receivers:
As transmitters and receivers don’t differentiate between the individual couplings, at the block inputs of the transmitter and receiver, a coupling type must not be specified. 

- CTS input to specify the coupling module
- address connection AR, AT or US to specify channel names and coupling-specific addresses

Before transmitters and receivers can transfer data, they must first identify- and synchronize with one another:

- Identification is realized via the data configured at the connections CTS and AT, AR or US.
- Synchronization is only possible,
  - if a transmitter identifies its partner as receiver (or vice versa).
  - if the length of the reserved data areas coincide.
  - if the net data structure is compatible.
  - if the data transfer mode is identical (data entry at the MOD input for transmitters/receivers).

If one of these conditions is not fulfilled, then the synchronizing transmitter/receiver logs-off with a communications error.

### 3.1.4.3 Compatible net data structures

#### General
The net data structures include information regarding the structure of the net data to be transferred:

- data regarding the position and data types of the associated net data

The net data of the transmitter and receiver must be structured the same to permit data transfer between the transmitter and receiver.

#### Data types
The following standardized data types are used:

<table>
<thead>
<tr>
<th>Standardized data type</th>
<th>SIMATIC TDC data type</th>
<th>Length in bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer 16</td>
<td>Integer</td>
<td>2</td>
</tr>
<tr>
<td>Integer 32</td>
<td>Double Integer</td>
<td>4</td>
</tr>
<tr>
<td>Unsigned 8</td>
<td>Bool, Byte</td>
<td>1</td>
</tr>
<tr>
<td>Unsigned 16</td>
<td>Word</td>
<td>2</td>
</tr>
<tr>
<td>Unsigned 32</td>
<td>Double Word</td>
<td>4</td>
</tr>
<tr>
<td>Floating Point</td>
<td>Real, SDTIME</td>
<td>4</td>
</tr>
<tr>
<td>Octet-String</td>
<td>-</td>
<td>1</td>
</tr>
<tr>
<td>Time and Date</td>
<td>-</td>
<td>6</td>
</tr>
</tbody>
</table>

*Table 3-11  Standardized data types*
The SIMATIC TDC connection types (e.g. SDTIME) are not used as data types, as the coupling partner does not always have to be a SIMATIC TDC function block.

- **Octet string**
  An octet string is an unstructured data type which does not appear at the block I/O (refer to the Chapter Channel marshalling blocks CCC4 and CDC4).

- **Time and date**
  Data type for the time which does not appear at the block I/O (refer to communications utility, message system).

  **Value range**
  - **1st octet and 2nd octet:**
    Specify the date relative to 1.1.1984.
    Resolution=1 day
    $0 \leq d \leq 65535$ days
  - **3rd octet to 6th octet:**
    Specify the time between 00:00 and 24:00.
    Resolution = 1ms
    $0 \leq x \leq 86400000$ ms
    The first 4 bits are not assigned in the sixth octet

![Time and date](image)

### 3.1.4.4 Number of coupling modules in a subrack

**Overview**
The number of coupling modules (CP50M0, CP51M1, CP5100 and CP52A0) are restricted by two system limits:

- **subrack size**
  The largest subrack in the SIMATIC TDC system has 21 slots. As a subrack must have at least one CPU, theoretically, 20 slots remain.

- **available address space**
  In practice, these limit is seldomly reached. For CP modules have 144 Mbyte address space.

**Assigned address space**
The individual CP modules always occupy a constant address space on the backplane bus.
• **Example**
  CP52A0 always occupies 2 Mbyte on the bus.

<table>
<thead>
<tr>
<th>Module type</th>
<th>Occupied address space</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP52A0</td>
<td>2 Mbyte</td>
</tr>
<tr>
<td>CP5100</td>
<td>4 Mbyte</td>
</tr>
<tr>
<td>CP50M0</td>
<td>2 Mbyte or 10 Mbyte buffer memory</td>
</tr>
<tr>
<td>CP50M1</td>
<td>2 Mbyte or 10 Mbyte buffer memory</td>
</tr>
<tr>
<td>CP51M1</td>
<td>1 Mbyte or 9 Mbyte buffer memory</td>
</tr>
</tbody>
</table>

*Table 3-12  Occupied address space*

### 3.1.4.5 Reorganizing a data interface

**General**

A data interface can be re-formatted without having to interrupt the RUN condition or diminish performance.

**Formatting the data interface**

Several central coupling blocks have a CDV connection (Bool. data type). If there is a positive edge at the CDV input, the central coupling block inhibits the coupling, and after approx. 10 seconds, formats the data interface. The data interface is then enabled again.

During this inhibit time and while the data interface is being re-formatted, all transmitters/receivers go into a wait condition. After enabling, channels log-on (register) and synchronize just the same as when the system runs-up.

This data is ignored for local data interfaces on a CPU.
3.2 Couplings on the subrack

Overview
These couplings include:
- local CPU coupling
- direct CPU-CPU coupling
- communications buffer coupling

3.2.1 Local CPU coupling

General
The local CPU coupling does not require a coupling module. This coupling type can only be used by function blocks, which are located on the same CPU as the data interface. The data interface always lies on that CPU and is 1 Mbyte.

Application
The coupling is mainly used for autonomous tasks (e.g. a closed-loop control) to provide defined interfaces. Thus, when configuring a project, it is simple if a CPU is "overloaded" to shift the complete task to another CPU without involving extensive configuring work. Communications can, for example, then be realized via the data interface in the buffer. Only the data at the CTS connection has to be changed at all communication function blocks.

Initialization and monitoring
The @LOCAL central blocks cyclically initialize and monitor the coupling. Thus, at the start of cyclic operation, the coupling is not enabled for all senders/receivers, but only after a delay of several operating cycles. The @LOCAL central block monitors the coupling after the coupling has been enabled.

Configuring
A @LOCAL central coupling block must be configured to initialize and monitor the coupling.

For the local CPU coupling, only the channel name has to be specified at the AT, AR or US connections of the send/receive blocks. Data for address stages 1 and 2 should not be configured. Transmitters and receivers with the same channel names communicate with one another.
3.2.2 Direct CPU-CPU coupling

**General information**

The data interface for direct CPU-CPU coupling is locally provided on a CPU and has a size of 1 Mbyte.

The data interface must be set-up on the CPU that contains the receive blocks. The reason for this is that the receive blocks cannot access the memories of the other CPUs via the backplane bus. This is only possible from the send blocks.

If the data interface is configured on the send side, this results in a communications error ("C") at the receive block.

---

**Use**

The direct CPU-CPU-coupling is used to exchange process data between various CPUs of a subrack. Contrary to a coupling memory coupling, higher data quantities are effectively transferred. With this type of coupling, one side (sender) accesses the data interface via the backplane bus – while the others (receivers) can access locally, saving time (fast access).

**Initialization and monitoring**

A central block @LOCAL should be configured on the CPU on which a data interface should be set-up. This is to initialize and monitor the coupling.

**Configuring**

The @LOCAL central block initializes and monitors the coupling in cyclic operation. This means that the coupling is not released for all send/receive blocks when cyclic operation starts – but instead with a delay of several operating cycles. After the coupling has been enabled, the @LOCAL central block monitors the coupling.

The direct CPU-CPU coupling can only be used by send/receive blocks that are configured in the same subrack.

For the direct CPU-CPU coupling, the channel name and in addition, an "E" as address stage 1 should be specified at connections AT or AR of the send/receive blocks. This data is optional for the CPU that must access via the backplane bus (sender).

Data for address stage 2 do not have to be configured. Senders and receivers with the same channel names communicate with one another.

Only "Handshake" or "Refresh" are possible as data transfer mode.
3.2.3 Communications buffer coupling

General

The 1 Mbyte data interface for the communications buffer coupling is located on a communications buffer.

The hardware consists of modules CP50M0, CP50M1, CP51M1 or CP53M0.

The communications buffer coupling is used to transfer data between various CPUs of a subrack. Contrary to $ signals, higher quantities of data are transferred more effectively.

A @GLOB central block must be configured on any CPU of the subrack to initialize and monitor the coupling.

The @GLOB central block cyclically initializes and monitors the coupling. Therefore, the coupling is not enabled for all transmit/receive blocks at the start of cyclic operation but only after a delay of several operating cycles. The @GLOB central block monitors the coupling after the coupling has been enabled.

The communications buffer coupling can only be used by send/receive blocks which are configured on the same subrack.

For the communications buffer coupling, only the channel name has to be specified at the AT-, AR- or US connections of the transmit/receive blocks. Address stages 1 and 2 do not have to be configured. Transmitters and receivers with the same channel names communicate with one another.

Fig. 3-9  Communications buffer coupling
3.3 Subrack coupling CP52M0

3.3.1 Applications

Data can be exchanged, across all of the subracks, between all CPU modules in the system via the memory in the Global Data Memory (GDM).

Up to 44 subracks can be coupled synchronously via the central memory. This means that 836 CPU modules can be used when the system is expanded up to its maximum.

The GDM has its own dedicated subrack (known as the GDM subrack in the following). The CP52M0 memory module (slot 1) and an appropriate number of CP52IO interface modules (slots 2-12) are accommodated in the UR5213 subrack with 21 slots.

Each subrack, which is coupled with GDM (these are called coupled subracks in the following text), must have a CP52A0 access module. These subracks are connected in a star configuration to GDM via glass-fiber optical cables.

![Diagram of GDM system with 5 subracks coupled through fiber-optic cables](image)

((in diagram: Rückwandbus = Backplane bus))

*Fig. 3-10 Example of a GDM system with 5 subracks coupled through fiber-optic cables*

**CP52M0 function**

The 2Mbyte central memory of the Global Data Memory system is located on the CP52M0 GDM memory module. This central memory handles all of the data transfer between the processes in the coupled subracks.
Data transfer between the CP52IO GDM interface modules and the CP52M0 is realized via the backplane bus.

**Literature on this subject:**
- GDM hardware documentation

### 3.3.2 Behavior when powering-up and powering-down

- The subracks can be powered-up in any sequence.
- If the GDM subrack is powered-down in operation, then all of the telegram channels are disabled in the coupled subracks. These telegram channels are re-initialized after the GDM subrack has been powered-up again.

**NOTE**
If the GDM subrack is powered-up while the coupled subracks are running, then an increased computational time can be expected when establishing a link for the CPUs communicating via the subrack coupling. For CPUs, which are already heavily utilized, this can result in an 'E' being displayed (error in the task manager).

- All of the coupled subracks can be powered-down and up again while operational. The coupled partners can then no longer receive data from this subrack nor send data to it.
- If a coupled subrack is powered-down and up again, then the communications between the remaining nodes (GDM subrack and a maximum of 43 coupled subracks, each with a CP52A0) are not affected.
- Coupled subracks which are powered-down can be re-configured and then powered-up again. Even if the number of senders and receivers has been changed (e.g. if one sender too little was configured).

**NOTE**
If the data length is changed and a coupling exists, then this results in communication errors in the subrack where the configuring was changed. In this particular case, the GDM subrack must also be reset.

- As soon as the subrack which was powered-down is powered-up again, a new coupling is established between the coupled partner which was powered-up and the GDM subrack. The telegram channels are re-initialized and communications are re-established without having to reset the coupled partner.
3.3.3 **Synchronizing and triggering methods**

The following synchronizing and trigger signals are available on the CP52A0 access module:

1. Basic clock cycle
2. Bus interrupt
3. Clock time

The clock time and basic clock cycle synchronizing signals can be sent, independently of one another only from one CP52A0. They can either be sent or received on a CP52A0. The decision to send or receive (basic clock cycle) or only to send (clock time) is made in HWConfig.

If the clock time and the basic clock cycle are configured for sending on several access modules, the signal is always sent from the CP52A0, which is connected with a CP52I/O, whose fiber-optic cable interface is located to the farthest left in the subrack.

The SYSFAIL* and bus alarm signals can be simultaneously sent and received from every CP52A0.

3.3.4 **Configuring**

**Rules**

1. The complete user application software is made in the coupled subracks.
2. The names of the coupled subracks (UR5213) must be assigned unique names (under the "General" tab of the object properties dialog box).
3. A CP52A0 GDM access module should be configured as communications module for each coupled subrack at any slot in HWConfig.
4. Only one CP52A0 GDM access module may be configured per coupled subrack.
5. A @SRACK central block must be configured for each CP52A0.

3.3.4.1 **Configuring in HWConfig**

The hardware configuration of a subrack is defined in HWConfig. The CP52A0 module is in the SIMATIC TDC module catalog under communication modules.

Under the “Synchronizing” register tab, you can specify whether the basic clock cycle, bus alarm and clock time signals are sent, received or should be de-activated:
The basic clock cycle signal can have the following statuses:

1. Receive signal, or
2. Send signal or
3. Inactive

The following statuses are available for the bus alarm signal:

1. Receive signal, and / or
2. Send signal or
3. Inactive

The following statuses are available for the time signal:

1. Send signal, or
2. Inactive

**NOTE**

The reception of the clock signal is set at block RTCM.

The signals are de-activated, if none of the buttons are selected.

**Default setting**

The signals are switched inactive (not selected) as default setting. The user can specify, for each signal, whether he wishes to send it, receive it or wishes to keep the basic setting, by simply clicking on the button with the mouse.
Communications configuring

Under the "Stop" tab, it is possible to set whether the module should stop the complete rack if the system error signal (SYSFAIL*) is received from other subracks. It can be simultaneously determined whether this signal is to be sent.

**NOTE**

As long as a coupled subrack flashes with "H" (SYSFAIL active), and this rack sends as a result of the SYSFAIL signal configuring, then the other coupled subracks no longer run-up. In this case, the master subrack must be powered-down and the coupled subrack, which caused the SYSFAIL signal, must be reset.

Fig. 3-12  "Stop" tab

### 3.3.4.2 Configuring in CFC

The @SRACK central block must be configured for the CP52A0 module of the coupled subrack.

In this case, the "CTS" connection (CP52A0 module name) must be configured.

Starting from N01 (and then increasing consecutively, without any gaps, with N02 etc.), it is possible to specify at the "Nxx" connections (name, subrack xx), which subrack should be monitored. The block evaluates the connection assignment until the first connection, with an empty string.

The data transfer is configured using send and receive blocks. For the subrack coupling, only the channel name is specified at the AT and AR inputs. Data for address stages 1 and 2 don't have to be configured. Senders and receivers with the same channel names communicate with one another.
3.3.5 Performance data

3.3.5.1 Data transfer rates

The data transfer rate between the individual subracks is very dependent on the configuration.

For a configuration of approx. 20 subracks, each with 4 CPUs, a **60 bytes/ms data transfer rate** can be assumed per CPU when sending and receiving.

3.3.5.2 Cable lengths

The performance of the subrack coupling depends on the length of the fiber-optic cables used. Thus, we recommend that the shortest possible cables are used. Longer cables slow down the memory access and, on one hand increase the computation loading of the CPU, and on the other hand, they reduce the maximum possible data transfer rate.

The maximum cable length for a connection between CP52A0 and CP521O is 200 m.

3.3.5.3 Interface assignment

The last assigned interface for each CP521O provides a somewhat wider time window for the GDM access. This results in, for the same data rate, a lower computational time loading of the CPU550.

**Example**

Seven subracks are connected to the GDM subrack via two CP521O.

Interfaces X1 to X4 are assigned to the first CP521O, and interfaces X1 to X3 to the second.

This means that interfaces **X4** (first CP521O) and **X3** (second CP521O) have a lower CPU computational load on the connected subracks.
3.4 Subrack coupling CP53M0

General

The following couplings can be realized using the CP53M0 module:

A SIMATIC TDC subrack can be connected to a SIMADYN D system with:

- SIMADYN D as master:
  
  At any location, instead of a CS22, a CP53M0 can be connected to the CS12/CS13/CS14. The CP53M0 should be parameterized in the slave mode.
  
- SIMATIC TDC as master:
  
  A CP53M0 is parameterized in the master mode in a SIMATIC TDC subrack. A CS22 or a CP53M0 in the slave mode can be inserted at the two fiber-optic cable interfaces.

In addition to the coupling to SIMADYN D, up to three SIMATIC TDC subracks can be coupled with one another. The CP53M0 is parameterized in the master mode in one of the subracks; the CP53M0 is parameterized in the slave mode in the other two subracks.

In the following text, the subrack in which the CP53M0 module is in the master mode, is designated as the master subrack.

The subrack in which the CP53M0 module is inserted in the slave mode, will be designated as the slave subrack.

The coupling via a CP53M0 in the master mode or slave mode is configured just like a coupling on the CS12 or CS22 on the SIMADYN D side.

Initialization and monitoring

One central block @CS1 (master mode) or @CS2 (slave mode) must be configured on any CPU in each subrack for coupling initialization and coupling monitoring.
Fig. 3-13 Maximum configuration for 8 Slaves with CS14

Fig. 3-14 Point-to-point coupling with CS12
Communications configuring

Fig. 3-15 Configuration for four slaves with CS13

Fig. 3-16 Maximum configuration with CP53M0 as master
3.4.1 Hardware structure

Overview

- Only SIMADYN D subracks with C-bus connection can be coupled on the CP53M0 (e. g. SR24).
- The master subrack, has, depending on the number of slaves to be connected, a CS12, CS13, CS14 or a CP53M0 module. The slave subracks have a CS22 or a CP53M0 module.
- A maximum of 2 slave modules (CS22 or CP53M0 in the slave mode) can be coupled to a CP53M0 in the master mode.
- Several CP53M0 in either the slave mode or master mode can be configured in a SIMATIC TDC subrack. Thus, several different subrack couplings can be configured in a subrack.
- The CP53M0 module of a subrack coupling must all be configured in different subracks.

3.4.2 Scope of supply

Overview

- All of the slave subracks are permanently coupled to the master subrack, as a slave subrack must continuously access the memory in the master subrack.
- The master/slave subracks can be powered-up in any sequence.
- All subracks can be powered-down and up again in continuous operation.
- If a slave subrack is powered-down and up again, then communications between the other nodes is not influenced.
- Slave subracks which are powered-down can be re-configured and powered-up again. The number of transmitters and receivers can also be changed (e. g. if one transmitter too little was configured).
- As soon as the slave partner, which was powered-down, is powered-up again, a new connection is established between the new partner which has been powered-up again and all other partners. This is also valid for slave-slave communications, i. e. if the CS12-, CS13-, CS14 or CP53M0 module (master mode) is only used as data transfer area and not as communications partner. Slave-slave communications are interrupted when the master subrack is powered-down.

NOTE

It is not permissible to remove the fiber-optic cable during operation as this can result in a CPU crash.
3.4.3 Response when "shutting down" a coupling partner

Response of the master subrack

The master subrack is shutdown:

The @CS2 central block can no longer access the master subrack and prepares a restart (in addition, the CDM block output is set to "faulted", refer to @CS2 mask). The system then waits until the master subrack is powered-up. All slave transmit/receive blocks can no longer access the master subrack and start a new channel log-on.

Response of the slave subrack

The slave subrack is shutdown:

The @CS1 central block and the maximum seven additional @CS2 central blocks decrement their particular NCP connection (i.e. the number of active slave subracks is reduced by one). Otherwise, there is no response, and the NCP connections are incremented again after the appropriate slave subrack runs-up again. All of the configured transmit/receive blocks, whose coupling partner is located on the subrack which is shutdown, wait until the subrack has run-up again.

3.4.4 Response when "powering-up" the master subrack

Response

If the master subrack is powered-up again while the slave subracks are operational, it can be assumed, that for a short period of time, increased computation time will be required to establish the connection for CPUs to communicate via the subrack coupling. For already highly utilized CPUs, this can result in an 'E' being displayed at the 7-segment display (error in the task administrator).

3.4.4.1 Acknowledging

The 'E' can be acknowledged in two ways:

Manual acknowledge

When manually acknowledging, after the connection has been established, the 'E' can be acknowledged by depressing the red acknowledge button on the CPU.

Automatic acknowledgement

For automatic acknowledgement, the following must be configured on all CPUs in the slave subrack which communicate via the subrack coupling. Automatic acknowledgement can be implemented in two different ways using this particular configuration:

1. All YEV outputs, of the function blocks communicating via the subrack coupling are monitored using a software which has to be configured. If the value of all YEV outputs is less than 9 (i.e. initialization has been completed), then the input NOT.I is set to '1'. Using the CDM output of the @CS2 central block, it is ensured that the system is only automatically acknowledged if the master subrack has actually been powered-up. Using the time limit (input T at PCL), automatic acknowledgement has to be realized within a certain time. The 'E' on the 7-segment display is now automatically acknowledged using the SYF4 function block.
2. If not all of the YEV outputs can be monitored or should be monitored, input OR.I2 should be set to "1" and input NOT.I should not be connected at all. In this case, the CPU is only acknowledged within the time, set at connection T of the PCL after the master subrack has been powered-up (output of @CS2.CDM).

![Diagram](image)

Fig. 3-17 Automatic acknowledgement of 'E'

### 3.4.5 Restart capability

**Synchronizing transmitters and receivers**

An additional important communications feature for external communication interfaces is the restart frequency of transmitters/receivers. Transmitters/receivers always re-locate their old channel and re-synchronize with them.
Subracks can be powered-up and down again in any sequence. The transmitters/receivers of the subracks, in which the CP53M0 (slave mode) is inserted, synchronize themselves to the previous channels at each restart (new run-up).

If a transmitter/receiver identifies the "right" channel at log-on, then it cannot identify

- if it had previously used this channel before.
- whether this channel is presently being used by another transmitter/receiver (or transmitter or receiver).

### 3.4.6 Configuring

#### Rules

- For a fiber-optic cable subrack coupling, all of the CP53M0 modules (slave mode) must have different names. If names have been assigned twice, then the appropriate central blocks log-off with multiple configuring (FB disable).
- All CP53M0 modules of a subrack must be inserted in different subracks.
- The sampling time range, $32 \text{ ms} \leq T_A \leq 256 \text{ ms}$, valid for central coupling blocks, is also valid for the subrack coupling central blocks @CS1 and @CS2. It should also be observed that the @CS2 central blocks may only be configured, as maximum, in twice the sampling time as the @CS1 central block (in the case of basic clock synchronization also same sampling times are permissible). The actual sampling time (in milliseconds) is decisive and not the cyclic task ($T_1$, $T_2$ etc.)
  - Example: If the @CS1 central block was configured in 100ms, the @CS2 central blocks can be configured in a sampling time up to 200ms (180ms, 150ms, 130ms, 50ms etc. are thus permitted).

#### Data interface

The data interface is located on the dual port RAM of the CP53M0 module (master mode). The available data transfer area is 128 kbytes.

#### Initialization and monitoring

The coupling initialization and monitoring is handled by the @CS1 and @CS2 central blocks in the RUN status. Thus, the coupling is not enabled at the start of cyclic operation for all transmit/receive blocks, but is delayed by several sampling cycles. The coupling is always first enabled in the master subrack and then in the slave subracks.

After the coupling has been enabled, central blocks @CS1 and @CS2 monitor the coupling. In this case, the number of active coupling partners is output at the central block outputs.

#### Names at the AT- and AR inputs

For the subrack coupling, only the channel name has to be specified at the AT- and AR inputs of the transmit/receive blocks. Names should not be configured for address stages 1 and 2. Transmitters and receivers with the same channel names communicate with one another.
3.4.7 Restrictions

Attention should be paid to the following restrictions, if data are exchanged with a SIMADYN D rack configured with STRUC:

- Only the blocks CTV / CRV may be used in configuring SIMATIC TDC. The use of blocks CTV_P / CRV_P (pointer blocks) causes a communications error ('C').

- A data exchange can only take place with data types I2, I4 and Real (NF) in STRUC. All the other data types cause a communications error ('C'). You can use type switching in STRUC in this case, though.

You should also pay attention to the different access times to the module CP53M0 over the backplane for master and slave:

- Master: approx. 1 µs (4 Byte)
- Slave: approx. 8 µs (4 Byte)

The load of the CPUs in the slave rack is proportionately increasing using the same number of data.
3.5 TCP/IP coupling (CP51M1)

Introduction

This application software example is intended to show how a design engineer should proceed when implementing a SIMATIC TDC subrack coupling via TCP/IP or UDP.

The configuration described here includes the basic hardware equipment as well as function blocks and shows how it is used. A conscious decision was made to keep the functional scope of this application software extremely low, so that those reading it can get up to speed quickly on the subject. The functionality and/or the hardware components can be expanded at any time. However, the information in the applicable function block documentation must be observed.

All of the names used in this application software have been randomly selected and are only binding for this configuration example.

The structure of these configuring instructions essentially determines the sequence that the various steps are made with which the complete application software can be generated. However, this should only be considered as a recommendation and does not have to be rigidly maintained.

Application cases

CP51M1 can be used for the following applications:

- Exchanging process data with other CP51M1 / CP5100 and SIMATIC Industrial Ethernet modules (e.g. CP443-1)
- Visualizing process data using WinCC
- Visualizing messages using WinCC
- Exchanging process data with third-party systems (e.g. process computer)
- Central commissioning (start-up) and diagnostics of all CPU modules in the subrack
- Time synchronization to use a unified time within a particular plant or system
- CP50M1 from FW version V1.1 onwards and with D7-SYS from V7.0 onwards supports the routing function.

NOTE

When integrating new modules into an existing TCP/IP network, you should always ask your network administrator about the IP, sub-network and router addresses as well as the port numbers for applications.

Literature on this subject:

- TCP/IP basics
  (e.g. W. Richard Stevens, TCP/IP Illustrated, Volume 1, Addison-Wesley Verlag)

- CP51M1 hardware documentation
### 3.5.1 Comparison between TCP/IP and UDP

#### TCP/IP

The TCP/IP protocol type is connection-oriented. This means that data can only be sent if the coupling partner can also be addressed. As long as there is a connection to the coupling partner, the TCP/IP protocol ensures that the data which is sent also arrives at the coupling partner. If a fault condition develops, the data are, if necessary, transferred several times.

If a connection is only established at one end, **data could be lost** in the TCP/IP stack of the CP51M1 or the coupling partner (e.g. PC) as a result of the protocol.

---

**NOTE**

For important information, data reception must be monitored at the **application level**.

---

#### UDP

The UDP protocol type is not connection-oriented. This means that data is also sent even if the coupling partner is temporarily not addressable. **Data is then lost**. However, received data is correct as a result of the data security mechanisms.

When compared to TCP/IP, UDP can achieve a higher communications speed between the coupling partners. However, this is only possible with a somewhat restricted data transfer security.

#### Channel modes

The following channel modes are possible using the TCP/IP and UDP protocols:

- Handshake
- Refresh
- Multiple
- Select

#### Typical applications

The **Refresh** and **Multiple** channel modes are overwriting modes (i.e. older data can be overwritten by more recent data). Thus, for these two channel modes, **UDP** is especially suitable as data transfer protocol.

The **Handshake** and **Select** channel modes are not overwriting; in this case **TCP/IP** should be recommended as data transfer protocol.

#### Client or server

An overview as to when SIMATIC TDC operates as TCP/IP client or server is provided in the following table:

<table>
<thead>
<tr>
<th>SIMATIC TDC (TCP/IP) process data (CRV/CTV)</th>
<th>Communications partner</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information of IP address and port in address stage 2</td>
<td>Connect $\rightarrow$ \hspace{1cm} \hspace{1cm} \hspace{1cm} \hspace{1cm} $\leftarrow$ accept \hspace{1cm} \hspace{1cm} \hspace{1cm} \hspace{1cm} Send data $\rightarrow$ \hspace{1cm} \hspace{1cm} \hspace{1cm} \hspace{1cm} must be server</td>
</tr>
<tr>
<td>no information in address stage 2</td>
<td>$\leftarrow$ Connect accept $\rightarrow$ \hspace{1cm} \hspace{1cm} \hspace{1cm} \hspace{1cm} $\leftarrow$ Send data \hspace{1cm} \hspace{1cm} \hspace{1cm} \hspace{1cm} must be client</td>
</tr>
</tbody>
</table>
3.5.2 Typical configuration

The following hardware components are required per station as a minimum for a coupling from SIMATIC TDC via TCP/IP:

- UR5213 subrack
- CPU551 CPU module with MC5xx memory module
- CP51M1

NOTE
A maximum of four CP51M1 can be operated in parallel in one subrack.

3.5.3 Configuring steps

Only the configuring steps for one station are shown in the following. All of the other stations can be essentially handled in the same way.

3.5.3.1 Configuring in HWConfig

Parameterizing the CP51M1

The CP51M1 is parameterized via the appropriate tab in the object property dialog box.

To parameterize the Ethernet interface, the following relevant settings must be specified in the sub-tab “Properties of the CP51M1 Ethernet interface”:

- **IP address ("Parameter" tab)**
  IP address of the module in the "dot" notation, in this case: 141.20.135.197

- **Sub-network mask ("Parameter" tab)**
  Sub-network mask to designate the network segment, in this case: 255.255.0.0 for a Class B network

- **IP address of the default router ("Parameter" tab)**,
in this case: "Use no router"

NOTE
It must be ensured that the IP address and sub-network mask are harmonized. For example, for a Class C IP address (193.x.y.z), the Class B sub-network mask 255.255.0.0 is not permissible. Detailed information on how to select the IP address and its value ranges is provided in the online help for CP51M1.

The following diagram shows the settings, specified above under the "Parameter" tab:
3.5.3.2 Configuring with CFC

Only the most important I/O are handled in the following. Deviations, which are obtained when configuring a UDP coupling, are described at the appropriate locations.

**FBs required**

The following function blocks are required for this example:

- **@TCPIP** central block to initialize and monitor the CP51M1 module (this is always required)
- **CRV** receive block (in this case, optional, for the process data coupling)
- **CTV** send block (in this case, optional, for the process data coupling)

### 3.5.3.2.1 Central block @TCPIP

<table>
<thead>
<tr>
<th>Configuring</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>D1800C.X01 (module name and connector of the configured CP51M1)</td>
</tr>
</tbody>
</table>

### 3.5.3.2.2 Receive block CRV

**"AR" connection**

Initialization connection to enter an address. **Address stage 1 and address stage 2 (only when client)** must be specified in addition to the channel name.

The two address stages are separated in the notation by a ".".

**Rules for address stage 1:**

- The first character (letter) defines the required protocol ("T" = TCP/IP, "U" = UDP) (in this case, "T")
- The second character must be a "-".
- The channel port number is defined by the next 5 digits, whereby leading zeros must be specified (in this case: "01024" for port number 1024).
Only ports 1024 to 65535 should be used as port number. This should be harmonized with the system administrator. Port numbers up to and including 1023 are generally reserved for "well known services" and "unix-specific services".

**Rules for address stage 2:**
- The first **12 digits** define the IP address of the remote coupling partner. This is entered in the so-called "dot" notation; however without specifying the separating point. Leading zeros should be specified (in this case: "141020135198" for IP address 141.20.135.198).
- The 13th character must be a ".".
- The port number of the remote coupling partner is defined by the next **5 digits**; leading zeros should be specified (in this case: "01024" for port number 1024).

<table>
<thead>
<tr>
<th>Configuring</th>
<th>Connection</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>D1800C.X01</td>
<td>(module name and connector of the configured CP51M1)</td>
</tr>
<tr>
<td>AR</td>
<td>RXKAN1.T-01024</td>
<td>(address parameter, receive)</td>
</tr>
<tr>
<td>MOD</td>
<td>H</td>
<td>(receive mode)</td>
</tr>
<tr>
<td>EN</td>
<td>1</td>
<td>(enable)</td>
</tr>
</tbody>
</table>

### 3.5.3.2.3 Send block CTV

**"AR" connection**

Initialization I/O for address data. **Address stage 1 and address stage 2 (only when client)** must be specified here, in addition to the channel names.

The two address stages are separated in the notation by a ".".

**Rules for address stage 1:**
- The first character (letter) defines the required protocol ("T" = TCP/IP, "U" = UDP) (in this case, "T").
- The second character must be a ".".
- The channel port number is defined by the next **5 digits**, whereby leading zeros must be specified (in this case: "01024" for port number 1024).

Only ports from 1024 to 65535 should be used as port number. Port numbers up to and including 1023 are generally reserved for "well known services" and "unix-specific services".

**Rules for address stage 2:**
- The first **12 digits** define the IP address of the remote coupling partner. This is entered in the so-called "dot" notation; however without specifying the separating point. Leading zeros should be
specified (in this case: "141020135198" for IP address 141.20.135.198).

- The 13th character must be a ".".
- The port number of the remote coupling partner is defined by the next 5 digits; leading zeros should be specified (in this case: "01024" for port number 1024).

<table>
<thead>
<tr>
<th>Connection</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>D1800C.X01 (module name and connector of the configured CP51M1)</td>
</tr>
<tr>
<td>AR</td>
<td>TXKAN1.T-01024.141020135198-01024 (address parameter, send)</td>
</tr>
<tr>
<td>MOD</td>
<td>H (send mode)</td>
</tr>
<tr>
<td>EN</td>
<td>1 (enable)</td>
</tr>
</tbody>
</table>
3.5.4 Application information

3.5.4.1 Channel number

A maximum of **128 channels** can be set-up on the TCP/IP module using send and receive blocks (e.g. CTV and CRV).

The actual possible number of channels depends on the size and the number of net data and the access mechanism (handshake, refresh). 254 Kbytes of RAM on the CP51M1 are available for the data interface.

**Calculation**

The number of channels can be roughly calculated according to the following formula:

- **per refresh/multiple channel**: 150 bytes + 2 * number of net data bytes (size of the virtual connection)
- **per handshake/select channel**: 150 bytes + 1 * number of net data bytes

3.5.4.2 Telegram length

The telegram length is restricted as follows:

- To 32767 bytes for receiving
- 32767 bytes for sending

3.5.4.3 "Ping" on CP51M1

Communications with the CP51M1 can be checked using a "Ping". The module only responds to a "Ping" if the communications partner is located within the particular network or a default router (within the particular network) can establish the coupling.

3.5.4.4 Performance

The performance of the TCP/IP coupling depends on the configuration used. The following data indicate the performance values for a typical configuration (do not necessarily represent the maximum values).

**Prerequisites**

- For telegram lengths 192 and 1024 bytes, 32 send and 32 receive UDP connections are configured for each CP51M1 (refresh).
- For a telegram length of 4096 bytes, 8 send and 8 receive connections are configured.

**Results**

The number of send/receive tasks per CP51M1 is approx. **1270**.

The maximum data transfer rate is approx. 1 Mbyte/s (telegram length of 1024 bytes); this cannot be increased, in spite of the higher channel lengths.

<table>
<thead>
<tr>
<th>Data transfer rate [kbytes/s]</th>
<th>Tasks/s</th>
<th>Send/receive cycle [ms] / connections</th>
<th>Telegram length [bytes]</th>
</tr>
</thead>
<tbody>
<tr>
<td>302.260</td>
<td>1270</td>
<td>64 / 40</td>
<td>192</td>
</tr>
<tr>
<td>974.556</td>
<td>911</td>
<td>64 / 56</td>
<td>1024</td>
</tr>
<tr>
<td>888.160</td>
<td>208</td>
<td>64 / 16</td>
<td>4096</td>
</tr>
</tbody>
</table>
3.5.5 Communications with WinCC

There are two possibilities of communicating with WinCC:

- Standard coupling (without any supplementary software in WinCC, only process data can be accessed)
- Coupling via TDC PMC TCP channel-DLL (additional channel-DLL for WinCC, access to process data and messages)

3.5.5.1 Standard coupling

When configuring the system on the TDC side, you can proceed as described for MPI in Chapter Fehler! Verweisquelle konnte nicht gefunden werden.. The difference is that on the WinCC side, instead of an MPI connection, an Industrial Ethernet connection must be set-up.

**NOTE**
Connections in the system may only be accessed by appropriately addressing data blocks. It is not permissible to access using flags; in WinCC this would result in an error message!

3.5.5.2 Coupling via TDC PMC channel-DLL

When configuring the system, you should proceed as described in Chapter 3.17.

D7-SYS is also supplied with a project example for the CP5100 ("D7-TDC-WinCC") with the appropriate documentation ("D7-SYS – SIMATIC TDC WinCC coupling") - that must be adapted for the CP51M1 (according to 3.5.8).

3.5.6 Central service

Chapter 3.13 describes how to proceed in order to set-up central service (e.g. CFC Online) via CP51M1.

3.5.7 Clock time synchronization

The subject of clock time synchronization is described in Chapter 3.14.

3.5.8 Changing-over from CP5100 to CP51M1

The following procedure should be carefully observed when configuring using the CP5100 on the new CP51M1 module:

- Delete CP5100 in HWConfig and configure CP51M1 (in so doing ensure that the same data is specified as for CP5100, e.g. IP address).
• In the CFC charts, the name of the CP5100 must be replaced at all CTS connections of CTV/CRV blocks using the module name of the CP51M1 and the connector designator (e.g. D1800C by D1800C.X01). The user is supported in doing this by opening any chart for each CPU and calling Options --> Convert CTS connection. Now, only the two names have to be specified in the dialog box that is displayed (available at CTS connections and new ones to be entered). If the names are correctly entered and can be replaced then the names are replaced in the complete chart container. If an error occurs, then an appropriate error message is output.

• Manual changes are only necessary if UDP telegrams are configured with a length > 2048 bytes. For UDP, the CP51M1 can only transfer 2048 bytes!
3.6 TCP/IP coupling (CP5100)

Introduction
This application software example is intended to show how a design engineer should proceed when implementing a SIMATIC TDC subrack coupling via TCP/IP or UDP.

The configuration described here includes the basic hardware equipment as well as function blocks and shows how it is used. A conscious decision was made to keep the functional scope of this application software extremely low, so that those reading it can get up to speed quickly on the subject. The functionality and/or the hardware components can be expanded at any time. However, the information in the applicable function block documentation must be observed.

All of the names used in this application software have been randomly selected and are only binding for this configuration example.

The structure of these configuring instructions essentially determines the sequence that the various steps are made with which the complete application software can be generated. However, this should only be considered as a recommendation and does not have to be rigidly maintained.

Application cases
CP5100 can be used for the following applications:
- Exchanging process data with other CP5100 and SIMATIC Industrial Ethernet modules (e.g. CP443-1)
- Visualizing process data using WinCC
- Visualizing messages using WinCC
- Exchanging process data with third-party systems (e.g. process computer)

NOTE
When integrating new modules into an existing TCP/IP network, you should always ask your network administrator about the IP, subnet and router addresses as well as the port numbers for applications.

Literature on this subject:
- TCP/IP basics (e.g. W. Richard Stevens, TCP/IP Illustrated, Volume 1, Addison-Wesley Verlag)
- CP5100 hardware documentation
3.6.1 Comparison between TCP/IP and UDP

TCP/IP
The TCP/IP protocol type is connection-oriented. This means that data can only be sent if the coupling partner can also be addressed. As long as there is a connection to the coupling partner, the TCP/IP protocol ensures that the data which is sent also arrives at the coupling partner. If a fault condition develops, the data are, if necessary, transferred several times.

If a connection is only established at one end, data could be lost in the TCP/IP stack of the CP5100 or the coupling partner (e.g. PC) as a result of the protocol.

NOTE
For important information, data reception must be monitored at the application level.

UDP
The UDP protocol type is not connection-oriented. This means that data is also sent even if the coupling partner is temporarily not addressable. Data is then lost. However, received data is correct as a result of the data security mechanisms.

When compared to TCP/IP, UDP can achieve a higher communications speed between the coupling partners. However, this is only possible with a somewhat restricted data transfer security.

Channel modes
The following channel modes are possible using the TCP/IP and UDP protocols:
- Handshake
- Refresh
- Multiple
- Select

Typical applications
The Refresh and Multiple channel modes are overwriting modes (i.e. older data can be overwritten by more recent data). Thus, for these two channel modes, UDP is especially suitable as data transfer protocol.

The Handshake and Select channel modes are not overwriting; in this case TCP/IP should be recommended as data transfer protocol.
An overview as to when SIMATIC TDC operates as TCP/IP client or server is provided in the following table:

<table>
<thead>
<tr>
<th>SIMATIC TDC (TCP/IP) process data</th>
<th>Communications partner</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function block CTV (client)</td>
<td>Connect ➔ accept</td>
</tr>
<tr>
<td></td>
<td>➔ Send data</td>
</tr>
<tr>
<td></td>
<td>Receiver</td>
</tr>
<tr>
<td>Function block CRV (server)</td>
<td>➔ Connect accept</td>
</tr>
<tr>
<td></td>
<td>➔ Send data</td>
</tr>
<tr>
<td></td>
<td>Sender</td>
</tr>
</tbody>
</table>

### 3.6.2 Typical configuration

The following hardware components are required per station as a minimum for a coupling from SIMATIC TDC via TCP/IP:

- **UR5213** subrack
- **CPU550** CPU module with **MC5xx** memory module
- **CP5100** communications module (here at slot 18)

**NOTE**

CP5100 may only be configured at **slots 18 to 21**. This means that a maximum of four CP5100 modules can be operated in parallel in a subrack.

Depending on the selected slot, BCD coding switches S1 to S3 (refer to Fig. 3-19 for their location on the module) must be set on the module according to the table below. The combination “C-8-0” is obtained for the typical configuration.

<table>
<thead>
<tr>
<th>Slot</th>
<th>S1</th>
<th>S2</th>
<th>S3</th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>C</td>
<td>8</td>
<td>0</td>
</tr>
<tr>
<td>19</td>
<td>C</td>
<td>8</td>
<td>4</td>
</tr>
<tr>
<td>20</td>
<td>C</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>21</td>
<td>C</td>
<td>8</td>
<td>C</td>
</tr>
</tbody>
</table>

(Fig. below: Coding switches to adapt to the slot in the subrack)
3.6.3 Configuring steps

Only the configuring steps for one station are shown in the following. All of the other stations can be essentially handled in the same way.

3.6.3.1 Configuring in HWConfig

Parameterizing the CP5100

The CP5100 is parameterized via the appropriate tab in the object property dialog box.

To parameterize the Ethernet interface, the following relevant settings must be specified in the sub-tab “Properties of the CP5100 Ethernet interface”:

- **IP address ("Parameter" tab)**
  IP address of the module in the "dot" notation, in this case: 141.20.135.197

- **Sub-network mask ("Parameter" tab)**
  Sub-network mask to designate the network segment, in this case: 255.255.0.0 for a Class B network

- **IP address of the default router ("Parameter" tab)**,
  in this case: "Use no router"

**NOTE**

It must be ensured that the IP address and sub-network mask are harmonized. For example, for a Class C IP address (193.x.y.z), the Class B sub-network mask 255.255.0.0 is not permissible. Detailed information on how to select the IP address and its value ranges is provided in the online help for CP5100.
The following diagram shows the settings, specified above under the "Parameter" tab:

![Diagram of CP5100 network settings]

**Fig. 3-20: CP5100 network settings**

### 3.6.3.2 Configuring with CFC

Only the most important I/O are handled in the following. Deviations, which are obtained when configuring a UDP coupling, are described at the appropriate locations.

#### FBs required

The following function blocks are required for this example:

- **@TCP/IP** central block to initialize and monitor the CP5100 module (this is always required)
- **CRV** receive block (in this case, optional, for the process data coupling)
- **CTV** send block (in this case, optional, for the process data coupling)

#### 3.6.3.2.1 Central block @TCP/IP

<table>
<thead>
<tr>
<th>Connection</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>D1800C (module name of the configured CP5100)</td>
</tr>
</tbody>
</table>

![CFC chart]

**Fig. 3-21: Connection assignment of the @TCP/IP**

#### 3.6.3.2.2 Receive block CRV

**"AR" connection**

Initialization connection to enter an address. **Address stage 1** must be specified in addition to the channel name.
Communications configuring

**Rules for address stage 1:**

- The first character (letter) defines the required protocol ("T" = TCP/IP, "U" = UDP) (in this case, "T").
- The second character must be a "-".
- The channel port number is defined by the next 5 digits, whereby leading zeros must be specified (in this case: "01024" for port number 1024).

Only ports 1024 to 65535 should be used as port number. This should be harmonized with the system administrator. Port numbers up to and including 1023 are generally reserved for "well known services" and "unix-specific services".

<table>
<thead>
<tr>
<th>Configuring</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>D1800C (module name of the configured CP5100)</td>
</tr>
<tr>
<td>AR</td>
<td>RXKAN1.T-01024 (address parameter, receive)</td>
</tr>
<tr>
<td>MOD</td>
<td>H (receive mode)</td>
</tr>
<tr>
<td>EN</td>
<td>1 (enable)</td>
</tr>
</tbody>
</table>

![Connection assignment of the CRV](image1.png)

Fig. 3-22: Connection assignment of the CRV

### 3.6.3.2.3 Send block CTV

"AR" connection Initialization I/O for address data. **Address stage 1** and **address stage 2** must be specified here, in addition to the channel names.

The two address stages are separated in the notation by a ".".

**Rules for address stage 1:**

- The first character (letter) defines the required protocol ("T" = TCP/IP, "U" = UDP) (in this case, "T").
- The second character must be a "-".
- The channel port number is defined by the next 5 digits, whereby leading zeros must be specified (in this case: "01024" for port number 1024).
Only ports from 1024 to 65535 should be used as port number. Port numbers up to and including 1023 are generally reserved for "well known services" and "unix-specific services".

**Rules for address stage 2:**

- The first **12 digits** define the IP address of the remote coupling partner. This is entered in the so-called "dot" notation; however without specifying the separating point. Leading zeros should be specified (in this case: "141020135198" for IP address 141.20.135.198).
- The 13th character must be a ".".
- The port number of the remote coupling partner is defined by the next **5 digits**; leading zeros should be specified (in this case: "01024" for port number 1024).

<table>
<thead>
<tr>
<th>Configuring</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>D1800C (module name of the configured CP5100)</td>
</tr>
<tr>
<td>AR</td>
<td>TXKAN1.T-01024.141020135198-01024 (address parameter, send)</td>
</tr>
<tr>
<td>MOD</td>
<td>H (send mode)</td>
</tr>
<tr>
<td>EN</td>
<td>1 (enable)</td>
</tr>
</tbody>
</table>

![CFC chart](image)

**Fig. 3-23 Connection assignment of the CTV**

### 3.6.4 Application information

#### 3.6.4.1 Channel number

A maximum of **256 channels** can be set-up on the TCP/IP module using send and receive blocks (e.g. CTV and CRV).

The actual possible number of channels depends on the size and the number of net data and the access mechanism (handshake, refresh). 254 Kbytes of RAM on the CP5100 are available for the data interface.

**Calculation**

The number of channels can be roughly calculated according to the following formula

- **per refresh/multiple channel:** 150 bytes + 2 * number of net data bytes (size of the virtual connection)
- **per handshake/select channel:** 150 bytes + 1 * number of net data bytes
3.6.4.2 Telegram length

The telegram length is restricted as follows:

- To 55759 bytes for receiving
- 65535 bytes for sending

3.6.4.3 "Ping" on CP5100

Communications with the CP5100 can be checked using a "Ping". The module only responds to a "Ping" if the communications partner is located within the particular network or a default router (within the particular network) can establish the coupling.

3.6.4.4 Performance

The performance of the TCP/IP coupling depends on the configuration used. The following data indicate the performance values for a typical configuration.

Prerequisites

- For telegram lengths 200 and 1000 bytes, 32 send and 32 receive UDP connections are configured for each CPU (refresh).
- For a telegram length of 4000 bytes, 8 send and 8 receive connections are configured.

Results

The maximum data transfer rate is approx. 1.2 Mbyte/s (telegram length of 1000 bytes); this cannot be increased, in spite of the higher channel lengths.

<table>
<thead>
<tr>
<th>Data transfer rate [kbytes/s]</th>
<th>Tasks/s</th>
<th>Send/receive cycle [ms] / connections</th>
<th>Telegram length [bytes]</th>
</tr>
</thead>
<tbody>
<tr>
<td>320.000</td>
<td>1600</td>
<td>64 / 40</td>
<td>200</td>
</tr>
<tr>
<td>1142.857</td>
<td>1143</td>
<td>64 / 56</td>
<td>1000</td>
</tr>
<tr>
<td>1000.000</td>
<td>250</td>
<td>64 / 16</td>
<td>4000</td>
</tr>
</tbody>
</table>
3.7 PROFI_BUS DP coupling (CP50M1)

3.7.1 General basics

The CP50M1 has the following characteristics on PROFI_BUS DP:

- **Master / Slave**
  Each of the two interfaces of the CP50M1 can be operated both as master (alone) or with other masters in the multi-master mode) as well as slave on PROFI_BUS DP. This can be independently realized for every interface.

- **Shared input**
  Each slave connected to PROFI_BUS DP is assigned just one master (the parameterizing master) and at first can only communicate with this master. Additional masters can read the slave input data using the "Shared input". The interfaces of the CP50M1 support this functionality as master.

- **Routing**
  CP50M1 from FW version V1.1 onwards and with D7-SYS from V7.0 onwards supports the routing function.

- **SYNC and FREEZE**
  The outputs/inputs of several slaves can be read/written in synchronism using the SYNC and FREEZE utilities. SIMATIC TDC supports these utilities as master.

- **Equidistance**
  Equidistance ia a property of PROFI_BUS DP and guarantees bus cycles that are always precisely the same length.

- **Peer-to-peer data transfer**
  The configured slaves can “directly” exchange data with one another without any configuring in the CP50M1.

- **Data lengths**
  A maximum of 244 bytes can be transferred in each direction and for each slave.

- **Consistency**
  Data within a telegram is always consistent.

---

**NOTE**
A maximum of six CP50M1 can be operated in parallel in one subrack.
3.7.2 Configuring

3.7.2.1 Configuring the DP system on CP50M1

For the CP50M1, the DP system is configured the same way as for SIMATIC with HW Config and the network configuring. This means that it is configured exactly the same as other DP masters (e.g. CPU 315-2DP).

The procedure is precisely described in the manual “Configuring Hardware and Communication Connections STEP 7” in Chapters 3, “Configuring the Distributed I/O (DP)” and 11, “Networking Stations”.

This is the reason that only the special features and issues of the CP50M1 are discussed in the following.

3.7.2.2 Configuring communications in CFC

**Function blocks**
The following function blocks must be configured for a PROFIBUS DP coupling:

- A central coupling block @PRODP
- A maximum of one transmitter- and receiver function block per slave station
- Maximum of one synchronizing function block SYNPRO can be configured
- A maximum of one diagnostics function block DPDIAG and one diagnostics function block per Slave can be configured

**Communications utility**
The following communication utilities are permitted:

- Process data
- Parameter processing of variable-speed drives

**Data transfer mode**
Permitted data transfer mode:

- Refresh for receivers, optionally also multiple

**Central coupling block**
The @PRODP central coupling block initializes and monitors the PROFIBUS DP coupling via connectors X1 und X2 of CP50M1.

**Entries at address connection AT, AR**
Special features when making data entries at address connection AT, AR when using PROFIBUS DP:

Input sequence:
"Channelname.Addressstage1.Addressstage 2"

- Channel name
  - max. 8 characters
Communications configuring

- ASCII characters except "Point" and @
- channel names of all transmit- and receive blocks, which access the interfaces X1 and X2 of the CP50M1 must be different (exception for the "Multiple" data transfer mode).
- the channel name has no special significance for PROFIBUS DP.

- Input "." after the channel name

- **Address stage 1:**
  - the slave PROFIBUS address is specified as address stage 1.
  - the slave PROFIBUS address may only assigned once for each transmit- and receive channel.
  - value range: 0, 3 - 123
  - 0: means that this channel itself is used as slave channel and can be addressed from another master.
  - 3...123: addressing external slaves.

- Enter "." after address stage 1

- **Address stage 2:**
  - Comprises a maximum of 2 characters, whereby the second character is of no significance for the CP50M1.
  - 1st character: Byte order
    - "1": Standard PROFIBUS setting
      The data are transferred in the "Motorola format" (most significant byte before the least significant byte).
    - "0": Exception setting
      The data are transferred in the "Intel format" (least significant byte before the most significant byte). This setting can be used for communication partners whose internal data administration uses the Intel format (e. g. SIMATIC TDC).

Examples for entries at the address connection

- AT- 'Setpoint.25.1'
  - the channel with the name setpoint transmits data to a slave with the PROFIBUS address 25.

- AR- 'RECEIVE.117.0'
  - the channel with the RECEIVE name receives data from a slave with PROFIBUS address 117. As an exception, data are transferred in the Intel format.
3.7.2.3 Configuring as Slave

The procedure when configuring as slave is described in detail in "CP50M1 as PROFIBUS DP Slave" using an example.

3.7.2.4 Shared Input

The procedure when configuring is described in detail in "Direct Data Exchange DX" using an example.

Configuration Notes

Compared with the old CP50M0, it is no longer possible with the CP50M1 to read all the slaves.

With the CP50M1 only those slaves can be read which support the function "Direct Data Exchange". You can see which of the slaves does this from the Hardware Configuration.

If a CP50M0 is being used as parameterization master, it is not possible to parameterize a CP50M1 as reading slave.

3.7.3 Equidistance

Introduction

Equidistance on PROFIBUS DP is configured for the CP50M1 just the same as for a SIMATIC CPU (also refer to the Manual "Configuring Hardware and Communication Connections STEP 7", Chapter 3.12 "Setting Constant Bus Cycle Times for PROFIBUS Subnets").

3.7.4 SYNC/FREEZE commands

General

The SYNC and FREEZE commands synchronize the inputs and outputs of a group of slaves. The SYNPRO function block initiates these commands and supports the consistency checking process.

Consistency

The configuring engineer is responsible in guaranteeing that data is consistent. For the SYNC/FREEZE command, this involves consistency of data via all of the slaves involved. It goes without saying that the consistency of the input or output data of a slave is always guaranteed.

SYNC

After initiating a SYNC command, the DP master (CP50M1) waits for one DP bus circulating time, so that all of the slaves have received the new output values. The DP master then sends a SYNC broadcast telegram to the configured slave group. All slaves of this group then simultaneously update their buffered outputs.

The outputs are only again cyclically updated if the DP master sends the control command UNSYNC (EN=0 at block SYNPRO).

Ensuring data consistency:
When configuring, it must be ensured that during a DP bus circulating time, after a SYNC command has been initiated, that the SIMATIC TDC CPUs do not change the data.
After initiating a FREEZE command, the DP master immediately transmits a FREEZE broadcast telegram to the configured slave group. All of the slaves of this group then simultaneously read their inputs and buffer them. This input data is then available for the SIMATIC TDC CPUs after a DP bus circulating time has expired.

Input data are only again cyclically sent from the DP slave to the DP master if the DP master sends the control command UNFREEZE (EN=0 at block SYNPRO).

Ensuring data consistency:
By suitably configuring, it should be ensured that during a DP bus circulating time, after the FREEZE command has been initiated, that the input data are not evaluated by the DP master.

### 3.7.4.1 Configuring versions of SYNC/FREEZE

**General**
The terminology involved with securing data consistency are explained and various configuring versions of SYNC/FREEZE are illustrated.

**Terminology**
- **Bus circulating time**
  Cycle, in which the DP master (CP50M1) addresses all of the slaves once. In multi-master systems, all of the masters poll their slaves. The bus circulating time is configured using STEP 7 using the baud rate, number and type of the slaves, and is computed by STEP 7.

- **Sampling time**
  This is the cycle in which the SYNPRO function block and the transmit- and receive function blocks (on SIMATIC TDC CPUs) are calculated. The sampling time is configured using CFC.

**NOTE**
Bus circulating time and sampling time are independent of one another.

- **Synccycle**
  Synccycle is a multiple integer of the sampling time. It can be configured at input CNX of function block SYNPRO. 
  (Synccycle=CNX x sampling time).
  A Synccycle always starts with a sampling time. A synchronizing command is always initiated by the SYNPRO function block in the system mode at the start of a sampling time.

**Configuring version 1**
Configuring version 1 corresponds to most of the applications:
- Generating SYNC commands.
- The data consistency over all slaves is guaranteed.
- The Synccycle is at least twice as long as the sampling time (CNX>1).
  - the length of the transmit telegrams (outputs) for each slave may not be greater than 32 bytes.
  - all transmit blocks and the SYNPRO function block must be configured in the same sampling time.
  - the SYNPRO function block must be configured before all of the transmit blocks (sequence of execution).
Communications configuring

- output SOK of function block SYNPRO must be connected with the enable inputs of all transmit blocks (belonging to a slave group).
- the bus circulating time must be shorter than the Syncycle minus 1 x sampling time. When operational, it should be checked as to whether the SOK output goes to “1” once in each Syncycle, otherwise the Syncycle should be increased.

Example:
- Syncycle=3 x sampling time
- Bus circulating time=2 x sampling time
- Assumption: The SYNPRO function block calculates at the center of the sampling time (before all transmit blocks)

| Output SOK | 1 | 0 |
| Sampling time | (1) | (2) | (3) |
| Synczyklus | SYNC_command | SYNC_quit | SYNC_command |
| Bus circulating time | SYNC_command | SYNC_quit | SYNC_command |

Fig. 3-24 Timing diagram, SYNC version 1

When initiating the SYNC command, the transmit blocks are inhibited (SOK=0) for two sampling times (one bus circulating time). The transmit blocks are enabled in the third sampling time after initiating the SYNC command (SOK=1).

Configuring version 2 has the highest SYNC performance:
- Generating SYNC commands.
- The data consistency over all slaves is guaranteed.
- Syncycle=sampling time (CNX=1)
  - the length of the transmit telegrams (outputs) for each slave may not be greater than 32 bytes.
  - all transmit blocks and the SYNPRO function block must be configured in the same sampling time.
  - high baud rate (>1.5 Mbaud). For lower baud rates, the time conditions can hardly be maintained.
  - the bus circulating time may only be a maximum of 50 % of the sampling time.
the bus circulating time must also be so low, that one sampling time expires from the start up to the calculation of the function block SYNPRO. This cannot be guaranteed, but must be checked when the system is operational.

Example:

- Synccycle=sampling time
- Bus circulating time=0.3 x sampling time
- Assumption: The SYNPRO function block calculates at the center of the sampling time (before all transmit blocks)

Normally, the transmit blocks are always enabled (SOK=1). If, due to time fluctuations, the SYNPRO function block is calculated before SYNC has expired (to the right in the diagram), the transmit data are not updated, but the values from the previous sampling time are transferred. The Synccycle and the data consistency are not influenced.

Instructions to achieve good SYNC functionality:

In addition to a low Synccycle, it is also necessary to have the lowest amount of jitter (time-based fluctuations) in the Synccycle. The following measures support this:

- Irregular data transfer along the DP bus should be prevented: Single-master operation; stations must not be temporarily switched-in.

- Alarm tasks should not be configured on the same SIMATIC TDC CPU. Sampling time overruns are not permissible; this would result in a SYNC command failure or a shift by a complete sampling time.

- Configure a high baud rate and short telegram lengths (the time to poll a slave is included in the jitter.).
- Configure the SYNPROM function block and all associated transmit blocks in T1=T0 (basic sampling time). The SYNC command is always initiated with the basic clock cycle interrupt. It is received with more accuracy (timing accuracy) as an interrupt, initiated in the system mode.

**Configuring version 3**

Configuring version 3 is for generally less frequently used applications of FREEZE:

- Generating SYNC and FREEZE or only FREEZE commands.
- The data consistency over all slaves is guaranteed.
- The Syncycle is at least 300 % longer than the sampling time (CNX>1).
  - the length of the transmit- or receive telegram (inputs or outputs) may not exceed 32 bytes per slave.
  - all transmit- and receive blocks and the SYNPROM function blocks must be configured in the same sampling time (on the same CPU).
  - the SYNPROM function block is configured as the last function block in the processing sequence.
  - output SOK of function block SYNPROM should be connected with the enable inputs of all (belonging to the slave group) transmit- and receive blocks.
- The bus circulating time must be less than the Syncycle minus 2 x the sampling time. When the system is operational, it should be checked whether the SOK output goes to “1” once per Syncycle; otherwise the Syncycle should be increased.

Example:

- Syncycle=4 x sampling time
- Bus circulating time=2 x sampling time
- Assumption:
  The SYNPROM function block calculates at the center of the sampling time (after all of the receive- and transmit blocks)

---

**Fig. 3-26 Timing diagram SYNC version 3**
After the SYNC command has been initiated, the transmit- and receive blocks are inhibited for three sampling times (one bus circulating time + one sampling time) (SOK=0). The transmit- and receive blocks are enabled in the fourth sampling time after the SYNC command has been initiated (SOK=1).

### 3.7.5 Commissioning/ diagnostics

#### 3.7.5.1 Diagnostics function block

**General**

Master- or slave-specific diagnostic information can be output from PROFIBUS DP using the DPDIAG, DPSLDG and DIAPRO function blocks.

**Further information**

on the diagnostic data, refer to the User Documentation for the individual slaves.

**Overview, diagnostic data**

- Function block **DPDIAG**: diagnostic overview The system diagnostics provides an overview as to which slave has provided diagnostic data.

- The 4 words are bit-coded.

- Each bit is assigned a slave with its PROFIBUS address corresponding to the following table.

- If the bit for the associated slave is set, then the slave has provided diagnostics data.

<table>
<thead>
<tr>
<th>Output</th>
<th>Bit 16</th>
<th>Bit 15</th>
<th>Bit 14</th>
<th>...</th>
<th>Bit 5</th>
<th>Bit 4</th>
<th>Bit 3</th>
<th>Bit 2</th>
<th>Bit 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>D01</td>
<td>15</td>
<td>14</td>
<td>13</td>
<td>...</td>
<td>4</td>
<td>3</td>
<td>(2)</td>
<td>(1)</td>
<td>(0)</td>
</tr>
<tr>
<td>D02</td>
<td>31</td>
<td>30</td>
<td>29</td>
<td></td>
<td>20</td>
<td>19</td>
<td>18</td>
<td>17</td>
<td>16</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td></td>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D07</td>
<td>111</td>
<td>110</td>
<td>109</td>
<td></td>
<td>100</td>
<td>99</td>
<td>98</td>
<td>97</td>
<td>96</td>
</tr>
<tr>
<td>D08</td>
<td>-</td>
<td>-</td>
<td>(125)</td>
<td>...</td>
<td>116</td>
<td>115</td>
<td>114</td>
<td>113</td>
<td>112</td>
</tr>
</tbody>
</table>

*Table 3-13 Assigning system diagnostics/data transfer list to the slave PROFIBUS address*

- The data transfer list provides an overview of the slaves which were involved with data transfer within a configured time.

- The 4 words (DL1 – DL4) are bit-coded as for the system diagnostics.

- If the bit for the assigned slave is set, then data is being transferred.
Master status:

Outputs information specific to the master:

<table>
<thead>
<tr>
<th>Output</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>MST</td>
<td>Status of the DP master: Stop (40h), Clear (80h), Operate (C0h)</td>
</tr>
<tr>
<td>ID</td>
<td>Ident-Nr.: 815Eh für CP50M1</td>
</tr>
</tbody>
</table>

Table 3-14 Information specific to the master

Function block **DPSLDG**: Slave diagnostics

- Output of slave diagnostics data.
- The SEL data entry corresponds to the slave PROFIBUS address.
- The diagnostics data is dependent on the slave type.
- The first 16-byte slave diagnostic data are output.
- Additional slave diagnostic data can be output with SEL>1000.

**Further information**

on slave-specific diagnostics data, refer to the user documentation for the individual PROFIBUS slaves.

Diagnostics data of slaves

<table>
<thead>
<tr>
<th>Anschluss</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST1</td>
<td>Status 1</td>
<td>Diagnostics according to the standard 6 bytes</td>
</tr>
<tr>
<td>ST2</td>
<td>Status 2</td>
<td></td>
</tr>
<tr>
<td>ST3</td>
<td>Status 3</td>
<td></td>
</tr>
<tr>
<td>MPA</td>
<td>Master PROFIBUS address</td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>Identification number</td>
<td></td>
</tr>
<tr>
<td>D01 – D59</td>
<td>device-related diagnostics (refer to the User Documentation of the particular PROFIBUS slave)</td>
<td></td>
</tr>
</tbody>
</table>

Table 3-15 Overview of the structure of the diagnostics data for Siemens DP slaves
Bits from status 1, 2 and 3

<table>
<thead>
<tr>
<th>Status 1 (ST1)</th>
<th>Bit 8</th>
<th>Bit 7</th>
<th>Bit 6</th>
<th>Bit 5</th>
<th>Bit 4</th>
<th>Bit 3</th>
<th>Bit 2</th>
<th>Bit 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>S: Slave was parameterized from another master</td>
<td>S: Last parameter telegram was erroneous</td>
<td>M: Errorneous slave response</td>
<td>S: Requested function is not supported</td>
<td>S: Diagnostics entry in the specific diagnostics area</td>
<td>S: Config. data don't match</td>
<td>S: Slave still not ready for data transfer</td>
<td>M: Slave cannot be addressed on the bus</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status 2 (ST2)</th>
<th>Bit 8</th>
<th>Bit 7</th>
<th>Bit 6</th>
<th>Bit 5</th>
<th>Bit 4</th>
<th>Bit 3</th>
<th>Bit 2</th>
<th>Bit 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>M: Slave entered as &quot;not active&quot;</td>
<td>(not used)</td>
<td>S: Slave has received a Sync command</td>
<td>S: Slave has received the Freeze command</td>
<td>S: Response monitoring activated</td>
<td>S: 1 (fixed)</td>
<td>S: Diagnostic data must be retrieved</td>
<td>S: Parameterization and configuring required</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status 3 (ST3)</th>
<th>Bit 8</th>
<th>Bit 7</th>
<th>Bit 6</th>
<th>Bit 5</th>
<th>Bit 4</th>
<th>Bit 3</th>
<th>Bit 2</th>
<th>Bit 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>S/M: Not all diagnostics data can be transferred</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

Table 3-16 Significance of the individual bits, status 1, 2 and 3

- M: Master identifies diagnostics data
- S: Slave identifies diagnostics data

Master PROFIBUS address

- PROFIBUS address of the master which had parameterized this slave.

If this slave is not parameterized, then FFh is used.

Identification number (ID)

- This identifies the slave type.

All additional diagnostic data are slave-specific.

Generally (standard DP slave) the diagnostic blocks follow: Device-related, identification-related and channel-related diagnostics. Not all slave-specific diagnostic blocks must be available.

Each block is preceded by a header byte. The diagnostics block is identified by bit 7 and bit 8.
Bit 7, 8 of the header byte | Significance
---|---
Bit 7, 8 = 00 | Device-related diagnostics
Bit 7, 8 = 01 | Identification-related diagnostics
Bit 7, 8 = 10 | Channel-related diagnostics

Table 3-17  Significance of bit 7 and bit 8 of the header byte

Bits 1 to 6 define the following:

- For device- and identification-related diagnostics the length of the diagnostic block including the header byte, value range 2...63.
- For channel-related diagnostics, the identification number, value range 0...63.

Function block DIAPRO (refer to chapter 3.7.1.5)

### 3.7.5.2 Error class (ECL) and error code (ECO)

**Outputs ECL, ECO**  Significance of the outputs ECL, ECO at function block @PRODP:

- **Error class>0:** An error is present. Function block @PRODP issues a communications error (flashing "LED" on the CP50M1 module). For users, these connections have hardly any significance as the corresponding communication errors can be read-out from the diagnostics buffer. When required, you will be asked about the values at these connections if you contact the hotline with critical faults.
3.8 PROFIBUS DP coupling (CP50M0)

Additionally required hardware and software

The following hardware and software are additionally required to configure and run the PROFIBUS DP coupling:

- COM PROFIBUS
  Order No. 6ES5 895-6SE03

- SS52load
  SS52load is included in COM PROFIBUS from V3.1.

- DP-capable PC card to download the COM database via COM PROFIBUS:

Characteristics

SIMATIC TDC has the following characteristics on PROFIBUS DP:

- **Master**
  The CP50M0 communications module can be operated on PROFIBUS both alone (stand alone) and with other masters in multi-master operation.

- **Slave**
  In addition to the master functionality, there is also the slave functionality. Both of these functionalities can be used simultaneously or separately.

- **Shared input**
  Each slave connected to PROFIBUS DP is assigned just one master (the parameterizing master) and at first can only communicate with this master. Additional masters can read the slave input data using the "Shared input". SIMATIC TDC supports this functionality as master and slave.

- **SYNC and FREEZE**
  The outputs/inputs of several slaves can be read/written in synchronism using the SYNC and FREEZE utilities. SIMATIC TDC supports these utilities as master.

- **Data lengths**
  A maximum of 244 bytes can be transferred in each direction and for each slave.

- **Data transfer times**
  For short telegrams (up to 32 byte), only the SIMADYN D sampling time and the DP bus circulating time are included in the data transfer time. For longer telegrams, the software processing times of the SS52 communications module must also be included (max. 5 ms).

- **Consistency**
  Data within a telegram is always consistent.
3.8.1 Configuring with D7-SYS

**Function blocks**
The following function blocks must be configured for a PROFIBUS DP coupling:
- A central coupling block @PRODP
- A maximum of one transmitter- and receiver function block per slave station
- Maximum of one synchronizing function block SYNPRO can be configured
- A maximum of one diagnostics function block DIAL2A can be configured

**Communications utility**
The following communication utilities are permitted:
- Process data
- Parameter processing of variable-speed drives

**Data transfer mode**
Permitted data transfer mode:
- Refresh
- For receivers, optionally also multiple

### 3.8.1.1 Central coupling block

**Baud rate and PROFIBUS address**
The baud rate and PROFIBUS address are specified, on one hand by CFC (function block @PRODP) and on the other hand by COM PROFIBUS. The following must be observed regarding the validity of these two parameters:
• If a COM database has still not been loaded, then
  - the parameters specified by CFC are valid.
  - the CP50M0 communications module waits for a COM database to be downloaded.

• If a COM database is loaded and the baud rate and PROFIBUS address are the same as those configured with the CFC, then
  - the COM database is activated.
  - communications module CP50M0 starts with net data transfer.

• If a COM database is loaded, but the baud rate or PROFIBUS address does not coincide with that configured in CFC, then
  - the parameters specified by CFC are valid.
  - the module waits for download. (the existing COM database can also be activated, by correcting the baud rate and PROFIBUS address at the central block of the COM configuring.)

3.8.1.2 Address connections AT, AR

Entries at address connection AT, AR

Special features when making data entries at address connection AT, AR when using PROFIBUS DP:

Input sequence:
"ChannelName.Addressstage1.Addressstage 2"

• Channel name
  - max. 8 characters
  - ASCII characters except "Point" and @
  - channel names of all transmit- and receive blocks, which access the same SS52 communications module must be different (exception for the "Multiple" data transfer mode).
  - the channel name has no special significance for PROFIBUS DP.

• Input "." after the channel name

• Address stage 1:
  - the slave PROFIBUS address is specified as address stage 1.
  - the slave PROFIBUS address may only assigned once for each transmit- and receive channel.
  - value range: 0, 3 - 123
  - 0: means that this channel itself is used as slave channel and can be addressed from another master.
  - 3..123: addressing external slaves.

• Enter "." after address stage 1
• Address stage 2:
  - consists of a maximum of 2 characters.
  - 1st character: Byte order
    "1": Standard PROFINET setting
    The data are transferred in the "Motorola format" (most significant byte before the least significant byte).

    "0": Exception setting
    The data are transferred in the "Intel format" (least significant byte before the most significant byte). This setting can be used for communication partners whose internal data administration uses the Intel format (e.g. SIMATIC TDC).

  - 2nd character: Optional, only receiver
    "R":
    The access is realized as second master which reads data. "R" can only be entered for receive channels. ("Shared input")

If a 2nd character is not specified, then the slave can be accessed as parameterizing master.

Examples for entries at the address connection

• AT- 'Setpoint.25.1'
  - the channel with the name setpoint transmits data to a slave with the PROFIBUS address 25.

• AR- 'RECEIVE.117.0'
  - the channel with the RECEIVE name receives data from a slave with PROFIBUS address 117. As an exception, data are transferred in the Intel format.

• AR- 'Input.33.1R'
  - the channel with the name input receives data from a slave with PROFIBUS address 33 as (second) master which reads data.

• AT- 'Slavelst.0.1'
  - the channel with the name slavelst transmits data as slave to a DP master.

3.8.1.3 SYNC/FREEZE commands

General
The SYNC and FREEZE commands synchronize the inputs and outputs of a group of slaves. The SYNPROM function block initiates these commands and supports the consistency checking process.

Consistency
The configuring engineer is responsible in guaranteeing that data is consistent. For the SYNC/FREEZE command, this involves consistency of data via all of the slaves involved. It goes without saying that the consistency of the input or output data of a slave is always guaranteed.
After initiating a SYNC command, the DP master (CP50M0) waits for one DP bus circulating time, so that all of the slaves have received the new output values. The DP master then sends a SYNC broadcast telegram to the configured slave group. All slaves of this group then simultaneously update their buffered outputs.

### FREEZE

Ensuring data consistency:
When configuring, it must be ensured that during a DP bus circulating time, after a SYNC command has been initiated, that the SIMATIC TDC CPUs do not change the data.

After initiating a FREEZE command, the DP master immediately transmits a FREEZE broadcast telegram to the configured slave group. All of the slaves of this group then simultaneously read their inputs and buffer them. This input data is then available for the SIMATIC TDC CPUs after a DP bus circulating time has expired.

Ensuring data consistency:
By suitably configuring, it should be ensured that during a DP bus circulating time, after the FREEZE command has been initiated, that the input data are not evaluated by the DP master.

### 3.8.1.4 Configuring versions of SYNC/FREEZE

#### General
The terminology involved with securing data consistency are explained and various configuring versions of SYNC/FREEZE are illustrated.

#### Terminology
- **Bus circulating time**
  Cycle, in which the DP master (CP50M0) addresses all of the slaves once. In multi-master systems, all of the masters poll their slaves. The bus circulating time is configured using COM PROFIBUS using the baud rate, number and type of the slaves, and is computed by COM PROFIBUS. It can be read-out there using the menu command **Bus parameters**, as "Typical data cycle time".

- **Sampling time**
  This is the cycle in which the SYNPRO function block and the transmit- and receive function blocks (on SIMATIC TDC CPUs) are calculated. The sampling time is configured using CFC.

#### NOTE
Bus circulating time and sampling time are independent of one another.

- **Synccycle**
  Synccycle is a multiple integer of the sampling time. It can be configured at input CNX of function block SYNPRO.
  (Synccycle=CNX x sampling time).
  A Synccycle always starts with a sampling time. A synchronizing command is always initiated by the SYNPRO function block in the system mode at the start of a sampling time.

#### Configuring version 1
Configuring version 1 corresponds to most of the applications:
- Generating SYNC commands.
- The data consistency over all slaves is guaranteed.
- The Synccycle is at least twice as long as the sampling time (CNX>1).
Communications configuring

- the length of the transmit telegrams (outputs) for each slave may not be greater than 32 bytes.
- all transmit blocks and the SYNPRO function block must be configured in the same sampling time.
- the SYNPRO function block must be configured before all of the transmit blocks (sequence of execution).
- output SOK of function block SYNPRO must be connected with the enable inputs of all transmit blocks (belonging to a slave group).
- the bus circulating time must be shorter than the Syncycle minus 1 x sampling time. When operational, it should be checked as to whether the SOK output goes to “1” once in each Syncycle, otherwise the Syncycle should be increased.

Example:
- Syncycle=3 x sampling time
- Bus circulating time=2 x sampling time
- Assumption: The SYNPRO function block calculates at the center of the sampling time (before all transmit blocks)

When initiating the SYNC command, the transmit blocks are inhibited (SOK=0) for two sampling times (one bus circulating time). The transmit blocks are enabled in the third sampling time after initiating the SYNC command (SOK=1).

Configuring version 2 has the highest SYNC performance:
- Generating SYNC commands.
- The data consistency over all slaves is guaranteed.
- Syncycle=sampling time (CNX=1)
  - the length of the transmit telegrams (outputs) for each slave may not be greater than 32 bytes.
Communications configuring

- all transmit blocks and the SYNPRO function block must be configured in the same sampling time.
- high baud rate (>1.5 Mbaud). For lower baud rates, the time conditions can hardly be maintained.
- the bus circulating time may only be a maximum of 50% of the sampling time.
- the bus circulating time must also be so low, that one sampling time expires from the start up to the calculation of the function block SYNPRO. This cannot be guaranteed, but must be checked when the system is operational.

Example:
- Synccycle=sampling time
- Bus circulating time=0.3 x sampling time
- Assumption: The SYNPRO function block calculates at the center of the sampling time (before all transmit blocks)

![Timing diagram, SYNC version 2](image_url)

Normally, the transmit blocks are always enabled (SOK=1). If, due to time fluctuations, the SYNPRO function block is calculated before SYNC has expired (to the right in the diagram), the transmit data are not updated, but the values from the previous sampling time are transferred. The Synccycle and the data consistency are not influenced.

**Instructions to achieve good SYNC functionality:**

In addition to a low Synccycle, it is also necessary to have the lowest amount of jitter (time-based fluctuations) in the Synccycle. The following measures support this:

- Irregular data transfer along the DP bus should be prevented: Single-master operation; stations must not be temporarily switched-in.
- Alarm tasks should not be configured on the same SIMATIC TDC CPU. Sampling time overruns are not permissible; this would result in a SYNC command failure or a shift by a complete sampling time.
Communications configuring

- Configure a high baud rate and short telegram lengths (the time to poll a slave is included in the jitter).

- Configure the SYNPRO function block and all associated transmit blocks in T1=T0 (basic sampling time). The SYNC command is always initiated with the basic clock cycle interrupt. It is received with more accuracy (timing accuracy) as an interrupt, initiated in the system mode.

Configuring version 3

Configuring version 1 (3) is for generally less frequently used applications of FREEZE:

- Generating SYNC and FREEZE or only FREEZE commands.

- The data consistency over all slaves is guaranteed.

- The Syncycle is at least 300 % longer than the sampling time (CNX>1).
  - the length of the transmit- or receive telegram (inputs or outputs) may not exceed 32 bytes per slave.
  - all transmit- and receive blocks and the SYNPRO function blocks must be configured in the same sampling time (on the same CPU).
  - the SYNPRO function block is configured as the last function block in the processing sequence.
  - output SOK of function block SYNPRO should be connected with the enable inputs of all (belonging to the slave group) transmit- and receive blocks.

- The bus circulating time must be less than the Syncycle minus 2 x the sampling time. When the system is operational, it should be checked whether the SOK output goes to “1” once per Syncycle; otherwise the Syncycle should be increased.

Example:

- Syncycle=4 x sampling time
- Bus circulating time=2 x sampling time
- Assumption:
  The SYNPRO function block calculates at the center of the sampling time (after all of the receive- and transmit blocks)
After the SYNC command has been initiated, the transmit- and receive blocks are inhibited for three sampling times (one bus circulating time + one sampling time) (SOK=0). The transmit- and receive blocks are enabled in the fourth sampling time after the SYNC command has been initiated (SOK=1).

### 3.8.1.5 Diagnostics function block

**General**

Master- or slave-specific diagnostic information can be output from PROFIBUS DP using the DIAPRO function block.

The diagnostic data to be output are selected using input SEL. It is output at D01 to D08.

**Further information**

on the diagnostic data, refer to the User Documentation "COM PROFIBUS" or in the User Documentation for the individual slaves.

**Overview, diagnostic data**

SEL=0: No diagnostic data

- The block does not output any valid diagnostic data.

SEL=126: System diagnostics

- The system diagnostics provides an overview as to which slave has provided diagnostic data.
- The 8 words are bit-coded.
- Each bit is assigned a slave with its PROFIBUS address corresponding to the following table.
- If the bit for the associated slave is set, then the slave has provided diagnostics data.
SEL=127: Data transfer list

- The data transfer list provides an overview of the slaves which were involved with data transfer within a configured time (COM PROFIBUS).
- The 8 words are bit-coded as for the system diagnostics.
- If the bit for the assigned slave is set, then data is being transferred.

SEL=128: Master status

Outputs information specific to the master (for users, the low byte of D01 is relevant; the significance of the other outputs has been documented, but hasn't been explained in any more detail):

<table>
<thead>
<tr>
<th>Output</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>D01 low byte</td>
<td>Status of the DP master: Stop (40h), Clear (80h), Operate (C0h)</td>
</tr>
<tr>
<td>D01 high byte</td>
<td>Ident No. SS52 (high byte)=80h</td>
</tr>
<tr>
<td>D02 low</td>
<td>Ident No. SS52 (low byte)=37h</td>
</tr>
<tr>
<td>D02 high</td>
<td>(irrelevant)</td>
</tr>
</tbody>
</table>

SEL=3 ... 123: Slave diagnostics

- Output of slave diagnostics data.
- The SEL data entry corresponds to the slave PROFIBUS address.
- The diagnostics data is dependent on the slave type.
- The first 16-byte slave diagnostic data are output.
- Additional slave diagnostic data can be output with SEL>1000.

Further information

on slave-specific diagnostics data, refer to the user documentation "COM PROFIBUS" and the User Documentation for the individual PROFIBUS slaves.
### Diagnostics data of SIEMENS DP slaves

<table>
<thead>
<tr>
<th>Connection</th>
<th>Slave type</th>
<th>EP 200U</th>
<th>ET 200B</th>
<th>ET 200K</th>
<th>SPM slave</th>
<th>ET 200C 8DE/8DA</th>
<th>DP stand. slaves</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SPC slaves, general</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D01 low</td>
<td>Status 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>high</td>
<td>Status 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D02 low</td>
<td>Status 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>high</td>
<td>Master PROFIBUS address</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D03 low</td>
<td>Identification number, high byte</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>high</td>
<td>Identification number, low byte</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D04 low</td>
<td>Header, device-related diagnostics</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>high</td>
<td>Device diagnostics U</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D05 low</td>
<td>Header identification-related diagnostics</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>high</td>
<td>BG 7-0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Channel 7-0</td>
<td></td>
</tr>
<tr>
<td>D06 low</td>
<td>BG 15-8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Channel 15-8</td>
<td></td>
</tr>
<tr>
<td>high</td>
<td>BG 23-16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Channel 23-16</td>
<td></td>
</tr>
<tr>
<td>D07 low</td>
<td>BG 31-24</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Channel 31-24</td>
<td></td>
</tr>
<tr>
<td>high</td>
<td>Additional device-specific diagnostics</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Irrelevant</td>
<td></td>
</tr>
<tr>
<td>D08 low</td>
<td>Specific</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Irrelevant</td>
<td></td>
</tr>
<tr>
<td>high</td>
<td>Specific</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Irrelevant</td>
<td></td>
</tr>
</tbody>
</table>

Table 3-20  Overview of the structure of the diagnostics data for Siemens DP slaves
Bits, status 1, 2 and 3

<table>
<thead>
<tr>
<th>Bit 8</th>
<th>Bit 7</th>
<th>Bit 6</th>
<th>Bit 5</th>
<th>Bit 4</th>
<th>Bit 3</th>
<th>Bit 2</th>
<th>Bit 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Status 1</strong> (D01 low byte)</td>
<td>S: Slave was parameterized from another master</td>
<td>S: Last parameter telegram was erroneous</td>
<td>M: Erroneous slave response</td>
<td>S: Requested function is not supported</td>
<td>S: Diagnostics entry in the specific diagnostics area</td>
<td>S: Config. data don't match</td>
<td>S: Slave still not ready for data transfer</td>
</tr>
<tr>
<td><strong>Status 2</strong> (D01 high byte)</td>
<td>M: Slave entered as &quot;not active&quot;</td>
<td>(not used)</td>
<td>S: Slave has received a Sync command</td>
<td>S: Slave has received the Freeze command</td>
<td>S: Response monitoring activated</td>
<td>S: 1 (fixed)</td>
<td>S: Diagnostic data must be retrieved</td>
</tr>
<tr>
<td><strong>Status 3</strong> (D02 low byte)</td>
<td>S/M: Not all diagnostics data can be transferred</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 3-21 Significance of the individual bits, status 1, 2 and 3

- **M**: Master identifies diagnostics data
- **S**: Slave identifies diagnostics data

**Master PROFIBUS address**

- PROFIBUS address of the master which had parameterized this slave.

If this slave is not parameterized, then FFh is used.

**Identification number**

- High/low byte:
  - This identifies the slave type.

All additional diagnostic data are slave-specific.

Generally (standard DP slave) the diagnostic blocks follow: Device-related, identification-related and channel-related diagnostics. Not all slave-specific diagnostic blocks must be available.

Each block is preceded by a header byte. The diagnostics block is identified by bit 7 and bit 8:
<table>
<thead>
<tr>
<th>Bit 7, 8 of the header byte</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit 7, 8= 00</td>
<td>Device-related diagnostics</td>
</tr>
<tr>
<td>Bit 7, 8= 01</td>
<td>Identification-related diagnostics</td>
</tr>
<tr>
<td>Bit 7, 8= 10</td>
<td>Channel-related diagnostics</td>
</tr>
</tbody>
</table>

**Table 3-22** Significance of bit 7 and bit 8 of the header byte

Bits 1 to 6 define the following:

- For device- and identification-related diagnostics the length of the diagnostic block including the header byte, value range 2...63.
- For channel-related diagnostics, the identification number, value range 0...63.

### Output of additional slave diagnostics data

- Diagnostic bytes 17 to 32 of a slave are output with SEL=1002 to SEL=1123.

#### 3.8.2 Configuring with COM PROFIBUS

**General**

COM PROFIBUS (Windows) should be used when configuring (it is also possible to use the earlier COM ET200 Version 2.1 for configuring). Using COM PROFIBUS you can define:

- The number and configuration of the nodes connected to the PROFIBUS DP bus system
- The baud rate
- Important parameters when using the PROFIBUS DP bus system

**SIMATIC TDC -specific information on COM PROFIBUS:**

- Configure the CP50M0 communications module as SIMADYN D SS52 station type ("SIMADYN" family).
- The input and output addresses should not be specified.
- After completing the configuring, the database is downloaded into CP50M0 via the DP bus using the menu command **File > Export > DP master.**
- Alternatively, it is also possible to download via RS232. The following menu command is used to start loading the SS52: **File > Export > SIMADYN Master.**

#### 3.8.2.1 Harmonizing with data configured in CFC

**Rules**

The configured software should be harmonized with one another as follows:

- The baud rate and the actual PROFIBUS address must be the same.
There is configured in COM must each have, in the receive- and transmit directions, a CRV/CTV function block configured in the CFC. This is assigned via the PROFIBUS address (address stage 1 at the address connection).

- The length of the input- (receive-) and output- (transmit-) data per slave must coincide.

Error- and alarm information

The rules (syntax) are checked. Error- or alarm information is issued if these rules (syntax) are not observed:

- Communications error field (flashing "C" on the CPU module), or output YTS at function block CRV/CTV
- Output ECO at function block @PRODP

NOTE

The following rules (syntax) are not checked:
The net data structure of the communication partners must be the same.

If this is not observed, the data could be incorrectly interpreted (e.g. bytes could be interchanged within a data word) between the communication partners.

Net data structure

For SIMATIC TDC, the net data structure with CFC is specified by configuring the virtual connections (refer to the Chapter Communications utility, process data).

- For most of the PROFIBUS slaves, the net data structure is specified using COM PROFIBUS by entering identification codes in the "Configuring" window.

3.8.2.2 CP50M0 as PROFIBUS slave

Configuring

The CP50M0 communications module can be configured as pure slave or combined as master and slave:

- CP50M0 as pure slave does not require COM to be configured: Input SLA should be set to 1 or 2 at function block @PRODP. A function block CRV and/or CTV should then be configured next to it. The address stage 1 at connection AR/AT should be set to "0".

- CP50M0 combined as master and slave
  Input SLA at function block @PRODP should be set to "0" (default value).
  - The bus is configured using COM PROFIBUS. A database ("master system") is created for each PROFIBUS master. This is used to download the particular master.
  - If the master is configured using another tool, when configuring the CP50M0 slave, a fictitious master must be configured in COM PROFIBUS. It should be ensured that the bus parameters are correctly set: It is recommended to increase the number of active stations and the token rotation time in both configuring tools.
There are two ways to load the database:

**Loading via PROFIBUS DP**
- Loading via PROFIBUS DP is the version which is the more user friendly.
  However, certain restrictions must be observed.
- A DP-capable PC card (currently available cards can be requested from the support facility product)
- The driver for the PC card is installed together with COM PROFIBUS. Loading is realized in COM PROFIBUS using the menu command **File > Export > DP master**.

**Loading via RS232**
- Using the "SS52LOAD" program, a database, generated from the COM PROFIBUS is loaded as binary file into the CP50M0 module via the RS232 interface.
- SS52LOAD is integrated in COM PROFIBUS (from Version 3.1).
- Restriction: If the Sync function block SYNPRO is configured, then the synchronous mode must be disabled (enable input EN=0), so that the download functions.
- The binary file (*.2bf) is generated in COM PROFIBUS using the menu command **File > Export > Binary file**.
- Loading is realized with SS52LOAD with the menu command **File > Download**.
- The RS232 interface is located together with the PROFIBUS interface on the 9-pin connector to the corresponding CP50M0-interface. The customer must assemble his own cable to establish the connection to the COM port of the PC. RS232 assignment at socket (no standard):
  - 2 - TxD
  - 7 - RxD

---

**CAUTION**

There is a danger of interchanging connections for the RS232 assignment.
3.8.3 Start-up/diagnostics

3.8.3.1 LEDs

Yellow LED
Contrary to the other communication modules, for the CP50M0 communications module, the yellow LED does not directly indicate the bus activity. The yellow LED provides information about the DP bus and the COM database.

Green LED
The green LED provides general information about the CP50M0 communications module and about synchronization with function block @PRODP from SIMATIC TDC.

<table>
<thead>
<tr>
<th>LED</th>
<th>Green</th>
<th>Yellow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dark</td>
<td>CPU not running</td>
<td>No bus operation (during run-up).</td>
</tr>
<tr>
<td>Flashes quickly (every 0.2 s)</td>
<td>Fatal error</td>
<td>Bus error (e. g. short circuit)</td>
</tr>
<tr>
<td></td>
<td>• Remedy: Read-out the error class and code at function block @PRODP and inform Siemens AG.</td>
<td>• Remedy: Check the cable and the other bus nodes.</td>
</tr>
<tr>
<td>Flashes (every 1 s)</td>
<td>Wait and synchronize to the SIMATIC TDC-CPU</td>
<td>COM database not available or not activated (also during download)</td>
</tr>
<tr>
<td></td>
<td>• Remedy: Check the configuring of function block @PRODP.</td>
<td>• Remedy: Load the database.</td>
</tr>
<tr>
<td>Flashes slowly (every 2 s)</td>
<td>-</td>
<td>CFC- and COM configuring do not match 100%. Only restricted bus operation is possible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Remedy: Adapt the CFC- and COM configuring so that they match.</td>
</tr>
<tr>
<td>Steady</td>
<td>Communications module CP50M0 and synchronization to SIMATIC TDC CPUs OK.</td>
<td>Bus operation with activated COM database OK.</td>
</tr>
</tbody>
</table>

Table 3-23 Significance of the LEDs of the CP50M0 communication module

Behavior at run-up
• After power-on, both diodes are briefly lit and then go dark again.
• Only the green LED is lit during the run-up time (approx. 5 seconds).
• When the system is OK, the yellow LED is lit after the run-up time has expired.
• After a reset, both LEDs initially stay in the last condition until the software again controls the LEDs.

Characteristics at download
• During download, the yellow LED flashes (this is extremely short at high baud rates).
• After this, the behavior is the same as for run-up.

The LEDs do not provide information as to whether all of the slaves are available at the bus and have been correctly parameterized. If data transfer with a slave is not OK, then this is flagged at the associated function block (YEV=0x0002 or YTS=0x6014) using a "break" ID.
Information regarding the current status of individual slaves is obtained using the diagnostics function block DIAPRO.

### 3.8.3.2 Error class (ECL) and error code (ECO)

#### Outputs ECL, ECO

Significance of the outputs ECL, ECO at function block @PRODP:

- **Error class=0**: An alarm is present. In some cases this alarm can be removed without a SIMATIC TDC reset. If there are several alarms, then the alarm of the lowest number is displayed.

- **Error class>0**: An error is present. Function block @PRODP issues a communications error (flashing "C" on the CPU module). After the error has been removed, the SIMATIC TDC subrack must be reset.

<table>
<thead>
<tr>
<th>Error class</th>
<th>Error code</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (alarm)</td>
<td>0</td>
<td>O.K.</td>
</tr>
<tr>
<td>1</td>
<td>COM database present, but not activated as the baud rate and the PROFIBUS address with connections BDR and MAA do not match.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remedy: Harmonize the baud rate and PROFIBUS address in the CFC and COM configuring.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>No COM database available.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remedy: Load the database.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>The COM database is presently being downloaded with subsequent start-up.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>The channels to DP nodes, configured with CFC, which are configured in the COM database, are missing. This status can also temporarily occur after a SIMATIC TDC run-up. The DP nodes are not addressed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remedy: Harmonize the CFC- and COM configuring.</td>
<td></td>
</tr>
<tr>
<td>5 (not used)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>There is at least one channel configured with CFC which does not match the COM database. The associated SIMATIC TDC-FB has issued a communications error (flashing &quot;C&quot;).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remedy: Harmonize the CFC- and COM configuring.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>There is at least one channel configured with CFC, which essentially does not match the COM database. The associated SIMATIC TDC-FB has issued a communications error (flashing &quot;C&quot;).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Correct the CFC configuring.</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Resource bottleneck. Not all of the CFC channels are processed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remedy: Reduce the CFC configuring (communication channels).</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>There are two channels, which wish to transmit data to the same slave or receive data from it. The SIMATIC TDC-FB which is associated with the channel which addressed the slave later, has issued a communications error (flashing &quot;C&quot;).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remedy: Correct the CFC configuring.</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Bus operation temporarily faulted.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Remedy: Check the cable and bus nodes.</td>
<td></td>
</tr>
<tr>
<td>&gt;1 (internal error)</td>
<td>(any)</td>
<td>- Remedy: Note the error class and error code and inform Siemens AG.</td>
</tr>
</tbody>
</table>

Table 3-24 Significance of the error class and error code
3.8.3.3 Application example, PROFIBUS DP coupling

General
The application example describes a typical configuration consisting of:

- SIMOVERT 6SE70
- ET200U
- ET200B
- SIMATIC S5

It is assumed that you are knowledgeable about configuring SIMATIC TDC as well as the CFC configuring language.

NOTE
Only those activities are described in detail which are of significance for this particular configuration. Versions or additional components are touched-on but not discussed in detail. In the text, these positions are identified with the symbol located on the right.

The following subjects are discussed in this application example:

- **Typical configuration**
  Description of a typical configuration for SIMATIC TDC connected to PROFIBUS DP with the associated system requirements.

- **Configuring under CFC**
  Grouping of the PROFIBUS DP specific blocks and their configuring in the typical configuration.

- **Configuring the CP50M0... communications module**
  Configuring the CP50M0 communication module using the COM PROFIBUS 3.0 parameterizing software and the download tool "SSS2load".
3.8.3.4 Typical configuration and system requirements

General

The following systems and devices are selected as typical configuration, whereby the specified PROFIBUS addresses were randomly defined:

Communications partner

The SIMATIC TDC communication partners (station 4) are as follows:

- **SIMATIC S5-105U (station 1) as master to SIMATIC TDC:**
  The CP50M0 as a master (S5) which poll the SIMATIC TDC. Data transfer (quantity and amount of process data) between the two controls can be freely configured. The following was defined:
  - S5 \(\rightarrow\) SIMATIC TDC: Three words (input/output), one word (input), one byte (input)
  - SIMATIC TDC \(\rightarrow\) S5: Three words (input/output), one word (output)

- **SIMOVERT MASTER DRIVE with CB1 (station 71) as slave:**
  Five defined PPO types are available for data transfer with this node.
  PPO: Parameter process data object structure of the net data for variable-speed drives. There is net data, which either consists of parameter ID values (PKW) and process data (PZD) (PPO types 1,2,5) or only process data (PPO types 3,4).
  In this configuring example, PPO type 3 is configured. In this case, two words (control word and main setpoint) are transmitted and two words (status word and main actual value) received.
• ET 200 B (station 51) as slave:
  When using this slave type, a precise type must be selected which then automatically defines data transfer. For 8DI/8DO types, one byte is output and one byte is read-in.

• ET 200 U (station 11) as slave:
  For this ET 200 U configuration (three digital output modules and a digital input module) three bytes are output and one byte is read-in.

3.8.3.5 Check list of the required hardware and software components for SIMATIC TDC

Fig. 3-32 Hardware and software components for SIMATIC TDC
### 3.8.3.6 Configuring under STEP 7 CFC

**General**

In order to simplify unified configuring of a "PROFIBUS DP coupling" under CFC, the bus-specific CFC blocks are now grouped together and the relevant syntax explained.

When configuring an CP50M0 communications interface under CFC, the following should be observed:

- Precisely one central block @PRODP must be used for each CP50M0 communications interface
- A maximum of one transmitter- and/or one receiver block per communications partner
Communications configuring

- Permitted communication utilities:
  - process data
  - parameter processing of variable-speed drives

- Permitted data transfer mode: Refresh (for receivers, also multiple)

- A maximum of one synchronization function block SYNPRO per CP50M0 communications interface

- A maximum of one diagnostics function block DIAPRO per CP50M0 communication module

**Function blocks**

Central block PROFIBUS DP coupling @PRODP

<table>
<thead>
<tr>
<th>@PRODP</th>
<th>Error class</th>
<th>Error code</th>
<th>Coupling status</th>
<th>Block status</th>
</tr>
</thead>
<tbody>
<tr>
<td>GV</td>
<td>CTS</td>
<td>ECL</td>
<td>BO</td>
<td>Block status</td>
</tr>
<tr>
<td>MAA</td>
<td>BDR</td>
<td>CDM</td>
<td>QTS</td>
<td>Block status</td>
</tr>
<tr>
<td>SLA</td>
<td>LCC</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Use**

This function block initializes and monitors the PROFIBUS DP coupling (CP50M0). It may only be configured in a sampling time of $32 \text{ ms} \leq TA \leq 255 \text{ ms}$.

**I/O**

ECL, ECO, CDM, QTS and YTS are service- and diagnostics I/O which are generally used for SIMATIC TDC start-up (commissioning). They are not used for configuring.

**Further information**

on the I/O of the central block PROFIBUS DP coupling @PRODP, refer to the User Documentation "SIMATIC TDC, function block library".
The configured name of the CP50M0 module (identical with the entry in the master program, actual: D04) and the designation of the interface (X01 or X02, actual: X02) is specified at this initialization input.

The configured name of the CP50M0 module (identical with the entry in the master program, actual: D04) and the designation of the interface (X01 or X02, actual: X02) is specified at this initialization input.

MAA: Just like all of the other bus nodes, the CP50M0 interface has a station address. This must be specified at this connector (a number between 1 and 123, actual: 4).

BDR: The baud rate, which the CP50M0 interface uses on the bus, is set using this connector. This value must be specified in a code:

- 0=9.6 kbaud
- 1=19.2 kbaud
- 2=93.75 kbaud
- 3=187.5 kbaud
- 4=500 kbaud
- 5=1.5 Mbaud
- 6=3 Mbaud
- 7=6 Mbaud
- 8=12 Mbaud

(actual: 5).

SLA: Initialization input, only for slave functionality:

- 0: CP50M0 operates as PROFIBUS master and/or slave. A COM PROFIBUS database must be loaded.
- 1 or 2: SS52 operates as pure PROFIBUS slave without COM PROFIBUS database
  - 1: Slave with either inputs or outputs,
  - 2: Slave with inputs and outputs

(actual: 0)

LCC: Initialization input for the time in which the CP50M0 monitors the SIMATIC TDC host CPU:

- <0: No monitoring
- >10: Monitoring time in 1/10 s

(actual: 0)

<table>
<thead>
<tr>
<th>Table 3-26</th>
<th>I/O of the central PROFIBUS DP coupling block</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CTS</strong></td>
<td>The configured name of the CP50M0 module (identical with the entry in the master program, actual: D04) and the designation of the interface (X01 or X02, actual: X02) is specified at this initialization input.</td>
</tr>
<tr>
<td><strong>MAA</strong></td>
<td>Just like all of the other bus nodes, the CP50M0 interface has a station address. This must be specified at this connector (a number between 1 and 123, actual: 4).</td>
</tr>
<tr>
<td><strong>BDR</strong></td>
<td>The baud rate, which the CP50M0 interface uses on the bus, is set using this connector. This value must be specified in a code: 0=9.6 kbaud ; 1=19.2 kbaud ; 2=93.75 kbaud ; 3=187.5 kbaud ; 4=500 kbaud ; 5=1.5 Mbaud ; 6=3 Mbaud ; 7=6 Mbaud ; 8=12 Mbaud ; (actual: 5).</td>
</tr>
<tr>
<td><strong>SLA</strong></td>
<td>Initialization input, only for slave functionality: 0: CP50M0 operates as PROFIBUS master and/or slave. A COM PROFIBUS database must be loaded. 1 or 2: SS52 operates as pure PROFIBUS slave without COM PROFIBUS database 1: Slave with either inputs or outputs, 2: Slave with inputs and outputs (actual: 0)</td>
</tr>
<tr>
<td><strong>LCC</strong></td>
<td>Initialization input for the time in which the CP50M0 monitors the SIMATIC TDC host CPU: &lt;0: No monitoring 0...10: Monitoring time=1s (default) &gt;10: Monitoring time in 1/10 s (actual: 0)</td>
</tr>
</tbody>
</table>

3.8.3.7 Using transmit- and receive blocks

General: The function blocks of the communications utility, process data must be configured for PROFIBUS DP.

The address connections AT and AR of those blocks, which access the CP50M0 data interface, must have the following syntax (rules):

**AT/AR- 'ChannelName.Addressstage1.Addressstage2'**

Channel name:
- Must be unique, corresponding to the general communication rules (the channel names of all transmit- and receive blocks, which access the same CP50M0 communications interface, must be different)
- It may consist of a maximum of 8 characters
- It has no special significance for PROFIBUS DP

Address stage 1
- The PROFIBUS address of the communication partner is specified in this address stage.
- Using address 0, this channel goes to the slave and is called-up by other bus masters.
- External slaves can be addressed using addresses 3..123.
• A PROFIBUS address may only be used once for each transmit/receive channel.

**Address stage 2**
This address stage is configured with one or two characters:

• **1st character:** Defines the byte order to transfer word quantities for various communication partners.
  - **1**=Motorola format (high byte before the low byte)
    Thus, it corresponds to the telegram structure of the PROFIBUS standard, and should be used as standard, especially when transferring single word quantities to standard bus nodes (analog I/O, SIMOVERT, SIMATIC etc.)
  - **0**=Intel format (low byte before the high byte)
    Can be used for data transfer to devices where data is processed according to the Intel format just like in SIMATIC TDC (e.g. second CP50M0)

<table>
<thead>
<tr>
<th>Coupling partner</th>
<th>1st character</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMOVERT Master Drives with CB 1 (standardized bus nodes)</td>
<td>1</td>
</tr>
<tr>
<td>ET200 distributed periphery (standardized bus nodes)</td>
<td>1</td>
</tr>
<tr>
<td>SIMATIC (IM 308 C,...) (standardized bus nodes)</td>
<td>1</td>
</tr>
<tr>
<td>SIMOREG 6RA24</td>
<td>1</td>
</tr>
<tr>
<td>MICRO / MIDI Master (standardized bus nodes)</td>
<td>1</td>
</tr>
<tr>
<td>SIMATIC TDC (CP50M0) (the coupling partner must also have the same setting)</td>
<td>0</td>
</tr>
</tbody>
</table>

*Table 3-27  Byte order for various communication partners*

• **2nd character** (optional, only for receivers):
  When an "R" is entered at a receive channel, the CP50M0 is authorized to read other slaves (shared input).

### 3.8.3.8 Configuring the typical configuration in CFC

**General**
In this case, it does not just involve process data processing, but mainly in implementing the listed communication paths to the other bus nodes.

A CFC chart with explanations shows how to configure the PROFIBUS DP. The CFC chart does not purport to include all details.

The following are to be configured:

• CPU CPU550 in slot S01 under the name D01P01:
• Communications module CP50M0 at slot S02, designation D02
• Communication interface 1 on CP50M0 connector X01
Communications configuring

Configured name of CP50M0 module: D02 and connector: X01

Own PROFIBUS address: 4
Baud rate: 5 (1.5 Mbaud)

Virtual connection name, transmit
"IT_MOTO"

Virtual connection name, receive
"IR_MOTO"

Transmit channel name: T_Moto
Slave address: 71

Receive channel name: R_Moto
Slave address: 71

Fig. 3-34  CFC chart (Part 1) of the typical configuration
Communications configuring

Status word:
1st word from the receive telegram
(virtual connection name R_MOTO)

Control word:
1st word for the transmit telegram
(virtual connection name T_MOTO)

Main actual value:
2nd word from the receive telegram
(R_MOTO)

Main setpoint:
2nd word for the transmit telegram
(T_MOTO)

Fig. 3-35 CFC chart (Part 2) of the typical configuration
3.8.3.9 Configuring the SS52 communications module with COM PROFIBUS

General

If a communication interface was configured of the CP50M0 (currently: X01, then values are transferred between the transmit- or receive blocks and the bus connector on the CP50M0 communications module. As SIMATIC TDC is a freely-configurable system, the following logical communication structures must be assigned:

- Bus parameters defined (baud rate, ...)
- The communication associations between the nodes defined (who communicates with whom, and in which function?)
- The communication objects must be defined (communication objects are useful (net) data. For SIMATIC TDC they consist of the process- and device data. However, for the typical configuration, communications only involves the process data.)

This data (in the following, designated as COM database) is saved on the CP50M0 in a permanently integrated memory and are changed and adapted by downloading via the 9-pin sub-D connector of the module.

3.8.3.10 Generating the COM database with COM PROFIBUS

Procedure

Master and slaves of a bus structure are configured using a graphic user interface and a list of communication partners which are supported.

At the start, all communication associations of the typical configuration are defined by selecting the nodes involved.

Parameterizing the 1st host system

1. After the program start, the first master system is set-up using the menu command File > New.

2. After buffering the data (File > Save under...) using any name (current: "Typical" ), a first host system is generated with the name "Mastersystem <1>". The code number (current: 1) is identical with the selected PROFIBUS address. This first step defines who has the “say” on this host system.
3. After selecting the button "ET200" in the "Slaves" menu, the mouse pointer points to an empty box with an arrow upwards.

This allows slaves to be assigned to the S5 station, by positioning the mouse pointer under the station symbol and then clicking on the mouse.

4. After interrogating the PROFIBUS address (current: 4) the communications partner can be selected in an additional selection window.
5. The majority of the setting possibilities in the "Slave characteristics" window are of now significance for the typical configuration. The standard settings can be used. Only the family (current: SIMADYN), the station type (current: "SS52 master/slave") and the "Configuring..." button are important.

![Fig. 3-39 Dialog box, "Slave characteristics"]

6. However before configuring starts, the specified settings must be acknowledged with OK in a dialog box "Master-host selection".

![Fig. 3-40 Dialog box, "Master-host selection"]

7. The bus node is now actually configured. For the CP50M0 communications module, this configuration window is at first completely empty. The net data structures must now be entered in the list in the dialog box "Configuring: SIMADYN D slave ...".

**NOTE**

S5 is the master in this "Master system <1>" so that the transmit- and receive mode must be considered from its perspective (I/O addresses of the S5).
8. All of the data types are entered in the "ID" column. In this case, the associated dialog box must be activated. You can achieve this by either double clicking on a cell, or after highlighting the cell, depressing the "ID" button.

The following parameters can now be specified:

- **Type**
  Select between:
  - input, output
  - input/output
  - empty location
  - special format

- **Length**
  1 to 16

- **Format**
  Select either single-word- or byte format
9. After terminating the dialog with OK, the appropriate ID is entered in the list. The sequence of the process data in the telegram is defined by the position at which the ID is entered in the input or output address ranges (fields with a grey background are not taken into account). Entries into the comments column are optional and can be freely configured. The address settings ("I-Adr." and "O-Adr.") are not required for the SIMATIC TDC/SIMADYN D database. Thus, the first host system has been generated in which the SIMATIC TDC is slave to the S5. Parameterization has now been completed. It should be observed, that this involves the configuring data for the IM308 (S5); therefore these no longer have to be processed, as they are not relevant for the CP50M0.

Parameterization of the 2nd host systems

1. The first host system is closed by double clicking on "Master 4" and the second host system is made accessible so that the CP50M0 master can be parameterized.

2. By double clicking on the symbol "SIMADYN D" it can be seen how important it is to first set-up the SS52 as slave in the "Host system <1>". The complete telegram structure is automatically transferred into
the CP50M0 configuration with the difference that the telegrams lie interchanged in the address ranges: The output of S5 becomes the input for SIMATIC TDC and vice-versa.

The data identification (by configuring...) now has a grey background and, for this communication, can no longer be changed from the present host system (identification and comment belong to the S5). The data are acknowledged with "OK". Thus, communications to the S5 have been set-up.

3. The master functions of CP50M0 can be configured. To realize this, you must return to the DP master system window, PROFIBUS address 4. After the slave menu has been re-activated (the mouse pointer changes), ET 200 U, ET 200 B and SIMOVERT Master Drive are coupled one after the other. Each time a component is called-up, you are prompted for the PROFIBUS address. The "Slave characteristics" window then automatically opens, in which, as already described, the necessary settings can be made using Configuring....

4. As the field devices are pure slaves, depending on the function, type of construction and "Intrinsic intelligence" they can only be parameterized with some restrictions. The individual configurations are as follows:

- **ET 200 U**
  Modular structure with three output modules (each with 8 digital outputs) and one input module (8 digital inputs): Three bytes must be transmitted and one byte must be received.
Communications configuring

ET 200 B
Compact type of construction with eight digital outputs and eight digital inputs: One byte in the transmit telegram and one byte in the receive telegram. The IDs are specified by the module selection.

<table>
<thead>
<tr>
<th>ID</th>
<th>Comments</th>
<th>E addr.</th>
<th>A addr.</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>8DO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>8DI</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fig. 3-47  "Configuring" window

SIMOVERT Master Drive
Slave with intrinsic intelligence: Depending on the drive converter setting, five different telegram structures (PPO types) are permitted. These must be defined when configuring and can no longer be changed. (Fields have a grey background and are therefore inactive)

<table>
<thead>
<tr>
<th>ID</th>
<th>Comments</th>
<th>E addr.</th>
<th>A addr.</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>2AX</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fig. 3-48  "Configuring" window

5. After configuring has been completed, the display should look like this:

Fig. 3-49  Window, "DP master system, PROFIBUS address"
Changing the slave configuration

The configuration of the individual slaves can be subsequently changed and adapted.

1. Select the particular symbol in the display above by clicking on it twice with the mouse. You can return to the configuration dialog boxes via the "Slave characteristics" window.

2. To complete parameterization, the bus parameters must be set as a final step. A dialog window is opened under **Configuring > Bus parameters...** In this window only the bus profile (PROFIBUS-DP) and the baud rate are of importance for this typical configuration. The baud rate must coincide with that specified in the CFC, and in our example is limited by the ET 200 U and the CB1 communications module of the SIMOVERT Master Drive (currently: 1.5 Mbaud).

![Bus parameters dialog box](image)

**Fig. 3-50** Dialog box, "Bus parameters"

3. This completes the configuration of the CP50M0 for this typical configuration, and it can now be saved.

Transferring the configured software into the CP50M0 memory

The next step when setting-up the CP50M0 configuration is to transfer this configured software into the memory of the CP50M0 communication interface. There are two ways to do this:

- Transfer data via a second module interface (RS232) which is located on the same 9-pin sub-D connector as for the RS485.
  - Data transfer via RS232 can be executed using a standard PC interface (COM 1 or COM 2) whereby a special transfer program named "SS52load" downloads data into the CP50M0 memory.
  - This download requires the "2bf" file format. This is why the marked "Host system <2>" must be converted into the correct format via the menu command **File > Export > Binary file...** (the host systems must be separately handled for this operation). The CP50M0 configuration file is thus now located in the root directory of the COM PROFIBUS program in the directory "progdat" for transfer to the module.

- Transfer data via the PROFIBUS interface RS485 (is directly supported by COM PROFIBUS).
  - Transfer via RS485 is not discussed, as a special PC interface card (e.g., CP 5411) is required in this case.
3.8.3.11 Downloading the COM database into the CP50M0

**Hardware required**

The following hardware is required to download the COM database onto the CP50M0:
- RS232 connection between the PC and SS52
  - In addition to the RS485, an additional RS232 interface is also integrated on the 9-pin sub-D connector.
  
**Further information**

Further information on the sub-D connector, refer to the User Documentation "SIMATIC TDC, hardware description".
- A special cable (TxD to RxD) must be assembled as the pin assignment of this connector does not correspond to any specific standard.

![RS232 interface diagram]

3.8.3.12 Working with the "SS52load" download tool

**SS52load**

SS52load is integrated in COM PROFIBUS (from Version 3.1).

The user interface offers the following functions:
- **Option comport**: Defines the COM port to be used
- **File download**: Selects the required file and downloads it

3.8.3.13 Behavior of the CP50M0 during and after the download

**General**

In order to successfully download, the different behavior patterns of SIMATIC TDC and the CP50M0 communication modules should be known before, during and after this operation. General system conditions are output via a green and a yellow LED, which are provided at each of the two CP50M0 interfaces.
These LEDs only provide information as to whether the SIMATIC TDC as self-contained autonomous system is functioning correctly, or if there are faults/errors. Bus activities or communications with other bus nodes are not evaluated.

- When the power is applied, both LEDs briefly light-up (approximately half a second).
- The yellow LED then goes dark, so that only the green LED is lit during the remaining run-up time (approx. five seconds). Downloading is not possible during this time.
- After the run-up phase has been completed, the operating status of the CP50M0 is displayed.
3.9 MPI coupling

3.9.1 Characteristics and hardware

**Characteristics**  
MPI (Multi Point Interface) is the standard communications protocol for SIMATIC S7/M7. Data transfer is realized via a multi-master bus with a maximum of 126 nodes.

For SIMATIC TDC, MPI is used to connect the CFC for start-up and testing configured software, and is also used to communicate with WinCC and SIMATIC OPs.

With the MPI coupling, the communication utilities service (FB-SER) and S7 communications (FB-S7OS) are used.

**Hardware**  
The following hardware is required for the MPI coupling:

- Subrack
- CPU
- CP50M1-/CP5M0 module (corresponding interface in HWKonfig for MPI configuring, at CP50M1 only X01)
- MPI cable (is in the scope of delivery of the PG contain)

3.9.2 Configuring

**HWConfig**  
The CP50M1/CP50M0 communications module and the SS52/MPI communications module must be configured in HWConfig. Its own MPI address must be specified for ES.

**Function block @MPI**  
Precisely one @MPI central coupling block must be configured for each SS52/MPI. The @MPI function block initializes and monitors the MPI coupling.

**Additional information**  
to configure an MPI coupling, refer to:

- Section "Communications Utility Service"
- Section "Communications with SIMATIC Operator Panels"
- Section "Communications with WinCC (MPI)"
### 3.10 Table function

#### 3.10.1 Introduction

The table function in SIMATIC TDC / SIMADYN D provides the user with the possibility of linking-in and using tabular values (values in a table) in a configured software application. In this case, the function blocks TAB and TAB_D must be configured on the SIMATIC TDC and SIMADYN D sides. Tabular values, data type REAL are managed using the TAB and data type DINT, using TAB_D. The user provides the tabular values.

The table function can be configured in three modes:

- **Manual mode**, i.e. the tabular values are directly entered at the block via an online interface (e.g. CFC in the test mode), or transferred to the block using teach-in from the program.

- **Automatic mode: Communications**, i.e. the tabular values are transferred via a communications interface (TCP/IP, DUST1, S7 via P bus). In order to transfer tabular values from an S7 control to a SIMATIC FM 458 application module via the P bus, in addition, the WR_TAB should be configured on the S7 control side.

- **Automatic mode: Memory card**, i.e. the table values are downloaded into the memory card, from where they are read.

**NOTE**

The “Automatic mode, memory card” mode is presently still not available.

It should be noted, that it is only possible to toggle the modes between "Manual mode" and "Automatic mode: Communications" as well as "Manual mode" and "Automatic mode: Memory card".

A validity check is made if the tabular values have been entered or transferred. The address of the table is displayed at "TAB" output.

The tabular values are managed twice, i.e. in two tables. The table, defined as "valid" (=active) is used for all arithmetic/computation operations of the configured application software. The "invalid" (=inactive) table is used to manage value changes. All of the tabular values, changed by the user, are initially transferred into the invalid table. If the inactive table is activated, the new tabular values are mirrored in the second table. The table which had been active up until then automatically becomes invalid. This means that the new tabular values are available in both tables.

Both tables can be saved in the SAVE area which is backed-up (buffered) by a battery in order to prevent data loss (connection SAV=1 when initializing).
NOTE
A precise description of function blocks TAB and TAB_D is provided in their respective online help. 
A detailed description of the WR_TAB function blocks is provided, further below in the Section "Function block WR_TAB".

3.10.1.1 Overview, "Manual mode"

The principle procedure in the "Manual mode" is shown in the following diagram:

![Diagram of Manual mode procedure]

Fig. 3-52: Principle procedure in the "Manual mode"

A detailed description of the "Manual mode" is provided in Section "Manual mode" (Page 3-107).

3.10.1.2 Overview, "Automatic mode: Communications"

In the "Automatic mode: Communications", tabular values can be transferred using the following communication versions:

- S7 via the P bus for SIMATIC FM 458 (it is necessary to additionally configure the WR_TAB on the control side)
- TCP/IP (tabular values can be transferred from a SIMATIC TDC module to another one using the CTV and CRV FBs)
- DUST1 (tabular values can only be transferred via a DUST1 interface)

The tabular values are transferred using data telegrams.

The following diagram illustrates the principle procedure in the "Automatic mode: Communications" for transferring tables from an S7 control to a SIMATIC FM 458 application module via the P bus:
Communications configuring

1. External tables (e.g. Excel, text file)
2. Format the table according to the entries
3. Import tabular values in the DB
4. Specify the DB at FB WR_TAB
5. Specify the user data area used
6. Transfer tabular values. Communications via P bus
7. Tabular values are available in the configured software

Fig. 3-53  Principle procedure for "Automatic mode: Communications" (via P bus)
A detailed description of the "Automatic mode: Communications" mode to transfer tables from an S7 control to a SIMATIC FM 458 application module is provided in the Section "Automatic mode: Communications" (Page 3-109).

### 3.10.1.3 Function block WR_TAB

The function block WR_TAB is used to transfer tables from one S7 control to a SIMATIC FM 458 application module. The tabular values (permissible data types are REAL and double integer) are saved in a data block. They are transferred from WR_TAB to the function blocks TAB and TAB_D on the SIMATIC FM 458 application module, which then internally manages the tabular values.

The WR_TAB should be configured on the control side. The tabular values are transferred from one S7-400 control to a SIMATIC FM 458 application module via the P bus. All of the values are always transferred, which are in the DB specified at the DBNUM input.

#### Symbol

<table>
<thead>
<tr>
<th>WR_TAB</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BO EN TABTEL W</td>
<td>Number of data blocks to transfer the complete DB contents</td>
</tr>
<tr>
<td>BO REQTAB CNTTEL W</td>
<td>Number of data blocks already transferred</td>
</tr>
<tr>
<td>BO REQDB STATUS W</td>
<td>Actual processing status</td>
</tr>
<tr>
<td>BO LASTDB ERROR W</td>
<td>If required fault messages</td>
</tr>
<tr>
<td>W LADDR DONE B</td>
<td>Status parameter DONE: Send operation completed</td>
</tr>
<tr>
<td>BY RECNUM</td>
<td>Data set number for the read and write data set</td>
</tr>
<tr>
<td>W DBNUM</td>
<td>Data block number</td>
</tr>
<tr>
<td>DW TFT</td>
<td>TIMEOUT time for receiving the acknowledge telegram from the FM module</td>
</tr>
</tbody>
</table>
The individual connections (I/O), their data types and a connection description are listed in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REQTAB</td>
<td>INPUT</td>
<td>BOOL</td>
<td>REQTAB = 1: Request to write a new table</td>
</tr>
<tr>
<td>REQDB</td>
<td>INPUT</td>
<td>BOOL</td>
<td>REQDB = 1: Request to write the tabular values which are saved in the data block</td>
</tr>
<tr>
<td>LASTDB</td>
<td>INPUT</td>
<td>BOOL</td>
<td>Last DB for the table</td>
</tr>
<tr>
<td>LADDR</td>
<td>INPUT</td>
<td>WORD</td>
<td>Logical address of the SIMATIC FM 458 application module</td>
</tr>
<tr>
<td>RECNUM</td>
<td>INPUT</td>
<td>BYTE</td>
<td>Data set number for the read and write data set</td>
</tr>
<tr>
<td>DBNUM</td>
<td>INPUT</td>
<td>WORD</td>
<td>Data block number of the DB in which the tabular values are located.</td>
</tr>
<tr>
<td>TFT</td>
<td>INPUT</td>
<td>DWORD</td>
<td>TIMEOUT time in ms for receiving acknowledge telegrams from the SIMATIC FM 458 application module.</td>
</tr>
<tr>
<td>TABTEL</td>
<td>OUTPUT</td>
<td>WORD</td>
<td>Number of data blocks required to transfer the complete DB contents</td>
</tr>
<tr>
<td>CNTTEL</td>
<td>OUTPUT</td>
<td>WORD</td>
<td>Number of data blocks already transferred to the FM module</td>
</tr>
<tr>
<td>STATUS</td>
<td>OUTPUT</td>
<td>WORD</td>
<td>Indicates the current status of the processing / data transfer:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0: Table transfer is inactive</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1: Table transfer is active. Table values have been partially transferred</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(wait for the next partial transfer)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2: Table values have still not been completely transferred from a data block.</td>
</tr>
<tr>
<td>ERROR</td>
<td>OUTPUT</td>
<td>WORD</td>
<td>If a fault/error occurs while processing the function, then the return value is an error code</td>
</tr>
<tr>
<td>DONE</td>
<td>OUTPUT</td>
<td>BOOL</td>
<td>Status parameter DONE=1: Send operation has been completed</td>
</tr>
</tbody>
</table>
The following errors can occur and are displayed at the ERROR output:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Explanation</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xB210</td>
<td>OK</td>
<td>-</td>
</tr>
<tr>
<td>0xB211</td>
<td>Logical module address invalid</td>
<td>Specify a valid module address at input LADDR.</td>
</tr>
<tr>
<td>0xB212</td>
<td>Data set number not valid</td>
<td>Enter the tabular values in an increasing sequence in the DB.</td>
</tr>
<tr>
<td>0xB213</td>
<td>Invalid table data format</td>
<td>Tabular values must have data type REAL for the TAB and data type DINT for the TAB_D.</td>
</tr>
<tr>
<td>0xB214</td>
<td>The data format of the new data set does not match that of the previously transferred data set</td>
<td>Ensure that all of the tabular values have the same data format.</td>
</tr>
<tr>
<td>0xB215</td>
<td>FM 458 does not respond</td>
<td>Check the communications connection and configuring.</td>
</tr>
<tr>
<td>0xB216</td>
<td>Table is too large</td>
<td>Transfer the table in sub-sets, i.e. either distribute tabular values over several DBs or after each partial transfer write new (additional) tabular values into DB and transfer.</td>
</tr>
<tr>
<td>0xB217</td>
<td>Table is not complete (X / Y values)</td>
<td>Complete the table, there must be a Y value for each X value.</td>
</tr>
<tr>
<td>0xB218</td>
<td>REQTAB is reset during processing</td>
<td>Transfer the tabular values again.</td>
</tr>
<tr>
<td>0xB219</td>
<td>REQDB reset during processing</td>
<td>Transfer the tabular values again.</td>
</tr>
<tr>
<td>0xB21A</td>
<td>DB number is not valid</td>
<td>Specify a valid DB number.</td>
</tr>
<tr>
<td>0xB21B</td>
<td>TIMEOUT when receiving the acknowledge telegram</td>
<td>Check the communications coupling and configuring. Transfer the tabular values again.</td>
</tr>
<tr>
<td>0xB21C</td>
<td>Invalid processing status</td>
<td>Check the configuring of the WR_TAB.</td>
</tr>
</tbody>
</table>

Errors associated with the SFC58 or SFC59 are displayed at the ERROR output.

3.10.2 Manual mode

3.10.2.1 Application

The "Manual mode" mode represents the simplest way of inserting tabular values into a configured software package. However, it is comparatively time consuming as data has to be manually entered or taught-in from the program.

**Entering tabular values**

After the TAB or TAB_D has been correctly configured, the tabular values can be entered one after another. To start off with, the table size, i.e. the number of value pairs (=points) should be specified at input NP. If the table is to be saved in the SAVE area, then input SAV of the must be 1.
The tabular values can then be subsequently entered. In this case, to start, the index point i should be specified at input IP of the value pair to be entered. The X and Y value of the point should then be entered at inputs XP and YP. In order to accept the entered value, after entering each value pair, input WR should be set from 0 to 1. Before entering the next point, the index at input IP should be incremented. The values for this point should then be entered. This procedure is repeated until all of the values have been entered.

A specific sequence does not have to be observed when entering the individual points.

The number of entered points must match the data at input NP.

All of the entries during this procedure are transferred into the inactive table of the and are only available after being activated in the configured software. In order to activate the inactive table with the entered values, input TVL should be set to 1.

Additional changes can then be again made in the inactive table and are only available after this has been re-activated again.

**Interrogating the tabular values**

In order to output the entered tabular values, after entering the data at input IP, the index of the point i, to be displayed is specified, and input RD is set from 0 to 1. The tabular values of point i are then displayed at the outputs YXP (X value) and YYP (Y value). The index of point i is output at output YIP.

**3.10.2.2 Configuring**

For the "Manual mode", only the TAB and/or TAB_D have to be configured depending on whether tabular values, data type REAL and/or DINT have to be managed. Each table may only contain values associated with one data type. If several tables having different data types are to be managed, then an TAB or TAB_D must be configured for each table.

The function blocks TAB and TAB_D should be configured in the same sampling time of 32ms. The following connection (I/O) settings are required:

- **AUT** = 0 (automatic mode de-activated)
- **NP** = [specifies the table size]
- **XP** = [enters the X values]
- **YP** = [enters the Y values]
- **IP** = [enters the value pair to be changed]
- **TVL** = 1 (to activate the table after all of the values have been entered)
- **WR** = 1 (to transfer the value pair which was entered in the table)
- **RD** = 1 (to display the value pair, specified under IP, at outputs YXP and YYP)
If, in the "Manual mode" the CTS connection is set to "0" when initializing (CTS=0; AUT=0), then it is no longer possible to changeover into the "Automatic mode: Memory card" (CTS=0; AUT=1). If the CTS connection is set to "0" while initializing, and the "Automatic mode: Memory card" is activated (AUT=1), then it is possible to subsequently changeover to "Manual mode" (CTS=0; AUT=0). The table, saved on the memory card, can then be processed in the "Manual mode".

If, after this, a change is made back to "Automatic mode: Memory card" (CTS=0; AUT=1), this no longer has any effect, because it is only activated during the initialization operation.

If a communications interface is configured at the CTS connection, it is possible to toggle, as required between "Manual mode" and "Automatic mode: Communications".

3.10.3 Automatic mode: Communications

3.10.3.1 Application with an S7 control and SIMATIC FM 458 application module

The following prerequisites must be fulfilled in order to successfully transfer tables:

- The function blocks TAB and/or TAB_D must be configured in the FM 458 application module corresponding to the configuring specifications for "Automatic mode: Communications" (A detailed explanation is provided in Section "Configuring for S7 control and SIMATIC FM 458 application module").

- The X and Y values of a table in a DB must always be present alternating. There must be a Y value for each X value, so that the number of values in a data set is always an integer number.

In order to start data transfer, inputs REQTAB and REQDB at WR_TAB must be set to 1. The tabular values of the DB, specified at input DBNUM at WR_TAB can then be transferred.

The actual number of transferred data blocks is always displayed at the CNTTEL output of the WR_TAB.

The number of data blocks is displayed at the TABTEL output of the WR_TAB, which is required until the complete contents of the DB are transferred to the SIMATIC FM 458 application module.

If the tabular values have been completely entered in the specified DB, or if it involves the last partial transfer of a table (sub-set of a table), which does not "fit" completely into a DB, then before starting the transfer, input LASTDB of the WR_TAB should be set to 1. This means that the SIMATIC FM 458 application module is signaled at the end of the data transfer. The STATUS output of the WR_TAB then changes from 2 to 0.

NOTE
If all of the tabular values, which are located in the DB, specified at the DBNUM input of the WR_TAB, are always transferred.

All of the tabular values, which are located in the DB, specified at the DBNUM input of the WR_TAB, are always transferred.
If the table is too large for a data block, then the tabular values are split-up into individual sub-sets for transfer. The procedure is as follows:

To start, the first table section is written into the DB and is then transferred as described above. The LASTDB input of the WR_TAB remains at 0. The STATUS output of WR_TAB stays at 2 during data transfer and then changes, at the end of the table sub-set transfer (partial transfer) from 2 to 1.

The old tabular values in the DB should then be overwritten with the following tabular values. Once this has been completed, at WR_TAB the REQDB input should be again set from 0 to 1 to activate the next table sub-set transfer.

This procedure should be repeated until all of the tabular values have been transferred.

At the last sub-set transfer, input LASTDB of the WR_TAB should be set from 0 to 1. This signals the SIMATIC FM application module that data transfer has been completed. The STATUS output of the WR_TAB then changes from 2 to 0.

NOTE

If there is adequate user memory available, the table can also be saved in several different DBs. In this particular case, for each table sub-set transfer, only the matching DB number at the input DBNUM of the WR_TAB has to be specified. However, it should be ensured that the DBs are transferred in the correct sequence, so that all of the tabular values are transferred in an increasing sequence.

The time taken to transfer the tabular values depends on the following factors:

- Number of tabular values
- Size of the data blocks
- Sampling time of the TAB and TAB_D
- WR_TAB processing time

In each cycle, a telegram with 56 tabular values is transferred, from the control to the SIMATIC FM 458 application module.

The time taken for a table to be transferred can be calculated as follows:

\[ \text{Duration of the data transfer} = \frac{\text{No. of tabular values}}{56} \times \text{cycle time of the slowest FB (i.e. TAB, TAB_D or WR_TAB)} \]

The time taken for the data to be transferred via the P bus is not relevant for this estimation, as this data transfer time is generally less than 1ms and generally, the function blocks TAB and TAB_D are configured in sampling times which are greater than 32ms.

If a table is distributed over several data blocks, the time required increases. The reason for this is that in addition to the time taken to
transfer the tabular values, which can be determined using the formula above, the user has to manually make the changes described above.

3.10.3.2 Configuring for S7 control and SIMATIC FM 458 application module

The following function blocks must be configured for the coupling between an S7 control and an SIMATIC FM 458 application module via P bus:

- SIMATIC FM 458 application module:
  - TAB (for REAL data type) and/or
  - TAB_D (data type DINT)
  - @CPB (P-bus coupling, central block)
- S7 control:
  - WR_TAB

Each table may only contain values associated with one particular data type. If several tables with different data types are to be managed, then an TAB or TAB_D must be configured for each table.

WR_TAB is used to transfer the tabular values from SIMATIC DB to function blocks TAB and TAB_D. The tabular values are transferred using a data telegram. When the last data telegram has been transferred, the TAB or TAB_D is automatically signaled that all of the tabular values have been transferred and that the table should be activated. WR_TAB receives a checkback signal as to whether activation was successful or not. After the table was successfully activated, its address is output at the TAB output of the TAB or TAB_D.

TAB and TAB_D

TAB and TAB_D should be configured as follows:

They should be configured in a sampling time greater than or equal to 32ms. The following connection settings are required:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>[name of the configured communications interface]</td>
</tr>
<tr>
<td>AUT</td>
<td>1 (automatic mode activated)</td>
</tr>
<tr>
<td>US</td>
<td>[channel name.address stage1] (address data for receive)</td>
</tr>
<tr>
<td>MOD</td>
<td>[data transfer mode] (H=Handshake; R=Refresh; S=Select; M=Multiple)</td>
</tr>
<tr>
<td>TFT</td>
<td>[monitoring time in milliseconds] (maximum telegram failure time while receiving tabular values)</td>
</tr>
<tr>
<td>NP</td>
<td>[specifies the maximum table size]</td>
</tr>
</tbody>
</table>

**NOTE**

If a communications interface is configured at the CTS connection, it is possible to toggle, as required between "Automatic mode: Communications" and "Manual mode".
The following connection settings should be configured at WR_TAB:

- **LADDR** = [specifies the logical address of the SIMATIC FM 458 application module]
- **RECNUM** = [specifies the data set number for the read and write channels. This must be identical with "Address stage 1" at the US connection of the TAB or TAB_D.]
- **DBNUM** = [specifies the data block number]

### 3.10.3.3 Inserting tabular values in the data block

In order to be able to transfer tabular values to a SIMATIC FM 458 application module, they must be available in a data block (DB). The DB should be programmed on the control side.

There are two ways of generating a DB with the required tabular values:

- Generating a new DB in STEP7 and manually entering the tabular values in the application "LAD/STL/CSF"
- Importing tabular values from an existing table (e.g. MS Excel) as external source in STEP7

#### 3.10.3.3.1 Manually entering tabular values

In this case, it involves the simplest method of providing tabular values in a DB. It is realized by entering the initial (starting) and actual values of the individual table values manually in a newly generated DB in the application "LAD/STL/CSF". The steps required will now be explained.

**NOTE**

The initial value is any value which can be defined for every tabular value. It is only used if there is no actual value specified for the associated tabular value.

The actual value is that value which is made available as tabular value in the configured software. The required tabular values should be specified here.

(1) Generating a new DB under STEP7

To start, a new DB should be generated under STEP7. In this case, the "Blocks" folder is selected in the appropriate S7 program and in the context-sensitive menu, the entry "Insert new object → data block" is selected.

The procedure is shown in the following diagram:
(2) Opening the new DB

The next step is to open the newly generated DB by double-clicking with the application "LAD/STL/CSF". "DB Editor" is the tool which is used to generate it and only one "Data block" is generated.

The following diagram illustrates the selection when opening a new DB:
Fig. 3-55  Making a selection when generating a new DB

The opened, new DB is illustrated in the following diagram:

Fig. 3-56  Newly generated DB in the application "LAD/STL/CSF"
(3) Entering the tabular values

The required tabular values can now be entered. It should be ensured that the X and Y values are entered, alternating.

To start, the data type, used in the table, should be entered (REAL or DINT). In this case, the name is always "Data type", "WORD" type and initial value for data type REAL "W#16#1", for data type DINT "W#16#2".

Then, for each individual tabular value, the name, data type ("Type" column) and value ("Initial value" column) should be entered.

The procedure when entering tabular values, data type REAL, is shown in the following diagram:

![Fig. 3-57 Manually entered tabular values in the "LAD/STL/CSF" application](image)

**NOTE**

Only values associated with the same data type may be included in a table. For this reason, specifying an ARRAY is an effective way of entering data. This means that the data type doesn't have to be specified each time.

Refer to the online help of the application "LAD/STL/CSF" - especially "Help for STL" for the procedure to make entries for an ARRAY type.
(4) Saving the DBs

After the tabular values have been completely entered, the DB can be saved under "File → Save". The tabular values are then located in the DB for transfer.

3.10.3.3.2 Importing tabular values

The tabular values, provided in the DB, can also be imported from an external source, e.g. an MS Excel table. However, the following points should be observed for error-free import:

- The source file of the table must have a specific format
- The source file must be linked-in as external source file under STEP7
- A new DB is generated from the external source file
- The necessary points and steps, required for the import operation, will now be explained.

Table format

In order to import an existing table (e.g. generated using Excel) into the DB, it must be compliant with a specific format syntax:

- The table must contain a header, which contains information about the name of the DB and the version.
- Information about the structure and the data type of the tabular values should then be specified.
- The tabular values are then specified (as initial values).
- It should be observed that X and Y values must always be specified, alternating.
- The table should be saved with the *.AWL extension.
- The table can then be used as external source file.

NOTE

The initial value is any value which can be defined for each tabular value. It is only used if an actual value is not specified for the associated tabular value. The tabular values are exclusively defined as initial values. Actual values are not used. This significantly reduces the file size and in turn, the required memory.
An example of a table with four X and four Y values, data type REAL is shown in the following diagram:

![Table with REAL data type](image1)

**Fig. 3-58** An example of a table with values, data type REAL

An example of a table with two X and two Y values, data type DINT is shown in the following diagram:

![Table with DINT data type](image2)

**Fig. 3-59** An example of a table with values, data type DINT
The following sections explain, using examples, how to re-format an Excel table to obtain the required table format.

The file example, shown in the following diagram, is formatted step-by-step corresponding to the specifications of the required table format.

![Fig. 3-60 An example of a table in MS Excel](image)

**1) Header**

Initially, the required header is inserted. To do this, 5 lines are inserted at the beginning and the following data is entered:

- DATA_BLOCK DB 1 [number of the DB]
- TITLE = [enter as required]
- VERSION : 0.1 [version data]
The Excel table with inserted header is shown in the following diagram:

![Excel table](image)

Fig. 3-61 An example of a table in MS Excel with inserted header

(2) Insert structure and tabular values

In a next step, the structure of the tabular values and the values, specifying the data type, are inserted. In this case, two lines plus an initial and end line are inserted for each value pair. Furthermore, a line is inserted at the start to specify the data type used.

The start of the structural data is displayed in the starting line with the "STRUCT" entry. The data type, used in the table, is specified in the following line ("W#16#1" for data type REAL, "W#16#2" for data type DINT).

This is followed by the structural data and tabular values for the individual value pairs, where X and Y values are always entered alternating. The tabular values are specified corresponding to the data type used (in this case REAL). The end of the structural data is displayed in the final line with the "END_STRUCT;" entry.

Finally, only the data for the data section of the actual values has still to be specified ("BEGIN" and "END_DATA_BLOCK"). As the tabular values already have the structural data in the starting (initial) values, it is not necessary to specify the individual actual values.
The Excel table with inserted structural data and tabular values is shown in the following diagram:

![Excel Table Example](image)

Fig. 3-62 Example of a table in MS Excel with inserted structural data and tabular values

(3) Saving as STL [AWL] file

Finally, the correctly formatted file only has to be saved as text file with the extension *.AWL. In this case, the following should be selected in MS Excel "File → Save as...". "Formatted text (separated by blanks) (*.prn)" file type should be selected and the table example should be saved under a freely selectable name and location.
"Save as" window in MS Excel with the appropriate selection is shown in the following diagram:

![Save as window in MS Excel](image)

**Fig. 3-63** An example of a table in MS Excel saved as text file (*.prn)

After the file has been saved, the file type should be changed from *.prn to *.awl. This file can then be opened with any text editor.

The following diagram shows the table example as STL [AWL] file, opened in the standard Windows text editor:

![Table example in text editor](image)

**Fig. 3-64** Table example, saved as *.awl file, opened in the text editor

This file can only be used as external source file in STEP7 for a DB.
Using the file example "BEISPIELTABELLE.AWL", generated above, the individual steps to incorporate an externally generated table in a DB will now be explained.

NOTE
In addition to specifying the tabular values, it is especially important to specify the name of the DB. A DB is subsequently generated using the name specified in the file.
In the above file example, "DB1" is specified as DB name in the first line. (refer to Fig. 10)

Now, an external source is inserted in the STEP7 configured software in the S7 program under "Sources". After selecting "Sources", the context-sensitive menu can be called-up by clicking in the righthand partial window with the righthand mouse key. An external source should be inserted here as new object.

The procedure is shown in the following diagram:

![Inserting an external source in STEP7](image)
The STL [AWL] file, generated above, is selected as source file. The following diagram shows the file selection window:

The selected file is opened (in this case: BEISPIELTABELLE.AWL). It now exists as source file in the configured software under "Sources". It is selected there and is opened.

The file example, available under "Sources" and its context-sensitive menu is shown in the following diagram:
After the file has been opened, it can be edited in the "LAD/STL/CSF" program. There it can be compiled via "File / Compile".

The procedure is shown in the following diagram:

After the file has been successfully compiled, a new DB is available in the configured software. The name of the DB corresponds to the name specified in the header line of the file.
The following diagram illustrates the newly generated DB in STEP7 configured software under "Blocks":

![Diagram of SIMATIC Manager - TAB_Test](image)

Fig. 3-69 Newly generated DB after compiling the source file

In order to check the contents of the DBs, it can be opened in the "LAD/STL/CSF" program. "Data view" should be selected in the "View" menu to display the initial (starting) values as well as the actual values.
The contents of the opened DB is illustrated in the following diagram:

![Diagram showing the contents of the newly generated DB in the "LAD/STL/CSF" application](image)

### 3.10.3.3.3 Subsequently downloading tabular values into a DB

If tabular values are to be subsequently downloaded into the DB, because the table is too large and there is not sufficient user memory for several DBs, then the table should be transferred to the SIMATIC FM 458 application module in several sub-sets of the table. To do this, the table must be split-up into sub-sets of the table. The size of the individual sub-set tables should be selected so that the user memory of the S7-CPU is not exceeded. The individual table sub-sets are then transferred one after another.

**NOTE**

It is especially important that the individual table sub-sets are transferred in the sequence of the value pairs. If they are transferred in the incorrect sequence, then the tabular values will not be correctly available in the configured software.
There are two possibilities:

- Manually enter the individual tabular parts at the DB in the "LAD/STL/CSF" application and then transfer this part of the table
- Generate individual source files with different names for each table sub-set and after being successfully linked-into the DB one after the other, then transfer

**Manual entry**
In order to subsequently download tabular values into a DB manually, the following steps should be carried-out:

- The appropriate DB should be opened by double-clicking in the "LAD/STL/CSF" application.
- The existing tabular values should be replaced by entering the value of the subsequent tabular section.
- The DB should be saved.
- The values of the table sub-sets can now be transferred.

**Generating several source files**
The following steps have to be carried-out when subsequently downloading tabular values into a DB by generating several source files:

- The same DB name should be specified in the header of the individual source files (*.AWL).
- The individual files may not exceed the memory size of the DB.
- The file names are best numbered in an increasing sequence.
- The individual files are now linked-in as source files as described above. However, they are still not compiled.
- The first source file is compiled and the tabular values, now available in the DB, transferred.
- The second source file is compiled so that its tabular values are now available in the DB. These are now transferred to the S7 control system.
- Analog to this, the other source files are compiled and transferred one after the other.
- After the last table sub-set has been transferred, the LASTDB connection should be set from 0 to 1. This signals that the table has been transferred.

### 3.10.3.4 Structure of the data telegram for TCP/IP or DUST1 connection

If the communications link involves a TCP/IP or DUST1 coupling, then the data telegram structure must be carefully observed. This is described in the following. The data telegrams are "generated" using the function blocks CTV and CRV.
The data telegram is defined so that all of the tabular values can be transferred in a data block as well as in several data blocks.

The structure of a data block is shown in the following table:

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>char [4]</td>
<td>Telegram ID&lt;br&gt;Each table telegram is identified with the &quot;TAB0&quot; ID</td>
</tr>
<tr>
<td>u_int16</td>
<td>Telegram commands (bit-coded)&lt;br&gt;1: New table (rising edge, from 0 -&gt; 1)&lt;br&gt;2: End of table</td>
</tr>
<tr>
<td>u_int16</td>
<td>Data format (REAL=1, DINT=2)</td>
</tr>
<tr>
<td>u_int32</td>
<td>No. of the actual data block</td>
</tr>
<tr>
<td>u_int32</td>
<td>No. of tabular values (X and Y values)&lt;br&gt;The number of values must always be an even number. This means that always the same number of X and Y values are transferred.</td>
</tr>
<tr>
<td>u_int32 [56] / float [56]</td>
<td>Array with tabular values. (X and Y values, always alternating)</td>
</tr>
</tbody>
</table>

The TAB or the TAB_D sends an acknowledgement to the sender for each data block received.

The structure of the acknowledge telegram is shown in the following table:

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>char [4]</td>
<td>Telegram ID&lt;br&gt;Identifies each table telegram with the &quot;TAB0&quot; ID</td>
</tr>
<tr>
<td>u_int32</td>
<td>No. of the actual data block</td>
</tr>
<tr>
<td>u_int32</td>
<td>Status / error numbers&lt;br&gt;0xB210 OK (data block is o.k.)</td>
</tr>
</tbody>
</table>

**NOTE**<br>New table data is now transferred into the inactive table if the "New table" command is set.<br>After the "End of table" command has been received, all additional table data are rejected until the "New table" command is received.

### 3.10.4 Automatic mode: Memory card

Table values can be combined to form components using the D7-SYS additionalComponentBuilder (this is included in D7-SYS V5.2 plus SP1). These components can be downloaded as additional objects on the memory card. From there, they are read-out using the TAB or TAB_D function blocks.
One or several table files are imported in the D7-SYS additionalComponentBuilder, which then combines these files to form a component file (download file), which can then be downloaded onto the memory card.

The D7-SYS additionalComponentBuilder (aCB) does not check the contents of the files. The tables are an exception to this rule. The contents of these table files are checked. If the table file has an erroneous structure, then aCB immediately flags this.

The procedure from generating a table file up to configuring the function blocks is explained in the following sections using an example.

### 3.10.4.1 Generating a table file in the csv format

The table values are generated as required using a table calculation program (e.g. Excel).

![Fig. 3-71 Tables values in Excel](image-url)
The table files must fulfill the following conditions:

- A table file may only comprise two columns – if additional columns are included in the table, an error message is displayed in a dialog window.

- Both of the columns must contain the same number of values. If this is not the case, then the D7-SYS additionalComponentBuilder displays an error message in a dialog window and the table values are rejected.

The D7-SYS additionalComponentBuilder expects the following data format:

- \([\pm] \text{xxx.yyy} – \text{real value, decimal places are specified using a “.”} \) (e.g. 145.123)

- \([\pm] \text{xxx,yyy} – \text{real value, decimal places are specified using a “,”} \) (e.g. 145,122)

- \([\pm] \text{xxx.yyyE+/mm} – \text{real values shown as an exponent, decimal places are specified using a “.”} \) (e.g. 145.122E+12)

- \([\pm] \text{xxx,yyyE+/mm} – \text{real values shown as an exponent, decimal places are specified using a “,”} \) (e.g. 187,122E+12)

For the „Table DINT“ type description:

- \([\pm] \text{xxx} – \text{Integer or double integer} \) (e.g. 145)

The following conditions still apply for the table files:

- ASCII files

- The table columns are separated using a semicolon or tab character

- Lines are separated using a line break or semicolon
Saving tables

Tables, which are generated using MS Excel and are saved in the *.csv format or as "Text (Tabs separate)" fulfill these conditions.

The following diagram shows two example files with table values which were saved in the csv format:

![Fig. 3-72 Table values which were separated using semicolons (*.csv format)](image)

3.10.4.2 Working with the D7-SYS additionalComponentBuilder

After the table files were saved in the csv format, they can be imported in the D7-SYS additionalComponentBuilder.

![Fig. 3-73 D7-SYS additionalComponentBuilder](image)

In the next step, a new component file is set-up with . To start, the properties are specified in the following dialog field.
New component

![Image of Properties dialog box](image)

**Fig. 3-74 Setting the properties**

The following settings should be made:

These properties cannot be changed at a later time and have a gray background.

- **D7-SYS version**
  List box, in which the version is specified for which the components should be generated

- **Component type**
  List box with the fixed entries "USER", "IT1" and "IT2". "USER" is the default value
  The entries have the following significance:
  - USER = Component file generated by the user, e.g. table files
  - IT1/IT2 = System component file for ITSP modules

- **Type description**
  List box with the "Table REAL" and "Table DINT" entries, "Table REAL" is the default value for the "USER" component type. "Table DINT" is used for tables in the DINT format.
  The entries have the following significance:
  - REAL table: Table file with REAL data type
  - DINT table: Table file with double integer data type

A new type description can be entered in the list box and acknowledged using RETURN. This new type description is then transferred into the list box and can be selected from the list box the next time.
## Saving

The new component file can be set-up after the settings have been completed. The new component file is, as standard, set-up in C:\temp. If another memory path is specified, then when the program re-starts, this is used as standard memory path.

![Fig. 3-75 Saving the new component file](image)

Table files can now be added. A file selection window is opened using ![file selection](image) with which the required table files can be selected.

**NOTE**

Only tables with a uniform value format can be included in a component with the "table" type description! This means that a REAL table only contains tables with REAL values.

The following diagram shows the contents of the D7-SYS additionalComponentBuilder after importing the two generated table files:

![Fig. 3-76 D7-SYS additionalComponentBuilder with imported table files](image)
Communications configuring

Additional table files can be added or imported or deleted at any time. The D7-SYS additionalComponentBuilder automatically takes-over the management of the table files and saves the modified component files.

Opening

When opening existing components, "C:\temp" is the standard search path of the D7-SYS additionalComponentBuilder. If another path is selected, when the program re-starts, this is used a standard search path.

3.10.4.3 Downloading

After the component file was set-up with the D7-SYS additionalComponentBuilder, it can be downloaded into the general download dialog box.

(1) Opening the download dialog box in D7-SYS with “target system → Download”
Using this dialog box, the current configuring can download the optional components into a memory card (offline/online).

Fig. 3-77 Download dialog box via target system → Downloading into D7-SYS
(2) Opening the dialog box for optional components
A maximum of 2 components can be selected. A file can be selected for the selected components by clicking on the “NEW” button.

![Selection dialog box for optional components, e.g. table data](image)

(3) A file selection dialog box opens to select additional components
The component file, previously created using the D7-SYS additionalComponentBuilder, is now assigned the component IT1 and during the next download operation, is written into the memory card.

![Downloading a component file](image)
3.10.4.4 Configuring the function blocks

For the "automatic mode, memory card" mode, only the TAB and/or TAB_D function blocks must be configured, depending as to whether table values, REAL data type and/or DINT data type have to be managed. Each table may only contain values of one data type. If several tables are to manage various data types, then a TAB or TAB_D should be configured for each table.

The TAB and TAB_D function blocks should be configured in a sampling time greater than or equal to 32ms. The following connection settings are required:

- **CTS** = 0
- **US** = Not assigned
- **NAM** = Name of the table file (with file name extension which was defined when "saving", e.g. MS Excel)
- **AUT** = 1 (automatic mode activated)

The configuring is shown in the following diagram:

![Diagram showing configuration of the TAB function block](image)

The table function blocks for 2 tables are shown in the following diagram. The table values, which are now managed by the function blocks, can now also be used by additional function blocks, e.g. FB TABCAM.
Communications configuring

Fig. 3-81 Configuring example
3.11 Communications utility, message system

General
The message system allows the user to log certain events which he has selected. A description of these events is collected in the message sequence buffer and is then made available to the user via a data interface.

Configuring
The message system operates purely on the CPU. Precisely one central block and at least one message evaluation block must be configured. There are no configuring rules regarding the number of blocks.

Function blocks for the message system
The message system consists of 3 types of function blocks:

- **Central block @MSC**
  The central block sets-up the required data structures and administers them. It is also responsible in evaluating communication- and system error messages.

- **Message entry blocks MER ...**
  Message entry blocks generate messages when an input changes. Message entry blocks can mutually interrupt each other. Thus, the messages do not have to be entered in the message sequence buffer in the sequence in which they occurred.
  The message entry blocks differ by:
  - the number of messages which can be generated.
  - the capability of being able to process additional incoming process conditions/statuses in the form of measured values.

- **Message evaluation blocks MSI ...**
  Message evaluation blocks output messages, generated by the message entry blocks, via a data interface and make them accessible to the user.

3.11.1 Entry logic of the message entry blocks

3.11.1.1 Message entry blocks for an activated message

**Entry logic**
For message entry blocks, which only generate an activated message, the following conditions must be fulfilled for message entry:

- input EN must be set.
- a positive edge must be available at input I1.
- connection Q1 or SM must be reset.

If the conditions are fulfilled, a message is generated and connection Q1 is set.

If the conditions are not fulfilled, then, if connection SM is reset, connection Q1 is also reset.
3.11.1.2 Message entry blocks for an activated and a de-activated message

**Entry logic**

For message entry blocks, which generate an activated and a de-activated message, the following conditions must be fulfilled for message entry:

- input EN must be set.
- for an activated message, a rising edge must be available at input I1 and connection Q1 or SM must be reset.
- for a de-activated message, a falling edge must be available at input I1 and connection Q2 or SM must be reset.

If these conditions are fulfilled, then:

- for a rising edge, an activated message is generated and connection Q1 is set.
- for a falling edge, a de-activated message is generated and connection Q2 is set. If these conditions are not fulfilled, and if connection SM is reset, connections Q1 and Q2 are reset.

**Special features for MER16, MERF16, MER0, MERF0**

For message entry blocks MER16, MERF16, MER0, MERF0, which have a vector as message connection, and which generate 16 or 32 messages, for message connection IS1 and output connection QS1 or QS2, the appropriate bit positions must fulfill the conditions of the entry logic.

Further, these blocks have a QN output, which indicates whether a message was generated.

3.11.2 Configuring example for a message system

**Prerequisites for a message system**

- Subrack
- At least one CPU in the subrack
- A data interface is available with the name "D01"

**Function blocks required**

In the example, only the actually required blocks for the message system are listed. Central communication blocks (e.g. for the data interface) are not listed.

The configured message system consists of:

- 1 central block @MSC
- 2 entry blocks (MER and MERF0)
- 2 message evaluation blocks (MSI and MSIPRI)

**Name and message buffer**

The name of the message system is "MELD". This name is configured at all CMS connections of the message blocks. The message buffer can accommodate 30 messages (connection NOM at @MSC), is located in a volatile RAM (connection SAV at @MSC) and is enabled for message entries (connection MUN at @MSC).
**Assigning message and block**

Generated messages can be assigned to blocks using the RP- and RRS connections, whereby each block of the message system has at least one RP connection. Proceed as follows:

- **Prefix 0**
  Designates a message which is generated by @MSC (communications- and system error messages). Thus, connection RP of @MSC is assigned the value 0. @MSC automatically generates the suffix, depending on the message type.

- **Prefix 1**
  Designates a message, which is generated by MSI (overflow messages). Thus, MSI assigns a value of 1 to connection RP. MSI automatically generates the suffix (number of messages which have overflowed).

- **Prefix 2**
  Designates a message which was generated by MSIPRI.

- **Prefix 3**
  Designates a message, which was generated from a message block (MER or MERF0). Thus, connection REP of MER and MERF0 is assigned the value 3. The suffix is not automatically generated as for the other blocks. In this case, the connections are available, at which the suffix can be configured. 33 various messages are generated in the example (1 MER message, 16 activated messages MERF0, 16 de-activated messages MERF0), which are numbered from 0 - 32:
  - The message of block MER is assigned suffix 0 (RS connection MER).
  - The 16 activated messages of block MERF0 are assigned suffix 1-16 (RS1 connection MERF0).
  - The 16 de-activated messages of block MERF0 are assigned suffix 17-32 (RS2 connection MERF0).

- **Suffix**
  For block MERF0, for the suffix a basis value is specified. The bit number of the message-generating bits of message signal vector IS1 is added to this basis value.

**Functional combination of the messages**

Using a prefix and suffix, it is not only possible to uniquely assign the messages to the generating blocks, but it is also possible to functionally combine the messages. In the configuring example, the MER and MERF0 blocks generate messages with the same prefix, which indicates a logical association.

**Channel on the data interface**

In the configuring example, both message evaluation blocks set-up a channel at the data interface D01 in the "select" mode (thus, the same channel name can be configured).

**Measured value input and message signals**

The measured value input of block MER is not connected in the particular example. At the measured value input, a process condition is normally applied. The message signals of function block MERF0 act similarly.
Generating and reading-out messages

Messages are generated by a rising edge at connection I1 of block MER or by a changing value at input IS1 of block MERF0. The message evaluation block immediately reads-out the first message from the message buffer and transfers into the data channel as both blocks are "enabled" (input EN=1). Additional messages are only transferred into the data channel when the previous message has been read-out of the channel.
Fig. 3-82  Configuring example, communications utility, message system
3.11.3 Output formats of the message evaluation block MSI

3.11.3.1 Structure of an error- or alarm message

General

The message evaluation block MSI has four inputs to select the format:

- input SNV
- input STM
- input STC
- input SSF

The message format is important for the receiver of a message and its interpretation.

Message text length

Input STC defines the message text length. It is set to a constant length (60 characters) using STC = 1. If a message text is shorter than the maximum length or is not available, it is filled with blanks. The advantage is the constant number of data which is to be transferred. This connection has no effect on the remaining structure of the message and the message type description.

Message text format

Inputs SNV, STM and SSF are evaluated once during the initialization phase and then define the format of the messages output. The messages are output at the channel, specified at input AT at the data interface specified at input CTS.

3.11.3.2 Overview of the message formats

Spontaneous ID

The spontaneous ID has a constant value of 0 and is of no significance.

Sequence number

The sequence number is provided for reasons of reliability and counts the number of messages transmitted so that the receiver can identify which messages have been lost. The sequence number lies in the range from 0-255. When the sequence number has reached the maximum value of 255, when the next message is transmitted, the minimum value 0 is used.

Message type description

Essentially a differentiation is made between the standardized and hexadecimal formats. For a standardized format, the individual values are transferred in the IEEE 754 or ISO 646 standard, which defines a normalized 32-bit floating point notation. The messages, both in the standardized as well as in the hexadecimal format, include a message type description which provides information about the format, selected by the initialization inputs and other parts of the message. The message type description is a bit vector, which should be interpreted as follows:

- Bit 0: If this bit is set, message numbers are output (copy of input SNV).
- Bit 1: If this bit is set, a message text is output (copy of input STM, unless the message is empty).
Communications configuring

- Bit 2: If this bit is set, the messages are output in the standardized format, otherwise in the hexadecimal format (copy of input SSF).
- Bit 3: If this bit is set, a measured value is present.
- Bit 4: If this bit is set, then a units text is present. The units text can only be present if there is also a measured value. If there is no measured value or units text, the appropriate message errors are of no significance and are in an undefined condition.
- Bit 5-7: Unassigned

**Message type**
The message type consists of a character, which specifies the message event type, whereby the following is defined: "S" system error, "C" communications error, "F" error messages and "W" warning messages. The first two message types are only generated by the message system central block.

**Message prefix**
Corresponds to the input value at RP of the entry block.

**Message suffix**
Corresponds to the input value at RS of the entry block.

**Measured value units and scaling factor**
In the hexadecimal format, the measured value description consist of:
- a 32-bit scaling factor which is output in the floating format
- the measured value acquired by the acquisition block
- a measured value data type (SIMADYN D / SIMATIC TDC data type as ASCII character sequence)
- an 8-character measured value unit

**HEX format and standardized format**
As the precise data format must be specified in the hexadecimal format when initializing data transfer, and on the other hand, the measured value can vary in the size of the notation (0,2 or 4 bytes), for measured values, 4 bytes are always transferred. If the measured value occupies less than 4 bytes, which can be recognized at the measured value data type, then the subsequent bytes cannot be assigned.

In the standardized format, only the scaled measured value and the 8-character long measured value units are transferred.

**Message instant**
The message instant is transferred in the hexadecimal format in the MMS format, time and date (reference point 1.1.84). In the standardized format, the message instant is transferred as ASCII character sequence, which includes date (day, month, year) and time of day (hours, minutes, seconds, milliseconds). Date and time of day are separated by a hyphen. The character sequence is 24 characters long (example: "01.05.1993 08:01:15:0045").

**Message text**
The message text is always transferred as ASCII character sequence. In this case, length information is not transferred. This is calculated from the total number of data received. The message text can be a minimum of 60 characters long.
3.11.3.3 Structure of an overflow message

Overflow message

If the message sequence buffer overflows, then the MSI/MSPRE generates an overflow message:

- The overflow message is the warning type ('W').
- The prefix includes the value at input RP of function block MSI which generates the message.
- The suffix includes the number of messages which have been lost.
- There is no measured value. This is indicated in the message type description.
- The time, at which the message evaluation block generated the overflow message, is entered as message instant.
- The "sequence buffer overflow" text is output as message text if input STM of the function block MSI is set.

3.11.3.4 Structure of a communications error message

Communications error message

The central block evaluates the communication errors occurring in the system and generates the following communication error messages:

- A communications error message is message type C error ('C').
- The prefix includes the value at input RP of the central block which generated the message.
- The suffix includes the error number of the C-error message (this is always positive).
- If a measured value is not available, then this is indicated in the message type description.
- The text, configured at input CMT at the central block is output as message text, if input STM of function block MSI is set.
- If the communications error field has overflowed, after all of the C-error messages have been output, a message is generated which includes, as suffix, the negative number of the messages which have been lost. After this message, MSI does not output any additional C-error messages. The instant at which the central block identified the communications error field overflow, is entered as message instant.

3.11.3.5 System error message structure

System error message

A system error message has essentially the same structure as a communications error message. The only differences are the "message text" where the "system message" is always used, as well as the message type ('S'). Further, a maximum of one system error message is generated, which is identified during the initialization phase of the central block.
As suffix, an ID is entered by the system error, which has the following significance:

<table>
<thead>
<tr>
<th>Value, suffix</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5 V power failure</td>
</tr>
<tr>
<td>2</td>
<td>15 V power failure</td>
</tr>
<tr>
<td>3</td>
<td>Software processing faulted</td>
</tr>
<tr>
<td>4</td>
<td>Error when accessing the L-bus communications buffer memory</td>
</tr>
<tr>
<td>5</td>
<td>Error when accessing the C-bus communications buffer memory</td>
</tr>
<tr>
<td>6</td>
<td>Error when accessing the standard periphery</td>
</tr>
<tr>
<td>7</td>
<td>Error when accessing the special periphery</td>
</tr>
<tr>
<td>8</td>
<td>Undefined L-bus access</td>
</tr>
<tr>
<td>9</td>
<td>Undefined C-bus access</td>
</tr>
<tr>
<td>10</td>
<td>(not used)</td>
</tr>
<tr>
<td>11</td>
<td>Hardware fault which cannot be identified</td>
</tr>
<tr>
<td>12</td>
<td>(not used)</td>
</tr>
<tr>
<td>13</td>
<td>Fault/error which cannot be identified</td>
</tr>
<tr>
<td>14</td>
<td>Fault message (ready internal) from the local expansion bus (LE bus)</td>
</tr>
<tr>
<td>15</td>
<td>Error when accessing the local periphery (LP bus)</td>
</tr>
<tr>
<td>16</td>
<td>Overrun of the system bus controller</td>
</tr>
</tbody>
</table>

Table 3-28  Suffix, system error message

3.11.3.6 Detailed description of the message formats of function block MSI

General

The description of the message formats consists of 3 parts:

- Assigning initialization inputs SNV, STM and SSF
- Basic format and maximum length of the message. This length corresponds to the size of the channel logged-on by MSI.
- Net data structure which is required to initialize the channel.
- Input STC connection is not listed here. For STC = 1, the length specification for the message text always corresponds with the maximum length; for STC = 0, it corresponds to the actual message text length.
### Contents

<table>
<thead>
<tr>
<th></th>
<th>Message structure (max. 108 bytes)</th>
<th>Net data structure</th>
<th>Data format</th>
<th>No. of data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spontaneous ID</td>
<td>Unsigned8</td>
<td>1. variable unit</td>
<td>Unsigned8</td>
<td>2</td>
</tr>
<tr>
<td>Sequence number</td>
<td>Unsigned8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message type descrip.</td>
<td>1 Octet</td>
<td>2. variable unit</td>
<td>Octet-String</td>
<td>2</td>
</tr>
<tr>
<td>Message type</td>
<td>1 Octet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prefix</td>
<td>Floating-Point</td>
<td>3. variable unit</td>
<td>Floating-Point</td>
<td>3</td>
</tr>
<tr>
<td>Suffix</td>
<td>Floating-Point</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value</td>
<td>Floating-Point</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value dimensions text</td>
<td>8 characters</td>
<td>4. variable unit</td>
<td>Visible-String</td>
<td>92</td>
</tr>
<tr>
<td>Message instant</td>
<td>24 characters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message text</td>
<td>max. 60 characters</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-29**  Standard format with number and text

### Contents

<table>
<thead>
<tr>
<th></th>
<th>Message structure (max. 100 bytes)</th>
<th>Net data structure</th>
<th>Data format</th>
<th>No. of data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spontaneous ID</td>
<td>Unsigned8</td>
<td>1. variable unit</td>
<td>Unsigned8</td>
<td>2</td>
</tr>
<tr>
<td>Sequence number</td>
<td>Unsigned8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message type descrip.</td>
<td>1 Octet</td>
<td>2. variable unit</td>
<td>Octet-String</td>
<td>2</td>
</tr>
<tr>
<td>Message type</td>
<td>1 Octet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value</td>
<td>Floating-Point</td>
<td>3. variable unit</td>
<td>Floating-Point</td>
<td>1</td>
</tr>
<tr>
<td>Measured value dimensions text</td>
<td>8 characters</td>
<td>4. variable unit</td>
<td>Visible-String</td>
<td>92</td>
</tr>
<tr>
<td>Message instant</td>
<td>24 characters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message text</td>
<td>max. 60 characters</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-30**  Standard format without number with text
### Contents Message structure (max. 48 bytes)  
### Net data structure  
### Data format  
### No. of data

<table>
<thead>
<tr>
<th>Contents</th>
<th>Message structure (max. 48 bytes)</th>
<th>Net data structure</th>
<th>Data format</th>
<th>No. of data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spontaneous ID</td>
<td>Unsigned8</td>
<td>1. variable unit</td>
<td>Unsigned8</td>
<td>2</td>
</tr>
<tr>
<td>Sequence number</td>
<td>Unsigned8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message type descrip.</td>
<td>1 Octet</td>
<td>2. variable unit</td>
<td>Octet-String</td>
<td>2</td>
</tr>
<tr>
<td>Message type</td>
<td>1 Octet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prefix</td>
<td>Floating-Point</td>
<td>3. variable unit</td>
<td>Floating-Point</td>
<td>3</td>
</tr>
<tr>
<td>Suffix</td>
<td>Floating-Point</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value</td>
<td>Floating-Point</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value dimensions text</td>
<td>8 characters</td>
<td>4. variable unit</td>
<td>Visible-String</td>
<td>32</td>
</tr>
<tr>
<td>Message instant</td>
<td>24 characters</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-31**  
Standard format with number without text

<table>
<thead>
<tr>
<th>Contents</th>
<th>Message structure (max. 48 bytes)</th>
<th>Net data structure</th>
<th>Data format</th>
<th>No. of data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spontaneous ID</td>
<td>Unsigned8</td>
<td>1. variable unit</td>
<td>Unsigned8</td>
<td>2</td>
</tr>
<tr>
<td>Sequence number</td>
<td>Unsigned8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message type descrip.</td>
<td>1 Octet</td>
<td>2. variable unit</td>
<td>Octet-String</td>
<td>2</td>
</tr>
<tr>
<td>Message type</td>
<td>1 Octet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value</td>
<td>Floating-Point</td>
<td>3. variable unit</td>
<td>Floating-Point</td>
<td>1</td>
</tr>
<tr>
<td>Measured value dimensions text</td>
<td>8 characters</td>
<td>4. variable unit</td>
<td>Visible-String</td>
<td>32</td>
</tr>
<tr>
<td>Message instant</td>
<td>24 characters</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-32**  
Standard format without number and text
### Communications configuring

**SNV=TRUE (message numbers available)**
**STM=TRUE (message text available)**
**SSF=FALSE (HEX format)**

<table>
<thead>
<tr>
<th>Contents</th>
<th>Message structure (max. 92 bytes)</th>
<th>Net data structure</th>
<th>Data format</th>
<th>No. of data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spontaneous ID</td>
<td>Unsigned8</td>
<td>1. variable unit</td>
<td>Unsigned8</td>
<td>2</td>
</tr>
<tr>
<td>Sequence number</td>
<td>Unsigned8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message type descr.</td>
<td>1 Octet</td>
<td>2. variable unit</td>
<td>Octet-String</td>
<td>2</td>
</tr>
<tr>
<td>Message type</td>
<td>1 Octet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prefix</td>
<td>Signed16</td>
<td>3. variable unit</td>
<td>Signed16</td>
<td>2</td>
</tr>
<tr>
<td>Suffix</td>
<td>Signed16</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value scaling factor</td>
<td>Floating-Point</td>
<td>4. variable unit</td>
<td>Floating-Point</td>
<td>1</td>
</tr>
<tr>
<td>Measured value</td>
<td>4 Octets</td>
<td>5. variable unit</td>
<td>Octet-String</td>
<td>6</td>
</tr>
<tr>
<td>Measured value data type</td>
<td>2 Octets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value dimensions text</td>
<td>8 characters</td>
<td>6. variable unit</td>
<td>Visible-String</td>
<td>8</td>
</tr>
<tr>
<td>Message instant</td>
<td>Time and date</td>
<td>7. variable unit</td>
<td>Time and Date</td>
<td>1</td>
</tr>
<tr>
<td>Message text</td>
<td>max. 60 characters</td>
<td>8. variable unit</td>
<td>Visible-String</td>
<td>60</td>
</tr>
</tbody>
</table>

*Table 3-33  Hexadecimal format with number and text*

**SNV=FALSE (message numbers not available)**
**STM=TRUE (message text available)**
**SSF=FALSE (HEX format)**

<table>
<thead>
<tr>
<th>Contents</th>
<th>Message structure (max. 88 bytes)</th>
<th>Net data structure</th>
<th>Data format</th>
<th>No. of data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spontaneous ID</td>
<td>Unsigned8</td>
<td>1. variable unit</td>
<td>Unsigned8</td>
<td>2</td>
</tr>
<tr>
<td>Sequence number</td>
<td>Unsigned8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message type descr.</td>
<td>1 Octet</td>
<td>2. variable unit</td>
<td>Octet-String</td>
<td>2</td>
</tr>
<tr>
<td>Message type</td>
<td>1 Octet</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value scaling factor</td>
<td>Floating-Point</td>
<td>3. variable unit</td>
<td>Floating-Point</td>
<td>1</td>
</tr>
<tr>
<td>Measured value</td>
<td>4 Octets</td>
<td>4. variable unit</td>
<td>Octet-String</td>
<td>6</td>
</tr>
<tr>
<td>Measured value data type</td>
<td>2 Octets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value dimensions text</td>
<td>8 characters</td>
<td>5. variable unit</td>
<td>Visible-String</td>
<td>8</td>
</tr>
<tr>
<td>Message instant</td>
<td>Time and date</td>
<td>6. variable unit</td>
<td>Time and Date</td>
<td>1</td>
</tr>
<tr>
<td>Message text</td>
<td>max. 60 characters</td>
<td>7. variable unit</td>
<td>Visible-String</td>
<td>60</td>
</tr>
</tbody>
</table>

*Table 3-34  Hexadecimal text without number with text*
<table>
<thead>
<tr>
<th>Contents</th>
<th>Message structure (max. 32 bytes)</th>
<th>Net data structure</th>
<th>Data format</th>
<th>No. of data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spontaneous ID</td>
<td>Unsigned8</td>
<td>1. variable unit</td>
<td>Unsigned8</td>
<td>2</td>
</tr>
<tr>
<td>Sequence number</td>
<td>Unsigned8</td>
<td>2. variable unit</td>
<td>Octet-String</td>
<td>2</td>
</tr>
<tr>
<td>Message type descrip.</td>
<td>1 Octet</td>
<td>2. variable unit</td>
<td>Octet-String</td>
<td>2</td>
</tr>
<tr>
<td>Message type</td>
<td>1 Octet</td>
<td>3. variable unit</td>
<td>Unsigned16</td>
<td>2</td>
</tr>
<tr>
<td>Prefix</td>
<td>Unsigned16</td>
<td>4. variable unit</td>
<td>Octet-String</td>
<td>1</td>
</tr>
<tr>
<td>Suffix</td>
<td>Unsigned16</td>
<td>5. variable unit</td>
<td>Octet-String</td>
<td>6</td>
</tr>
<tr>
<td>Measured value scaling factor</td>
<td>Floating-Point</td>
<td>6. variable unit</td>
<td>Visible-String</td>
<td>8</td>
</tr>
<tr>
<td>Measured value</td>
<td>4 Octets</td>
<td>7. variable unit</td>
<td>Time and Date</td>
<td>1</td>
</tr>
<tr>
<td>Measured value data type</td>
<td>2 Octets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measured value dimensions text</td>
<td>8 characters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message instant</td>
<td>Time and Date</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 3-35  Hexadecimal format with number without text

<table>
<thead>
<tr>
<th>Contents</th>
<th>Message structure (max. 28 bytes)</th>
<th>Net data structure</th>
<th>Data format</th>
<th>No. of data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spontaneous ID</td>
<td>Unsigned8</td>
<td>1. variable unit</td>
<td>Unsigned8</td>
<td>2</td>
</tr>
<tr>
<td>Sequence number</td>
<td>Unsigned8</td>
<td>2. variable unit</td>
<td>Octet-String</td>
<td>2</td>
</tr>
<tr>
<td>Message type descrip.</td>
<td>1 Octet</td>
<td>2. variable unit</td>
<td>Octet-String</td>
<td>2</td>
</tr>
<tr>
<td>Message type</td>
<td>1 Octet</td>
<td>3. variable unit</td>
<td>Octet-String</td>
<td>1</td>
</tr>
<tr>
<td>Measured value scaling factor</td>
<td>Floating-Point</td>
<td>4. variable unit</td>
<td>Octet-String</td>
<td>1</td>
</tr>
<tr>
<td>Measured value</td>
<td>4 Octets</td>
<td>5. variable unit</td>
<td>Octet-String</td>
<td>6</td>
</tr>
<tr>
<td>Measured value data type</td>
<td>2 Octets</td>
<td>6. variable unit</td>
<td>Octet-String</td>
<td>6</td>
</tr>
<tr>
<td>Measured value dimensions text</td>
<td>8 characters</td>
<td>7. variable unit</td>
<td>Visible-String</td>
<td>8</td>
</tr>
<tr>
<td>Message instant</td>
<td>Time and Date</td>
<td>8. variable unit</td>
<td>Time and Date</td>
<td>1</td>
</tr>
</tbody>
</table>

Table 3-36  Hexadecimal format without number and text
3.11.3.7 Output format of the message evaluation block MSIPRI

**General**
Contrary to the message evaluation block MSI, the format of the messages of the MSIPRI evaluation block can be freely selected. Here, only one format is output. Thus, there are no connections to select a format when configuring the block. The MSIPRI block has been especially developed to output messages on a printer. All of the messages are output as text and with line feed. A message consists of a maximum of two lines.

**Structure of the 1st line**

<table>
<thead>
<tr>
<th>Character of the 1st line</th>
<th>Significance</th>
<th>Output format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-24</td>
<td>Date/time</td>
<td>Day.Month.Year, Hour:Minute:Second:Millisecond</td>
</tr>
<tr>
<td>25-27</td>
<td>Text: &quot;P:&quot;</td>
<td></td>
</tr>
<tr>
<td>28-32</td>
<td>Prefix</td>
<td>Max. 5 characters and right justified</td>
</tr>
<tr>
<td>33-35</td>
<td>Text: &quot;S:&quot;</td>
<td></td>
</tr>
<tr>
<td>36-40</td>
<td>Suffix</td>
<td>Max. 5 characters and right justified</td>
</tr>
<tr>
<td>41-45</td>
<td>Text: &quot;Type:&quot;</td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>Message type</td>
<td>One character</td>
</tr>
<tr>
<td>47-50</td>
<td>Text: &quot;Nr:&quot;</td>
<td></td>
</tr>
<tr>
<td>51-53</td>
<td>Sequence number</td>
<td>Max. 3 characters and right justified</td>
</tr>
<tr>
<td>54</td>
<td>Text: &quot; &quot;</td>
<td></td>
</tr>
<tr>
<td>55-67</td>
<td>Measured value (optional: this is only entered if the message contains a measured value)</td>
<td>Is output as floating value in the following sequence:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sign (positive = &quot;+&quot;, negative = &quot;+&quot;)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• number of places before the decimal point followed by a decimal point and 6 places after the decimal point</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• exponent, started with the character ‘e’</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sign (positive = &quot;+&quot;, negative = &quot;+&quot;) as well as 2 exponent positions</td>
</tr>
<tr>
<td>68</td>
<td>Blanks (optional)</td>
<td></td>
</tr>
<tr>
<td>69-76</td>
<td>Measured value unit (optional: is only entered if the message contains a measured value)</td>
<td>8 characters</td>
</tr>
<tr>
<td>77, 78</td>
<td>Special characters, CR and LF</td>
<td>Line feed</td>
</tr>
</tbody>
</table>

Table 3-37  Structure of the MSIPRI evaluation block message, 1st line
Communications configuring

Structure of the 2nd line

The second line contains the message text, and is only output if there is a message text. Otherwise this is completely eliminated.

<table>
<thead>
<tr>
<th>Character of the 2nd line</th>
<th>Significance</th>
<th>Output format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-60</td>
<td>Measured value text (optional)</td>
<td>Variable length</td>
</tr>
<tr>
<td>61, 62</td>
<td>Special characters, CR and LF</td>
<td>Line feed</td>
</tr>
</tbody>
</table>

Table 3-38 Structure of the MSIPRI evaluation block message, 2nd line

Example of a message output

"01.05.1993 08:01:15:0045 P: 123 S: 10 Typ: W Nr: 25 -1.123456e+12 ms 
"This is a message text"

Table 3-39 Example of a message output

NOTE

Overflow-, communication error- and system error messages have the same logical structure as for block MSI.
3.12 Communications utility process data

The communications utility, process data supports "pure" data transfer in the transmit- and receive directions, i.e. the function blocks only transfer process data. The data itself is neither evaluated nor logically interpreted.

There are two block classes for data transfer:

- receive- and transmit blocks: CTV and CRV
- channel marshalling blocks: CCC4 and CDC4

The CRV and CTV blocks can handle most of the communication applications.

3.12.1 Receive- and transmit blocks

There is one receive- and one transmit block. They are called CRV (communication receive virtual) and CTV (communication transmit virtual).

Using a receive- or transmit block a telegram is configured, which is transferred from or to a coupling module. The structure and contents of the telegram are defined when configuring the virtual connections.

3.12.1.1 Virtual connections

A virtual connection is an "invisible" connection between block connections. There is no interconnection drawn at the configuring interface, and only a margin connection is created.

The configuring engineer defines which values are to be transferred from block outputs or to block inputs. He does this using "connection name receive/transmit" at the receivers or transmitters and the "virtual connection name" and the "sequence number" at the block inputs or block outputs to be processed.

Connection name

The connection name consists of an exclamation mark ("!") and a maximum of 6 characters (upper case letters or numbers). The character sequence is located directly after the exclamation mark (e.g. "ISEND"). The exclamation mark does not have to be configured as it is automatically generated.

A virtual connection consists of:

- virtual connection name
- sequence number

Connection name and sequence number are separated by a point (e.g. "ISEND.0056"); the point (period separator) between the connection name and the sequence number does not have to be configured as it is automatically generated.

Data types

Virtual connections can be configured at I/O with the following data types:
• BOOL (BO), BYTE (BY)
• WORD (W), DOUBLE WORD (DW)
• INTEGER (I), DOUBLE INTEGER (DI)
• REAL (R) and SDTIME (TS)

**NOTE**
Virtual connections cannot be configured at I/O, data types STRING (S) or GLOBAL VARIABLE (GV).

**Telegram structure**
The virtual connections with the same connection name (data) define a telegram with a specific structure. The sequence of the data within the telegram is defined by the sequence number. The data with the lowest number is located at the start of the telegram; that with the highest number, at the end. The sequence number defines the relative position of the data in the telegram. Gaps in the sequence numbers are ignored.
Receiving and transmitting with virtual connections.

Configuring example

![Diagram of virtual connections configuration]

**Configuring rules with reference to the example:**

- The virtual connections, which belong to a virtual connection name, can be configured at block I/O with different data types (ANY_FB.Y1 "REAL" and ANY_FB.Y6 "INTEGER") and in any sequence.

- Virtual connections (receive) at block inputs can be configured a multiple number of times if the inputs have the same data type. These inputs are supplied with identical data. (ANY_FB.X4 and X5)

- The same virtual connection (transmit) with identical connection name and sequence number may not be configured a multiple number of times at block outputs.

- Several different virtual connections (transmit) can be configured at a block output (ANY_FB.Y3). The connections can differ, both in the connection name as well as in the sequence number.
Telegram structure of the connection name/data "IREC" from the example:

<table>
<thead>
<tr>
<th>Connection</th>
<th>Virtual connection</th>
<th>Data type</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANY_FB.X2</td>
<td>IREC.0003</td>
<td>R</td>
<td>4</td>
</tr>
<tr>
<td>ANY_FB.X1</td>
<td>IREC.0017</td>
<td>R</td>
<td>4</td>
</tr>
<tr>
<td>ANY_FB.X4/X5</td>
<td>IREC.0555</td>
<td>R</td>
<td>4</td>
</tr>
</tbody>
</table>

Table 3-40  Telegram structure of the connection name/data "IREC"

Telegram structure of the connection name/data "ISEND" from the example:

<table>
<thead>
<tr>
<th>Connection</th>
<th>Virtual connection</th>
<th>Data type</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANY_FB.Y1</td>
<td>ISEND.0001</td>
<td>R</td>
<td>4</td>
</tr>
<tr>
<td>ANY_FB.Y3</td>
<td>ISEND.0004</td>
<td>R</td>
<td>4</td>
</tr>
<tr>
<td>ANY_FB.Y6</td>
<td>ISEND.0007</td>
<td>I</td>
<td>2</td>
</tr>
</tbody>
</table>

Table 3-41  Telegram structure of the connection name/data "ISEND"

The structure of the configured telegram appears in similar form in the CFC reference data in the view "cross-references, operands" or in the CPU MAP listing (of the CFC) under "virtual connections". The configuring can be checked using these lists.

**NOTE**

- The virtual connection names are known on the CPU. Data from various function charts can be combined to form a telegram; however, this is not possible from various CPUs.
- Data is processed by the receive/transmit blocks in their sampling time. The sampling times of the blocks with virtual connections have no influence on the telegram processing cycle.
- The configuring engineer is responsible in ensuring that the telegram structure and length are compatible with that of the coupling partner (refer to the chapter Mode of operation of the couplings). These regulations are dependent on the secondary coupling. If an error situation develops, the receive/transmit block disables itself and makes an entry in the communications error field (e.g. PROFIBUS DP or subrack coupling), or, communications are not established (e.g. Industrial Ethernet).
3.12.1.2 I/O of the CRV, CTV blocks

Inputs CTS  
The configured coupling module name via which communications is to be realized, is specified at input CTS of the block. For CP50M0/CP51M1 modules, it is also necessary to specify the connector (X01 for CP50M0/CP51M1 or X02 for CP50M0).

Input AR, AT  
The address parameter for communications is specified at input AR, AT. It consists of a channel name and the optional address stages. The significance of the address parameters is dependent on the coupling used. (e.g. PROFIBUS or DUST).

Input MOD  
The data transfer mode is configured at the MOD input (e.g. "R" for refresh or "H" for handshake).

Input EN  
Input EN defines whether data is to be transferred in the current operating cycle.

Inputs CRR, CRT  
The virtual connection name, receive or send is configured at input CRR or CRT.

3.12.2 Channel marshalling blocks CCC4 and CDC4

Application  
Channel marshalling blocks are used to split-up or combine channels.

3.12.2.1 Group block CCC4

General  
The CCC4 function block (Communication Collect Channel 4) combines up to 4 channels to form one. The channels may have different address data, be located at different interfaces and have different data transfer modi as well as channel lengths.

Prerequisites  
In order that the function block can operate, at least 2 channels must be combined (CT1- and CT2 input data are mandatory).

Data entries at connections CT3, CT4  
If only 2 channels are to be combined, then a "0" (zero) should be configured at initialization inputs CT3 and CT4. In this case, connections AR3, AR4, MO3, MO4, LT3 and LT4 are no longer evaluated.

Data entries at input CTS, AT, MOD  
The transmit channel is specified at inputs CTS, AT and MOD. The length of the net data to be transmitted is obtained from the sum of the receive data. Receive channels 1-4 are combined, one after the other to form a large net data block.
3.12.2.2 Distribution block CDC4

General

The function block CDC4 (Communication Distribute Channel 4), subdivides a channel in up to 4 channels. The channels may have different address data, be located on different data interfaces, and have different data transfer modi as well as channel lengths.
Prerequisites

In order that the function block can operate, the receive channel must be sub-divided into at least 2 transmit channels (CT1- and CT2 input data are mandatory).

Data entries at inputs CT3, CT4

When sub-dividing a channel into only 2 channels, a "0" (zero) must be configured at initialization inputs CT3 and CT4. AR3, AR4, MO3, MO4, LT3 and LT4 are, in this case, no longer evaluated.

Data entries at inputs CTS, AT, MOD

The receive channel is specified at inputs CTS, AT and MOD. The length of the net data to be received is obtained from the sum of the transmit data.

NOTE

If one of the transmit channels is configured in the handshake mode and precisely this channel is not read-out on the receive side, then the CDC4 function block cannot operate until this one channel has been read-out. In this case, the block is temporarily inhibited.

3.12.2.3 Compatible net data structure

For blocks CCC4 and CDC4, the net data are unstructured (data type, octet string). Thus, they are compatible to any net data structure. In order that the transmitter and the associated receiver can correctly synchronize with one another, only the net data lengths must be identical.

3.12.3 Diagnostic outputs

General

After each processing cycle, the result of the processed data interface(s) is output at the YEY output of the transmit- and receive blocks as well as the channel marshalling blocks (CTV, CRV, CCC4, CDC4). The YEY output is the WORD type; the 16 bits are sub-divided into three areas:

<table>
<thead>
<tr>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel statuses (only CCC4, CDC4)</td>
<td>Channel assignment (only CCC4, CDC4)</td>
<td>Fault cause</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 3-42 Diagnostic outputs

3.12.3.1 Fault/error cause

Hexadecimal value

The possible fault/error cause is displayed in bits 0-7 in the form of a hexadecimal value (this should not be evaluated bit-coded):
### Table 3-43 Fault/error cause

<table>
<thead>
<tr>
<th>Hex. Value</th>
<th>Significance</th>
<th>Counter-measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No fault/error, data transfer was successful.</td>
<td>None (proceed with new initialization)</td>
</tr>
<tr>
<td>1</td>
<td>Block was permanently disabled after initialization due to a configuring error or after an internal error (refer to the communications error field or YTS output for detailed information).</td>
<td>Correct configuring.</td>
</tr>
<tr>
<td>2</td>
<td>Communications partner not ready or the communications link was physically interrupted (refer to YTS for more detailed information).</td>
<td>Check coupling partner, cables and connector</td>
</tr>
<tr>
<td>3</td>
<td>Communications partner is not transmitting/receiving (depending on the enable input of the communications partner). The function block is not transmitting/receiving because the communications partner has signaled that it is not transmitting data.</td>
<td>Activate the communications partner</td>
</tr>
<tr>
<td>4</td>
<td>Only for transmitters: Data cannot be transmitted. Normally, in the handshake/select mode: The communications partner has still not read-out the last data; seldom in the refresh mode: Communications partner is presently reading).</td>
<td>Configure the transmitter to be slower or the receiver to be faster</td>
</tr>
<tr>
<td>5</td>
<td>Only for receivers: No new data could be received (the communications partner hasn’t transmitted any new data since the last data was received).</td>
<td>Configure the receiver to be slower or the transmitter faster.</td>
</tr>
<tr>
<td>6</td>
<td>Inconsistent data (subrack coupling: when shutting down the master subrack)</td>
<td>None (proceed with new initialization)</td>
</tr>
<tr>
<td>7</td>
<td>Only select transmitters: channel occupied. Another function block is presently transmitting.</td>
<td>All select transmitters can coordinate via the enable input.</td>
</tr>
<tr>
<td>8</td>
<td>Only multiple receivers: Reception erroneous. Data read-out took too long; in the meantime, the transmitter has already written new data into the channel.</td>
<td>Configure receivers in a faster (higher-priority) sampling time.</td>
</tr>
<tr>
<td>9</td>
<td>Still being initiated. Transmit/receive operation was therefore not able to be started.</td>
<td>None (proceed with new initialization)</td>
</tr>
</tbody>
</table>

**Comments to numbers 4 and 5**

In the handshake mode, these numbers can sporadically occur which is quite acceptable. This is because full synchronization between the communications partner is not always possible. Receivers and transmitters should operate approximately in the same cycle.

In the refresh mode, these numbers should not occur if the transmitter is always faster than the receiver.

### 3.12.3.2 Channel assignment

**General information**

The area is only used by the CCC4 and CDC4 function blocks. In this case, a number indicates which channel is involved with the error (bits 0-7). As the channel marshalling block can process up to five channels, the numbering is as follows:
Communications configuring

<table>
<thead>
<tr>
<th>Number</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Main transmitter/receiver (corresponding to CTS-, AT- or AR-connection data).</td>
</tr>
<tr>
<td>1</td>
<td>Transmit/receive part 1 corresponding to the CT1- and AT1- or AR1 connection data)</td>
</tr>
<tr>
<td>2</td>
<td>Transmit/receive part 2</td>
</tr>
<tr>
<td>3</td>
<td>Transmit/receive part 3</td>
</tr>
<tr>
<td>4</td>
<td>Transmit/receive part 4</td>
</tr>
</tbody>
</table>

Table 3-44 Channel assignment

3.12.3.3 Channel statuses

General

The area is only used by function blocks CCC4 and CDC4. This indicates which channels are not operating error-free.

In the "channel statuses" range it is specified on which channel faults were identified when processing the channel

This area is bit-structured:

- 1=no fault
- 0=fault

<table>
<thead>
<tr>
<th>Bit</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Transmit/receive part 1</td>
</tr>
<tr>
<td>12</td>
<td>Transmit/receive part 2</td>
</tr>
<tr>
<td>13</td>
<td>Transmit/receive part 3</td>
</tr>
<tr>
<td>14</td>
<td>Transmit/receive part 4</td>
</tr>
<tr>
<td>15</td>
<td>Main transmitters/receivers</td>
</tr>
</tbody>
</table>

Table 3-45 Channel statuses

3.12.4 Introduction – "Pointer-based communication blocks"

Up to D7-SYS Version 6, serial or parallel data transfer operations for SIMATIC control systems were configured using the so-called "virtual communication couplings" methods (shown in CFC charts e.g.: "!VNAME.0001").

Exception: The fiber-optic cable drive coupling SIMOLINK is configured using special SIMOLINK blocks.

From D7-SYS Version 6, communication links, for example PROFIBUS-DP, SIMATIC-CPU ↔ FM 458-1 DP as well as for SIMATIC TDC or T400 and SIMADYN D can be alternatively configured using communication blocks which have become recently available.
In this case, interface data is accessed from the CFC screen using new blocks, which are inter-connected using a special pointer interface.

Both of these configuring methods (virtual interconnections and pointer-based communications) can be used together on the same hardware platform, in the same configuring (application software) and even for the same interface.

3.12.4.1 Principle mode of operation

Telegram blocks (CRV_T, CTV_P and S7RD_P, S7WR_P) allow access to the receiving or to the sending data blocks (telegrams) by providing a pointer to the particular data block.

This pointer is connected to read/write blocks (DRD..., DWR...). Together with an offset, a write block can save the data at its input connection at the required location in the buffer. A read block then retrieves the appropriate data from the specified location of the receive buffer and makes it available at its output.

This means that in principle, a virtual interconnection is replaced by a (read/write) block and a "normal" CFC connection.

3.12.4.2 Applications

<table>
<thead>
<tr>
<th>Large data quantities</th>
<th>Pointer-based communications are especially advantageous where large amounts of data are involved. For large amounts of data, it is simpler and faster to configure and change and interconnections are more flexible.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access to the I/O area (P bus) for FM 458-1 DP</td>
<td>128 bytes can be transferred from the FM 458-1 DP to the S7-CPU in each direction via the I/O area of the P bus. Using the new S7RD_P/S7WR_P blocks, all 128 bytes can be copied into a buffer using a block and that with an optimized computation time. This buffer can then be accessed flexibly using read/write blocks via the pointer interface. Indexed access is also possible. Sub-areas can also be accessed using offset and length data.</td>
</tr>
<tr>
<td>Saving data in a data block</td>
<td>Data can be saved in a data memory which can be universally used. This data memory can then be accessed using read/write blocks via a pointer interface. Several similar buffers can be set-up in this data block. This means, for example, that recipes can be easily saved and called-up.</td>
</tr>
</tbody>
</table>

3.12.4.3 Features of pointer-based communications

When generating CFC charts, the configuring time and costs are reduced, especially if very many virtual connections had to be generated.

Connections to the telegram data can be newly inserted and changed online (pointer, buffer offset).
Communication connections can be copied with or within chart blocks and centrally changed with them. This means that it is especially simple and quickly to configure, for example, similar communication links to a large number of drives.

Telegram buffer data can be accessed indexed using 2 offset data. This means that extremely simple modular programs (e.g. chart blocks) can be generated and used.

Larger data quantities can be transparently processed (e.g. blockwise) (copied), e.g. using the copy block CPY_P in data block DB_P.

For FM 458-1 DP:

using "B-Receive" (BRCV) high quantities of data can be transferred from the S7-CPU to the FM 458-1 DP via the K bus.

128 bytes can be simply configured and quickly transferred with low computation overhead via the I/O area of the P bus.

A special read/write block is available for every data type (BYTE, INT, DINT, REAL).

Before accessing REAL data, the type is checked.

These configuring possibilities can be principally used for all of the SIMATIC control system platforms. This means FM 458-1 DP, SIMATIC TDC, T400 and SIMADYN D. The reason for this is that block processing is independent of the subordinate (secondary) hardware.

For the same reason, this type of block communications can be principally used for all types of serial and parallel data transfer routes, where today "virtual communications" are used.

### 3.12.4.4 Associated function blocks

The blocks which can be used are arranged under the family names "ZeigrKom" or "PointCom" in the CFC block Catalog.

In order to be able to simply identify and easily assign to this block group, the blocks, whose function already corresponds to existing blocks, and which now output a pointer for this application, have a "_P" (pointer) at the end of the name.

<table>
<thead>
<tr>
<th>Type name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPY_P</td>
<td>Copying buffer areas</td>
</tr>
<tr>
<td>CRV_P</td>
<td>Telegram block, receive (interface processing)</td>
</tr>
<tr>
<td>CTV_P</td>
<td>Telegram block, send (interface processing)</td>
</tr>
<tr>
<td>DB_P</td>
<td>Data block</td>
</tr>
<tr>
<td>DRD</td>
<td>Data Read REAL</td>
</tr>
<tr>
<td>DRD_D</td>
<td>Data Read DINT</td>
</tr>
<tr>
<td>DRD_I</td>
<td>Data Read INT</td>
</tr>
<tr>
<td>DRD_8</td>
<td>Data Read 8*REAL</td>
</tr>
</tbody>
</table>
### 3.12.4.5 Pointer interface

For pointer-based communications, a **pointer is transferred to the telegram data buffer** between the blocks involved:

This pointer is actually a pointer which includes a structure, which in addition to the pointer to the net data also has information for monitoring purposes. This data includes, for example, the sampling time, block class, byte/word swap. It has the connection comment "ZeigPuffer".

### 3.12.4.6 Configuring information and instructions

The telegram blocks as well as the read/write blocks must be configured in the same sampling time in order to ensure consistency (this is checked when initializing).

**Offset data** must be carefully entered.

a) For pointer-based communications, the configuring engineer must precisely observe the offset (in bytes) of the 16-bit value (INT) or 32-bit value (REAL, DINT) to be addressed.
b) The offset must always be smaller than the buffer size. Before accessing buffer data, a check is made as to whether the area (range) has been exceeded because of an offset which has been set too high.

If data is transferred to a PROFIBUS-DP station or to a SIMATIC CPU, then bytes (for INT) and, where relevant, words of the value to be transferred (for REAL, DINT) must be swapped. The read/write blocks have a "Swap" connection – SWP – for this specific purpose.

<table>
<thead>
<tr>
<th>Type name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRD_8D</td>
<td>Data Read 8*DINT</td>
</tr>
<tr>
<td>DRD_8I</td>
<td>Data Read 8*DINT</td>
</tr>
<tr>
<td>DRD_BY</td>
<td>Data Read BYTE</td>
</tr>
<tr>
<td>DWR</td>
<td>Data Write REAL</td>
</tr>
<tr>
<td>DWR_D</td>
<td>Data Write DINT</td>
</tr>
<tr>
<td>DWR_I</td>
<td>Data Write INT</td>
</tr>
<tr>
<td>DWR_8</td>
<td>Data Write 8*REAL</td>
</tr>
<tr>
<td>DWR_8D</td>
<td>Data Write 8*DINT</td>
</tr>
<tr>
<td>DWR_8I</td>
<td>Data Write 8*INT</td>
</tr>
<tr>
<td>DWD_BY</td>
<td>Data Write BYTE</td>
</tr>
<tr>
<td>S7RD_P</td>
<td>Receive 128 bytes via a P bus (only for FM 458-1 DP)</td>
</tr>
<tr>
<td>S7WR_P</td>
<td>Send 128 bytes via a P bus (only for FM 458-1 DP)</td>
</tr>
<tr>
<td>BRCV</td>
<td>Block data receive via S7 connection (only for FM 458-1 DP)</td>
</tr>
</tbody>
</table>
In order to transfer telegrams via an interface, initially, it is sufficient to just configure the telegram block with the appropriate length data (CRV_T, CTV_P and S7RD_P, S7WR_P). Read/write blocks still don’t have to be configured. This means that the interface can be tested or the computation time load through the interface configured using, for example, few resources.
3.12.4.7 Examples of CFC screenshots

Fig. 3-86  CFC screenshot: Data transfer with telegram blocks and read/write blocks; here, for the interface P bus of the FM 458-1 DP (@CPB); bytes/words must be swapped due to the data management on the SIMATIC-CPU: SWP(Swap)=1
Communications configuring

Fig. 3-87 CFC screenshot: Data transfer SIMATIC-CPU ↔ FM 458-1 DP via P bus I/O area
Fig. 3-88  CFC screenshot: Indexed addressing of the telegram data with 2 offsets
Fig. 3-89  CFC screenshot: Re-saving 2 received telegrams in a data block and single accesses to the data memory
Communications configuring

Fig. 3-83-90  CFC screenshot: Large data quantities received from a SIMATIC CPU via K bus using BRCV
3.13 Communications utility service

Brief description
- Provides a pool of information functions so that the user has access to system information on the CPU.
- Resource for start-up (commissioning) and debugging.

Start-up
The configured data (setpoints/actual values) are displayed and/or changed here, as well as the software optimized (interconnections, controller times modified.

Debugging
Causes of system faults (crash, run-up problems) and disturbances, where the cause is within the CPU module, can be determined here.

All of the communication utility, service activities are controlled via tasks, which are received via a coupling (corresponding to the data entries at the CTS and US inputs).

Operator control devices for the communications utility, service:
- Windows PC with CFC (e.g. in the test mode)
- Windows PC with SIMATIC Manager

Local service
Using CFC, SIMATIC Manager or the basic service tool, it is possible to access a CPU via the local RS232 interface of the CPU. No additional configuring is required.

NOTE
You can read-out the CPU module information using the CFC and the SIMATIC Manager.

Additional information
on the CPU module, refer to the User Documentation "SIMATIC TDC, Basis software D7-SYS", Section "Diagnostics".

Central service
Each CPU of this subrack can be accessed via MPI or Industrial Ethernet coupling configured in the subrack.

The following must be configured:
- One per subrack:
  - MPI coupling: One CP50M1-/CP50M0 module and a central block MPI coupling "@MPI"
  - Industrial Ethernet coupling: CP51M1 module and a central block "@TCP/IP"
- At least one per CPU:
  - "SER" service function block.

Additional information
Refer to the Chapter "MPI coupling" for details on the MPI couplings or refer to the Chapter "Industrial Ethernet (TCP/IP) coupling" for details on the Industrial Ethernet couplings.
3.13.1 Function block SER

Data entries at the connections

"SER" function has a coupling connection. It can be configured several times for each CPU.

The CTS input designates the coupling module and the interface via which an operator control device is connected.

A channel name and address stage 1 is specified at input US.

- **Channel name**
  - max. 6 characters
  - ASCII characters with the exception of "point" and @
  - the channel name on a data interface must be unique.

- **Address stage 1**
  - CPU slot number. The operator control program addresses the CPU via this number.
  - The data entry must have two digits: e.g. "01", "02", ..., "24".

Example: Configuring with CFC

![Diagram showing configuration example]

Fig. 3-91 Example: Configuring with CFC
3.13.2 System load, response times

**General**

Service is actually processed in a sampling time of approximately 32 ms. (The sampling time, specified at the SER blocks is therefore not decisive for processing.) In the sampling time used, the service blocks have a certain computation time available, and more precisely, a maximum of one basic clock cycle (T0).

**NOTE**
The ratio of the basic clock cycle T0 to the sampling time used defines the CPU performance available and therefore the system load.

<table>
<thead>
<tr>
<th>Example 1</th>
<th>Basic clock cycle T0=1ms; selected sampling time=32ms</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Every 32 ms, 1 ms is reserved for the service utility</td>
</tr>
<tr>
<td></td>
<td>• System load=1 ms / 32 ms=0.03125=3.125 %</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Example 2</th>
<th>Basic clock cycle T0=2ms; selected sampling time=16ms</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Every 16 ms, 2ms is reserved for the service utility</td>
</tr>
<tr>
<td></td>
<td>• System load=2 ms/16 ms=0.125=12.5 %</td>
</tr>
</tbody>
</table>

**Computation time**
The computation time available is evenly distributed among all of the service blocks (there is no priority). This means, that as long as time is available, if possible, all SER blocks are executed once. An SER block processes a maximum of one task per each clock cycle. If the reserved computation time isn't fully used, for example, as there is no task to process, then this computation time is made accessible to the system.

**Resource distribution**
For multiple configuring and simultaneous access to system resources which are only available once (e.g. EEPROM), the first to request a resource is the first to receive it. All others are rejected and an error message is output, at the latest after 1 s ("resource occupied").
3.14 Communications utility time of day synchronization

**General**
The communications utility, time of day synchronization allows a unified system time to be provided over several SIMATIC TDC subracks.

**Time**
The following can be used as time source:

- the CPU inserted to the far left in a subrack
- the CP52A0 / CP53M0 communications buffer module
- The industrial Ethernet module CP51M1

The time is distributed:

- within a SIMATIC TDC subrack via a communications buffer module
- to other SIMATIC TDC subracks via the subrack coupling

**Function block**
Precisely one function block RTCM should be configured per subrack to distribute the system time.

**Further information**
to configure function blocks, refer to the user documentation "SIMATIC TDC, Function Block Library".

The following function blocks are used to read-out the system time:

- RTCABS: absolute time in the date/time of day format
- RTCREL: relative time in seconds since 01.01.88

These blocks can be configured as required.

**CP51M1**
The CP51M1 IE module is in a position to actively retrieve the time from up to four NTP time servers (e.g. SICLOCK TM).

**Additional information**
on the NTP clock synchronization technique, refer to: [www.ntp.org](http://www.ntp.org)

The following settings are required in HW config under the tab "Time synchronization" of the "Ind. Ethernet connection of the CP51M1":

- Enable the NTP technique
- Add the IP address of the NTP server or addresses of the servers (if there are several)
- Set the update interval (seconds)
The CP51M1 module retrieves the actual time from all configured NTP servers in the update interval (10 seconds is recommended). The time of the actual (best) NTP server is used. This means that the time supplied from all of the configured NTP servers cannot noticeably differ (<< 1 ms). If the time of the NTP servers deviate between one another, then “jumps” are possible in the time. The "best" NTP server is continually determined using among other things the runtime of the time interrogation.

Note: If more than one NTP server is configured, then only the NTP servers are used for the time synchronization that calibrated themselves with a reference clock (e.g. DCF77 or GPS) within the last 24 hours. If only one NTP server is configured, then this is used even if it was not synchronized with a reference clock.

Entries for important events are made in the CP51M1 diagnostics buffer – for example:

- Synchronization with an NTP server (coming/going)
- NTP server is not accepted
- Loss of the synchronization of the NTP server with reference clock

Note: If an SNTPR-FB has been configured for this CP51M1 and in addition an NTP, then the time, determined by SNTPR is distributed in the TDC rack. The time determined using the NTP technique is only used to set the module clock of the CP51M1 module. An appropriate entry is made in the diagnostics buffer.
3.15 Communications with SIMATIC Operator Panels

Introduction

A configuring engineer will be shown how to implement a coupling from SIMATIC TDC to a SIMATIC OP7 using this configuring software example.

NOTE

Proceed in a similar fashion when configuring couplings to the OP27, OP37 SIMATIC Operator Panels and the TP37 SIMATIC Touch Panel.

The example described here, includes all of the available SIMATIC TDC function blocks, and shows how they are essentially used. The functional scope of the configuring software example has been consciously kept extremely low, so that you can quickly get to grips with the subject. It is simply possible to expand the functionality and/or the hardware components. However, the information provided in the applicable function block documentation must be observed.

The designations used for data blocks, flags, variables etc. have been randomly selected, and are only binding for this particular configuration software example.

NOTE

- When saving values which have been changed using SIMATIC Ops, this is realized on the SIMATIC TDC CPU in the SAVE area.

- When the battery back-up fails, the configured value at the input is used as default.

Prerequisites

The structure of these configuring instructions represents the sequence of the various operating steps, with which the complete configuring software can be generated. However, it should only be considered as a recommendation, and is not mandatory.

We are assuming that you know how to handle the SIMATIC Manager (including HWConfig and CFC), configuring SIMATIC TDC as well as configuring OP7 with ProTool/Lite.

Literature which is available on these subjects:

- SIMATIC TDC User Manuals
- SIMATIC Equipment Manual OP7/17
- SIMATIC HMI, User Manual
  ProTool/Lite configuring software

3.15.1 Configuring example

Functional scope

The configuring software example supports the following OP7 functions:

- Reading and writing variables
- Output of operating messages
- Output of alarm messages including acknowledgment
• Interrogating the function keyboard
• Updating date and time

**Hardware**

The following equipment and components are selected and located as follows for the configuration example:

![Diagram of SIMATIC TDC configuration example](image)

---

### 3.15.2 Configuring SIMATIC TDC

#### General information

All of the configuring, which involves SIMATIC TDC, is made in the SIMATIC Manager. The work is divided into the "Selecting components in HWConfig" and "Configuring with CFC" sections.

#### 3.15.2.1 Selecting the components in HWConfig

The configuration example is configured in HWConfig. The standard program inputs can be accepted. The only changes involved:

- Sampling time $T_4$ of the CPU550 = **64ms**
- Highest MPI address of the MPI interface onto CP50M1 / CP50M0 = **126** (126 is entered as standard in ProTool/Lite)
- The first interface as MPI configured

#### 3.15.2.2 Configuring with CFC

After executing "Save and compile" in the "HWConfig", the "D01_P1" symbol was inserted in the SIMATIC Manager below the "SIMADYN D station".
A new chart, called "OP7" is added, in the associated chart container, to the existing charts "@SIMD1" and "@SIMD2". All of the additional configuring work will now be made in a new chart called "OP7".

- All of the function blocks to be configured are configured in the sequence level T4.
- If not explicitly listed, the standard assignments of the function block connections are kept.
- Only the relevant connections are listed in the following configuring tables.

### 3.15.2.2.1 Initializing the OP7

**Brief description**
The function blocks @MPI and S7OS are connected to the configured coupling module (first interface onto CP50M1/CP550M0) via the CTS inputs. This establishes the connection between SIMATIC TDC and OP7.

<table>
<thead>
<tr>
<th>Configured software</th>
<th>FB</th>
<th>Connection</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>@MPI</td>
<td>CTS</td>
<td>D0200C.X01</td>
<td>(global operand, module name)</td>
</tr>
<tr>
<td>S7OS</td>
<td>CTS</td>
<td>D0200C.X01</td>
<td>(global operand, module name)</td>
</tr>
<tr>
<td></td>
<td>US</td>
<td>testop.01</td>
<td>(address parameter)</td>
</tr>
</tbody>
</table>

*Table 3-46 Connection assignment @MPI and S7OS*

### 3.15.2.2.2 Reading function block connections (I/O)

**Brief description**
A counter was configured for this function, which continually increments from the initial value ("0") up to a final value ("50"). It then automatically resets itself and starts again from the beginning. Output Y (counter status) of the CTR is interlocked with a global operand (OP connection), whose contents are read-out at OP7.

**NOTE**
The flag No., specified under SIMATIC TDC for the OP connection, must also be assigned the configured variables under ProTool/Lite.
### 3.15.2.2.3 Writing function block connections

**Brief description**
A value from OP7 is read-in using a global operand (OP connection), fed through a dummy block (NOP1_I), and is sent back to the OP7 with an additional global operand (OP connection); it is read-out from the OP7.

**NOTE**
The flag No. for the OP connections, specified under SIMATIC TDC, must also be assigned the configured variables under ProTool/Lite.

<table>
<thead>
<tr>
<th>Configured software</th>
<th>FB</th>
<th>Connection</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOP1_I</td>
<td>X</td>
<td>Symbol name: <strong>OP_SOLL</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flag No.: MW20</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(global operand, OP connection)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y</td>
<td>Symbol name: <strong>OP_IST</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flag No.: MW30</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(global operand, OP connection)</td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-48** Connection assignment, NOP1_I

### 3.15.2.2.4 Configuring events

**Brief description**
If the counter starts a new count loop, an event is output. Output **QO** of function block **CTR** outputs the signal. This signal is extended (FB PDF), converted from the "boolean" format into the "word" format (FB B_W), and transferred to function block **S7EMA** as the first event message word.

The **S7EMA** is assigned a virtual data block number for the user data area "event messages" via a global operand (OP connection).

**NOTE**
The data block No., specified under SIMATIC TDC for the OP connection, must also be assigned the configured area pointer for event messages under ProTool/Lite.
### 3.15.2.2.5 Configuring alarm messages

<table>
<thead>
<tr>
<th>Configured software</th>
<th>FB</th>
<th>Connection</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>I</td>
<td></td>
<td>Function block CTR, output QO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(event message signal)</td>
</tr>
<tr>
<td></td>
<td>T</td>
<td></td>
<td>5000ms (time constant)</td>
</tr>
<tr>
<td>B_W</td>
<td>XDB</td>
<td></td>
<td>Symbol name: BM</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Data block No: DB1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(global operand, OP connection)</td>
</tr>
</tbody>
</table>

Table 3-49 Connection assignment, @MPI and STOS

**Brief description**

If the counter starts a new count loop a alarm message is output (at the same time as the event message). Output QO of function block CTR supplies the signal. This signal is converted from the "boolean" format into the "word" format (FB B_W), and is transferred to function block S7AMA as the first event message word.

S7AMA is assigned a virtual data block No. for the user data area "alarm messages" via a global operand (OP connection).

**NOTE**

The data block No. for the OP connection, assigned under SIMATIC TDC, must also be assigned the configured area pointer for alarm messages under ProTool/Lite.

### 3.15.2.2.6 Configuring the function keyboard

<table>
<thead>
<tr>
<th>Configured software</th>
<th>FB</th>
<th>Connection</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>B_W</td>
<td>I</td>
<td></td>
<td>Function block CTR, output QO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(signal for the alarm message)</td>
</tr>
<tr>
<td>S7AMA</td>
<td>XDB</td>
<td></td>
<td>Symbol name: SM</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Data block No.: DB10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(global operand, OP connection)</td>
</tr>
</tbody>
</table>

Table 3-50 Connection assignment, B_W and S7AMA

**Brief description**

The configuring of the function keyboard includes, on the SIMADYN D side, only the S7FKA function block. The actual assignment of the key functions is realized under ProTool/Lite.

S7FKA is assigned, via a global operand (OP connection) a virtual data block No. for the user data area "function keyboard image".

**NOTE**

The data block No., assigned under SIMATIC TDC, for the OP connection, must also be assigned the configured area pointer for the function keyboard under ProTool/Lite.
### Configuring the interface area

**Brief description**

The time and date of the OP7 is cyclically updated by SIMATIC TDC using this function. S7IA is assigned, via a global operand (OP connection) a virtual data block No. for the user data area “interface area”.

**NOTE**

The data block No., assigned under SIMATIC TDC, for the OP connection, must also be assigned the configured area pointer for the interface area under ProTool/Lite.

**Configured software**

<table>
<thead>
<tr>
<th>FB</th>
<th>Connection</th>
<th>Connection assignment (significance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7FKA</td>
<td>XDB</td>
<td>Symbol name: FK_Tast</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data block No.: DB20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(global operand, OP connection)</td>
</tr>
</tbody>
</table>

### Importing the symbol table

**General information**

While configuring the CPU in HWConfig an empty symbol table is automatically set-up, which will later accept the symbol names configured using CFC. The file with the symbol names must then be imported into the symbol table when the CFC has been configured.

**Symbol editor**

The symbol editor is opened from the chart container by double-clicking on "Symbols".

The symbol file (symbol.asc) is loaded in the symbol table using the menu command “Import table...”.

**NOTE**

If changes are made in the symbol file in the CFC between two compilations, then a message to this effect is output. This message can also be taken from the actual memory path of the symbol file.
Communications configuring

The following diagram shows the complete symbol table of the test software after having been imported:

![Symbol table with imported symbol file](image)

The symbol table is saved and the operation completed using "Save table".

### 3.15.3 Configuring the OP7 with ProTool/Lite

#### General information

The configuring of OP7 is not described in detail here. If not explicitly mentioned, when configuring, the standard settings can be taken from ProTool/Lite.

#### NOTE

For error-free communications, it is absolutely necessary, that the flag- and data block numbers, configured in CFC, are transferred for the individual functions, unchanged, into ProTool/Lite.

#### Symbol table

CFC generates a symbol table, in which all of the flags and data blocks used are saved. This symbol table must be imported for the configuring work for ProTool/Lite.

The symbol names, configured in CFC for the OP7 configuring, can now be used in ProTool/Lite.
Configuring software

Configured software with displays (including variables to read and write values), event- and alarm messages as well as configured function keys must be generated for the OP7.

The following table provides an overview of the required configuring components with the associated values, harmonized and adapted to the CFC configured software:

<table>
<thead>
<tr>
<th>Configured software</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control</td>
<td>SIMATIC S7-300/400</td>
</tr>
<tr>
<td>MPI settings</td>
<td>Communications partner slot: 1</td>
</tr>
<tr>
<td>Variables to read the function block connections (I/O)</td>
<td>Symbol name: \textit{Z_Ausgabe} (\textit{VAR_1}: Format &quot;INT&quot;, type &quot;A&quot; area &quot;M&quot;, MW10)</td>
</tr>
</tbody>
</table>
|Variables to write into the function block connections (I/O) | Symbol name: \textit{OP\_SOLL} (\textit{VAR\_2}: Format "INT", type "E" area "M", MW20)  
Symbol name: \textit{OP\_IST} (\textit{VAR\_3}: Format "INT", type "A" area "M", MW30) |
| Area pointer, event messages | Symbol name: \textit{BM} (DB1, DBW0, length "8" words) |
| Area pointer, alarm messages | Symbol name: \textit{SM} (DB10, DBW0, length "8" words) |
| Area pointer, acknowledge PLC | DB10, DBW16, length "8" words |
| Area pointer, acknowledge OP | DB10, DBW32, length "8" words |
| Area pointer, function keyboard | Symbol name: \textit{FK\_Tast} (DB20, DBW0, length "1" word) |
| Area pointer, interface area | Symbol name: \textit{SB} (DB30, DBW0, length "16" words) |

### 3.15.4 Application information

#### 3.15.4.1 Computation times

**General information** The computation times of the function blocks are dependent on the application.

The computation times of the function blocks for an OP7 are listed in the following table. Each additional configured OP7 correspondingly increases the computation time.

<table>
<thead>
<tr>
<th></th>
<th>S7OS</th>
<th>S7EMA</th>
<th>S7AMA</th>
<th>S7FKA</th>
<th>S7IA</th>
</tr>
</thead>
<tbody>
<tr>
<td>One OP7</td>
<td>120</td>
<td>2</td>
<td>33</td>
<td>22</td>
<td>18</td>
</tr>
<tr>
<td>Each additional OP7</td>
<td>55</td>
<td>2</td>
<td>33</td>
<td>22</td>
<td>18</td>
</tr>
</tbody>
</table>
3.16 WinCC connection to SIMATIC TDC via the standard channel (SIMATIC S7 Protocol Suite.CHN)

The chapter describes the procedure when configuring the access to process variables (block connections) of a SIMATIC TDC CPU via the "standard channel" using WinCC. The various configuring and coupling options are shown in the following diagram.

The coupling via TCP/IP using the FB property "OCM" functions (Operator Control and Monitoring), when creating an address book, is completely described.

The special features of the configuration version with function block "S7DB_P" that supersedes to create an address book, is described in the following chapter.

An explanation is then given on how to use the MPI and PROFIBUS DP coupling types. (When using a PROFIBUS DP coupling for visualization purposes, it should however be taken into account that this coupling - generally used as fast drive coupling - is possibly slowed down by the HMI signals.)

The use of the D7-SYS-OS engineering tool (WinCC mapper) is then explained.
3.16.1 Coupling via TCP/IP with "OCM" functions

This chapter describes the procedure when configuring the access to process variables (block connections) of a SIMATIC TDC CPU using WinCC.

3.16.1.1 Configuring the coupling-relevant TDC hardware

A CP51M1 should be configured as communication module in the SIMATIC TDC rack for the TCP/IP coupling.
Click on the properties button to open a window for inserting a subnet and defining the IP address.
3.16.1.2 Configuring the CFC

3.16.1.2.1 Configuring the coupling-relevant CFC function blocks

Configuring a function block to initialize the TCP/IP interface ("X01") of the CP51M1 module at slot 14 ("D1400C"). The function block should be configured in a task between 32 and 256 ms.

"Slot.front connector" of the communication module
Configuring the "S7OS" function block to initialize the OS communication on the "CPU 01" located in slot 1. Instead of the "S7OS" block, block "SER" could also be used. However, this could have a negative influence on the response times. Details regarding this issue can be taken from the description of the function block.
3.16.1.2.2 Marking the function block connections in the CFC charts and creating the address book

The block connections, which must be handled and monitored (OCM) using WinCC must initially be marked in the CFC charts as OCM-capable. To do this, you must proceed in the following steps:

1. Open the Properties dialog box of the block, set the checkmark for "OCM possible" and then press the "Operator C and M" button (refer to the following diagram).

![Properties dialog box screenshot with instructions]
2. In the dialog box that is then displayed, set the checkmark for "Complete block structure", if all connections of the selected block are to be OCM-capable (refer to the following diagram). If only individual connections are to be selected then skip this step and continue with Step 3.
3. Individually mark the OCM-capable connections in the WinCC attribute tab if not all of the connections are to be selected as in Step 2 (refer to the next screenshot).

4. Repeat steps 2 and 3 for all of the blocks that are to be controlled and monitored.
5. Select the address book creation in the option dialog box to compile from CFC (Options → Customize → Compile/download) (refer to the next screenshot), in order to obtain the address information for the WinCC configuration.

The address book is created when compiling. This then completes all of the activities necessary in the CFC charts. Access using WinCC is possible after it has been downloaded into the target system.

A "D7-SYS-OS engineering tool" – called "Mapper" in the following – is supplied with D7-SYS version 7.1. When run (executed), the tool sets-up a tag (WinCC variable) for each of the function block connectors that was marked.

If this mapper is used, then the workflow can be exited at this point and the work continued in Section 3.16.4.
Communications configuring

The DB numbers and offsets of the individual connections, necessary to configure WinCC, can now be taken from the address book. A log can be found under the menu item "Options>Logs" in which information is provided as to where the address book has been saved.

The location where the address book is saved is marked in the following log diagram:
The WinCC-relevant information - such as data block number and offset of the selected function block connectors – can now be taken from the address book.
3.16.1.3 Configuring WinCC

When configuring WinCC, proceed in the following steps:

1. Start the WinCC Control Center.
2. Set-up a new project or open an existing one.
3. By selecting Tag Management \rightarrow right-hand mouse key \rightarrow Add New Driver \rightarrow SIMATIC S7 Protocol Suite.CHN \rightarrow Open set-up a new driver. If this already exists, then continue with the next step.
4. Set-up a new connection by selecting TCP/IP \rightarrow right-hand mouse key \rightarrow New Driver Connection.
5. To do this, assign a name to the connection in the dialog box, press the properties button and enter the parameter for the connection (TCP/IP address and slot can be taken from HW Config; refer to the following screenshot).

A new TCP/IP connection is created after the dialog box is exited with OK.
6. **Setting-up tags:** Select the connection that has just been set-up using the righthand mouse key and select "New Tag" in the menu that is displayed.

![Image of WinCC Explorer](image)

7. In the dialog box that opens, enter a variable name (e.g. function block name_connection name, however, any other name can also be specified).
   The data type of the selected connector, taken from the CFC configuring or from the address book created, can be set under "Data Type" (a reference table of the various data types can be found later on).
   The address dialog box is opened by pressing the "Select" button. The DB number and the offset are specified in this address dialog box.
   Take this data for the particular connection from the address book created when the CFC was compiled (refer to the next screenshot).
Communications configuring
8. After entering the appropriate data and exiting the dialog boxes with OK, a variable is set-up in WinCC for the selected block connection.

9. For additional block connections required, the procedure from step 6 onwards should be repeated.

10. In the input window "System Parameter" the driver (TCP / MPI → righthand mouse key → System Parameter) the checkmark for "Cycle management" must not be set (refer to the next screenshot).
11. The logical device name has to be select here.

12. Now, a reference can be made in the screen configuring to the tags that have been set-up in this way.

3.16.2 "S7DB" configuration version

When using the "S7DB_P" function block, the connection markings in the CFC charts and the creation of the address book are not required.

Instead of this, the "S7DB_P" function block should be configured with the appropriate pointer-based communication blocks. The block connections, which must be accessed from WinCC, must be connected-up to the S7DB_P function block using "pointer-based communication blocks". Function block S7DB_P sets-up a data block for this data. Please proceed with the following steps:

1. Configure function block S7DB_P. With a righthand mouse click in connector "XDB", select "Interconnection to operands" and specify the required DB number.

2. Connect each connector to be visualized (e.g. as in the next diagram): Connectors "X" and "Y" of the "Integrator" function block to a dedicated pointer-based communication block from the "pointer com" family of function blocks corresponding to the particular connector type (e.g.: "DRD" function block for read real variables).

3. Connect connector "PTR" of the S7DB_P to the "PTR" connectors of all pointer-based communication blocks.
4. Take the data block number (e.g.: DB1) from the sheet bar and the offset from the pointer-based communication block connector (OF1 + OF2) of the CFC configuring, open the address dialog box by pressing the "Select" button, and then specify the DB number and the offset in this address dialog box (Refer to the next screenshot). Then close the input window with OK.

All of the other configuring steps do not differ from the procedure when using OCM functions.
3.16.3 MPI and PROFIBUS DP coupling versions

The deviations relating to either an MPI or DP coupling - when compared to the TCP coupling – that must be taken into account are described in the following chapter.

3.16.3.1 Hardware configuration

For a PROFIBUS DP or MPI coupling, as shown in the following example, a CP50M1 is to be configured with the appropriate coupling type.

1. Double click on the required CP50M1 interface.
2. Click on "Properties" under the "General" tab.
3. In the next window, insert a new "Subnet" by clicking on "New".

4. If required, change the name and open the "Network Settings" tab.
5. Select the required baud rate in the next window.

![Properties - PROFIBUS window]

6. Close this window and set the address in the next window. Then close all of the other windows with "OK".

![Properties - PROFIBUS interface DP (R0/S7.2) window]
7. This means that the PROFIBUS DP or MPI line is configured as shown in the next screenshot.
The station address and slot between the TDC station and WinCC should then be aligned as follows:
3.16.3.2 Configuring the CFC

To initialize the MPI or DP coupling, the corresponding "@MPI" or "@PRODP" central block should be configured in a task between 32 and 256 ms. The CTS connector should be interconnected to the CP50M1 slot and its front connector.

In addition, the "S7OS" function block should also be configured in a task between 32 and 256 ms and interconnected as follows:

3.16.3.3 Configuring WinCC

1. Set up a new driver by selecting Tag Management → righthand mouse key → Add New Driver → SIMATIC S7 Protocol Suite.CHN → Open.
   If this already exists, then continue with the next step.

2. Set-up a new connection by selecting MPI → righthand mouse key → New Driver Connection
   If a PROFIBUS DP- coupling is to be used, then this is set-up at this location in the same way
   PROFIBUS DP → righthand mouse key → New Driver Connection.
3. Assign a name in the dialog box, press the Properties button and enter the parameters for the connection.

4. In the WinCC input screen "Connection Parameter" the station address and the slot number - as shown in the following diagram - should be taken from the HW configuration.

The remaining configuring steps do not differ from those associated with a TCP/IP coupling, and should therefore be taken from the previous chapter.
3.16.4 Configuring using the "D7-SYS-OS engineering tool"

The "D7-SYS engineering tool" - also called "Mapper" in the following text - sets-up tags for the selected connectors of the CFC function blocks. These tags can then be further processed by WinCC. The following chapter describes how to use this tool.

Calling the mapper:

Prerequisites for mapping:

- Select the CFC function block connectors and then compile with the "Create address book" option activated, as described in the previous chapter.
- Inserted PC station with communication module and WinCC application.
- The "NetPro" configuration should be checked as to whether all stations are connected with one another via the required coupling types; for example, in this case, via TCP/IP. The same procedure should be used for MPI or DP couplings.
- A transfer to WinCC can only proceed, if the WinCC explorer has been started and the related WinCC project has been loaded.
After the call, the target project should be selected using the lefthand "Open" icon.
A Wizard is started by clicking twice on the 2nd icon (Wizard's hat):

Then click on "Continue":

The operator station is then selected as shown in the next screenshot:

Then click on "Continue":
The selection and assignment of the programs to the operator stations is then realized in the next step:

Displaying the selected programs:
If the connection parameters are to be checked, then click on "Connection". This is not absolutely necessary if "NetPro" has been correctly configured. However, if various couplings are used (TCP/IP, MPI or DP) then the required connection should be selected.

Then click on "Continue":

Then click on "Continue":

![Diagram showing network connection settings](image-url)
Then, start the actual mapping (transfer) process by clicking on "Transfer":

Transferring (mapping) then runs:

This therefore completes data transfer:

End by clicking on "OK".
The tags that have been created are listed in WinCC Explorer:

![WinCC Explorer screenshot]

The system parameters of the coupling, shown in the following diagrams, now have to be checked:
Deactivate cycle management by the automation system:

Select the device name:

After changing the system parameters WinCC has to be restarted. It will be possible to access the configured variables once this has been completed.
3.17 Communications with WinCC (TCP/IP)

Introduction
This User Manual shows you how you can couple WinCC to SIMATIC TDC via a TCP/IP coupling using a simple example of the configuring software. All of the necessary configuring steps (including the hardware- and software requirements) are described. The handling of the necessary software tools is not described here, but a reference is made to the appropriate User Manuals.

3.17.1 Prerequisites

Software

<table>
<thead>
<tr>
<th>TDC PMC TCP channel-DLL</th>
<th>Software prerequisites</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>WinCC-Systemsoftware: fom version 5.0 für Windows NT 4.0</td>
</tr>
<tr>
<td></td>
<td>SIMATIC TDC: PCS7 fom version 5.0 mit D7-SYS V5.1</td>
</tr>
<tr>
<td><strong>Order No. (SIMATIC TDC PMC TCP/IP)</strong></td>
<td>2XV9450-1WC43-0KX0</td>
</tr>
</tbody>
</table>

**Further information**
Siemens AG
Industrial Solutions and Services
IT Plant Solutions
I&S IT PS 3
Werner-von-Siemens-Straße, 60
91052 Erlangen

Contact: your IT4Industry Team
E-Mail: info@it4industry.de
WWW: http://www.it4industry.de

<table>
<thead>
<tr>
<th>Tools</th>
<th>PROBI:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The configuring package PROBI is component of every SIMADYN D-PMC licence.</td>
</tr>
</tbody>
</table>

Table 3-52 Software prerequisites

**NOTE**
The TDC PMC TCP channel-DLL can only be used in conjunction with WinCC from V5.0. The software is installed via a setup routine, which is provided on the product software floppy disk.

Table 3-53 Hardware prerequisites

Hardware
PC configuring station:

network card for TCP/IP, for example 3COM
### SIMATIC TDC hardware

<table>
<thead>
<tr>
<th>System</th>
<th>D7-SYS from V5.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subrack</td>
<td>UR5213</td>
</tr>
<tr>
<td>Slot 1</td>
<td>CPU550</td>
</tr>
<tr>
<td>Slot 1.1</td>
<td>MC500</td>
</tr>
<tr>
<td>Slot 2</td>
<td>CP50M1/CP50M0</td>
</tr>
<tr>
<td>Slot 18</td>
<td>CP51M1/CP5100</td>
</tr>
</tbody>
</table>

Table 3-54  Hardware design for the configuring example

### 3.17.2 Process variables

A SIMATIC TDC station must be configured and parameterized and a test chart generated using the CFC configuring tool. The hardware configuration is described under **Point 26.1 (SIMATIC TDC hardware design)**. We will not discuss in detail here how SIMATIC TDC software is generated using the CFC. If you require further information refer to the Configuring Instructions.

#### 3.17.2.1 SIMATIC TDC software

The CFC chart for the WinCC link does not have to be realized on a separate chart, but is however recommended as this is more transparent. The following function blocks are required for the coupling between SIMATIC TDC and WinCC for process variables:

- LI - LAN interface block
- VM visualization block
- VI interface block
- VC concentrator block
- CI interface block
- SER02 communications block

The blocks are connected as follows:

(Only the relevant I/O are described)
### Communications configuring

**FB LI**

<table>
<thead>
<tr>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>Name of the interface used (CP51M1/CP5100)</td>
<td>D1800C</td>
</tr>
<tr>
<td>AT</td>
<td>[channel name].[protocol].[local port-no]</td>
<td>ARC01.T-19001 with T for TCP/IP</td>
</tr>
<tr>
<td>NA</td>
<td>Maximum number of parallel jobs from WinCC</td>
<td>20</td>
</tr>
<tr>
<td>NC</td>
<td>WinCC ID</td>
<td>0</td>
</tr>
<tr>
<td>COM</td>
<td>Communications medium TCP/IP</td>
<td>3</td>
</tr>
<tr>
<td>CCV</td>
<td>Connection with VM, connection CVP</td>
<td>&lt;VM.CVP</td>
</tr>
<tr>
<td>CCF</td>
<td>No connection with the FM block</td>
<td>16#0</td>
</tr>
<tr>
<td>CCB</td>
<td>No connection with the MM block</td>
<td>16#0</td>
</tr>
</tbody>
</table>

**FB VM**

<table>
<thead>
<tr>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>NA</td>
<td>Sum of the jobs reserved for the VM</td>
<td>20</td>
</tr>
<tr>
<td>NL</td>
<td>No. of LI blocks</td>
<td>1</td>
</tr>
<tr>
<td>NV</td>
<td>No. of VI blocks</td>
<td>1</td>
</tr>
<tr>
<td>MEM</td>
<td>Default</td>
<td>0</td>
</tr>
<tr>
<td>TGL</td>
<td>Default</td>
<td>0</td>
</tr>
<tr>
<td>CVP</td>
<td>Connection with LI.CCV, VI.CCV</td>
<td>&gt;LI.CCV,VI.CCV</td>
</tr>
</tbody>
</table>

**FB VI**

<table>
<thead>
<tr>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>Processor name</td>
<td>D01P01</td>
</tr>
<tr>
<td>AT</td>
<td>Send channel name to the VC</td>
<td>'CMDVCH'</td>
</tr>
<tr>
<td>AR</td>
<td>Receive channel name from the VC</td>
<td>'ACKVCH'</td>
</tr>
<tr>
<td>CCV</td>
<td>Connection with VM, connection CVP</td>
<td>'VM.CVP'</td>
</tr>
</tbody>
</table>

**FB VC**

<table>
<thead>
<tr>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>Processor name</td>
<td>D01P01</td>
</tr>
<tr>
<td>AT</td>
<td>Send channel name to the VI</td>
<td>'ACKVCH'</td>
</tr>
<tr>
<td>AR</td>
<td>Receive channel name from the VI</td>
<td>'CMDVCH'</td>
</tr>
<tr>
<td>NC</td>
<td>No. of connected CIs</td>
<td>8</td>
</tr>
<tr>
<td>CVP</td>
<td>Connection with CI, connection CCV</td>
<td>&gt;(CI.CCV)</td>
</tr>
</tbody>
</table>
### Communications configuring

#### FB CI

<table>
<thead>
<tr>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>Processor name</td>
<td>D01P01</td>
</tr>
<tr>
<td>AT</td>
<td>Send channel name to the SER02</td>
<td>‘CMDH’</td>
</tr>
<tr>
<td>AR</td>
<td>Receive channel name from the SER02</td>
<td>‘ACKH’</td>
</tr>
<tr>
<td>ADT</td>
<td>Data channel name from the SER02</td>
<td>‘DATH’</td>
</tr>
<tr>
<td>CCV</td>
<td>Connection with VC, connection CVP</td>
<td>&lt;VC.CVP</td>
</tr>
</tbody>
</table>

#### FB SER02

<table>
<thead>
<tr>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>Processor name</td>
<td>D01P01</td>
</tr>
<tr>
<td>AT</td>
<td>Send channel name to the CI</td>
<td>‘ACKH’</td>
</tr>
<tr>
<td>AR</td>
<td>Receive channel name from the CI</td>
<td>‘CMDH’</td>
</tr>
<tr>
<td>ADT</td>
<td>Data channel name to the CI</td>
<td>‘DATH’</td>
</tr>
<tr>
<td>CLT</td>
<td>Length, send channel</td>
<td>116</td>
</tr>
<tr>
<td>CLR</td>
<td>Length, receive channel</td>
<td>524</td>
</tr>
<tr>
<td>CLD</td>
<td>Length, data channel</td>
<td>432</td>
</tr>
<tr>
<td>TPD</td>
<td>For operator control and visualization (HMI)</td>
<td>0</td>
</tr>
<tr>
<td>NL</td>
<td>Maximum number of MWLs (measured value lists)</td>
<td>50</td>
</tr>
<tr>
<td>NV</td>
<td>Max. number of measured values (connections)</td>
<td>1000</td>
</tr>
</tbody>
</table>

**NOTE**
In addition, the @GLOB central block must be configured for the buffer memory module and the @TCP/IP central coupling block (in the case above, also the @LOCAL, as all of the connections are connected to D01P01).

#### FB @TCP/IP

<table>
<thead>
<tr>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>Name of the interface used (CP51M1/CP5100)</td>
<td>‘D1800C’</td>
</tr>
</tbody>
</table>

#### FB @GLOB

<table>
<thead>
<tr>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>Buffer memory module name</td>
<td>‘D0200A’</td>
</tr>
<tr>
<td>CDV</td>
<td>Memory re-structure (1)</td>
<td>0</td>
</tr>
</tbody>
</table>

#### 3.17.2.2 Configuring WinCC

For the particular example, it is sufficient to use a basic WinCC configuring software with several input/output fields.
We will not discuss the WinCC configuring software here. If you require further information refer to the comprehensive WinCC Configuring Manuals. We recommend the Getting Started SIMATIC WinCC Manual for an introduction into configuring WinCC.

### 3.17.3 Binary events

**SIMATIC TDC configuring software**

No additional configuring is required for process value visualization for the binary event technique with WinCC. The selection regarding which bit of a variable initiates which message is realized exclusively in WinCC. The configuring rules to output process variables remain.

**WinCC configuring software**

In addition to configuring software for the process variables, an ALARM logging configuring software must be generated. We will not discuss the WinCC configuring software here. If you require more detailed information, refer to the comprehensive WinCC Configuring Manuals. We recommend the Getting Started SIMATIC WinCC Manual for an introduction into configuring WinCC.

### 3.17.4 SIMATIC TDC messages

#### 3.17.4.1 SIMATIC TDC configuring software

To output messages from SIMATIC TDC to WinCC, the WinCC block MM is required in addition to configuring the process value output:

- MM message manager

The blocks are connected as follows:

(Only the relevant connections are described)

**FB MM**

<table>
<thead>
<tr>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTS</td>
<td>Processor name</td>
<td>D01P01</td>
</tr>
<tr>
<td>AR</td>
<td>Channel name</td>
<td>EMPFKANA</td>
</tr>
<tr>
<td></td>
<td>(This is identical with the AT connection of the MSI block)</td>
<td></td>
</tr>
<tr>
<td>NZ</td>
<td>No. of cycles per data transfer</td>
<td>5</td>
</tr>
<tr>
<td>NL</td>
<td>No. of connected LI blocks</td>
<td>1</td>
</tr>
<tr>
<td>MEM</td>
<td>Diagnostics triplet</td>
<td>0</td>
</tr>
<tr>
<td>TGL</td>
<td>Diagnostics triplet</td>
<td>0</td>
</tr>
<tr>
<td>CVP</td>
<td>Connection with LI, connection CCV</td>
<td>&gt;LI.CCV</td>
</tr>
</tbody>
</table>

**NOTE**

In addition, the following must be configured: Central message block @MSI, message output block MSI and the message block MERF0 or a other MERFxx.
3.17.4.2 WinCC configuring software

In addition to the configuring software for the process variables, an ALARM logging configuring software must be generated. The WinCC configuring software will not be discussed here. If you require information refer to the comprehensive WinCC Configuring Manuals. We recommend the Getting Started SIMATIC WinCC Manual for an introduction into configuring WinCC. The assignment of the SIMATIC TDC message numbers to the message blocks (RS* connections) to the message

<table>
<thead>
<tr>
<th>FB @MSI</th>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMS</td>
<td>Message system name</td>
<td>MYMELD</td>
<td></td>
</tr>
<tr>
<td>CMT</td>
<td>Message text (this is not output)</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>NOM</td>
<td>No. of messages which can be saved</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>SAV</td>
<td>Message buffer, buffered RAM</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>RP</td>
<td>Prefix for communication errors</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>MUN</td>
<td>Enable for message entries</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FB MSI</th>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMS</td>
<td>Message system name</td>
<td>MYMELD</td>
<td></td>
</tr>
<tr>
<td>CTS</td>
<td>Coupling module name</td>
<td>D01P01</td>
<td></td>
</tr>
<tr>
<td>AT</td>
<td>Address parameter</td>
<td>EMPFKANA</td>
<td></td>
</tr>
<tr>
<td>RP</td>
<td>Prefix for overflow messages</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>SNV</td>
<td>Output, message number</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>STM</td>
<td>Output, message text</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>STC</td>
<td>Output, message text constant length</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>SSF</td>
<td>Output format</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>EN</td>
<td>Enable</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MUN</td>
<td>Enable for message entries</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FB MERF0</th>
<th>I/O name</th>
<th>Significance</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMS</td>
<td>Message system name</td>
<td>MYMELD</td>
<td></td>
</tr>
<tr>
<td>MT</td>
<td>Message type</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>RP</td>
<td>Prefix</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>RS1</td>
<td>Suffix, incoming message</td>
<td>10001</td>
<td></td>
</tr>
<tr>
<td>RS2</td>
<td>Suffix, outgoing message</td>
<td>00005</td>
<td></td>
</tr>
<tr>
<td>EN</td>
<td>Message enable</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>IS1</td>
<td>Message trigger</td>
<td>16#0</td>
<td></td>
</tr>
<tr>
<td>SM</td>
<td>Save message</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
numbers, generated by WinCC, can only be identified by the "PMC message no", which is generated from the message numbers of the signal list.

3.17.5 Generating the address book using the CFC editor

To generate the signal list for WinCC, ADRIMP requires the symbol information of the SIMATIC TDC processors. For each CPU, SIMATIC TDC generates an ASCII file, which contains this information. The file name consists of the subrack names and the CPU number, separated by a "_". "ADR" is used as extension.

The address book is generated by calling-up the required project chart, and selecting the menu items Options - Settings compilation.... Then mark the Option, Create address book, and enter OK. Call-up the menu items Chart compilation. The address book is now created when compiling. The path of the generated address book is then located via the menu items Options - Report.

---

NOTE

All connections in SIMATIC TDC which should be controlled by WinCC have to be activated for operator control and monitoring (Refer to Manual “D7-SYS - STEP 7, CFC and SFC configuring, chapter 2.1.6.1”).

---

3.17.6 Address list import tool ADRIMP

In order that WinCC can interpret the addresses of the SIMATIC TDC path names, the ADRIMP address list tool is required. The ADRIMP address list tool allows text address lists (TALI) to be listed in the WinCC data base. A precise description is provided in the User Manual TDC PMC TCP channel DLL for WinCC.

3.17.6.1 Prerequisites

A variable definition file must exist, and the SIMATIC TDC address book must have been previously generated. The variable definition file and the address book must be located in the same path. The generation path can be different, but should also be generated in this path to enhance the software transparency.

3.17.6.1.1 Generating the variable definition file

The variable definition file is a text file, which must be generated by the user. The variable definition file consists of two defined header lines (1. and 2.), followed by the assignment of symbolic names to the connection path names. The symbolic names can be freely selected, but should be the same as those used in the WinCC text fields to ensure transparency.
Excerpt from the variable definition file

E.g.: winccvar.txt
1.) [VDM:wincc]
2.) [PN:A000_1,C:\wincc\vardatei]
3.) MOTOR_EIN,ANBIND.CI.CCV
   MOTOR_AUS,ANBIND.CI.YTS

3.17.6.1.2 Generating and importing a new signal list

Prerequisites Before generating and importing the signal list, the TDC PMC TCP driver must be installed in the WinCC configuring software.

- Call-up the WinCC configuring software
- Click-on tag management
- Click-on the menu item "Add new driver"
- Select the TDC PMC TCP.chn

If no WinCC configuring software is started before ADRIMP starts, when importing the signal list, the last configuring software which was used, is used.

Execution

- Call-up ADRIMP
- Select the "File" menu item
- Select the "Probi" menu item
- Search for the variable definition file (e.g.: winvar.txt)
- Define the generation path
- Generate the signal list (e.g.: wincc.txt)
- Exit Probi

Note ADRIMP automatically imports the signal list into the tag management of the appropriate WinCC data administration.

3.17.6.1.3 Importing an existing signal list

- Start WinCC with the required project
- Call-up ADRIMP
- Select the "File" menu item
Communications configuring

- Select the "Open" menu item
- Select the signal list (e.g.: wincc.txt)
- Exit ADRIMP

NOTE  ADRIMP automatically imports the signal list into the tag management of the appropriate WinCC data administration.

3.17.6.2 Checking the generated tag management in WinCC

Check the imported data, their symbolic names, data formats and path names:

- Call-up the WinCC configuring software
- Select the variables tag management
- Click-on the logical connection (corresponds to the VDM name)
- Select TDC PMC TCP
- Select the logical connection names

The logical names and path names, defined in the variables file, is displayed. The data formats are also displayed. WinCC can now access these variables.

3.17.7 Communications set-up, SIMATIC TDC-WinCC

3.17.7.1 Activating WinCC

In order to establish communications between SIMATIC TDC and WinCC, the imported data of the WinCC database must be assigned to the input/output fields of the graphic configuring software. This is realized by selecting the appropriate fields in the Graphics Designer and clicking on the interactive configuration dialog. Each field can be assigned one of the imported variables. After this assignment has been made, the File menu item is selected in the main menu, and the data are saved. Before starting runtime, the connection properties must be set.

In the Control Center

- Click-on tag management
- Click-on TDC PMC TCP
- With the righthand mouse key click-on TCP/IP Unit 1
- Click-on properties
- Click-on the properties, Channel Unit (configure PMC parameter)
• Click-on the connection

Enter the TCP/IP address for the AG (PLC) (local/remote)

Port no. (local/remote)

• Confirm with OK

• Select "File" in the Control Center

• Click-on activate

WinCC is now ready to transfer data between SIMATIC TDC and WinCC

3.17.7.2 Activating SIMATIC TDC

Power-up the configured subracks. After the subracks have run-up, the connection has been established between SIMATIC TDC and WinCC. Data is now cyclically transferred between SIMATIC TDC and WinCC.
3.18 Communications service Trace

Three different services exist for the trace value recordings:

- **Simple Trace**
  It only contains an output interface.

- **System Trace**
  It contains an interactive interface (request and reply interface). The user must develop his own tool in order to utilize the system trace. This tool must be capable of fully utilizing the system trace request/reply language. For this reason, the system trace will not be described further at this point. The interface specification and the configuring guide can be obtained from the ASI 1 R department.

- **Analog Trace**
  It contains no data interface. This service is only processed with the function blocks TRCC, TRCC_D and TRCC_I. A description is not be found in this configuring guide. The function is described in detail in chapter 7 of the "Standard Function Blocks P32" catalog.

3.18.1 Simple Trace

The simple trace permits values from local processor connectors to be recorded, saved and output. The simple trace consists of a control block @TCP and one or several acquisition blocks TRP, TRP_B, TRP_D and TRP_I or TRHI. Any number of acquisition blocks can be configured in any number of sampling times.

3.18.1.1 Method of Operation of the @TCP

The @TCP consists of essentially the following tasks:

- Control of the trace value acquisition blocks TRP, TRP_B, TRP_D and TRP_I.
- Output of recorded values.
- Error Handling.

These tasks are described in detail in the following.

**Control of the Trace Value Acquisition**

The recording and output of trace values is controlled by the input connectors STA and TBR of the @TCP.
Recording Trace Values

A recording of the acquisition blocks is initiated in the following manner:

- R Connector: 0
- TBR Connector: 0
- STA Connector: Transition from 0 to 1

The recording is active until a transition from 1 to 0 is detected at the STA connector (a premature termination of the trace value recording by a reset will not be considered at this point). During an active recording, the @TCP is in the record mode. The recording of trace values is terminated when a transition from 1 to 0 is detected at the STA connector. If the value 0 is defined at the input connector TDC, then the trace value recording is immediately terminated. Otherwise the @TCP FB waits for the number of cycles, defined at the TDC, to terminate the trace value recording.

Output of Trace Values

An output of trace values by the @TCP can be implemented as follows after terminating a trace value recording:

- R Connector: 0
- TBR Connector: Transition from 0 to 1
- STA Connector: 0
- OUT Connector: Group telegram output (yes / no)
- CID Connector: When no group telegram output: number of connectors, whose recorded values are to be output.

During an active output, the @TCP is in the so called output state (a temporary status change into the wait state is possible, as long as the data interface is temporarily not accessible).

In principle, two possibilities are available for the output of trace values:

- All trace values of all acquisition blocks are transmitted together in one telegram. This is the case when the connector OUT has the value of 1.
- An acquisition block, whose trace values are to be output, is selected via the CID connector. The recorded trace values are output via the data interface in the form of one or several reply telegrams. If the recorded values, for a connector, cannot be transmitted together in one reply telegram, then further (follow up) reply telegrams are automatically transmitted. The logical sequence of the follow up telegrams is contained in two counters within the telegram: counter number of packets, describes the number of packets required to output all the values of the corresponding connector. The counter packet number, describes the number of the current packet (the numbering convention that this is based on is described in the following section). An output is terminated when either all existing trace values have been output or a transition from 1 to 0 occurs at the TBR connector.
3.18.1.2 Method of Operation of the Acquisition Blocks

The acquisition blocks TRP, TRP_B, TRP_D and TRP_I have the following tasks:

- Recording the desired input variables (trace recording),
- Error handling.

The method of operation of all acquisition blocks is identical. They differ only with regard to the format with which the input variables are to be recorded (TRP = Real, TRP_B = BOOL, TRP_D = Double Integer, TRP_I = Integer).

Trace Recording

Each acquisition block records the values of its input connector and saves them into a ring buffer. Each acquisition block is allocated one ring buffer. The ring buffer is allocated at the start of the cyclic phase. The total trace buffer memory, whose size is determined by the connector TBL of the @TCP FB, is distributed to the ring buffers. The ring buffers are defined such that each ring buffer can record the same number of values.

The acquisition blocks record exactly one value per cycle, as long as the trace value acquisition has been activated by the central block @TCP. If connectors are recorded by acquisition blocks, configured in the interrupt layer (acyclic recording), then the acquisition time point, consisting of date and time of day, is additionally entered into the trace buffer with each trace value. No values are recorded by the acquisition blocks when the trace value acquisition is deactivated by the @TCP. If the SSF connector of the @TCP is set to 1, then the trace values are recorded by the acquisition blocks in the standardized form as floating point numbers (Real values).

Error Handling

If a communication error occurs, then an entry is made into the communication error panel and the corresponding acquisition block is disabled (QTS connector = 0). The communication error number is additionally available at the YTS connector.
NOTE
The disconnection of TRP, TRP_B, TRP_D oder TRP_I after an occurrence of a communication error has no influence on the other blocks of the simple trace, as long as at least one other configured functional acquisition block is available. The cause of the error as well as the guide to resolving the error can be reviewed in “D7-SYS - Errorcodes for fast access”.

3.18.1.3 Method of Operation of the Header Block TRHI

The header block holds parameters for the group telegram. A group telegram is generated when the connector OUT of the @TCP FB has the value of 1.

The header block TRHI only affects a trace system, when a group telegram output has been configured.

The configuring of a TRHI FB has no practical consideration when no group telegram has been configured.

NOTE
Configuring a TRHI FB only affects the layout of a group telegram. See also the section “Reply Telegrams”.
3.18.1.4 Simple Trace Configuring

The simple trace can be configured once (exactly 1 @TCP) or multiply (more than 1 @TCP on a P32).

Exacty One Simple Trace

Exactly one control block @TCP and at least one acquisition block TRP, TRP_B, TRP_D or TRP_I must be configured for exactly one simple trace. The following configuring regulations are mandatory:

- @TCP and acquisition blocks of a simple trace possess the same identifiers at the TRC connector.
- The value at the TBL connector of the @TCP must be larger than zero.
- All acquisition blocks possess unique, i.e. differing, number ID’s at the CID connector.
- The acquisition blocks can be configured in differing sampling times.
- At least one acquisition block (any number are permitted) must be configured.
- A maximum of 255 acquisition blocks can be configured when group telegram outputs are desired (connector OUT of the @TCP FB = 1).

Example: Assignment of the Initialization Connectors for Configuring Exactly one Simple Trace mit vier Erfassungsbausteinen und Sammeltelegrammausgabe.

Fig. 3-94 Example for configuring of one Simple Trace
In addition to configuring a simple trace, it is possible to configure several simple traces in parallel.

A simple trace is formed exactly by its blocks, that have identical identifiers at the TRC connectors. The following supplementary configuring regulations are valid, in addition to the configuring regulations described in the previous section.

**All configured @TCP blocks must have unique, i.e. differing, TRC identifiers.**

**Example:** Assignment of the Initialization Connectors for Configuring Two Simple Trace.

![Example diagram](image-url)

**Fig. 3-95 Example for configuring of two Simple Trace**
### 3.18.1.5 Reply Telegrams

The reply telegrams, generated by @TCP FB, are dependent upon the value of the connector OUT at the @TCP FB. If the connector has the value 0, then individual telegrams are generated and the same output format as known in the system trace is utilized. When individual telegrams are utilized, then an acquisition block is selected, whose trace values are to be output in one or several telegrams, via the CID connector of the @TCP FB. A group telegram is generated when the OUT connector has the value 1. A group telegram is characterized that it contains all the trace values of all the acquisition blocks. Information at the CID connector of the @TRP FB is then not necessary.

#### Individual Telegrams

An individual telegram is generated by the simple trace when the initialization connector OUT of the @TCP contains 0. The telegram has the following layout:

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Contents</th>
<th>Data Format</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1, 2</td>
<td>Connector ID Number</td>
<td>unsigned int16</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Output Format</td>
<td>char</td>
<td>0 = Binary, 1 = Standardized</td>
</tr>
<tr>
<td>4</td>
<td>Connector Interpretation</td>
<td>char</td>
<td>1 - 12</td>
</tr>
<tr>
<td>5 bis 10</td>
<td>Last Acquisition Time Point</td>
<td>6 chars</td>
<td></td>
</tr>
<tr>
<td>11, 12</td>
<td>Packet Number</td>
<td>unsigned int16</td>
<td></td>
</tr>
<tr>
<td>13, 14</td>
<td>Number of Packets</td>
<td>unsigned int16</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Record Mode</td>
<td>char</td>
<td>0 = Cyclic, 1 = Interrupt Task</td>
</tr>
<tr>
<td>16</td>
<td>Connector Format</td>
<td>char</td>
<td></td>
</tr>
<tr>
<td>17 bis 20</td>
<td>Sampling Time</td>
<td>unsigned int32</td>
<td>Information in 1/10 ms</td>
</tr>
<tr>
<td>21, 22</td>
<td>Request Identifier</td>
<td>unsigned int16</td>
<td></td>
</tr>
<tr>
<td>23, 24</td>
<td>No. of Blocks in Trace Buffer</td>
<td>unsigned int16</td>
<td></td>
</tr>
<tr>
<td>25, 26</td>
<td>No. of Blocks in Telegram</td>
<td>unsigned int16</td>
<td></td>
</tr>
<tr>
<td>27, 28</td>
<td>Empty</td>
<td>unsigned int16</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE**

Telegram Body: From 29 Trace Value Blocks See the following description.

The **connector ID number** identifies the acquisition block whose trace values are to be output by the telegram. This information is identical with the information at the input connector CID of the @TCP FB.

The **output format** defines the format of the trace values in the trace value blocks. A binary format causes the connectors to output in their data types. In standardized format, floating point values of a length of 4 bytes are always utilized.
The **connector interpretation contains** information regarding the type of recorded connector and can have the following values:

<table>
<thead>
<tr>
<th>Constant</th>
<th>Connector Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>N = Standard Interpretation</td>
</tr>
<tr>
<td>3</td>
<td>I = Whole Number</td>
</tr>
<tr>
<td>8</td>
<td>B = Boolean Value</td>
</tr>
</tbody>
</table>

The **last acquisition time point refers** to the last recorded trace value, as long as the recording has been implemented cyclically (this information has no significance for acyclic recordings). This trace value is the last trace value or trace value block in the telegram body with the packet number 0. The acquisition time point is transmitted in SIMADYN D format time and date (Time and Date See description „D7-SYS - SIMADYN D system and communication project planning“, chapter „Kompatible user data structures“).

The panels **packet number and number of packets sequentially** number the telegram. Each reply telegram to an (implemented) output command has two counters, that contain the current number of the packet and the total number of necessary packets required for transmitting all recorded values. The numbering convention is defined such that the last packet contains the packet number 0. If, for example, three reply telegrams are required for transmitting the trace value, then the following numbering sequence occurs:

**Example:**

<table>
<thead>
<tr>
<th></th>
<th>Reply Telegram 1st.</th>
<th>Reply Telegram 2nd</th>
<th>Reply Telegram 3rd..</th>
</tr>
</thead>
<tbody>
<tr>
<td>Packet Number</td>
<td>2</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Number of Packets</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>

The **record mode defines** whether the acquisition block is configured in a cyclic layer or an interrupt layer.

The **connector format defines** the size of the recorded trace values and can have the following values:

<table>
<thead>
<tr>
<th>Constants</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1-Byte (recorded by TRP_B block)</td>
</tr>
<tr>
<td>2</td>
<td>2. Byte (recorded by TRP_I block)</td>
</tr>
<tr>
<td>4</td>
<td>4-Byte (recorded by TRP_D block)</td>
</tr>
<tr>
<td>5</td>
<td>4-Byte standardized (recorded by TRP block)</td>
</tr>
</tbody>
</table>
The **sampling time** defines the sampling time of the corresponding acquisition block in 1/10 ms.

The **request identifier** contains information regarding the layer in which the corresponding acquisition blocks were configured:

<table>
<thead>
<tr>
<th>Sampling</th>
<th>Time Constants</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>0</td>
</tr>
<tr>
<td>T2</td>
<td>1</td>
</tr>
<tr>
<td>T3</td>
<td>2</td>
</tr>
<tr>
<td>T4</td>
<td>3</td>
</tr>
<tr>
<td>T5</td>
<td>4</td>
</tr>
</tbody>
</table>

**Interrupt Layer Constants**

<table>
<thead>
<tr>
<th></th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>I1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The **number of trace value blocks in the trace buffer defines** how many recorded values are contained in the trace buffer for this acquisition.

The **number of trace value blocks in the telegram defines** how many trace value blocks are contained in the current telegram.

The **trace value blocks contain** the data of a connector, recorded up to a certain time point (possibly expanded with dummy bytes). The structure of a trace value block is dependent upon the connector format and the recording mode of the acquisition block (recording this connector) and the configured output format of the @TCP. All the possible trace value blocks are described in the following table (all number definitions in bytes).

<table>
<thead>
<tr>
<th>Recording Mode</th>
<th>Output Format</th>
<th>Connector Format</th>
<th>Connector Value</th>
<th>Dummy Bytes</th>
<th>Time Point of Recording</th>
<th>Dummy Bytes</th>
<th>Block Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyclic</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>1</td>
</tr>
<tr>
<td>Cyclic</td>
<td>0</td>
<td>2</td>
<td>2</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>2</td>
</tr>
<tr>
<td>Cyclic</td>
<td>0</td>
<td>4</td>
<td>4</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>4</td>
</tr>
<tr>
<td>Cyclic</td>
<td>0</td>
<td>5</td>
<td>4</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>4</td>
</tr>
<tr>
<td>Acyclic *</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>6</td>
<td>-</td>
<td>8</td>
</tr>
<tr>
<td>Acyclic *</td>
<td>0</td>
<td>2</td>
<td>2</td>
<td>-</td>
<td>6</td>
<td>-</td>
<td>8</td>
</tr>
<tr>
<td>Acyclic *</td>
<td>0</td>
<td>4</td>
<td>4</td>
<td>-</td>
<td>6</td>
<td>2</td>
<td>12</td>
</tr>
<tr>
<td>Acyclic *</td>
<td>0</td>
<td>5</td>
<td>4</td>
<td>-</td>
<td>6</td>
<td>2</td>
<td>12</td>
</tr>
<tr>
<td>Cyclic</td>
<td>0</td>
<td>1,2,4,5</td>
<td>4</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>4</td>
</tr>
<tr>
<td>Acyclic *</td>
<td>0</td>
<td>1,2,4,5</td>
<td>4</td>
<td>-</td>
<td>6</td>
<td>2</td>
<td>12</td>
</tr>
</tbody>
</table>
A trace value block consists of the connector value, a dummy byte (optional), the time point of the acquisition (only for acyclic recording, output in SIMADYN D format *time and date*) and further dummy bytes (optional). The output format is defined by the SSF connector of the @TCP block. The connector format is defined by the acquisition block type.

* The connector value is recorded by an acquisition block in an interrupt layer (I1--I5).

**Example:**

Structuring the values in the telegram body for a 1 byte connector, recorded by an acquisition block acyclically (interrupt layer). The output is implemented in standardized form as a floating point number.

<table>
<thead>
<tr>
<th>Byte</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>29 ... 32</td>
<td>Trace Value to Time Point t1</td>
</tr>
<tr>
<td>33 ... 38</td>
<td>Acquisition Time Point t1</td>
</tr>
<tr>
<td>39, 40</td>
<td>Dummies</td>
</tr>
<tr>
<td>41 ... 44</td>
<td>Trace Value to Time Point t2</td>
</tr>
<tr>
<td>45 ... 50</td>
<td>Acquisition Time Point t2</td>
</tr>
<tr>
<td>51, 52</td>
<td>Dummies</td>
</tr>
</tbody>
</table>

**Group Telegrams**

A group telegram is generated by @TCP FB, when the value 1 is present at the initialization connector OUT of the @TCP FB.

A group telegram basically consists of one telegram. This signifies that the output channel must be correspondingly dimensioned to accept all trace values at one time (CHA connector of the @TCP FB). If the channel is too small, then the @TCP FB reverts to the status OFF at the start of the cyclic phase. A communication error message is generated, whereby the error message contains the minimum channel size information. The minimum size of the output channel can be calculated according to the following formula:

\[
CHA \geq 12 + 4 \times HIA + 12 \times TRPx + 4 \times TBL
\]

**Index:**

- **CHA** -Minimum channel size in bytes (information at the connector CHA of the @TCP)
- **HIA** -Information at the connector HIA of the TRHI FB (0 when TRHI FB is not configured)
- **TRPx** -Number of configured (and correctly initialized) acquisition blocks
- **TBL** -Size of the trace buffer (information at the connector TBL of the @TCP)
The group telegram layout is made up as follows:

### Telegram Header:

<table>
<thead>
<tr>
<th>Byte Number</th>
<th>Content</th>
<th>Data Format</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number of Active TRPx</td>
<td>char</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Output Format</td>
<td>char</td>
<td>See individual telegram</td>
</tr>
<tr>
<td>3 to 8</td>
<td>Last Acquisition Time Point</td>
<td>6 chars</td>
<td></td>
</tr>
<tr>
<td>9 to 12</td>
<td>Parameter 0</td>
<td>unsigned int32</td>
<td>First parameter TRHI--FB</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9 + (n-1) * 4</td>
<td>Parameter n-1</td>
<td>unsigned int32</td>
<td>n--th. parameter TRHI--FB</td>
</tr>
</tbody>
</table>

### Telegram Body:

<table>
<thead>
<tr>
<th>Byte-Nr.</th>
<th>Inhalt</th>
<th>Datenformat</th>
<th>Bedeutung</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 + n * 4</td>
<td>Connector ID Number</td>
<td>unsigned int16</td>
<td>See individual telegram</td>
</tr>
<tr>
<td>11 + n * 4</td>
<td>Connector Interpretation</td>
<td>char</td>
<td>See individual telegram</td>
</tr>
<tr>
<td>12 + n * 4</td>
<td>Connector Format</td>
<td>char</td>
<td>See individual telegram</td>
</tr>
<tr>
<td>13 + n * 4</td>
<td>Sampling Time</td>
<td>unsigned int32</td>
<td>See individual telegram</td>
</tr>
<tr>
<td>17 + n * 4</td>
<td>Request Identifier</td>
<td>unsigned int16</td>
<td>See individual telegram</td>
</tr>
<tr>
<td>19 + n * 4</td>
<td>Number of Trace Value Blocks</td>
<td>unsigned int16</td>
<td>See individual telegram</td>
</tr>
<tr>
<td>21 + n * 4</td>
<td>Number of Trace Value Blocks</td>
<td></td>
<td>See individual telegram</td>
</tr>
</tbody>
</table>

A telegram body exists for each acquisition block. The telegram bodies are sorted according to the log on sequence of the corresponding acquisition blocks.

The type of data within the group telegram is basically identical to the type of data in the individual telegram.

The number of active TRPx corresponds to the number of telegram bodies in the group telegram. The allocation of the telegram bodies to the acquisition blocks is then possible via the connector ID number, which corresponds to the CID information of the acquisition blocks.

The last acquisition time point in the telegram header of a group telegram receives the time point of detection of the stop signal. The last acquisition time point in the individual telegrams corresponds to the time point of the recording of the last trace value in the trace buffer and can therefore differ in acquisition blocks.

The parameter 1- n of the TRHI FB is only entered when it has also been configured. The connector HIA of the TRHI FB indicates how many parameters are inserted into the header.

Warning: no information exists in the group telegram of whether and how many parameters have been transferred from the TRHI FB. The interpretation of the group telegram is therefore dependent upon the configuring. The parameters contain supplementary information, of which the number and its interpretation is left up to the user.
Each telegram body starts with an offset, with regard to the start of the telegram, which is divisible by 4. Therefore telegram bodies are filled with dummy bytes under certain circumstances.

Example: a group telegram is generated in which three trace values of a TRP_B FB exist. The TRP_B FB are operated in cyclic recording mode and with a binary output format, such that the corresponding trace value block has a size of 1 byte. Therefore the panel number of trace value blocks, in the telegram body, has the value of 3 and is followed by 3 bytes of trace value blocks, which are existent in the telegram. A dummy byte is now inserted. The next telegram body starts behind this dummy byte. No dummy bytes are inserted behind the last telegram body.
## Index

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>$ signals</td>
<td>2-17</td>
</tr>
<tr>
<td>7</td>
<td>2-45</td>
</tr>
<tr>
<td>7-segment display</td>
<td>2-45</td>
</tr>
<tr>
<td>Acknowledge error</td>
<td>2-45</td>
</tr>
<tr>
<td>Application example PROFIBUS DP</td>
<td>3-82</td>
</tr>
<tr>
<td>Configuring slaves</td>
<td>3-98</td>
</tr>
<tr>
<td>Assigning a name</td>
<td>2-3</td>
</tr>
<tr>
<td>Basic clock cycle</td>
<td>2-25</td>
</tr>
<tr>
<td>Basic CPU clock cycle</td>
<td>2-19</td>
</tr>
<tr>
<td>Basic information, communications</td>
<td>3-2</td>
</tr>
<tr>
<td>Behavior under fault conditions</td>
<td>2-39</td>
</tr>
<tr>
<td>CFC chart (Continuous Function Chart)</td>
<td>2-7</td>
</tr>
<tr>
<td>CFC editor</td>
<td>2-7</td>
</tr>
<tr>
<td>Margins</td>
<td>2-11</td>
</tr>
<tr>
<td>Parameterizing dialogs</td>
<td>2-8</td>
</tr>
<tr>
<td>COM PROFIBUS</td>
<td>3-77</td>
</tr>
<tr>
<td>SIMATIC Operator Panels</td>
<td>3-176</td>
</tr>
<tr>
<td>Communication blocks</td>
<td>3-7</td>
</tr>
<tr>
<td>Address connections AT, AR, US</td>
<td>3-15</td>
</tr>
<tr>
<td>Central coupling blocks</td>
<td>3-12</td>
</tr>
<tr>
<td>Firmware status, ECL, ECO connection</td>
<td>3-11</td>
</tr>
<tr>
<td>Initialization input CTS</td>
<td>3-9</td>
</tr>
<tr>
<td>MOD connection</td>
<td>3-13</td>
</tr>
<tr>
<td>Status display, output YTS</td>
<td>3-15</td>
</tr>
<tr>
<td>Transmitter and receiver</td>
<td>3-15</td>
</tr>
<tr>
<td>Communication utilities</td>
<td>3-6</td>
</tr>
<tr>
<td>WinCC via SINEC H1</td>
<td>3-216</td>
</tr>
<tr>
<td>Communications buffer coupling</td>
<td>3-21</td>
</tr>
<tr>
<td>Configuring SIMADYN D stations</td>
<td>3-24</td>
</tr>
<tr>
<td>Consistency check</td>
<td>2-7</td>
</tr>
<tr>
<td>Coupling modules</td>
<td></td>
</tr>
</tbody>
</table>
### Index

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number in the subracks</td>
<td>3-17</td>
</tr>
<tr>
<td>Couplings</td>
<td></td>
</tr>
<tr>
<td>Data interface</td>
<td>3-18</td>
</tr>
<tr>
<td>Mode of operation</td>
<td>3-13</td>
</tr>
<tr>
<td>Net data structures</td>
<td>3-16</td>
</tr>
<tr>
<td>Overview</td>
<td>3-2</td>
</tr>
<tr>
<td>Couplings on the subrack</td>
<td>3-19</td>
</tr>
<tr>
<td>CPU synchronization</td>
<td>2-25</td>
</tr>
<tr>
<td>Configuring the CPU basic clock cycle</td>
<td>2-26</td>
</tr>
<tr>
<td>Configuring the interrupt task</td>
<td>2-28</td>
</tr>
<tr>
<td>Cycle errors</td>
<td>2-31</td>
</tr>
<tr>
<td>Eliminating</td>
<td>2-32</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Data consistency</td>
<td>2-21</td>
</tr>
<tr>
<td>Data transfer mode</td>
<td></td>
</tr>
<tr>
<td>Handshake</td>
<td>3-9</td>
</tr>
<tr>
<td>Image</td>
<td>3-12</td>
</tr>
<tr>
<td>Multiple</td>
<td>3-11</td>
</tr>
<tr>
<td>Overview</td>
<td>3-8</td>
</tr>
<tr>
<td>Refresh</td>
<td>3-9</td>
</tr>
<tr>
<td>Select</td>
<td>3-10</td>
</tr>
<tr>
<td>Deadtimes</td>
<td>2-19</td>
</tr>
<tr>
<td>Direct CPU-CPU coupling</td>
<td>3-20</td>
</tr>
<tr>
<td>Download in the RUN status</td>
<td>2-15</td>
</tr>
<tr>
<td>E</td>
<td></td>
</tr>
<tr>
<td>Error differentiation</td>
<td>2-36</td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>Fast $ signal</td>
<td>2-18</td>
</tr>
<tr>
<td>Features</td>
<td></td>
</tr>
<tr>
<td>Computation times of the operating system</td>
<td>2-33</td>
</tr>
<tr>
<td>Cyclic tasks</td>
<td>2-33</td>
</tr>
<tr>
<td>Interrupt tasks</td>
<td>2-33</td>
</tr>
<tr>
<td>Memory requirement of the operating system</td>
<td>2-34</td>
</tr>
<tr>
<td>Function block</td>
<td></td>
</tr>
<tr>
<td>Assignment to interrupt tasks</td>
<td>2-9</td>
</tr>
<tr>
<td>Comments</td>
<td>2-12</td>
</tr>
<tr>
<td>Function blocks</td>
<td></td>
</tr>
<tr>
<td>Assigning to cyclic tasks</td>
<td>2-9</td>
</tr>
<tr>
<td>H</td>
<td></td>
</tr>
<tr>
<td>hardware address</td>
<td>2-12</td>
</tr>
<tr>
<td>Hardware timer</td>
<td>2-26</td>
</tr>
<tr>
<td>HWConfig</td>
<td>2-5</td>
</tr>
<tr>
<td>Parameterizing dialogs</td>
<td>2-5</td>
</tr>
<tr>
<td>I</td>
<td></td>
</tr>
<tr>
<td>Initialization</td>
<td>2-35</td>
</tr>
</tbody>
</table>
### Index

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interconnecting</td>
<td>3-101</td>
</tr>
<tr>
<td>Interrupt-controlled processing</td>
<td>2-36</td>
</tr>
<tr>
<td>Libraries</td>
<td>2-4</td>
</tr>
<tr>
<td>Limited number of interconnections</td>
<td>2-20</td>
</tr>
<tr>
<td>Loading the user program</td>
<td></td>
</tr>
<tr>
<td>Offline loading</td>
<td>2-13</td>
</tr>
<tr>
<td>Online loading</td>
<td>2-13</td>
</tr>
<tr>
<td>Local CPU coupling</td>
<td>3-19</td>
</tr>
<tr>
<td>Operating system components</td>
<td>2-34</td>
</tr>
<tr>
<td>Operator Panels (SIMATIC)</td>
<td>3-176</td>
</tr>
<tr>
<td>Pointer-based communications blocks</td>
<td></td>
</tr>
<tr>
<td>Applications</td>
<td>3-162</td>
</tr>
<tr>
<td>Associated function blocks</td>
<td>3-163</td>
</tr>
<tr>
<td>Configuring information and instructions</td>
<td>3-164</td>
</tr>
<tr>
<td>Examples</td>
<td>3-166</td>
</tr>
<tr>
<td>Features</td>
<td>3-162</td>
</tr>
<tr>
<td>Pointer interface</td>
<td>3-164</td>
</tr>
<tr>
<td>Principal mode of operation</td>
<td>3-162</td>
</tr>
<tr>
<td>Pointer-based communications blocks</td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>3-161</td>
</tr>
<tr>
<td>Process data</td>
<td>3-153</td>
</tr>
<tr>
<td>Blocks CRV, CTV</td>
<td>3-157</td>
</tr>
<tr>
<td>Channel marshalling blocks</td>
<td>3-157</td>
</tr>
<tr>
<td>Channels</td>
<td>3-180</td>
</tr>
<tr>
<td>Configuring example</td>
<td>3-155</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>3-159</td>
</tr>
<tr>
<td>Distribution block</td>
<td>3-158</td>
</tr>
<tr>
<td>Function blocks</td>
<td>3-153</td>
</tr>
<tr>
<td>Communications error message</td>
<td>3-145</td>
</tr>
<tr>
<td>Entry logic</td>
<td>3-138</td>
</tr>
<tr>
<td>Error or alarm message</td>
<td>3-143</td>
</tr>
<tr>
<td>Message entry blocks</td>
<td>3-138</td>
</tr>
<tr>
<td>Message format</td>
<td>3-146</td>
</tr>
<tr>
<td>Message formats</td>
<td></td>
</tr>
<tr>
<td>Message type description</td>
<td>3-143</td>
</tr>
<tr>
<td>Messages</td>
<td>3-140</td>
</tr>
<tr>
<td>Output format</td>
<td>3-151</td>
</tr>
<tr>
<td>Overflow message</td>
<td>3-145</td>
</tr>
<tr>
<td>System error</td>
<td>3-146</td>
</tr>
<tr>
<td>System error message</td>
<td>3-145</td>
</tr>
<tr>
<td>MPI coupling</td>
<td>3-101</td>
</tr>
<tr>
<td>Configuring</td>
<td></td>
</tr>
<tr>
<td>Configuring example</td>
<td>3-155</td>
</tr>
<tr>
<td>Channels</td>
<td></td>
</tr>
<tr>
<td>Channel marshalling blocks</td>
<td>3-157</td>
</tr>
<tr>
<td>Channels</td>
<td>3-180</td>
</tr>
<tr>
<td>Configuring example</td>
<td>3-155</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>3-159</td>
</tr>
<tr>
<td>Distribution block</td>
<td>3-158</td>
</tr>
<tr>
<td>Function blocks</td>
<td>3-153</td>
</tr>
<tr>
<td>Entry logic</td>
<td>3-138</td>
</tr>
<tr>
<td>Error or alarm message</td>
<td>3-143</td>
</tr>
<tr>
<td>Message entry blocks</td>
<td>3-138</td>
</tr>
<tr>
<td>Message format</td>
<td>3-146</td>
</tr>
<tr>
<td>Message formats</td>
<td></td>
</tr>
<tr>
<td>Message type description</td>
<td>3-143</td>
</tr>
<tr>
<td>Messages</td>
<td>3-140</td>
</tr>
<tr>
<td>Output format</td>
<td>3-151</td>
</tr>
<tr>
<td>Overflow message</td>
<td>3-145</td>
</tr>
<tr>
<td>System error</td>
<td>3-146</td>
</tr>
<tr>
<td>System error message</td>
<td>3-145</td>
</tr>
<tr>
<td>MPI coupling</td>
<td>3-101</td>
</tr>
<tr>
<td>Configuring</td>
<td></td>
</tr>
<tr>
<td>Configuring example</td>
<td>3-155</td>
</tr>
<tr>
<td>Channels</td>
<td></td>
</tr>
<tr>
<td>Channel marshalling blocks</td>
<td>3-157</td>
</tr>
<tr>
<td>Channels</td>
<td>3-180</td>
</tr>
<tr>
<td>Configuring example</td>
<td>3-155</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>3-159</td>
</tr>
<tr>
<td>Distribution block</td>
<td>3-158</td>
</tr>
<tr>
<td>Function blocks</td>
<td>3-153</td>
</tr>
</tbody>
</table>

System- and communication configuring D7-SYS - SIMATIC TDC